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FOREWORD

The National Instructional Media Institute (NIMI) is an autonomous body under the Directorate General of
Employment and Training (DGE&T) Ministry of Labour and Employment has been developing, producing
and disseminating Instructional Media Packages (IMPs are extensively used in the Industrial Training
Institutes/Training centres in  Industries to impart practical training and develop work-skills for the train-
ees and the trainers

The Ministry of Labour & Employment constituted Mentor Councils (MCs) to revampcourses run / to be
run under National Council of Vocational Training (NCVT) in 25 sectors. The MCs have representatives
from thought leaders among various stakeholders viz. one of the top ten industries in the sector innovative
entrepreneurs who have proved to be game-changers, academic/professional institutions (IITs etc.), ex-
perts from field institutes of DGE&T, champion ITIs for each of the sectors and experts in delivering
education and training through modern methods like through use of IT, distance education etc. The
technical support to the MCs is provided by Central Staff Training and Research Institute (CSTARI),
Kolkata and National Instructional Media Institute (NIMI), Chennai. Some of the MCs are also supported
by sector-wise Core Groups which were created internally in the Ministry (in 11 sectors).

A Steering Committee to provide overall coordination and guidance to Mentor Councils has also been
constituted and has representation from the MCs, Chair positions to be endowed by the Ministry, trade
unions, and experts on distance education and training. The MCs are mandated to work towards revamp-
ing/suggesting new courses, improving assessment systems, overall learning etc. for subjects under the
purview of the NCVT.

Accordingly NIMI with the support and assistance of  MC has developed DTPO Trade Theory 2nd Semester
in IT & ITES sector to enhance the employability of ITI trainees across the country and also to meet the
industry requirement.

I have no doubt that the trainees and trainers of ITIs & Training centres in industries will derive maximum
benefit from these books and that NIMI's effort will go a long way in improvement of Vocational Training.

I complement Director, Mentor Council members, Media Development Committee (MDC) members and
staff of NIMI for their dedicated and invaluable contribution in bringing out this publication.

ALOK KUMAR, I.A.S.,
Director General of Employment &

Training/ Joint Secretary
Ministry of Labour and Employment

Government of India

New Delhi - 110 001
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PREFACE

This National Instructional Media Institute (NIMI) was set up at Chennai by the Directorate General
of Employment and Training (DGE&T) Ministry of Labour and Employment, Government of
India with technical assistance from the Govt. of the Federal Republic of Germany. The prime
objective of this institute is to develop and disseminate instructional materials for various trades
as per the prescribed syllabi under the Craftsmen and Apprenticeship Training Schemes.

The instructional materials are developed and produced in the form of Instructional Media
Packages (IMPs). An IMP consists of Trade Theory book, Trade Practical book, Test and
Assignment book, Instructor guide, Wall Charts and Transparencies.

Hon'ble Union Minister of Finance during the budget speech 2014-2015 mentioned about
developing Skill India and made the following announcement

"A national multi-skill programme called Skill India is proposed to be launched. It would skill the
youth with an emphasis on employability and entrepreneur skills. It will also provide training and
support for traditional  professions like welders, carpenters, cobblers, masons, blacksmiths,
weavers etc. Convergence of various schemes to attain this objective is also proposed."

The Ministry of Labour & Employment constituted Mentor Councils (MCs) to revamp courses
run / to be run under National Council of Vocational Training (NCVT) in 25 sectors which will give
a sustained skill based employability to the ITI trainees  as the main objective of Vocational
training. The ultimate approach of NIMI is to prepare the validated IMPs based on the exercises
to be done during the course of study. As the skill development is   progressive the theoretical
content on a particular topic is limited to the requirement in every stage.  Hence the reader will
find a topic spread over a number of units. The test and assignment will enable the instructor to
give assignments and evaluate the performance of a trainee. If a trainee possesses the same
it helps the trainee to do assignment on his own and also to evaluate himself. The wall charts
and transparencies are unique, as they  not only help the instructor to effectively present a topic
but also helps the trainees to grasp the technical topic quickly. The instructor guide enables the
instructor to plan his schedule of instruction, plan the raw material requirement ,

Thus the availability of a complete Instructional Media Package in an institute helps the trainer
and management to impart an effective training. Hence it is strongly recommended that the
Training Institutes/Establishments should provide at least  one IMP per unit. This will be small,
one time investment but the benefits will be long lasting.

The DTPO Trade Theory 2nd semester in IT&ITES sector  is one of the book develop by the
core group members of the Mentor Councils (MCs). The 2nd  semester book includes Module1-
Photoshop, Module 2 - Corel Draw, Module 3 - InDesign, Module 4 - Bi-Lingual Software,
Module 5 - Printing and Publishing

The DTPO Trade Theory 2nd semester is the outcome of the collective efforts of Members of
Mentor Council which includes academic/professional institutions (IITs etc.) , experts from field
institutes of DGE&T, champion ITIs for each of the sectors, and also Media Development
Committee (MDC) members and staff of NIMI.

NIMI wishes that the above material (Trade Practical & Trade Theory) will fulfil to satisfy the long
needs of the Trainees and Instructor and helps the trainees for their employability in vocational
training.

NIMI would like to take this opportunity to convey sincere thanks to all the Mentor Council members
and Media Development Committee (MDC) members.

A. MAHENDIRAN
Chennai - 600 032.          Director, NIMI
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INTRODUCTION

TRADE THEORY

The  manual of trade theory consists of  theoretical information for the Second Semester course of the  DTPO
Trade.  The contents are sequenced according to the practical exercise contained in the manual on Trade
practical.  Attempt has been made to relate the theortical aspects with the skill  covered in each exercise to
the extent possible. This co-relation is maintained to help the trainees to develope the perceptional capabilities
for performing the skills.

The Trade theory has to be taught and learnt along with the corresponding exercise contained in the manual
on trade practical. The indicating about the corresponding practical exercise are given in every sheet of this
manual.

It will be preferable to teach/learn the trade theory connected to each exercise atleast one class before
performing the related skills in the shop floor. The trade theory is to be treated as an integrated part of each
exercise.

The material is not the purpose of self learning and should be considered as supplementary to class room
instruction.

TRADE PRACTICAL

The trade practical manual is intented to be used in workshop. It consists of a series of practical exercies to
be completed by the trainees during the  Second Semester course  of the DTPO trade  supplemented and
supported by instructions/ informations to assist in performing the exercises. These exercises are designed
to ensure that all the skills in the prescribed syllabus are covered.

The manual is divided into Five modules.  The distribution of exercises in the Five modules are given below.

Module 1 Photoshop 11 Exercises

Module 2 Corel Draw 13 Exercises

Module 3 InDesign   9 Exercises

Module 4 Bilingual software   3 Exercises

Module 5 Printing and publishing   8 Exercises

       Total                     44 Exercises

The skill training in the shop floor is planned through a series of practical exercises centred  around some
practical project. However, there are few instance where the individual exercise does not form a part of project.

While developing the practical manual a sincere effort was made to prepare each exercise which will be easy
to understand and carry out even by below average traninee. However the development team accept that there
if a scope for further improvement.   NIMI, looks forward  to the suggestions from the experienced training faculty
for improving the manual.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.01
Image editing softwares
Objectives : At the end of this lesson you shall be able to
• explain about the process of producing printed products
• describe various image editing software
• explain about Adobe Photoshop CS6
• learning about Creating, Opening, and importing images in Adobe Photoshop
• identifying workspace and tools.

Graphic reproduction

The process of producing printed products can be divided
into three parts: prepress, printing (press), and print
finishing (postpress).

Printed products are graphic products in the widest sense:
books and brochures, newspapers and magazines, leaf-
lets and posters, labels and stickers, stamps and securi-
ties, credit and check cards, as well as folding cartons and
blister packs, bags and pouches, beakers and tins, paper
plates and lanterns, paper tissues, beer mats, mailings,
and much more.

Prepress includes all the processing steps required to go
from the preparation of the text, original images and
graphics as well as the design concept right up to the
production of the ready-for-print master; the master (print-
ing plate) is then employed at the printing stage to produce
the job.

The informational content and professional typographic/
graphic design of printed products are also a useful starting
point for publications in the field of electronic media even
outside print media, such as homepages on the Internet or

Text

The possibilities of word capturing and processing, as well
as the generation of a typesetting product, are described
in.  The method of working has not been changed by the
introduction of digital production, only the place of execu-
tion has changed in most cases: that is from the depart-
ments of typesetting and reproduction to the correspond-
ing departments at the customer's or at the agency.

The text data are primarily prepared in "Word" format,
which has virtually become the word processing standard,
since it is most widely used and offers many professional
tools.  The text data are very rarely edited directly in word;
instead they are positioned and typographically edited in a
layout program (e.g., Quark XPress, InDesign, or
Pagemaker).

CD-ROMs containing text and pictures.  In a wider sense,
therefore, "prepress" is also referred to as "pre-media",
meaning the preparation of text and image for the several
publication media.  As can be seen in, the premedia
production stage may already be incorporated in the actual
prepress stage.

A fundamental technological change has taken place
within prepress. The use of conventional typesetting ma-
chines, repro cameras, and film has been replaced by
computer technology in virtually all branches of this indus-
try. Text and image are digitized or actually created
digitally, processed electronically and output directly onto
the printing plate in print format, and increasingly without
the use of film intermediates. Nevertheless, for many
companies film remains an indispensable information
carrier, albeit for a short-term transitional phase.  It is for
this reason that both prepress technologies.

• Conventional and

• Digital

Images

The picture objects of a printed product are usually avail-
able as photograph, slide, or reflection copy, and are
scanned in, or digitized, for publication.  The digital data are
then available at a workstation for further processing (i.e.,
corrections of the image contents or geometry).  In the
mean time, further alternatives have been added to this
classical procedure: for instance the principle of the photo
CD.  This procedure still includes the use of a camera and
the development of the film.  However, very often the result
is not a slide, but a data file, for example stored on a Photo
CD, containing original pictures that are already digitized.
As for the scanned image, these data can also be pro-
cessed directly onto the workstation.
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Graphics

Graphics constitute the third main element of a printed
page.  They are generally generated in so called illustration
programs such as Freehand, Illustrator, or Coreldraw.
These data are usually saved in the form of vector-based
data files, which cannot be edited or positioned in a layout
program.  Therefore, these software programs offer an
opportunity to save graphics or drawings in EPS format and
make them available in the  layout for geometric processing
(scaling, cropping).

Layout

Layout programs are software packages allowing for flex-
ible, creative work and for integrating the elements (text,
images, and graphics) on pages or a sequence of pages,
or to position them on the page depending on the current
job.  Thus they have taken over a significant function of
production.  One particular layout program has virtually
become a standard application: Quark Xpress.  In 1999, a
competitor appeared on the market: Indesign from Adobe.
Another popular layout program is page-maker (formerly by
Aldus, today Adobe), which is mostly used in offices.

Photomechanical image processing/reproduction

Image processing or reproduction is the process that
information in the form of images undergoes when it is
converted from an original to a ready-for-print master/plate.
In photomechanical image processing the master (usually
film) is produced by using optical devices to record the
images (camera, optics, filters, etc.) and process them
(color filters, optical screens, special properties of the film
material, etc.); no digital processes are used for photome-
chanical recording and processing the images, which is
the case in "electronic reproduction technology"

Images may be present both as line art (graphics), black-
and-white or colored, and as black-and-white or colored
continuous-tone images.  The base material containing the
image data is called the original. In the case of a continu-
ous-tone original it is most often a photograph. A black-
and-white photo contains a large number of gray values
ranging from the black areas of the image, the "shadows,"
to the white areas, the "highlights", the range of optical
density of a positive slide, which is often the original for
image reproduction, is greater than that of a print, it is
necessary for adjustments to be made depending on the
subject matter.  In addition there is scaling (enlargement/
reduction), image correction (spotting out unwanted de-
tails, smoothing or contours, addition or removal of ele-
ments of the image, etc.), color correction, and, as already
mentioned, screening for the halftone reproduction of
continuous-tone images for printing.  This whole range of
tasks must be accomplished during the image processing/
reproduction process-efficiently and within tightly con-
trolled limits.  There are two processing routes to achieve
this goal, which involve different principles:

• Analog image processing and

• Digital image processing.

Analog image processing uses predominantly photome-
chanical, chemical, and physical means to complete the
tasks whereas digital image processing is carried out
electronically/digitized.

Principles, tasks of photomechanical reproduction

Photomechanical reproduction technology has the task of
producing masters/copies (films) for the platemaking pro-
cess from original images via a photomechanical route.
Knowledge of fundamental definitions and laws of light
technology and the properties of films used in repro
technology is required in order to fully master the optical
and photographic processes involved.

IT&ITES : DTPO - Related Theory for Exercise 2.1.01
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Image editing softwares

Modern cameras can make digital photography seem very
easy, and even the most basic models will often produce
crisp, clear photos.

You'll still have occasional issues with lighting, white
balance, red-eye and more, though, so it's a good idea to
learn & use a photo editor around to help resolve these
issues.

The extremely demanding software for image editing is
Photoshop, and there's no doubt it's a great program. But
it is a licensed program which is costly as well.

Some excellent free tools are also available. Lets get some
brief on a few Image editing softwares before studying
Photoshop.

1. GIMP

GIMP (the GNU Image Manipulation Program) first ap-
peared way back in 1996, and has been regularly updated
ever since, so it's no surprise that the package is one of the
most powerful free photo editor. There are tools to correct
colours, enhance contrast, brightness and more; sharpen
or blur an image, fix perspective problems, remove red-eye;
add special lighting effects, turn a photo into an oil painting,
and create an animation.

The paint tools alone are amazing, there's full layer support
and lots of ways to extend the program.

All this power does mean GIMP takes a while to learn, but
don't let that put you off - if you've any previous image editing
experience then you'll be doing useful work within minutes.

2. Paint.NET

It may not have anything like the power of GIMP, but there's
still plenty to like about Paint.NET. It's strong on image
editing basics, with options to resize and rotate your
photos, a good range of selection and paint tools, and
some excellent special effects.

Support for layers means you can apply your edits to part
of an image only, and the program can be extended with
plugins.

Best of all, though, Paint.NET'sar and straightforward
interface means it's very easy to use, even if you're a
complete graphics novice.

3. PhoXo

PhoXo has been around for almost 10 years now, and it's
grown into a very useful editor with something for everyone.
Kids can play around with the clipart, customising images
with cartoon cats; practical types will enjoy options like the
ability to add a custom watermark to an entire folder of
images; and everyone else will appreciate the drawing and
paint tools, image transformations, effects and more.

4. Funny Photo Maker

Funny Photo Maker has no layer support, no smart
selection tools, no paint or drawing options. But that
doesn't matter, because what it does have is an amazing
range of effects which you can apply in seconds.

So you can add someone's face to a movie poster,
magazine cover or a dollar bill; transform a still image into
an animation; add rain or snow to a photo, apply some
excellent frames, and turn your photos into a college,
amongst many other options.

Fig 1

Fig 2

Fig 3

Fig 4
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Introduction

Photoshop can be described as a digital editing application
for digital-copy of raster images. Besides the standard
colour and lighting correction tools along with filtering,
painting, masking, and layering options, it provides additional
functionality to work with 3D objects, digital animations,
and video editing.

Photo Corrections

Photoshop's strength lies in the ability to correct digital
images to restore original color and lighting as well as to
correct problems introduced in images by camera lenses.

Photo composition

Image editing may be used to combine multiple images
into one single image or composition. Multiple images

5. Photo Pos Pro

Its tiny toolbars and dated interface mean Photo Pos
Prodoesn't look too promising, but begin to explore and
you'll soon be impressed.

There are plenty of selection options, a wide range of paint
tools, colour corrections and more.

You get reasonable support for layers and masks, lots of
effects (all extremely configurable), and a scripting tool
which helps you automate many editing tasks.

And the program offers some fun touches, too, like a set of
"Magical" effects which help you add fireworks, bubbles,
stardust or similar decorations to an image.

Introduction to photoshop CS5

Explain the capabilities and features for Photoshop

Fig 5

taken from different horizontal angles from the same spot
can be merged into a single panoramic image.

Artistic effects

Photoshop provides the ability to use different filters and
warping tools to apply artistic effect to images. The
combination of numerous tools and filters in Photoshop
can create unexpected results.

Painting

Photoshop is one of the best applications available for
creating digital paintings. The addition of wet brush capability
in Photoshop CS5 makes it the first choice for digital
painting. Many of the powerful features, such as the
layering and masking, are available for use with the painting
tools. The paint-brushes are integrated into many of the
other tools in Photoshop.

Fig 6
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Creating vector artwork

Photoshop also is an excellent application to use for
creating vector artworks. The path tool quickly creates/
manipulates vector artwork created on a separate masked
layer upon any raster image. You also can add vector
artwork (including vector text) to raster images.

Adding text to images

Photoshop provides various type tools used to add text
upon images. The text can be resized, warped, and
adjusted to add special visual effects to the image(s).

Creating Web images

Another area where Photoshop excels is preparing images
for the web. Photoshop provides utilities to quickly format
images with the appropriate size, file format, and colors for
use in web pages. Photoshop also provides tools for slicing
of an image into clickable sections and provides the
required HTML code for use of the slices in Web pages.

Print preparation

Photoshop is often used to convert the images from one
colour format to another making it ready for being printed.
Usually RGB colour mode is changed to CYMK for four-
colour printing. Spot colors are added separately and color
separations are also created.

Creating 3D objects

Photoshop has the capability to create and manipulate 3D
objects. Although it is not the best utility for creating
3Dobjects, it is very good at manipulating them and then
applying them to 2D images.

Adding textures to 3D objects

Photoshop has a big advantage over other 3Dapplications
at applying textures to 3D objects. With photoshop's filter
and painting capabilities, Edit the textures of your 3D
objects in ways that you may not have thought possible.

Video corrections

Just as with 3D modeling, photoshop should not be your
choice for creating video projects; however, using
photoshop's color, lighting, and filter effects, Quickly apply
corrections to video and even add some artistic effects,

Animating images

Another fun feature of Photoshop is the ability to add
animation to your images. Animated images can gives life
to web pages and allow you to create short animates
movies.

New Photo shop document

New

Go to File Menu → Choose the Option New from file menu.
The New Dialogue box opens as shown in Fig. 7

 Fig 7

Name

These settings specify the name of the document which is
used to locate the document in the file system later.

Preset

This option includes a drop down list as shown below.

Size

This settings to select drop down list based on the preset
setting selected standard photo sizes and paper sizes or
custom sizes available on the clip board.

 Fig 8

Width

This setting specify the sizes document width area available
on the size, The available units they are inches, mm, cm,
picas, point, pixels and columns the available in the preset.

Height

This setting specify the sizes document height area
available on the size, The available units they are inches,
mm, cm, picas, point, pixels and columns the available in
the preset.

Resolution

This settings specify the resolution and the units to set the
resolution of the new document, The available units are
pixels/inch and pixels/cm

Color mode

This settings specify the Colour mode and number of
channels to use the creating document, Colour mode
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• The ability to import 3D images and to edit individual
frames or image sequence files by painting, cloning,
retouching, or transforming them.

• Support for 3D files including the U3D, 3DS, OBJ, KMZ,
and Collada file formats created by programs such as
Adobe Acrobat® 9 Professional and Google Earth. See
Lesson 12, "Working with 3D Images," to learn about
these features.

• Support for specialized file formats, such as DICOM,
the most common standard for receiving medical scans;
MATLAB, a high-level technical computing language
and interactive environment for developing algorithms,
visualizing and analyzing data, and computing num-
bers; and 32-bit highresolution images, including a
special HDR Color Picker and the capability to paint
and layer these 32-bit HDR images.

Installing adobe Photoshop

Before you begin using Adobe Photoshop CS6, make sure
that your system is set up correctly and that you've
installed the required software and hardware. You must
purchase the Adobe Photoshop CS6 software separately.
For system requirements and complete instructions on
installing the software, see the Adobe Photoshop CS6
Read Me file on the application DVD or on the web at
www.adobe.com/support. Note that some Photoshop CS6
Extended features, including all 3D features, require a
video card that supports OpenGL 2.0. Photoshop and
Bridge use the same installer. You must install these
applications from the Adobe Photoshop CS6 application
DVD (you cannot run the programs from the disc), or from
the installation files you downloaded from Adobe, onto your
hard drive. Follow the onscreen instructions. Make sure
that your serial number is accessible before installing the
application.

Photoshop CS6 system requirements

Windows

• Intel® Pentium® 4 or AMD Athlon® 64 processor

• Microsoft® Windows® XP with Service Pack 3
orMicrosoft Windows 7 with Service Pack 1. Adobe®
Creative Suite® 5.5 and CS6 applications also support
Windows 8 and Windows 8.1. See the CS6 FAQ for
more information about Windows 8 support.*

• 1 GB of RAM

• 1 GB of available hard-disk space for installation;
additional free space required during installation (can-
not install on removable flash storage devices)

• 1024 x 768 display (1280 x 800 recommended) with 16-
bit color and 512 MB (1 GB recommended) of VRAM

• OpenGL 2.0-capable system

• DVD-ROM drive

(Bitmap, RGB colour, CMYK colour, Gray scale, Lab
Colour and bit level (1bit,8 bit,16 bit32 bit)available on the
new document

Background Contents

This setting specifies the contents of the background of the
new document, This options are white, background color
and transparent . background Colour is selected the Colour
is selected the Colour of the back ground Photoshop
toolbox is used as the background for the document.

Introduction to Adobe Photoshop CS6

Adobe® Photoshop® CS6, the benchmark for digital
imaging excellence, provides strong performance, powerful
image-editing features, and an intuitive interface. Adobe
Camera Raw, included with Photoshop CS6, offers flexibility
and control as you work with raw images as well as TIFF
and JPEG images. Photoshop CS6 pushes the boundaries
of digital image editing and helps you turn your dreams into
designs more easily than ever before.

What's New in this Edition

This edition covers many new features in Adobe Photoshop
CS6, such as intuitive video editing tools, which make it
easy to create and add effects to video clips and still
images; the Content-Aware Move tool, which lets you
remove unwanted objects or replicate existing portions of
an image; simpler and more powerful 3D controls
(Photoshop CS6 Extended only); and the all-new Crop tool,
providing greater flexibility in cropping, straightening, and
skewing an image. In addition, these lessons introduce
you to erodible brush tips, new vector layers, lens-aware
adjustments, paragraph styles, and more. New exercises
and lessons cover:

• Using the Timeline panel, keyframes, and motion ef-
fects to create movie files from video clips and still
images within Photoshop.

• Creating and applying paragraph styles to text.

• Painting more realistic effects with erodible brush tips.

• Creating, positioning, and adding effects to objects in a
3D scene (Photoshop CS6 Extended only).

This edition is also chock-full of extra information on
Photoshop features and how best to work with this robust
application. You'll learn best practices for organizing,
managing, and showcasing your photos, as well as how to
optimize images for the web. And throughout this edition,
look for tips and techniques from one of Adobe'sown
experts, Photoshop evangelist Julieanne Kost.

Adobe Photoshop CS6 Extended

This edition of works with the 3D features in Adobe
Photoshop CS6 Extended-a version with additional func-
tions for professional, technical, and scientific users,
intended for those creating special effects in video or in
architectural, scientific, or engineering images. Photoshop
Extended features include:
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• This software doesn't operate without activation. Broad-
band Internet connection and registration are required
for software activation, validation of subscriptions, and
access to online services.

Starting to work in adobe Photoshop

The Adobe Photoshop work area includes menus, toolbars,
and panels that give you quick access to a variety of tools
and options for editing and adding elements to your image.
You can also add commands and filters to the menus by
installing third-party software known as plug-ins. Photoshop
works with bitmapped, digitized images (that is, continu-
ous-tone images that have been converted into a series of
small squares, or picture elements, called pixels). You can
also work with vector graphics, which are drawings made
of smooth lines that retain their crispness when scaled.
You can create original artwork in Photoshop, or you can
import images from many sources, such as:

• Photographs from a digital camera

• Commercial CDs of digital images

• Scans of photographs, transparencies, negatives, graph-
ics, or other documents

• Captured video images

• Artwork created in drawing programs

Open files

You can open files using the Open command and Open
Recent command. You can also open files into Photoshop
from Adobe Bridge or Adobe® Photoshop® Lightroom™.

When opening certain files, such as camera raw and PDF,
you specify settings and options in a dialog box before the
files completely open in Photoshop.

In addition to still images, Photoshop® Extended users
can open and edit 3D files, video and image sequence files.

Photoshop uses plug-in modules to open and
import many file formats. If a file format does not
appear in the Open dialog box or in the File >
Import submenu, you may need to install the
format's plug-in module.

Sometimes Photoshop may not be able to determine the
correct format for a file. This can happen, for example,
because the file has been transferred between two operat-
ing systems. Sometimes a transfer between Mac OS and
Windows can cause the file format to be mislabeled. In
such cases, you must specify the correct format in which
to open the file.

You can retain (where possible) layers, masks, transpar-
ency, compound shapes, slices, image maps, and editable
type when bringing your Illustrator art into Photoshop. In
Illustrator, export the art in the Photoshop (PSD) file format.
If your Illustrator art contains elements that Photoshop
doesn't support, the appearance of the artwork is pre-
served, but the layers are merged and the artwork is
rasterized.

Specify the file format in which to open a file

If a file was saved with an extension that doesn't match its
true format (for example, a PSD file saved with a .gif
extension), or has no extension, Photoshop may not be
able to open the file. Selecting the correct format will allow
Photoshop to recognize and open the file.

(Windows) Choose File > Open As, and select the file you
want to open. Then choose the desired format from the
Open As pop up menu, and click Open.

If the file does not open, then the chosen format
may not match the file's true format, or the file
may be damaged.

Open PDF files

Adobe Portable Document Format (PDF) is a versatile file
format that can represent both vector and bitmap data. It
has electronic document search and navigation features.
PDF is the primary format for Adobe Illustrator and Adobe
Acrobat.

Some PDF files contain a single image, and others contain
multiple pages and images. When you open a PDF file in
Photoshop, you can choose which pages or images to
open and specify rasterization options.

You can also import PDF data using the Place command,
the Paste command, and the drag-and-drop feature. The
page or image is placed on a separate layer as a Smart
Object.

The following procedure is only for opening ge-
neric PDF files in Photoshop. You don't need to
specify options in the Import PDF dialog box,
when opening Photoshop PDF files.

Open an EPS file

Encapsulated PostScript (EPS) can represent both vector
and bitmap data and is supported by virtually all graphic,
illustration, and page-layout programs. The Adobe applica-
tion that primarily produces PostScript artwork is Adobe
Illustrator. When you open an EPS file containing vector
art, it is rasterized-the mathematically defined lines and
curves of the vector artwork are converted into the pixels or
bits of a bitmap image.

You can also bring PostScript artwork into Photoshop
using the Place command, the Paste command, and the
drag-and-drop feature.

Opening a file with adobe Bridge

In this book, you'll work with different start files in each
lesson. You may make copies of these files and save them
under different names or locations, or you may work from
the original start files and then copy them from the DVD
again if you want a fresh start. This lesson includes three
start files.

In the previous lesson, you used the Open command to
open a file. Now you'll open another file using Adobe Bridge,
a visual file browser that helps take the guesswork out of
finding the image file that you need.
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Acquiring digital images from cameras

You can copy images to your computer by connecting your
camera or a media card reader to your computer.

• Use theGet Photos From Camera command in Adobe®
Bridge® to download photos, and to organize, rename,
and apply metadata to them.

• If your camera or the card reader appears as a drive on
your computer, copy images directly to your hard disk
or into Adobe Bridge.

• Use the software that came with your camera, Win-
dows Image Acquisition (WIA), or Image Capture (Mac
OS). For more information on using Windows Image
Acquisition or Image Capture, see your computer
documentation.

Import images from a digital camera using WIA
(Windows only)

Certain digital cameras import images using Windows
Image Acquisition (WIA) support. When you use WIA,
Photoshop works with Windows and your digital camera or
scanner software to import images directly into Photoshop.

Importing scanned images

To import scanned images, either open TIFF files saved
from separate scanning software, or use a TWAIN or WIA

interface directly in Photoshop. In either case, make sure
to install the software necessary for your scanner. For
installation instructions, see the documentation provided
by the scanner manufacturer.

Scanner drivers are supported by the scanner
manufacturer, not Adobe. If you have problems
with scanning, make sure that you are using the
latest version of the scanner driver and software.

Import images from a separate scanning application

Most scanners come with software you can run outside of
Photoshop, providing identical scanning options and qual-
ity. This method avoids issues caused by outdated TWAIN
drivers. It can also improve efficiency, letting you edit
images in Photoshop while scanning continues in the
background.

1 Start the scanning software, and set options as de-
sired.

2 Save scanned images in TIFF format.

3 In Photoshop, open the saved TIFF files.

Workspace overview

You create and manipulate your documents and files using
various elements, such as panels, bars, and windows. Any
arrangement of these elements is called a workspace.

Default workspace

A. Tabbed Document windows B. Application bar C. Workspace switcher D. Panel title bar E. Control panel F. Tools panel
G. Collapse To Icons button H. Four panel groups in vertical dock
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• The Application bar across the top contains a workspace
switcher, menus (Windows only), and other application
controls.

• The Tools panel contains tools for creating and editing
images, artwork, page elements, and so on. Related
tools are grouped.

• The Options bar Control panel displays options for the
currently selected tool.

• The Document window displays the file you're working
on. Document windows can be tabbed and, in certain
cases, grouped and docked.

• Panels help you monitor and modify your work. For
example, the Layers panel in Photoshop. Panels can
be grouped, stacked, or docked.

Hide or show all panels

• To hide or show all panels, including the Tools panel and
Control panel, press Tab.

• To hide or show all panels except the Tools panel and
Control panel, press Shift+Tab.

You can temporarily display hidden panels if Auto-Show
Hidden Panels is selected in Interface preferences. Move
the pointer to the edge of the application window (Win-
dows®) or to the edge of the monitor (Mac OS®) and hover
over the strip that appears.

Display panel options

• Click the panel menu icon  in the upper-right corner
of the panel.

You can open a panel menu even when the panel is
minimized.

Dock and undock panels

A dock is a collection of panels or panel groups displayed
together, generally in a vertical orientation. You dock and
undock panels by moving them into and out of a dock.

• To dock a panel, drag it by its tab into the dock, at the
top, bottom, or in between other panels.

• To dock a panel group, drag it by its title bar (the solid
empty bar above the tabs) into the dock.

• To remove a panel or panel group, drag it out of the dock
by its tab or title bar. You can drag it into another dock
or make it free-floating.

Add and remove panels

If you remove all panels from a dock, the dock disappears.
You can create a dock by moving panels to the right edge
of the workspace until a drop zone appears.

• To remove a panel, right-click (Windows) or Control-
click (Mac) its tab and then select Close, or deselect it
from the Window menu.

• To add a panel, select it from the Window menu and
dock it wherever you want.

Save a custom workspace

1. With the workspace in the configuration you want to
save, choose Window > Workspace > New Workspace.

2. Type a name for the workspace.

3. Under Capture, select one or more options:

Keyboard shortcuts

Saves the current set of keyboard shortcuts (Photoshop
only).

Menus or Menu Customization

Saves the current set of menus.

Restore the default workspace

1. Select the Default or Essentials workspace from the
workspace switcher in the application bar.

2. Select Window > Workspace > Reset [Workspace
Name].

3. You can view information about any tool by positioning
the pointer over it. The name of the tool appears in a tool
tip below.

Photoshop CS5 tools

When you start Photoshop, the Tools panel appears at the
left of the screen. Some tools in the Tools panel have
options that appear in the context-sensitive options bar.
You can expand some tools to show hidden tools beneath
them. A small triangle at the lower right of the tool icon
indicates the presence of hidden tools.

You can view information about any tool by positioning the
pointer over it. The name of the tool appears in a tool tip
below the pointer.
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When you start Photoshop, the Tools panel appears at the
left of the screen. Some tools in the Tools panel have
options that appear in the context-sensitive options bar.

You can expand some tools to show hidden tools beneath
them. A small triangle at the lower right of the tool icon
signals the presence of hidden tools.

You can view information about any tool by positioning the
pointer over it. The name of the tool appears in a tool tip
below the pointer.

Selecting and displaying tools

Select a tool

• Click a tool in the Tools panel. If there is a small triangle
at a tool's lower right corner, hold down the mouse
button to view the hidden tools. Then click the tool you
want to select.

• Press the tool's keyboard shortcut. The keyboard
shortcut is displayed in its tool tip. For example, you
can select the Move tool by pressing the V key.

Pressing and holding a keyboard shortcut key lets you
temporarily switch to a tool. When you let go of the shortcut
key, Photoshop returns to the tool you were using before
the temporary switch.

IT&ITES : DTPO - Related Theory for Exercise 2.1.01

Accessing tools

A. Tools panel B. Active tool C. Hidden tools D. Tool name
E. Tool shortcut F. Hidden tool triangle

Change tool pointers

Each default pointer has a different hotspot, where an effect
or action in the image begins. With most tools, you can
switch to precise cursors, which appear as cross hairs
centered around the hotspot.

In most cases, the pointer for a tool is the same as the icon
for that tool; you see that pointer when you select the tool.
The default pointer for the marquee tools is the cross-hair
pointer  ; for the text tool, the default pointer is the I beam
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; and for the painting tools the default pointer is the Brush
Size icon.

1. Choose Edit > Preferences > Cursors (Windows)
2. Choose tool pointer settings under Painting Cursors or

Other Cursors:

Standard
Displays pointers as tool icons.

Precise
Displays pointers as cross hairs.

Normal Brush Tip
The pointer outline corresponds to approximately 50% of
the area that the tool will affect. This option shows the
pixels that would be most visibly affected.

Full Size Brush Tip
The pointer outline corresponds to nearly 100% of the area
that the tool will affect, or nearly all the pixels that would be
affected.

Show Crosshair In Brush Tip

Displays cross hairs in the center of the brush shape.

Show Only Crosshair While Painting

Improves performance with large brushes.

3. Click OK.

The Painting Cursors options control the pointers for the
following tools:

Eraser, Pencil, Paintbrush, Healing Brush, Clone Stamp,
Pattern Stamp, Quick Selection, Smudge, Blur, Sharpen,
Dodge, Burn, and Sponge tools

The Other Cursors options control the pointers for the
following tools:

Marquee, Lasso, Polygonal Lasso, Magic Wand, Crop,
Slice, Patch, Eyedropper, Pen, Gradient, Line, Paint
Bucket, Magnetic Lasso, Magnetic Pen, Freeform Pen,
Measure, and Color Sampler tools

Using the options bar

The options bar appears below the menu bar at the top of
the workspace. The options bar is context sensitive-it
changes as you select different tools. Some settings in the
options bar (such as painting modes and opacity) are
common to several tools, and some are specific to one tool.

You can move the options bar in the workspace by using
the gripper bar, and you can dock it at the top or bottom of
the screen. Tool tips appear when you position the pointer
over a tool. To show or hide the options bar, choose
Window > Options.

Tool presets

Tool presets let you save and reuse tool settings. You can
load, edit, and create libraries of tool presets using the Tool
Preset picker in the options bar, the Tool Presets panel,
and the Preset Manager.

To choose a tool preset, click the Tool Preset picker in the
options bar, and select a preset from the pop up panel. You
can also choose Window > Tool Presets and select a
preset in the Tools Presets panel.

The Magic Wand tool selects similarly colored areas.
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Lasso options bar

A. Gripper bar B. Tool tip

Viewing the Tool Preset picker

A. Click the Tool Preset picker in the options bar to show the Tool
Preset pop up panel. B. Select a preset to change the tool's options
to the preset, which applies each time you select the tool until you
choose Reset Tool from the panel menu. C. Deselect to show all
tool presets; select to show presets for only the tool selected in
the toolbox.

The marquee tools make rectangular, elliptical, single
row, and single column selections.

The Move tool moves selections, layers, and guides.

The lasso tools make free hand, polygonal (straight-
edged), and magnetic (snap- to) selections.
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The Dodge tool lightens areas in an image.

The Quick Selection tool lets you quickly "paint" a
selection using an adjustable round brush tip

• Crop and slice tools gallery

Crop tool trims images.

The tool creates slices.

The Slice Select tool selects slices.

• Retouchingtoolsgallery

The Spot Healing Brush tool removes blemishes and
objects

The Clone Stamp tool paints with a sample of an image.

The Magic Eraser tool erases solid-colored areas to
transparency with a single click.

The Healing Brush tool paints with a sample or pattern to
repairimperfections in a image.

The Pattern Stamp tool paints with part of an imageas a
pattern.

The Blur tool blurs hard edges in an image.

IT&ITES : DTPO - Related Theory for Exercise 2.1.01
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TheBurn tool darkens are as in an image.

The Patch tool repairs imperfections in a selected area of
an image using a sampleor pattern.

The Eraser tool erase spixels and restores parts of an
image to a previously savedstate.

The Sharpen tool sharpens soft edges in an image.

The Sponge tool changes the color saturation of an area.

The Red Eye tool removes the red reflection caused by a
flash.

The Background Eraser tool erases are as to transpar-
ency by dragging.

The Smudge tools mudges data in an image.

• Painting tools gallery

The Brush tool paints brush strokes.

The History Brush tool paints a copy of  the  selected state
or snaps hot into the current image window.
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The Pencil tool paints hard- edged strokes.

The Art History brush tool paints with stylized strokes
that simulate the look of  different paint styles, using a
selected state or snapshot.

The Color  Replacement  tool replaces a selected color
with a new color.

The gradient tools create straight-line, radial,angle, re-
flected, and diamond blends between colors.
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The Mixer Brush tool Simulates realistic painting tech-
niques such as blending canvas colors and varying paint
wetness.

The Paint Bucket tool fills similarly colored areas with the
fore ground color.

• Drawing and type tools gallery

The path selection tools make shape or segment selec-
tions showing anchor points, direction lines, and direction
points.

The shape tools and Line tool draw shapes and lines in
a normal layer or a shape layer.

The type tools create type on an image.

The Custom Shape tool makes customized shapes
selected from a custom shape list.

The type mask tools create a selection in the shape of
type.

The pen tools let you draw smooth-edged paths.

• Navigation, notes and measuring tools gallery

The Hand tool moves an image within its window.

The Eye dropper tool samples colors in an image.

The Rotate View tool non- destructively rotates the
canvas.

The Color Sampler tool displays color values for upto four
areas.

IT&ITES : DTPO - Related Theory for Exercise 2.1.01
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The Zoom tool magnifies and reduces the view of an
image.

The Ruler tool measures distances, locations, and angles.

The Note tool makes notes that can be attached to an
image.

The Count tool counts objects in an image. (Photoshop
Extended only)

• 3D tools gallery

The 3D Object Rotate tool rotates the object around its x-
axis.
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The 3D Object Scale tool scales the object larger or
smaller.

The 3D Walk Camera tool moves laterally when you drag
horizontally, or forward and back when you drag vertically.

The 3D Object Roll tool rotates the object around its z-
axis.

The 3D Rotate Camera tool orbits the camera in the x or
y direction.

The 3D Zoom Camera tool changes the field of view closer
or farther away.

The 3D Object Pan tool pans the object in the x or y
direction.
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The 3D Roll Camera tool rotates the camera around the
z-axis.

The 3D Object Slide tool moves the object laterally when
you drag horizontally, or forward and back when you drag
vertically.

The 3D Pan Camera tool pans thecamera in the x or y
direction.
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Marquee tool

The marquee tools let you select rectangles, ellipses, and
1 pixel rows and columns.

Select with the Lasso tool

The Lasso tool is useful for drawing freeform segments of
a selection border.

Select with the Polygonal Lasso tool

The Polygonal Lasso tool is useful for drawing straight-
edged segments of a selection border.

Select with the Magnetic Lasso tool

When you use the Magnetic Lasso tool , the border
snaps to the edges of defined areas in the image. The
Magnetic Lasso tool is not available for 32 bits-per-channel
images.

The Magnetic Lasso tool is especially useful for quickly
selecting objects with complex edges set against high-
contrast backgrounds.

1. Select the Magnetic Lasso tool.

2. Specify one of the selection options in the options bar.

IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.02
Selecting, Editing and Cropping the images
Objectives : At the end of this lesson you shall be able to
• use of Marquee tools in Adobe Photoshop
• use of Lasso, Polygonal Lasso, and Magnetic Lasso Tools
• learning about Transformation, Crop, Rotation and Canvas.

Contrast

To specify the lasso's sensitivity to edges in the image,
enter a value between 1% and 100% for Contrast. A higher
value detects only edges that contrast sharply with their
surroundings; a lower value detects lower-contrast edges.

Frequency

To specify the rate at which the lasso sets fastening points,
enter a value between 0 and 100 for Frequency. A higher
value anchors the selection border in place more quickly.

On an image with well-defined edges, try a higher width and
higher edge contrast, and trace the border roughly. On an
image with softer edges, try a lower width and lower edge
contrast, and trace the border more precisely.

Stylus Pressure

If you are working with a stylus tablet, select or deselect the
Stylus Pressure option. When the option is selected, an
increase in stylus pressure decreases the edge width.

5. Click in the image to set the first fastening point.
Fastening points anchor the selection border in place.

6. Release the mouse button or keep it depressed, and
then move the pointer along the edge you want to trace.

The most recent segment of the selection border remains
active. As you move the pointer, the active segment snaps
to the strongest edge in the image, based on the detection
width set in the options bar. Periodically, the Magnetic
Lasso tool adds fastening points to the selection border to
anchor previous segments.

7. If the border doesn't snap to the desired edge, click
once to add a fastening point manually. Continue to
trace the edge, and add fastening points as needed.

3. (Optional) Set feathering and anti-aliasing in the options
bar

4. Set any of these options:

Width

To specify a detection width, enter a pixel value for Width.
The Magnetic Lasso tool detects edges only within the
specified distance from the pointer.

To change the lasso pointer so that it indicates the lasso
width, press the Caps Lock key. You can change the
pointer while the tool is selected but not in use. Press the
right bracket (]) to increase the Magnetic Lasso edge width
by 1 pixel; press the left bracket ([) to decrease the width
by 1 pixel.

Selection options
A. New B. Add To C. Subtract From D. Intersect With

Fastening points anchor selection border to edges
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8. To switch temporarily to the other lasso tools, do one
of the following:

• To activate the Lasso tool, hold down Alt (Windows)
or Option (Mac OS), and drag with the mouse button
depressed.

• To activate the Polygonal Lasso tool, hold down Alt
(Windows) or Option (Mac OS), and click.

9. To erase recently drawn segments and fastening points,
press the Delete key until you've erased the fastening
points for the desired segment.

10.Close the selection border:

• To close the border with a magnetic segment,
double-click, or press Enter or Return. (To manually
close the border, drag over the starting point and
click.)

• To close the border with a straight segment, hold
down Alt (Windows), and double-click.

11.(Optional) Click Refine Edge to further adjust the
selection boundary.

Transforming objects

Transformations

Transforming scales, rotates, skews, stretches, or warps
an image. You can apply transformations to a selection, an
entire layer, multiple layers, or a layer mask. You can also
apply transformations to a path, a vector shape, a vector
mask, a selection border, or an alpha channel. Transform-
ing affects image quality when you manipulate the pixels.
To apply non-destructive transformations to raster images,
use Smart Objects. Transforming a vector shape or path is
always non-destructive because you're only changing the
mathematical calculations producing the object.

To make a transformation, first select an item to transform
and then choose a transformation command. If necessary,
adjust the reference point before manipulating the transfor-
mation. You can perform several manipulations in succes-
sion before applying the cumulative transformation. For
example, you can choose Scale and drag a handle to
scale, and then choose Distort and drag a handle to distort.
Then press Enter or Return to apply both transformations.

Photoshop uses the interpolation method selected in the
General area of the Preferences dialog box to calculate the
color values of pixels that are added or deleted during
transformations. This interpolation setting directly affects
the speed and quality of the transformation. Bicubic
interpolation, the default, is slowest but yields the best
results.

You can also warp and distort raster images using
the Liquify filter

Transform submenu commands

Scale

Enlarges or reduces an item relative to its reference point,
the fixed point around which transformations are per-
formed. You can scale horizontally, vertically, or both

horizontally and vertically.

Rotate

Turns an item around a reference point. By default, this
point is at the center of the object; however, you can move
it to another location.

Skew

Slants an item vertically and horizontally.

Distort

Stretches an item in all directions.

Perspective

Applies one-point perspective to an item.

Warp

Manipulates the shape of an item.

Rotate 180, Rotate 90 CW, Rotate 90 CCW

Rotates the item by the specified number of degrees, either
clockwise or counterclockwise.

Flip

Flips the item vertically or horizontally.

Set or move the reference point for a transformation

All transformations are performed around a fixed point
called the reference point. By default, this point is at the
center of the item you are transforming. However, you can
change the reference point or move the center point to a
different location using the reference point locator in the
options bar.

1 Choose a transformation command. A bounding box
appears in the image.

2 Do one of the following:

• In the options bar, click a square on the reference point
locator. Each square represents a point on the bound-
ing box. For example, to move the reference point to the
upper-left corner of the bounding box, click the top left
square on the reference point locator.

• In the transform bounding box that appears in the
image, drag the reference point . The reference point
can be outside the item you want to transform.

Transform freely

The Free Transform command lets you apply transforma-
tions (rotate, scale, skew, distort, and perspective) in one
continuous operation. You can also apply a warp transfor-
mation. Instead of choosing different commands, you
simply hold down a key on your keyboard to switch
between transformation types.

If you are transforming a shape or entire path, the
Transform command becomes the Transform Path
command. If you are transforming multiple path
segments (but not the entire path), the Transform
command becomes the Transform Points com-
mand.
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Warp an item

The Warp command lets you drag control points to
manipulate the shape of images, shapes, or paths, and so
on. You can also warp using a shape in the Warp Style pop-
up menu in the options bar. Shapes in the Warp Style pop-
up menu are also malleable; drag their control points.

When using the control points to distort an item, choosing
View > Extras shows or hides the warp mesh and control
points.

Puppet Warp

Puppet Warp provides a visual mesh that lets you drasti-
cally distort specific image areas, while leaving other areas
intact. Applications range from subtle image retouching
(such as shaping hair) to total transformations (such as
repositioning arms or legs).

In addition to image layers, you can apply Puppet Warp to
layer and vector masks. To nondestructively distort im-
ages, use Smart Objects.

Crop images

Cropping is the process of removing portions of an image
to create focus or strengthen the composition. You can
crop an image using the Crop tool   and the Crop command.
You can also trim pixels using the Crop And Straighten and
the Trim commands.

Cropping is the process of removing portions of an image
to create focus or strengthen the composition. Use the
Crop tool to crop and straighten images in Photoshop. The
Crop tools in Photoshop CC and CS6 are non-destructive
and you can choose to retain the cropped pixels to
optimize the crop boundaries later. The Crop tool also
provides intuitive methods to straighten the image while
cropping.

For all operations, visual guides provide an interactive
preview. When you crop or straighten photos, real-time
feedback helps you visualize the final result.

Using Crop tools

Watch how to preview the angle of your image to confirm
that your crop is plumb. You can revisit a crop any time you
like, so you never waste effort.

Crop or remove part of an image

 

Size and proportions

Choose a ratio or size for the crop box. You can also
choose a preset, enter your own, or even define your own
preset values for later use.

View

Choose a view to display overlay guides while cropping.
Guides such as Rule of Thirds, Grid, and Golden Ratio are
available. To cycle through all the options, press O.

Crop Options

Click the Settings menu to specify additional crop options.

Use Classic mode

Enable this option if you want to use the Crop tool like it was
in previous versions of Photoshop.

Auto-center preview

Enable this option to place the preview in the center of the
canvas.

Show Cropped Area

Enable this option to display the area that is cropped. If this
option is disabled, only the final area is previewed.

A. Active tool B. Size and proportions C. Rotate crop box D. Straighten image E. View F. Crop options G. Delete Cropped Pixels

Enable crop shield

Use the crop shield to overlay the cropped areas with a tint.
You can specify a color and opacity. If you Enable Auto
Adjust Opacity, the opacity is reduces when you edit the
crop boundaries.

Delete cropped pixels

Disable this option to apply a non-destructive crop and
retain pixels outside the crop boundaries. Non-destructive
cropping does not remove any pixels. You can later click
the image to see areas outside current crop borders.

Enable this option to delete any pixels that are outside the
crop area. These pixels are lost and are not available for
future adjustments.

Right-click the Crop box and access common crop options
from the context menu.

Crop an image using the Trim command

The Trim command crops an image by removing unwanted
image data in different ways than the Crop command. You
can crop an image by trimming surrounding transparent
pixels, or background pixels of the color you specify.

Transform perspective while cropping | CS5

The Crop tool has an option that lets you transform the
perspective in an image. Transforming the perspective is
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useful when working with images that contain keystone
distortion. Keystone distortion occurs when an object is
photographed from an angle rather than from a straight on
view. For example, if you take a picture of a tall building from
ground level, the edges of the building appear closer to
each other at the top than they do at the bottom.

• To straighten an image do one of the following:

• Place the pointer a little outside the corner handles
and drag to rotate the image. A grid displays inside
the crop box and the image rotates behind it.

• Click Straighten in the control bar and then using the
Straighten tool, draw a reference line to straighten
the photo. For example, draw a line along the
horizon or an edge to straighten the image along it.

Straighten an image

The Ruler tool provides a Straighten option that quickly
aligns images with horizon lines, building walls, and other
key elements.

1. Select the Ruler tool . (If necessary, click and

hold the Eyedropper tool to reveal the Ruler.)

2. In the image, drag across a key horizontal or vertical
element.

3. In the options bar, click Straighten.

Photoshop straightens the image and automatically crops
it. To reveal image areas that extend beyond the new
document boundaries, choose Edit > Undo.

Rotate or flip an entire image

The Image Rotation commands let you rotate or flip an
entire image. The commands do not work on individual
layers or parts of layers, paths, or selection borders. If you
want to rotate a selection or layer, use the Transform or
Free Transform commands.

Choose Image > Image Rotation, and choose one of the
following commands from the submenu:

180°

Rotates the image by a half-turn.

90° CW

Rotates the image clockwise by a quarter-turn.

90° CCW

Rotates the image counterclockwise by a quarter-turn.

Crop and straighten scanned photos

You can place several photos on your scanner and scan
them in one pass, which creates a single image file. The
Crop and Straighten Photos command is an automated
feature that can create separate image files from the
multiple-image scan.

For best results, keep 1/8 inch between the images in your
scan, and the background (typically the scanner bed)
should be a uniform color with little noise. The Crop and
Straighten Photos command works best on images with
clearly delineated outlines. If the Crop and Straighten
Photos command cannot properly process the image file,
use the Crop tool.

Straighten an image

You can straighten an image while cropping. The image is
rotated and aligned to straighten it. The image canvas is
automatically resized to accommodate the rotated pixels.

A Draw initial cropping marquee B Adjust cropping marquee to
match the object's edges C Extend the cropping bounds D Final
image

Rotate the image using the crop tool to straighten it
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Arbitrary

Rotates the image by the angle you specify. If you choose
this option, enter an angle between -359.99 and 359.99 in
the angle text box. (In Photoshop, you can select °CW or
°CCW to rotate clockwise or counterclockwise.) Then click
OK.

Flip Canvas Horizontal or Vertical

Flips the image along the corresponding axis.

Image Rotation is destructive editing and actually
modifies the file information. If you want to non-
destructively rotate the image for viewing, use
the Rotation tool.

Change the canvas size

The canvas size is the full editable area of an image. The
Canvas Size command lets you increase or decrease an
image's canvas size. Increasing the canvas size adds
space around an existing image. Decreasing an image's
canvas size crops into the image. If you increase the
canvas size of an image with a transparent background, the
added canvas is transparent. If the image doesn't have a
transparent background, there are several options for
determining the color of the added canvas.

Crop and straighten photos

Cropping is the process of removing portions of an image
to create focus or strengthen the composition. Use the
Crop tool to crop and straighten images in Photoshop. The
Crop tools in Photoshop CC and CS6 are non-destructive
and you can choose to retain the cropped pixels to
optimize the crop boundaries later. The Crop tool also
provides intuitive methods to straighten the image while
cropping.

For all operations, visual guides provide an interactive
preview. When you crop or straighten photos, real-time
feedback helps you visualize the final result.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.03
Image essentials
Objectives : At the end of this lesson you shall be able to
• explain Raster and Vector graphics
• learn about various file format used in Adobe Photoshop
• explain Tonal value and Tonal Gradation.

Bitmap images

Bitmap images-technically called raster images-use a
rectangular grid of picture elements (pixels) to represent
images. Each pixel is assigned a specific location and
color value. When working with bitmap images, you edit
pixels rather than objects or shapes. Bitmap images are
the most common electronic medium for continuous-tone
images, such as photographs or digital paintings, because
they can more efficiently represent subtle gradations of
shades and color.

Bitmap images are resolution-dependent-that is, they
contain a fixed number of pixels. As a result, they can lose
detail and appear jagged if they are scaled to high magni-
fications on-screen or if they are printed at a lower resolu-
tion than they were created for.

Bitmap images sometimes require large amounts of stor-
age space, and often need to be compressed to keep file
sizes down when used in certain Creative Suite compo-
nents. For instance, you compress an image file in its
original application before you import it into a layout.

In Adobe Illustrator, you can create bitmap effects
in your artwork using effects and graphic styles.

Vector graphics

Vector graphics (sometimes called vector shapes or vector
objects) are made up of lines and curves defined by
mathematical objects called vectors, which describe an
image according to its geometric characteristics.

You can freely move or modify vector graphics without
losing detail or clarity, because they are resolution-inde-
pendent-they maintain crisp edges when resized, printed
to a PostScript printer, saved in a PDF file, or imported into
a vector-based graphics application. As a result, vector
graphics are the best choice for artwork, such as logos,
that will be used at various sizes and in various output
media.

The vector objects you create using the drawing and shape
tools in Adobe Creative Suite are examples of vector
graphics. You can use the Copy and Paste commands to
duplicate vector graphics betweenCreative Suite compo-
nents.

Combining vector graphics and bitmap images

When combining vector graphics and bitmap images in a
document, it's important to remember that how your
artwork looks on-screen isn't always how it will look in its
final medium (whether commercially printed, printed on a
desktop printer, or viewed on the web). The following factors
influence the quality of your final artwork:

Transparency

Many effects add partially transparent pixels to your
artwork. When your artwork contains transparency,
Photoshop performs a process called flattening before
printing or exporting. In most cases, the default flattening
process produces excellent results. However, if your
artwork contains complex, overlapping areas and you
require high-resolution output, you will probably want to
preview the effects of flattening.

Image Resolution

The number of pixels per inch (ppi) in a bitmap image. Using
too low a resolution for a printed image results in pixelation-
output with large, coarse-looking pixels. Using too high a
resolution (pixels smaller than what the output device can
produce) increases the file size without increasing the
quality of the printed output, and slows the printing of the
artwork.
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Printer resolution and screen frequency

The number of ink dots produced per inch (dpi) and the
number of lines per inch (lpi) in a halftone screen. The
relationship between image resolution, printer resolution,
and screen frequency determines the quality of detail in the
printed image.

Color channels

Every Photoshop image has one or more channels, each
storing information about color elements in the image. The
number of default color channels in an image depends on
its color mode. By default, images in Bitmap, Grayscale,
Duotone, and Indexed Color mode have one channel; RGB
and Lab images have three; and CMYK images have four.
You can add channels to all image types except Bitmap
mode images.

Channels in color images are actually grayscale images
that represent each of the color components of an image.
For example, an RGB image has separate channels for
red, green, and blues color values.

In addition to color channels, alpha channels, can be added
to an image for storing and editing selections as masks,
and spot color channels can be added to add spot color
plates for printing.

Bit depth

Bit depth specifies how much color information is available
for each pixel in an image. The more bits of information per
pixel, the more available colors and more accurate color
representation. For example, an image with a bit depth of
1 has pixels with two possible values: black and white. An
image with a bit depth of 8 has 28, or 256, possible values.
Grayscale mode images with a bit depth of 8 have 256
possible gray values.

RGB images are made of three color channels. An 8-bit per
pixel RGB image has 256 possible values for each channel
which means it has over 16 million possible color values.
RGB images with 8-bits per channel (bpc) are sometimes
called 24-bit images (8 bits x 3 channels = 24 bits of data
for each pixel).

In addition to 8-bpc images, Photoshop can also work with
images that contain 16-bpc or 32-bpc. Images with 32-bpc
are also known as high dynamic range (HDR) images.

Photoshop support for 16-bit images

Photoshop provides the following support for working with
16-bpc images:

• Working in Grayscale, RGB Color, CMYK Color, Lab
Color, and Multichannel, modes.

• All tools in the toolbox, except the Art History Brush
tool, can be used with 16-bpc images.

• Color and tonal adjustment commands are available

• You can work with layers, including adjustment layers,
in 16-bpc images.

• Many Photoshop filters can be used with 16-bpc im-
ages.

To take advantage of certain Photoshop features, such as
some filters, you can convert a 16-bpc image to an 8-bpc
image. It's best if you do a Save As and convert a copy of
the image file so the original file retains the full 16-bpc
image data.

Convert between bit depths

• Do any of the following:

• To convert between 8 bpc and 16 bpc, Choose
Image > Mode > 16 Bits/Channel or 8 Bits/Channel.

• To convert from 8 bpc or 16 bits to 32 bpc, choose Image
> Mode > 32 Bits/Channel.

Pixel dimensions and printed image resolution

Pixel dimensions measure the total number of pixels along
an image's width and height. Resolution is the fineness of
detail in a bitmap image and is measured in pixels per inch
(ppi). The more pixels per inch, the greater the resolution.
Generally, an image with a higher resolution produces a
better printed image quality.

Unless an image is resampled the amount of image data
remains constant as you change either the print dimen-
sions or resolution. For example, if you change the
resolution of a file, its width and height change accordingly
to maintain the same amount of image data.

In Photoshop, you can see the relationship between image
size and resolution in the Image Size dialog box (choose
Image >Image Size). Deselect Resample Image, because
you don't want to change the amount of image data in your
photo. Then change width, height, or resolution. As you
change one value, the other two values change accord-
ingly. With the Resample Image option selected, you can
change the resolution, width, and height of the image to suit
your printing or on-screen needs.
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Quickly display the current image size

If you want to quickly display a document's current image
size, use the information box at the bottom of the document
window.

• Position the pointer over the file information box, and
hold down the mouse button.

File size

The file size of an image is the digital size of the image file,
measured in kilobytes (K), megabytes (MB), or gigabytes
(GB). File size is proportional to the pixel dimensions of the
image. Images with more pixels may produce more detail
at a given printed size, but they require more disk space to
store and may be slower to edit and print. Image resolution
thus becomes a compromise between image quality
(capturing all the data you need) and file size.

Another factor that affects file size is file format. Because
of the varying compression methods used by GIF, JPEG,
PNG, and TIFF file formats, file sizes can vary considerably
for the same pixel dimensions. Similarly, color bit-depth
and the number of layers and channels in an image affect
file size.

Photoshop supports a maximum pixel dimension of 300,000
by 300,000 pixels per image. This restriction places limits
on the print size and resolution available to an image.

Monitor resolution

Your monitor's resolution is described in pixel dimensions.
For example, if your monitor resolution and your photo's
pixel dimensions are the same size, the photo will fill the
screen when viewed at 100%. How large an image appears
on-screen depends on a combination of factors-the pixel
dimensions of the image, the monitor size, and the monitor
resolution setting. In Photoshop, you can change the
image magnification on-screen, so you can easily work
with images of any pixel dimensions.
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AOriginal dimensions and resolution B Decreasing the resolution
without changing pixel dimensions (no resampling) C Decreasing
the resolution at same document size decreases pixel dimensions
(resampling).

When preparing images for viewing on-screen, you should
consider the lowest monitor resolution that your photo is
likely to be viewed on.
Printer resolution
Printer resolution is measured in ink dots per inch, also
known as dpi. Generally, the more dots per inch, the finer
the printed output you'll get. Most inkjet printers have a
resolution of approximately 720 to 2880 dpi. (Technically,
inkjet printers produce a microscopic spray of ink, not
actual dots like imagesetters or laser printers.)
Printer resolution is different from, but related to image
resolution. To print a high quality photo on an inkjet printer,
an image resolution of at least 220 ppi should provide good
results.
Screen frequency is the number of printer dots or halftone
cells per inch used to print grayscale images or color
separations. Also known as screen ruling or line screen,
screen frequency is measured in lines per inch (lpi)-or lines
of cells per inch in a halftone screen. The higher the
resolution of the output device, the finer (higher) a screen
ruling you can use.
The relationship between image resolution and screen
frequency determines the quality of detail in the printed
image. To produce a halftone image of the highest quality,
you generally use an image resolution that is from 1.5 to at
most 2 times the screen frequency. But with some images
and output devices, a lower resolution can produce good
results. To determine your printer's screen frequency,
check your printer documentation or consult your service
provider.

Some imagesetters and 600-dpi laser printers use
screening technologies other than halftoning. If
you are printing an image on a nonhalftone
printer, consult your service provider or your
printer documentation for the recommended im-
age resolutions.
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Resampling

Resampling is changing the amount of image data as you
change either the pixel dimensions or the resolution of an
image. When you downsample(decrease the number of
pixels), information is deleted from the image. When you
resample up (increase the number of pixels, or upsample),
new pixels are added. You specify an interpolation method
to determine how pixels are added or deleted.

About file formats

Graphic file formats differ in the way they represent image
data (as pixels or as vectors), in compression technique,
and in which Photoshop and ImageReady features they
support.

If a supported file format does not appear in the
appropriate dialog box or submenu, you may
need to install the format's plug-in module.

BMP

BMP is a standard Windows image format on DOS and
Windows-compatible computers. BMP format supports
RGB, Indexed Color, Grayscale, and Bitmap color modes.
You can specify either Windows or OS/2® format and a bit
depth for the image. For 4-bit and 8-bit images using
Windows format, you can also specify RLE compression.

Photoshop EPS

Encapsulated PostScript (EPS) language file format can
contain both vector and bitmap graphics and is supported
by virtually all graphic, illustration, and page-layout pro-
grams. EPS format is used to transfer PostScript-lan-
guage artwork between applications. When you open an
EPS file containing vector graphics, Photoshop rasterizes
the image, converting the vector graphics to pixels.

EPS format supports Lab, CMYK, RGB, Indexed Color,
Duotone, Grayscale, and Bitmap color modes, and does
not support alpha channels. EPS does support clipping
paths. Desktop Color Separations (DCS) format, a version
of the standard EPS format, lets you save color separa-
tions of CMYK images. You use DCS 2.0 format to export
images containing spot channels.To print EPS files, you
must use a PostScript printer.

EPS TIFF or EPS PICT Preview (Photoshop)

These formats let you open images saved in file formats
that create previews but are not supported by Adobe
Photoshop (such as QuarkXPress®). An opened preview
image can be edited and used like any other low-resolution
file. EPS PICT Preview is available only in Mac OS.

GIF

Graphics Interchange Format (GIF) is the file format
commonly used to display indexed-color graphics and
images in hypertext markup language (HTML) documents
over the World Wide Web and other online services. GIF is
an LZW-compressed format designed to minimize file size
and electronic transfer time. GIF format preserves trans-
parency in indexed-color images; however, it does not
support alpha channels.

JPEG

Joint Photographic Experts Group (JPEG) format is com-
monly used to display photographs and other continuous-
tone images in hypertext markup language (HTML) docu-
ments over the World Wide Web and other online services.
JPEG format supports CMYK, RGB, and Grayscale color
modes, and does not support alpha channels. Unlike GIF
format, JPEG retains all color information in an RGB image
but compresses file size by selectively discarding data.

A JPEG image is automatically decompressed when
opened. A higher level of compression results in lower
image quality, and a lower level of compression results in
better image quality. In most cases, the Maximum quality
option produces a result indistinguishable from the original.

PDF

Portable Document Format (PDF) is a flexible, cross-
platform, cross-application file format. Based on the
PostScript imaging model, PDF files accurately display
and preserve fonts, page layouts, and both vector and
bitmap graphics. In addition, PDF files can contain elec-
tronic document search and navigation features such as
electronic links.

Photoshop and ImageReady recognize two types of PDF
files: Photoshop PDF files and Generic PDF files. You can
open both types of PDF files; however, you can only save
images to Photoshop PDF format.

PNG

Developed as a patent-free alternative to GIF, Portable
Network Graphics (PNG) format is used for lossless
compression and for display of images on the World Wide
Web. Unlike GIF, PNG supports 24-bit images and pro-
duces background transparency without jagged edges;
however, some Web browsers do not support PNG im-
ages. PNG format supports RGB, indexed-color, grayscale,
and Bitmap-mode images without alpha channels. PNG
preserves transparency in grayscale and RGB images.

TIFF

Tagged-Image File Format (TIFF) is used to exchange files
between applications and computer platforms. TIFF is a
flexible bitmap image format supported by virtually all paint,
image-editing, and page-layout applications. Also, virtually
all desktop scanners can produce TIFF images.

TIFF format supports CMYK, RGB, Lab, indexed-color,
and grayscale images with alpha channels and Bitmap-
mode images without alpha channels. Photoshop can save
layers in a TIFF file; however, if you open the file in another
application, only the flattened image is visible. Photoshop
can also save annotations, transparency, and multiresolution
pyramid data in TIFF format.
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Tonal Value is defined as the comparative flimsiness or
darkness of tones linking black and white. These are the
darkened lines of a drawing. Tonal values are what make a
painting 'talk' not the color - no matter how much color you
put in a picture.

Tone refers to the degree of lightness or darkness of an
area. Tone varies from the bright white of a light source
through shades of gray to the deepest black shadows. How
we perceive the tone of an object depends on its actual
surface lightness or darkness, color and texture, the
background and lighting. Tone is may be used broadly
('global tone') to denote the major planes of an object;
realist artists use 'local tone' to accurately denote subtle
changes within the plane

Tonal gradation

In pictures often concentrate on the density and detail of
highlights and shadows when they should actually be
considering the most important or middle tones of the
negative. Middle tones are the various tones of gray
between the highlights and the shadows; that is, the
densities that are not highlights or shadows are termed
middle tones or intermediate tones.

Fig 1

The middle tones vary with the type of film and the subject
contrast. A negative should have a range of middle tone
densities that correspond proportionally to the middle
reflective brightness of the subject. A panchromatic nega-
tive that does not have proportionate mid  tones is contrasty
or flat.

Continuous tone

A continuous tone image is one where each color at any
point in the image is reproduced as a single tone, and not
as discrete halftones, such as one single color for mono-
chromatic prints, or a combination of halftones for color
prints.

The most common continuous tone images are digital
photographs every single pixel of which can take a continu-
ous range of colors depending on the quantity of captured
radiance. On the other hand, at a microscopic level,
developed black-and-white photographic film consists of
only two colors, and not an infinite range of continuous
tones. For details, see film grain. Therefore, film is a
halftone medium.

An example of a continuous-tone device is a CRT computer
screen. Here, any pixel can represent any color, because
the color components of the pixel are analog and can vary
in infinite steps, and hence do not need halftones to make
the colors. Of course, because the computer is a digital
device, it cannot provide the CRT with infinite tone varia-
tions. In 24-bit color mode, it provides the monitor with 256
discrete steps for each channel (red, green, and blue), for
a total of 16,777,216 (2563) discrete colors. A purely
analog video signal (one that has not been manipulated by
a computer of any kind) can provide infinite tone variations
inside its own gamut.

A halftone device, in contrast, uses discrete dots of color,
which at a certain distance printers. Magazines and most
printed material also use th look closely like the intended
color. Examples of this are inkjetis technique to create the
colors.

Halftone

Halftone is the reprographic technique that simulates
continuous tone imagery through the use of dots, varying
either in size, in shape or in spacing, thus generating a
gradient like effect as shown in Fig.2. "Halftone" can also
be used to refer specifically to the image that is produced
by this process.

Fig 2

Where continuous tone imagery contains an infinite range
of colors or greys, the halftone process reduces visual
reproductions to an image that is printed with only one color
of ink, in dots of differing size. This reproduction relies on
a basic optical illusion-that these tiny halftone dots are
blended into smooth tones by the human eye. At a
microscopic level, developed black-and-white photographic
film also consists of only two colors, and not an infinite
range of continuous tones. For details, see film grain.

Just as color photography evolved with the addition of filters
and film layers, color printing is made possible by repeating
the halftone process for each subtractive color-most com-
monly using what is called the "CMYK color model". The
semi-opaque property of ink allows halftone dots of different
colors to create another optical effect-full-color imagery.
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Moire pattern

A moire pattern is a secondary and visually evident
superimposed pattern created, for example, when two
identical (usually transparent) patterns on a flat or curved
surface (such as closely spaced straight lines drawn
radiating from a point or taking the form of a grid) are overlaid
while displaced or rotated a small amount from one
another.

This interference is called a moire pattern. In a scanned
image, Moiré patterns are caused by interference between
two sets of fine pattern grids, the scanner samples and the
halftone screen in the original image as in Fig.3. Every
scanner does this.

Fig 3

Any image printed on a printing press (like a book,
magazine, newspaper, postcard, calendar, etc.) is printed
with halftone screen patterns. The printed image is com-
posed of a pattern of dots. A strong magnifying glass will
show them. The halftone dots are printed entirely in black
if a B&W image, or there are four screens in each of the
three primary colors plus black (CMYK) if a Color image.
These fine dots cause optical problems in a scanned image
because the scanned image is also composed of fine dots.

The two patterns of dots, the printed magazine's 133 or 150
lpi screened pattern, and the 300 or 600 dpi scanner CCD
cells, combine into maximums or minimums every several
pixels in the image, depending on the spacing of the dots
as shown in Fig.4. It affects the overall light intensity in
periodic patterns that become very visible. The pattern is
named Moire.

Fig 4

In the graphic arts, the term moiré means an excessively
visible moiré pattern. Part of the prepress art consists of
selecting screen angles and halftone frequencies which
minimize moiré. The visibility of moiré is not entirely
predictable. The same set of screens may produce good
results with some images, but visible moiré with others.
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In graphic arts and prepress, the usual technology for
printing full-color images involves the superimposition of
halftone screens. These are regular rectangular dot pat-
terns-often four of them, printed in cyan, yellow, magenta,
and black. Some kind of moiré pattern is inevitable, but the
spatial frequency of the moiré is so high that it is not
noticeable.

 
With the help of a strong magnifying glass you might
discover these crosshatched or dotted pattern in your
scanned images from printed material. Some image scan-
ner driver programs provide an optional filter, called a
"descreen" filter, to remove Moiré-pattern artifacts which
would otherwise be produced when scanning printed half-
tone images to produce digital images

Highlight, middletone and shadow area

It's important to know what shadows, midtones and high-
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lights in photographic in terms of photograph. These three
elements are present are in every photograph color or black
and white so it is important to understand how to improve
an adjust these settings.

Highlight

Highlight are the lightest area of an image, therefore the
parts that have the most light hitting it.if something has too
many highlights we may say that it is overexposed and the
area is lacking in detail.

Middle tone

Midtones show the middle tones of an image - the colors
that are in between. For example - If we had black and white
image, the midtone would be grey somewhere between the
two. You want a good amount of midtone in a balanced
image but at the same time, you don't want everything to
be 'grey' or flat.

Shadow area

Shadows are the darkest areas of a photograph. A shadow
is also devoid of color, it could be black in the photograph
or just the areas that carry little light. An image with too
many shadows may be underexposed and, will not show
so much detail although this can be normally adjusted.

Contrast

Contrast is the difference in luminance and/or color that
makes an object (or its representation in an image or
display) distinguishable. In visual perception of the real
world, contrast is determined by the difference in the color
and brightness of the object and other objects within the
same field of view. Because the human visual system is
more sensitive to contrast than absolute luminance, we
can perceive the world similarly regardless of the huge
changes in illumination over the day or from place to place.
The maximum contrast of an image is the contrast ratio or
dynamic range.

Contrast is also the difference between the color or shading
of the printed material on a document and the background
on which it is printed, for example in optical character
recognition.

Saturation

In graphics and imaging, color saturation is used to
describe the intensity of color in the image. A saturated
image has overly bright colors. Using a graphics editing
program you can increase saturation on under-exposed
images, or vice versa.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.04
Image editing softwares
Objectives : At the end of this lesson you shall be able to
• understanding about color
• convert an image to another color mode
• learning about Hue, Saturation and vibrance.

Understanding color

Knowing how colors are created and how they relate to
each other lets you work more effectively in Photoshop.
Instead of achieving an effect by accident, you'll produce
consistent results thanks to an understanding of basic
color theory.

Primary colors

Additive primaries are the three colors of light (red, green,
and blue) that produce all the colors in the visible spectrum
when added together in different combinations. Adding
equal parts of red, blue, and green light produces white. The
complete absence of red, blue, and green light results in
black. Computer monitors are devices that use the additive
primaries to create color.

Subtractive primaries are pigments, which create a spec-
trum of colors in different combinations. Unlike monitors,
printers use subtractive primaries (cyan, magenta, yellow,
and black pigments) to produce colors through subtractive
mixing. The term "subtractive" is used because the primary
colors are pure until you begin mixing them together,
resulting in colors that are less pure versions of the
primaries. For example, orange is created through the
subtractive mixing of magenta and yellow together.

Additive colors (RGB)
A. Red B. Green C. Blue

Subtractive colors (CMYK)
A. Cyan B. Magenta C. Yellow D. Black

The color wheel

If you're new to adjusting color components, it helps to
keep a standard color wheel diagram on hand when you
work on color balance. You can use the color wheel to
predict how a change in one color component affects other
colors and also how changes translate between RGB and
CMYK color models.

For example, you can decrease the amount of any color in
an image by increasing the amount of its opposite on the
color wheel-and vice versa. Colors that lie opposite each
other on the standard color wheel are known as comple-
mentary colors. Similarly, you can increase and decrease
a color by adjusting the two adjacent colors on the wheel,
or even by adjusting the two colors adjacent to its opposite.

In a CMYK image, you can decrease magenta either by
decreasing the amount of magenta or by increasing its
complement, which is green (the color on the opposite side
of the color wheel from magenta). In an RGB image, you
can decrease magenta by removing red and blue or by
adding green. All of these adjustments result in an overall
color balance containing less magenta.

Color models, spaces, and modes

A color model describes the colors we see and work with
in digital images. Each color model, such as RGB, CMYK,
or HSB, represents a different method (usually numeric) for
describing color.

A color space is a variant of a color model and has a specific
gamut (range) of colors. For example, within the RGB color
model are a number of color spaces: Adobe RGB, sRGB,
ProPhoto RGB, and so on.

Each device, like your monitor or printer, has its own color
space and can only reproduce colors in its gamut. When
an image moves from one device to another, image colors

Color wheel
A. Red B. Yellow C. Green D. Cyan E. Blue F. Magenta
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may change because each device interprets the RGB or
CMYK values according to its own color space. You can
use color management when moving images to ensure that
most colors are the same or similar enough so they appear
consistent.

In Photoshop, a document's color mode determines which
color model is used to display and print the image you're
working on. Photoshop bases its color modes on the color
models that are useful for images used in publishing. You
can choose from RGB (Red, Green, Blue), CMYK (Cyan,
Magenta, Yellow, Black), Lab Color (based on CIE L* a*
b*), and Grayscale. Photoshop also includes modes for
specialized color output such as Indexed Color and Duotone.
Color modes determine the number of colors, the number
of channels, and the file size of an image. Choosing a color
mode also determines which tools and file formats are
available.

When you work with the colors in an image, you are
adjusting numerical values in the file. It's easy to think of a
number as a color, but these numerical values are not
absolute colors in themselves-they only have a color
meaning within the color space of the device that is
producing the color.

Adjusting color hue, saturation, and brightness

Based on the human perception of color, the HSB model
describes three fundamental characteristics of color:

Hue

Color reflected from or transmitted through an object. It is
measured as a location on the standard color wheel,
expressed as a degree between 0° and 360°. In common
use, hue is identified by the name of the color, such as red,
orange, or green.

Saturation

Strength or purity of the color (sometimes called chroma).
Saturation represents the amount of gray in proportion to
the hue, measured as a percentage from 0% (grey) to
100% (fully saturated). On the standard color wheel,
saturation increases from the center to the edge.

Brightness

Relative lightness or darkness of the color, usually mea-
sured as a percentage from 0% (black) to 100% (white).

Convert an image to another color mode

You can change an image from its original mode (source
mode) to a different mode (target mode). When you choose
a different color mode for an image, you permanently
change the color values in the image. For example, when
you convert an RGB image to CMYK mode, RGB color
values outside the CMYK gamut (defined by the CMYK
working space setting in the Color Settings dialog box) are
adjusted to fall within gamut. As a result, some image data
may be lost and can't be recovered if you convert the image
from CMYK back to RGB.

Before converting images, it's best to do the following:

• Do as much editing as possible in the original image
mode (usually RGB for images from most scanners or
digital cameras, or CMYK for images from traditional
drum scanners or imported from a Scitex system).

• Save a backup copy before converting. Be sure to save
a copy of your image that includes all layers so that you
can edit the original version of the image after the
conversion.

• Flatten the file before converting it. The interaction of
colors between layer blending modes changes when
the mode changes.

Convert an image to Bitmap mode

• Converting an image to Bitmap mode reduces the
image to two colors, greatly simplifying the color
information in the image and reducing its file size.

• When converting a color image to Bitmap mode, first
convert it to Grayscale mode. This removes the hue and
saturation information from the pixels and leaves just
the brightness values. However, because only a few
editing options are available for Bitmap mode images,
it's usually best to edit the image in Grayscale mode
and then convert it to Bitmap mode.

• Images in Bitmap mode are 1 bit per channel. You must
convert a 16  or 32 bits-per-channel image to 8 bit
Grayscale mode before converting it to Bitmap mode.

50% Threshold

Converts pixels with gray values above the middle gray level
(128) to white and pixels with gray values below that level
to black. The result is a very high-contrast, black-and-white
representation of the image.

Pattern Dither

Converts an image by organizing the gray levels into
geometric configurations of black and white dots.

Diffusion Dither

Converts an image by using an error-diffusion process,
starting at the pixel in the upper-left corner of the image. If
the pixel's value is above middle gray (128), the pixel is
changed to white-if below it, to black. Because the original
pixel is rarely pure white or pure black, error is inevitably
introduced. This error is transferred to surrounding pixels
and diffused throughout the image, resulting in a grainy,
film-like texture.

HSB color model
A. Hue B. Saturation C. Brightness
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Halftone Screen

Simulates the appearance of halftone dots in the converted
image. Enter values in the Halftone Screen dialog box:

• For Frequency, enter a value for the screen frequency,
and choose a unit of measurement. Values can range
from 1.000 to 999.999 for lines per inch and from 0.400
to 400.00 for lines per centimeter. You can enter
decimal values. The screen frequency specifies the
ruling of the halftone screen in lines per inch (lpi). The
frequency depends on the paper stock and type of
press used for printing. Newspapers commonly use an
85 line screen. Magazines use higher resolution
screens, such as 133 lpi and 150 lpi. Check with your
print shop for correct screen frequencies.

• Enter a value for the screen angle in degrees from  180
to +180. The screen angle refers to the orientation of the
screen. Continuous-tone and black-and-white halftone
screens commonly use a 45° angle.

• For Shape, choose the dot shape you want.

The halftone screen becomes part of the image.
If you print the image on a halftone printer, the
printer will use its own halftone screen as well as
the halftone screen that is part of the image. On
some printers, the result is a moiré pattern.

Custom Pattern

Simulates the appearance of a custom halftone screen in
the converted image. Choose a pattern that lends itself to
thickness variations, typically one with a variety of gray
shades.

To use this option, you first define a pattern and then screen
the grayscale image to apply the texture. To cover the
entire image, the pattern must be as large as the image.
Otherwise, the pattern is tiled. Photoshop comes with
several self-tiling patterns that can be used as halftone
screen patterns.

Convert a Bitmap mode image to Grayscale mode

You can convert a Bitmap mode image to Grayscale mode
in order to edit it. Keep in mind that a Bitmap mode image
edited in Grayscale mode may not look the same when you
convert it back to Bitmap mode. For example, suppose a
pixel that is black in Bitmap mode is edited to a shade of
gray in Grayscale mode. When the image is converted
back to Bitmap mode, that pixel is rendered as white if its
gray value is above the middle gray value of 128.

1. Choose Image > Mode > Grayscale.
2. Enter a value between 1 and 16 for the size ratio.

The size ratio is the factor for scaling down the image. For
example, to reduce a grayscale image by 50%, enter 2 for
the size ratio. If you enter a number greater than 1, the
program averages multiple pixels in the Bitmap mode
image to produce a single pixel in the grayscale image.
This process lets you generate multiple shades of gray
from an image scanned on a 1 bit scanner.

Convert a grayscale or RGB image to indexed color

Converting to indexed color reduces the number of colors
in the image to at most 256-the standard number of colors
supported by the GIF and PNG 8 formats and many
multimedia applications. This conversion reduces file size
by deleting color information from the image.

To convert to indexed color, you must start with an image
that is 8 bits per channel and in either Grayscale or RGB
mode.

About foreground and background colors

Photoshop uses the foreground color to paint, fill, and
stroke selections and the backgroundcolor to make gradi-
ent fills and fill in the erased areas of an image. The
foreground and background colors are also used by some
special effects filters.

You can designate a new foreground or background color
using the Eyedropper tool, the Color panel, the Swatches
panel, or the Adobe Color Picker.

The default foreground color is black, and the default
background color is white. (In an alpha channel, the default
foreground is white, and the background is black.)

Choose colors in the toolbox

The current foreground color appears in the upper color
selection box in the toolbox; the current background color
appears in the lower box.

Foreground and background color boxes in toolbox
A. Default Colors icon B. Switch Colors icon C. Foreground color
box D. Background color box

• To change the foreground color, click the upper color
selection box in the toolbox, and then choose a color in
the Adobe Color Picker.

• To change the background color, click the lower color
selection box in the toolbox, and then choose a color in
the Adobe Color Picker.

• To reverse the foreground and background colors, click
the Switch Colors icon in the toolbox.

• To restore the default foreground and background col-
ors, click the Default Colors icon in the toolbox.

Adobe Color Picker overview

In the Adobe Color Picker, you choose colors using four
color models: HSB, RGB, Lab, and CMYK. Use the Adobe
Color Picker to set the foreground color, background color,
and text color. You can also set target colors for different
tools, commands, and options.

You can configure the Adobe Color Picker to let you
choose only colors that are part of the web-safe palette or
choose from specific color systems. Photoshop Extended
users can access an HDR (high dynamic range) picker to
choose colors for use in HDR images
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Why colors sometimes don't match

No device in a publishing system is capable of reproducing
the full range of colors viewable to the human eye. Each
device operates within a specific color space that can
produce a certain range, or gamut, of colors.

A color model determines the relationship between values,
and the color space defines the absolute meaning of those
values as colors. Some color models (such as CIE L*a*b)
have a fixed color space because they relate directly to the
way humans perceive color. These models are described
as being device-independent. Other color models (RGB,
HSL, HSB, CMYK, and so forth) can have many different
color spaces. Because these models vary with each
associated color space or device, they are described as
being device-dependent.

Because of these varying color spaces, colors can shift in
appearance as you transfer documents between different
devices. Color variations can result from differences in
image sources; the way software applications define color;
print media (newsprint paper reproduces a smaller gamut
than magazine-quality paper); and other natural variations,
such as manufacturing differences in monitors or monitor
age.

What is a color management system?

Color-matching problems result from various devices and
software using different color spaces. One solution is to
have a system that interprets and translates color accu-
rately between devices. A color management system
(CMS) compares the color space in which a color was
created to the color space in which the same color will be
output, and makes the necessary adjustments to repre-
sent the color as consistently as possible among different
devices.

A color management system translates colors with the
help of color profiles. A profile is a mathematical descrip-
tion of a device's color space. For example, a scanner
profile tells a color management system how your scanner
"sees" colors. Adobe color management uses ICC profiles,
a format defined by the International Color Consortium
(ICC) as a cross-platform standard.

Because no single color-translation method is ideal for all
types of graphics, a color management system provides a
choice of rendering intents, or translation methods, so that
you can apply a method appropriate to a particular graphics
element. For example, a color translation method that
preserves correct relationships among colors in a wildlife
photograph may alter the colors in a logo containing flat
tints of color.

Do you need color management?

Without a color management system, your color specifica-
tions are device-dependent. You might not need color
management if your production process is tightly con-
trolled for one medium only. For example, you or your print
service provider can tailor CMYK images and specify color
values for a known, specific set of printing conditions.

The value of color management increases when you have
more variables in your production process. Color manage-
ment is recommended if you anticipate reusing color
graphics for print and online media, using various kinds of
devices within a single medium (such as different printing
presses), or if you manage multiple workstations.

About color profiles

Precise, consistent color management requires accurate
ICC-compliant profiles of all of your color devices. For
example, without an accurate scanner profile, a perfectly
scanned image may appear incorrect in another program,
simply due to any difference between the scanner and the
program displaying the image. This misleading represen-
tation may cause you to make unnecessary, time-wasting,
and potentially damaging "corrections" to an already
satisfactory image. With an accurate profile, a program
importing the image can correct for any device differences
and display a scan's actual colors.

A color management system uses the following kinds
of profiles:

Monitor profiles

Describe how the monitor is currently reproducing color.
This is the first profile you should create because viewing
color accurately on your monitor allows for critical color

A. Picked color B. Original color C. Adjusted color D. Out-of-gamut
alert icon E. Not a web-safe color alert icon F. Displays only web-
safe colors G.Color field H.Color slider I.Color values

Colorgamuts of various devices and documents

A. Lab color space B. Documents (working space) C. Devices
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decisions in the design process. If what you see on your
monitor is not representative of the actual colors in your
document, you will not be able to maintain color consis-
tency.

Input device profiles

Describe what colors an input device is capable of captur-
ing or scanning. If your digital camera offers a choice of
profiles, Adobe recommends that you select Adobe RGB.
Otherwise, use sRGB (which is the default for most
cameras). Advanced users may also consider using differ-
ent profiles for different light sources. For scanner profiles,
some photographers create separate profiles for each type
or brand of film scanned on a scanner.

Output device profiles

Describe the color space of output devices like desktop
printers or a printing press. The color management system
uses output device profiles to properly map the colors in a
document to the colors within the gamut of an output
device's color space. The output profile should also take
into consideration specific printing conditions, such as the
type of paper and ink. For example, glossy paper is
capable of displaying a different range of colors than matte
paper.

Most printer drivers come with built in color profiles. It's a
good idea to try these profiles before you invest in custom
profiles.

Document profiles

Define the specific RGB or CMYK color space of a
document. By assigning, or tagging, a document with a
profile, the application provides a definition of actual color
appearances in the document. For example, R=127,
G=12, B=107 is just a set of numbers that different devices
will display differently. But when tagged with the Adobe
RGBcolor space, these numbers specify an actual color or
wavelength of light-in this case, a specific color of purple.

When color management is on, Adobe applications auto-
matically assign new documents a profile based on Work-
ing Space options in the Color Settings dialog box.
Documents without assigned profiles are known as untagged
and contain only raw color numbers. When working with
untagged documents, Adobe applications use the current
working space profile to display and edit colors.

Managing color with profiles

A. Profiles describe the color spaces of the input device
and the document.

B. Using the profiles' descriptions, the color management
system identifies the document's actual colors.

C. The monitor's profile tells the color management sys-
tem how to translate the document's numeric values to
the monitor's color space.

D. Using the output device's profile, the color management
system translates the document's numeric values to
the color values of the output device so the correct
appearance of colors is printed.

Color Correction

Color correction is a lot easier than you think. You just need
to know which colors are complimentary (meaning on the
opposite end of the color wheel) and you can use those to
cancel out too much of another color. (If you need a
refresher on color, check out our color guide.) You also
need to be able to spot where colors are the most
prominent. This means being able to tell, for example,
when red is dominating the light areas of the photo and blue
is dominating the dark areas. If you simple applied a blue
filter to the entire photo, you'd end up with more neutral
highlights-which you want-but a photo that looks too cool
because the shadows are overly saturated with blue color.
To recap, you need to pay attention to two major things
when color correcting: which colors are dominating the
photograph and which colors aren't, and also where,
tonally, those dominating colors exist.

Fig 1

This is something you can generally do just by eying the
photo, but the proper method is to consult the histogram.
You can bring this up by going into the Window menu and
choosing Histogram. The left side represents the shadows,
the right side the highlights, leaving the middle for the
midtones. If a particular color is dominating the photo in any
area, you'll see it dominating that space on the histogram.
This can be a handy guide for spotting necessary correc-
tions.

Now that you've got a basic idea of what we're going to be
targeting, let's take a look at some of the best color
balancing tools Photoshop has to offer. You can find all the
adjustments we'll be discussing in the following places:

• You can find standard adjustments that apply to a
single layer by going to the Image menu, choosing
Adjustments, then choosing the adjustment you want.

• If you want to create an adjustment layer that can apply
to multiple layers and be adjusted after the first applica-
tion you can create an adjustment layer. You can either
do this by going into the Layers menu, choosing
Adjustment Layer, and then selecting the adjustment
you want, or just selecting the adjustment you want
from the Adjustments palette.

IT&ITES : DTPO - Related Theory for Exercise 2.1.04



34

Color Balance

Fig 2

Color Balance is not a very flexible tool, but sometimes you
just need minor adjustments to color and you can use Color
Balance to apply them quickly. If the brightest parts of your
photo are just a little bit too red-something that's common
with photos taken in low light-you can just select the
Highlights radio button and then move the sliders towards
cyan and blue a bit until you start to see the colors look a
bit more balanced and neutral. You can also use Color
Balance to create some interesting color effects by empha-
sizing different colors in the shadows, midtones, and
highlights.

Levels

Levels is like Curves (which we'll discuss next) with training
wheels. You have three main sliders. On the left, you have
the shadows slider. Moving it to the right will increase the
intensity of the shadows. On the right, you have the
highlights slider. Moving it to the left will increase the
intensity of the highlights of your photo. In the middle, you
have the midtones slider. Moving it to the left will brighten
up your photo and moving it to the right will make it darker.

Fig 3

These sliders mainly affect contrast. The sliders under
Output Levels affect brightness. Moving the black slider
towards the white one will brighten things up. Moving the
white slider toward the black one will darken them. By
default, Levels applies any of these changes to the entire
photo, but you can select a specific color channel and alter
it all by itself. There's a little drop-down menu at the top of
the Levels panel that lets you select from all channels-I'm
going to assume you're in the RGB colorspace and it says

RGB-or each individual channel (red, green, and blue). If
you want to brighten or darken just the reds, select the red
channel and make your adjustments.

Curves

Fig 4

Curves is definitely the best color correction tool you've got
in Photoshop, but you might find it a little intimidating and
shy away from it since Levels seems to work well enough.
Trust me-curves is much better, so take the time to get to
know it and learn how it works so you're using it to do most
of your adjustments. It's powerful, versatile, and very easy
to control once you get the hang of it. That said, it works
a lot like levels only you set your own points. You can
adjust the entire image or just specific channels, just like
you can in levels. To make a point on the curve, you just
click anywhere on the line and drag in a particular direction.
If you pull towards the top left corner, you'll brighten things
up. If you pull down towards the bottom right corner, you'll
darken things. The middle of the line in curves represents
the midtones. The bottom of the line, touching the bottom
left corner, represents the shadows. That would leave the
top, which represents the highlights.

Here's an example of creating a simple curve: make a point
at the midpoint of the line and then two more points that are
each about one grid space away from the midpoint. Pull the
bottom-most point down into the shadows a bit and the top-
most point up into the highlights. This will create basic
contrast and is the simplest adjustment you can make in
curves.

Auto Tone

Fig 5
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Sometimes you can just let Photoshop do a lot of the work
for you. While you don't want to rely on Photoshop's Auto
Tone option, you can just chose it from the Image menu to
let Photoshop make an educated guess about what your
photo needs in terms tone and color adjustments. Some-
times you can save yourself a little time by just using Auto
Tone, but definitely don't rely on it. Sometimes it just gets
it right and it takes about two seconds to try it out and see
if it works. If it doesn't work, undo it, and do the corrections
yourself. If it does work, you just saved yourself some time.

Photo Retouching and Enhancing

Basic photo retouching and enhancing is very easy and
very effective if done with the right level of subtlety. We're
going to take a look at some options for correcting
problems in your photos-like cuts on a face, dry skin, dust
from the lens, etc.-and also how to enhance a portrait to
make it look especially nice.

Touch Ups

Most of the touch ups you're going to want to perform can
be accomplished with the healing brush or the cloning
stamp. If you're trying to just make a person look their best-
which is all you really ought to be doing with a portrait-you
can do most of what you want to do with the healing brush
and clone stamp. We'll also take a brief look at some of
your other options as well.

The Healing Brush Revisited

Fig 6

Basically it works by selecting a source point (which you
do by option-clicking an area of the photo) and painting over
the area you want to "heal" with image data from the source
point. The healing brush then uses its magic to blend in the
painted source material with the stuff surrounding it.
Generally this results in a more realistic result than you'd
get with the Clone Stamp, but not always. The Clone
Stamp works in the exact same fashion as the Healing
Brush, but the Clone Stamp doesn't do any healing. All it
does is replace the target area with whatever you selected
as a source point. While you're technically cloning another
part of the photo and this may seem like it's going to look
redundant, when you're correcting small areas it can
sometimes look better than what the Healing Brush will
give you-especially when you're near hard edges and areas
of contrast.

Other Tools

Fig 7

In addition to the Healing Brush and Clone Stamp, there are
a few other ways to make corrections. If you're looking to
reduce redness in certain parts of the skin, often times you
can accomplish this by simply desaturating the red area a
little bit. The Sponge Tool can help you easily desaturate
a particular area. If you're removing blemishes and want
some alternatives, the Spot Healing Brush can sometimes
be a little easier to use than the regular Healing Brush (you
can find it by clicking and holding down the Healing Brush
in the tool bar). It doesn't require you to set a source point.
One last option is using Content-Aware Fill, which is a new
feature in Photoshop CS5. To use it, what you want to
remove needs to be in the background layer. Select the part
you want to remove with a Marquee or Lasso tool and press
delete. You should be presented with a dialogue box
asking you what you want to do. If "Use:" isn't set to
Content-Aware, change that and then press OK. Once you
do, Photoshop will try to figure out what your photo should
look like without that element. The more precise your
selection is, the more successful Photoshop will be in
replacing it.

Enhancing a Portrait

Using a couple of minor enhancements, you can make a
portrait look significantly better than the original photo-
graph. Everything we're going to discuss here is designed
to bring out the best in the image of the person you're
working on and not necessarily look better than they
actually do. Photos tend to pick up more detail than we'd
normally notice and people generally don't have pimples,
cuts, or other blemishes on their faces all the time. The idea
is to bring out the best in the subject and not perform
anything that's untrue to their appearance or is just
downright unrealistic.

Color Channeling

Fig 8

One of the best and easiest tricks to enhancing a portrait
is making use if your color channels. You can find your
color channels in the Channels palette on the right side of
your screen. Assuming you're in the RGB color space,
you'll see four options: RGB, red, green, and blue. RGB is
the color image as you know it. The others are the
respective channels. Click each of these and note their
differences. You'll find that red has the most light, blue has
the most detail, and green is kind of a combination of them
both. When you're dealing with people, detail in skin is
generally something you want to avoid and that's exactly
what the red channel can help you do. Sometimes it's a
near-perfect black and white photo all by itself, but if we're
working with color it's still very useful. To make a nice
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adjustment, select the red channel, then select all and
copy the image. Now switch back to the RGB combine
channel, go back to your Layers palette, and paste the red
channel. This will create a new layer on top of your
background and you'll see only the red channel on your
canvas. From the Layers palette, select a blending mode
of Overlay for your red channel layer and reduce its opacity
to somewhere between 20 and 30 percent. This is one of
the easiest adjustments to make and it's incredibly useful.
It removes unwanted detail in the skin, adds contrast right
where you want it, and often improves your photo's color as
well.
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Fig 9

Burning and Dodging

Burning and dodging can also be extremely useful when
applying "virtual makeup" to your subject. This is some-
thing you'll want to do for men as well as women, because
we're going to be very subtle and make it look as natural as
possible. The idea is to place added contrast in the features
of the face we want to emphasize: the eyes, nose, and
mouth. You can use the burn tool to burn the midtones and
shadows of the eyelashes and eyebrows, the curve of the
nose, and the inner edges of the lips. You can use the
dodge tool to brighten up the midtones of the colored and
white parts of the eye and the inside of the lips.

While these enhancements are pretty minor, they make a
significant difference in the overall look of the photo.

Hue/Saturation lets you adjust the hue, saturation, and
lightness of a specific range of colors in an image or
simultaneously adjust all the colors in an image. This
adjustment is especially good for fine-tuning colors in a
CMYK image so that they are in the gamut of an output
device.

Apply a Hue/Saturation adjustment

Do one of the following:

• Click the Hue/Saturation icon  in the Adjustments
panel.

• (CS5) Click a Hue/Saturation preset in the Adjustments
panel.

• Choose Layer > New Adjustment Layer > Hue/Satura-
tion. Click OK in the New Layer dialog box.

The two color bars in the dialog box represent the colors in
their order on the color wheel. The upper color bar shows
the color before the adjustment; the lower bar shows how
the adjustment affects all of the hues at full saturation.

You can also choose Image > Adjustments >
Hue/Saturation. But keep in mind that this
method makes direct adjustments to the image
layer and discards image information.

Color wheel

A. Saturation B. Hue

• In the Adjustments panel (CS5) or the Properties panel
(CS6), choose from the menu to the right of the On-
image adjustment tool .

• Choose Master to adjust all colors at once.

• Choose one of the other preset color ranges listed for
the color you want to adjust. To modify the color range,
Choose a Hue/Saturation preset from the Preset menu.

• For Hue, enter a value or drag the slider until you are
satisfied with the colors.

The values displayed in the box reflect the number of
degrees of rotation around the wheel from the original color
of the pixel. A positive value indicates clockwise rotation;
a negative value, counterclockwise rotation. Values can
range from 180 to +180.

You can also select the On-image adjustment tool  in
the Adjustments panel (CS5) or the Properties panel
(CS6), and then Ctrl-click a color in the image. Drag left or
right in the image to modify the hue value.

• For Saturation, enter a value or drag the slider to the
right to increase the saturation or to the left to decrease
it.

The color shifts away from or toward the center of the color
wheel. Values can range from 100 (percentage of
desaturation, duller colors) to +100 (percentage of satura-
tion increase).

You can also , select the On-image adjustment tool  
in the Adjustments panel (CS5) or the Properties panel
(CS6), and click a color in the image. Drag left or right in the
image to decrease or increase saturation of the color range
that includes the pixel you clicked.

• For Lightness, enter a value or drag the slider to the right
to increase the lightness (add white to a color) or to the
left to decrease it (add black to a color). Values can
range from 100 (percentage of black) to +100 (percent-
age of white).

Click the Reset button   to undo a Hue/Satura-
tion setting in the Adjustments panel (CS5) or
the Properties panel (CS6).
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Specify the range of colors adjusted using Hue/
Saturation

• Apply a Hue/Saturation adjustment.

• In the Adjustments panel (CS5) or the Properties panel
(CS6), choose a color from the menu to the right of the

On-image adjustment button .

Four color wheel values (in degrees) appear in the Adjust-
ments panel (CS5) or the Properties panel (CS6). They
correspond to the adjustment sliders that appear between
the color bars. The two inner vertical sliders define the color
range. The two outer triangle sliders show where the
adjustments on a color range "fall off" (falloff is a feathering
or tapering of the adjustments instead of a sharply defined
on/off application of the adjustments).

• Use either the eyedropper tools or the adjustment
sliders to modify the range of colors.

• Click or drag in the image with the Eyedropper tool
  to select a color range. To expand the range,

click or drag in the image with the Add To Sample
Eyedropper tool .  To reduce the range of color,
click or drag in the image with the Subtract From
Sample Eyedropper tool . While an eyedropper
tool is selected, you can also press Shift to add to
the range, or Alt (Windows) or Option (Mac OS) to
subtract from it.

• Drag one of the white triangle sliders to adjust the
amount of color falloff (feathering of adjustment)
without affecting the range.

• Drag the area between the triangle and the vertical
bar to adjust the range without affecting the amount
of falloff.

• Drag the center area to move the entire adjustment
slider (which includes the triangles and vertical bars)
to select a different color area.

• Drag one of the vertical white bars to adjust the range
of the color component. Moving a vertical bar from
the center of the adjustment slider and closer to a
triangle increases the color range and decreases
the falloff. Moving a vertical bar closer to the center
of the adjustment slider and away from a triangle
decreases the color range and increases the falloff.

• Ctrl-drag (Windows) or Command-drag (Mac OS)
the color bar so that a different color is in the center
of the bar.

If you modify the adjustment slider so that it falls into a
different color range, the name in the Edit menu changes
to reflect this change. For example, if you choose Yellow
and alter its range so that it falls in the red part of the color
bar, the name changes to Red 2. You can convert up to six
of the individual color ranges to varieties of the same color
range (for example, Red through Red 6).

By default, the range of color selected when you choose a
color component is 30° wide, with 30° of falloff on either
side. Setting the falloff too low can produce banding in the
image.

Colorize a grayscale image or create a monotone
effect

• (Optional) If you are colorizing a grayscale image,
choose Image > Mode > RGB Color to convert the
image to RGB.

• Apply a Hue/Saturation adjustment.

• In the Adjustments panel (CS5) or the Properties panel
(CS6), select the Colorize option. If the foreground color
is black or white, the image is converted to a red hue
(0°). If the foreground color is not black or white, the
image is converted to the hue of the current foreground
color. The lightness value of each pixel does not
change.

• (Optional) Use the Hue slider to select a new color. Use
the Saturation and Lightness sliders to adjust the
saturation and lightness of the pixels.

Adjust color saturation using Vibrance

• Vibrance adjusts the saturation so that clipping is
minimized as colors approach full saturation. This adjust-
ment increases the saturation of less-saturated colors
more than the colors that are already saturated. Vibrance
also prevents skintones from becoming over saturated.

• Do one of the following:

• In the Adjustments panel, click the Vibrance icon  .

• Choose Layer > New Adjustment Layer > Vibrance
. In the New Layer dialog box, type a name for the

Vibrance adjustment layer and click OK.

Hue/Saturation adjustment slider

A. Hue slider values B. Adjusts falloff without affecting
range C. Adjusts range without affecting falloff D. Adjusts
range of color and falloff E. Moves entire slider
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You can also choose Image > Adjustments >
Vibrance. But keep in mind that this method
makes direct adjustments to the image layer
and discards image information.

• In the Adjustments panel (CS5) or the Properties panel
(CS6), drag the Vibrance slider to increase or decrease
color saturation without clipping when colors become
more saturated. Then, do one of the following:

• To apply more adjustment to less saturated colors
and prevent colors clipping as they reach total
saturation, move the Vibrance slider to the right.

• To apply the same amount of saturation adjustment
to all colors regardless of their current saturation,
move the Saturation slider. In some situations, this
may produce less banding than the Saturation slider
in the Hue/Saturation Adjustments panel or Hue/
Saturation dialog box.

• To decrease saturation, move either the Vibrance or
the Saturation slider

Adjust color saturation in image areas

The Sponge tool subtly changes the color saturation of an
area. When an image is in Grayscale mode, the tool
increases or decreases contrast by moving gray levels
away from or toward the middle gray.

• Select the Sponge tool .

• Choose a brush tip and set brush options in the options
bar.

• In the options bar, choose the way you want to change
the color from the Mode menu:

Saturate

Intensifies the color's saturation

Desaturate

Dilutes the color's saturation

• Specify the flow for the Sponge tool.

• Select the Vibrance option to minimize clipping for fully
saturated or desaturated colors.

• Drag over the part of the image you want to modify.

The "Hue / Saturation" Adjustment Layer in Photoshop

In a well-exposed image, it is quite possible that Levels and
Hue / Saturation are the only 2 tools that you'll need for
working with the first 4 elements: Contrast, Color Balance,
Luminance, and Color Saturation.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.05
Formatting text, paragraphs using the brushes and layers
Objectives : At the end of this lesson you shall be able to
• formatting text and Paragraph
• explain various options in Image, Layer, Select and Filter Menu
• explain arranging and displaying panels
• creating and Modifying brushes
• explain about brush and painting option
• filling and stroking selections, layers and paths.

Formatting characters

Photoshop give you precise control over individual charac-
ters in type layers, including font, size, color, leading,
kerning, tracking, baseline shift, and alignment. You can
set type attributes before you enter characters or reset
them to change the appearance of selected characters in
a type layer.
Selecting characters
Before you can format individual characters, you must
select them. You can select one character, a range of
characters, or all characters in a type layer.
Character panel
The Character panel provides options for formatting charac-
ters. Some formatting options are also available from the
options bar.
You can display the Character panel by doing one of the
following:

• Choose Window > Character, or click the Character
panel tab if the panel is visible but not active.

• With a type tool selected, click the Panel button   in
the options bar.

To set an option in the Character panel, choose a value from
the pop up menu on the right side of the option. For options
with numeric values, you can also use the up and down
arrows to set the value, or you can edit the value directly in
the text box. When you edit a value directly, press Enter
or Return to apply a value, Shift+Enter or Shift+Return to
apply a value and then highlight the value just edited, or Tab
to apply a value and move to the next text box in the panel.

Select Show Asian Text Options in the Type
preferences for the Set Tsume option to appear in
the Character panel.

You can access additional commands and options in the
Character panel menu. To use this menu, click the triangle
in the upper right corner of the panel.

Dynamic Shortcuts

Dynamic Shortcuts are keyboard shortcuts that are acces-
sible only when you are entering point or paragraph type,
when type is selected, or when the I beam is in text. You
can view Dynamic Shortcuts in the Character panel menu
when they are accessible. Dynamic Shortcuts are avail-
able for type options such as Faux Bold, Faux Italic, All
Caps, Small Caps, Superscript, Subscript, Underline, and
Strikethrough.

Character panel

A. Font Family B. Font Size C. Vertical Scale D. Set Tsume
option E. Tracking F. Baseline Shift G. Language H. Font
Style I. Leading J. Horizontal scale K. Kerning

Dynamic shortcuts appear in the Character panel menu
only when you are entering point or paragraph type, when
type is selected, or when the I beam is in text.

Specify type size

The type size determines how large the type appears in the
image.

The default unit of measurement for type is points. One
PostScript point is equal to 1/72 of an inch in a 72 ppi
image; however, you can switch between using the
PostScript and traditional definitions of point size. You can
change the default unit of measurement for type in the Units
& Rulers area of the Preferences dialog box.

Change the type color

The type you enter is rendered in the current foreground
color; however, you can change the color before or after you
enter type. When editing existing type layers, you can
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change the color of individual, selected characters or of all
type in a layer.

• Do one of the following:

• Click the Color selection box in the options bar or
Character panel, and select a color using the Adobe
Color Picker.

• Use fill shortcuts. To fill with the foreground color,
press Alt+Backspace (Windows) or Option+Delete
(Mac OS); to fill with the background color, press
Ctrl+Backspace (Windows) or Command+Delete
(Mac OS).

• Apply an overlay layer style to the type layer to apply
a color, gradient, or pattern on top of the existing
color. You can't apply an overlay layer style selec-
tively; it affects all characters in the type layer.

• Click the foreground color selection box in the
toolbox, and select a color using the Adobe Color
Picker. Alternatively, click a color in the Color panel,
or the Swatches panel. If you use this method to
change the color of an existing type layer, you must
first select characters on that layer.

Set leading

The vertical space between lines of type is called leading
(rhymes with sledding). For Roman type, leading is mea-
sured from the baseline of one line of text to the baseline
of the line above it. The baseline is the invisible line on which
most letters sit. You can apply more than one leading
amount within the same paragraph; however, the largest
leading value in a line of type determines the leading value
for that line.

Kern and track

Kerning is the process of adding or subtracting space
between specific pairs of characters. Tracking is the
process of loosening or tightening the spacing between the
characters in selected text or an entire block of text.

Change the orientation of a type layer

The orientation of a type layer determines the direction of
type lines in relation to the document window (for point
type) or the bounding box (for paragraph type). When a type
layer is vertical, the type flows up and down; when a type
layer is horizontal, the type flows from left to right. Don't
confuse the orientation of a type layer with the direction of
characters in a type line.

1 Select the type layer in the Layers panel.

2 Do one of the following:

• Select a type tool, and click the Text Orientation
button  in the options bar.

• Choose Layer > Type > Horizontal, or choose
Layer> Type > Vertical.

• Choose Change Text Orientation from the Character
panel menu.

Rasterize type layers

Some commands and tools-such as filter effects and
painting tools-are not available for type layers. You must
rasterize the type before applying the command or using
the tool. Rasterizing converts the type layer into a normal
layer and makes its contents uneditable as text. A warning
message appears if you choose a command or tool that
requires a rasterized layer. Some warning messages
provide an OK button you can click to rasterize the layer.

♦ Select the type layer and choose Layer > Rasterize >
Type.

Creating type effects

You can perform various operations on type to change its
appearance. For example, you can warp type, convert type
to shapes, or add a drop shadow to type. One of the easiest
ways to create type effects is to play the default Text
Effects actions that come with Photoshop on a type layer.
You can access these effects by choosing Text Effects
from the Actions panel menu.

Create type along or inside a path

You can enter type that flows along the edge of a work path
created by a pen or a shape tool. When you enter type
along a path, the type flows in the direction that anchor
points were added to the path. Entering horizontal type on
a path results in letters that are perpendicular to the
baseline. Entering vertical type on a path results in text
orientation parallel to the baseline.

You can also enter type inside a closed path. In this case,
however, the type is always oriented horizontally, with line
breaks occurring wherever the type reaches path bound-
aries.

Warp and unwarp type

You can warp type to create a special type effect. For
example, you can warp type in the shape of an arc or a
wave. The warp style you select is an attribute of the type
layer-you can change a layer's warp style at any time to
change the overall shape of the warp. Warping options give
you precise control over the orientation and perspective of
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the warp effect. Note: You cannot warp type layers that
include Faux Bold formatting or that use fonts without
outline data (such as bitmap fonts).

Warp type

1 Select a type layer.

2 Do one of the following:

• Select a type tool, and click the Warp button  in
the options bar.

• Choose Type > Warp Text (CC, CS6) or Layer >
Type > Warp Text (CS5).

You can use the Warp command to warp text in
a type layer. Choose Edit > Transform Path >
Warp.

3 Choose a warp style from the Style pop-up menu.

4 Select the orientation of the warp effect-Horizontal or
Vertical.

5 If desired, specify values for additional warping options:

• Bend to specify how much warp is applied to the
layer

• Horizontal Distortion or Vertical Distortion to apply
perspective to the warp

Unwarp type

1 Select a type layer that has warping applied to it.

2 Select a type tool and click the Warp button  in the
options bar, or choose Layer > Type > Warp Text.

3 Choose None from the Style pop-up menu, and click
OK.

Create a work path from type

You can work with type characters as vector shapes by
converting them to a work path. A work path is a temporary
path that appears in the Paths panel and defines the
outline of a shape. After you create a work path from a type
layer, you can save and manipulate it as you do any other
path. You cannot edit characters in the path as text;
however, the original type layer remains intact and editable.

• Select a type layer, and choose Type > Create Work
Path (CC, CS6) or Layer > Type > Create Work Path
(CS5). Note: You cannot create work paths from fonts
that don't include outline data (such as bitmap fonts).

Convert type to shapes

When you convert type to shapes, the type layer is
replaced by a layer with a vector mask. You can edit the
vector mask and apply styles to the layer; however, you
cannot edit characters in the layer as text.

• Select a type layer, and choose Type > Convert To
Shape (CC, CS6) or Layer > Type > Convert To Shape
(CS5). Note: You cannot create shapes from fonts that
don't include outline data (such as bitmap fonts).

Format paragraphs

For point type, each line is a separate paragraph. For
paragraph type, each paragraph can have multiple lines,
depending on the dimensions of the bounding box.

You can select paragraphs and then use the Paragraph
panel to set formatting options for a single paragraph,
multiple paragraphs, or all paragraphs in a type layer.

• Select the Horizontal Type tool   or the Vertical Type

tool .

• To apply formatting to a single paragraph, click in a
paragraph.

• To apply formatting to multiple paragraphs, make a
selection within a range of paragraphs.

• To apply formatting to all paragraphs in the layer,
select the type layer in the Layers panel.

Paragraph panel

You use the Paragraph panel to change the formatting of
columns and paragraphs. To display the panel, choose
Window > Paragraph, or click the Paragraph panel tab if the
panel is visible but not active. You can also select a type

tool and click the Panel button  in the options bar.

To set options with numeric values in the Paragraph panel,
you can use the up and down arrows or edit the value
directly in the text box. When you edit a value directly,
press Enter or Return to apply a value, Shift+Enter or
Shift+Return to apply a value and then highlight the value
just edited, or Tab to apply a value and move to the next text
box in the panel.

Paragraph panel

A. Alignment and justification B. Left indent C. First line left indent
D. Space before paragraph E. Hyphenation F. Right indent G.
Space after paragraph
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You can access additional commands and options in the
Paragraph panel menu. To use this menu, click the triangle
in the upper right corner of the panel.

Specify alignment

You can align type to one edge of a paragraph (left, center,
or right for horizontal type; top, center, or bottom for vertical
type). Alignment options are available only for paragraph
type.

1. Do one of the following:

• Select a type layer if you want all the paragraphs in
that type layer to be affected.

• Select the paragraphs you want affected.

2. In the Paragraph panel or options bar, click an align-
ment option.

The options for horizontal type are:

Left Align Text

Aligns type to the left, leaving the right edge of the
paragraph ragged.

Center Text

Aligns type to the center, leaving both edges of the
paragraph ragged.

Right Align Text

Aligns type to right, leaving the left edge of the paragraph
ragged.

The options for vertical type are:

Top Align Text

Aligns type to the top, leaving the bottom edge of the
paragraph ragged.

Center Text

Aligns type to the center, leaving both the top and bottom
edges of the paragraph ragged.

Bottom Align Text

Aligns type to the bottom, leaving the top edge of the
paragraph ragged.

Specify justification for paragraph type

Text is said to be justified when it is aligned with both
edges. You can choose to justify all text in a paragraph
excluding the last line, or you can justify text in a paragraph
including the last line. The settings you choose for justifi-
cation affect the horizontal spacing of lines and the
aesthetic appeal of type on a page.

Justification options are available only for paragraph type
and determine word, letter, and glyph spacing. Justification
settings apply only to Roman characters; double byte
characters available in Chinese, Japanese, and Korean
fonts are not affected by these settings.

1. Do one of the following:

• Select a type layer if you want all the paragraphs in
that type layer to be affected.

• Select the paragraphs you want affected.

2. In the Paragraph panel, click a justification option.

The options for horizontal type are:

Justify Last Left

Justifies all lines except the last, which is left aligned.

Justify Last Centered

Justifies all lines except the last, which is center aligned.

Justify Last Right

Justifies all lines except the last, which is right aligned.

Justify All

Justifies all lines including the last, which is force justified.

The options for vertical type are:

Justify Last Top

Justifies all lines except the last, which is top aligned.

Justify Last Centered

Justifies all lines except the last, which is center aligned.

Justify Last Bottom

Justifies all lines except the last, which is bottom justified.

Justify All

Justifies all lines including the last, which is force justified.

Justification (right, center, and left align, and
justify all) for type on a path starts at the insertion
point and ends at the end of the path.

Indent paragraphs

Indention specifies the amount of space between type and
the bounding box or line that contains the type. Indention
affects only the selected paragraph or paragraphs, so you
can easily set different indentions for paragraphs.

1. Do one of the following:

• Select a type layer if you want all the paragraphs in
that type layer to be affected.

• Select the paragraphs you want affected.

2. In the Paragraph panel, enter a value for an indention
option:

Indent Left Margin

Indents from the left edge of the paragraph. For vertical
type, this option controls the indention from the top of the
paragraph.

Indent Right Margin

Indents from the right edge of the paragraph. For vertical
type, this option controls the indention from the bottom of
the paragraph.
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Indent First Line

Indents the first line of type in the paragraph. For horizontal
type, the first line indent is relative to the left indent; for
vertical type, the first line indent is relative to the top indent.
To create a first line hanging indent, enter a negative value.

Image menu

Fig 1

Photoshop enables you to carry out a variety of effects on
various types of images. This program offers versatile tools
through which you can add effects to image. It is the 'Image
Menu' that enables you to add effects. Let's take a closer
look at the tools offered by this menu.

When you are dealing with Images in Photoshop, the first
thing that you will be using is the Image Menu. The Image
menu has many submenus, each of which enable you to
carry out a particular function that transforms the look of the
image that you are working with.

Mode

This submenu enables you to alter an image's appearance
and its color scheme. The options available here are
Bitmap, Grayscale, Duotone, Indexed Color, RGB Color,
CMYK Color, Lab Color, Multichannel, 8 Bits/Channel, 16
Bits/ Channel, and Color Table. These options enhance
you to enhance the appearance of your image as you think
is required. You can carry out many different color effects
through this menu.

Adjustments

This submenu enables you to make adjustments to your
image. It contains options such as the 'Curves' (which
enables you to manipulate color), 'Bright/Contrast' (which
enables you to set the brightness and contrast), 'Hue/
Saturation' (which enables you to set the depth of color),
and 'Black and White' (which enables you to set the image
as Black or White). This submenu has a variety of options
through which you can perform so many different effects on
the image that you are working with.

Image Size

This submenu enable you to resize the size of your image.
Not only can you change the height and width of the image,
you can also change the height, width and resolution of
your document. This option enables you to set the size of
the working area of the document.

Canvas Size

This submenu enables you to change the working area of
the image so that you have more space to work with.

Crop

This submenu enables you to crop or cut off parts of an
image that you feel is not necessary for including in your
work area.

Trim

This submenu enables is similar to the Crop action. You
can remove unnecessary areas of the image. Use it to trim
parts of the image that you feel is unnecessary for your
usage.

Each of these options enables you to carry out different
effects on the images that you are working with. You can
carry out so many different effects and in each image the
result will be different, interesting and also unique.

Layers Menu

One of the most important Photoshop tools is the Layers
Panel. The Layers Panel lists out all the layers that make
up your working image. You can use the Layers panel to
Create New Layers, Work with a Layer Group, or to Show
and Hide Layers. Let's take a look at the many different
things that can be done with the Layers Panel.
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Deleting Photoshop Layer

Deleting a layer is quite simple. Right click the layer you
want to delete to open a pop up menu. Click Delete Layer
to delete the layer. Alternatively, highlight the layer by
clicking it and then click the trashcan icon at the bottom of
the Layers Panel to delete it.

Locking and Unlocking Layers

Locking a layer is easy, you just have to click the Padlock
icon at the top of the Layers Panel to do this. This action
locks all the layers. You can unlock a layer by clicking the
Padlock Layer in the layer.

Merging Layers

You can merge layers by clicking on one layer and then
pressing CTRL to click the other layers that you wish to
merge with this layer. Once you have highlighted all the
layers, right click on any one. A pop up menu opens, where
you can click Merge Layers to carry out the merge action.

Select Menu

Creating a Layer

You can create a new layer by clicking the 'sheet-shaped'
icon bottom of the Layers Panel. You can also create a new
layer by going to the top of your Photoshop window and
click Layer > New > Layer.

Renaming a Layer

When you create a new layer, it is named as Layer 1 or
Layer 2, depending on when you create it. However, you
can assign your own name to a layer by renaming it. You
have to double-click the name of the layer to rename it.

Razterize your Layer

You can rasterize any layer by first highlighting the layer
and then right clicking the layer to rasterize it.

Using Blending Options

You can use this option in three different ways. The first
way to do this is by double clicking the layer and opening
the Blending Options. You can also access this option by
doing a right click on the layer you are working with. This
opens a pop up menu that will allow you to access this
option. You can also access this option from the Photoshop
window and click Layer > Layer Styles > Blending Options.

Fig 2

Fig 3

The Select menu is used when you want to add something,
delete something, or make changes to one specific part of
the photo, rather than the photo as a whole. This Photoshop
tutorial will explain which menu option does what, and what
they can be used for.

All, Deselect, and Reselect

All: Select all will select the entire photo (or layer) that you
are working on. This works well if you want to copy the
contents to a new layer, or a new document.
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Deselect: This will rid you of the "marching ants" around
whatever part of the photo you've selected. This is usually
used once you've copied the contents and pasted to a new
layer and no longer need to have the contents of your image
selected.

Reselect: Reselecting is used when you've selected
something, deselected it, and then realized you still need
that portion of your image selected. This will select exactly
what you had previously, rather than making you try to
select the exact portion of your image again.

Inverse: This tool is probably one of the most under-
estimated within the batch. I love this tool. Inverse allows
you to select a part of an image, go to inverse, and
Photoshop Elements will select the exact opposite of what
you've just selected. I use this all the time when I want to
put a portion of my photo on a new background. Rather than
selecting every pixel of the background to delete it, I select
an easier portion of the image, go to inverse, and it will
select the background for me!

All Layers: If you're working with a multi-layer document,
this is a great tool to have. If you draw a marquis around a
layer, you're only selecting that layer, nothing under it.
Select all layers allows you to select every layer and work
with them as a whole.

Deselect Layers: Does the same as deselect, but will
deselect all layers rather than just the layer you are working
on.

Similar Layers: This select option allows you to select
layers of the same type such as all text layers, or all
adjustment layers.

Feather and Refine Edge

Feather: Feather is a great way to make your photo look
more realistic if you change its background. It will blur the
pixels around the selection (you can choose how many
pixels) and create the illusion that the photo was on that
background all along, rather than making it look like you
took a portion of a photo and pasted into a new background.

Refine Edge: Refine edge gives you three options with
sliders to control the density of the change. Smooth will
remove the jagged edges along a selection. Feather works
the same as feather above, blurring the edges to make the
selection look more realistic. Contract/Expand allows you
to increase or decrease the amount of selected pixels. You
can choose to view the image as you would see it, or view
the selection with an overlay color so that you can view the
selection more in depth.

Modify

Modify gives you a few options for your selection. Border
allows you to create a border around the selected pixels (up
to 200 pixels) so that only the pixels within that border are
selected. You can copy this selection to a new layer and
fill the layer with a color to make an outline of your image.
Smooth works a lot like feathering. It will give the selection
a softer edge so it looks better, rather than having jagged
pixels. Expand lets you make your selection bigger by up
to 200 pixels so that you can select the exact portion of the

image. Lastly, Contract will let you make your selection
smaller to define the exact portion of the image you want
to select.

Grow and Similar

Grow: Grow works by selecting more pixels that match the
color of your selection. For example, you've selected a
portion of a tree. Grow will choose all of the pixels that
match the color of the tree portion you've selected. This
works best if you have an image that has a high contrast,
otherwise it may select more pixels than you need.

Similar: Similar will select all of the pixels in an image that
match the color of your selected pixels. Again, this works
best with high contrast images so that you don't end up
selecting pixels you didn't need.

Loading, Saving, and Deleting a Selection

Load Selection, Delete Selection, and Save Selection all
work together. To load a selection, you first must save it.
When you are finished with selecting a portion of an image,
suppose a flower, you've spent tons of time selecting the
details of that flower, making sure you have selected all of
the pixels. Saving the selection allows you to save that
exact outline to use it later. Load selection allows you to
load a previously saved selection, and delete selection
deletes any saved selections you no longer want or need.

Filter Menu

One of the most important things that you can do with
Photoshop is applying filters. Filters are some ready-made
effects that you can apply to the image that you are working
with.

Photoshop offers a wide variety of filters. You can create
some of the most stunning effects through Photoshop's
filters. You can access them from the Filters menu in the
Photoshop Menu Bar. When you use any of the filter
options available, a dialog box will open through which you
can see a preview of the effect that you are going to apply
on the image. This gives you information on how the image
result will look after application.

Here are the many filter options on Photoshop:

••••• Artistic - This filter enables you to achieve artistic
effects. You can get some of the most distinct effects
through this option.

••••• Blur - This filter enables you to soften the look of an
image. It can be used to soften the look of an entire
image part of an image. You can use it to reduce the
hard edges of an image.

••••• Brush Strokes - This filter enables you to create artistic
effects using brush strokes.

••••• Distort - This filter enables you distort the image so that
you can get a unique effect on the original image. This
is one of the most interesting Photoshop effects to try
out.

••••• Noise - This filter is used for creating textures. Many
texture effects can be added using the options available
here.
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••••• Pixelate -  It creates small cells in the image that you
are working with, based on color similarity.

••••• Render - This bring about cloud and light effects in the
image that you are selecting.

••••• Sharpen - This sharpens the soft edges in the image
by increasing pixel contrast.

••••• Sketch - This works much like the artistic filter, except-
ing here you get a hand draw effect on the image.

••••• Stylize - This option enables you to create special
stylish effects on the image.

••••• Texture - This option enables you to create various
types of texture effects that can really enhance the way
your image looks.

••••• Video - When you have image captured through video,
you can use this command to smoothen them out.

••••• Digimark - You have to use his option when you want
to add a digital watermark to the image.

Each of the filters enables you to create unique and
stylistic effects on your image document. You can carry
out so many variations in the image that you are working
with and bring out some of the best results. Check out the
results of each effect and carefully experiments with as
many variations as possible so that you get the kind of
results you want in your photo retouching or image enhanc-
ing requirements.

IT&ITES : DTPO - Related Theory for Exercise 2.1.05

In Photoshop, palettes are used to help modify and monitor
your documents. An understanding of how to use, orga-
nize, and adjust palettes is essential in learning how to use
Photoshop.

The Palettes

In order to see how big of a role palettes play in Photoshop,
simply Press Tab in Photoshop to hide all palettes.
Palettes include everything from the toolbox, to the option
bar, to the layers and colors windows.

Arranging Palettes

It's possible to arrange palettes to your personal taste.
Doing so can help increase your efficiency by moving your
most frequently used palettes to a more accessible part of
the screen.

To move a palette to a separate palette group, or into a
palette group of its own, drag and drop that palettes tab into
another group, or anywhere else in the work area.

To move a palette group, drag the title bar of that palette
with your mouse, and release when it is positioned as you
see fit.

Fig 1

You can also Dock Palettes to one another by having their
upper and lower edges meet one another. When a palette
is docked to another, it will snap into place.

Resizing, Showing, and Hiding Palettes

Perhaps you're working with a palette with a large number
of styles, colors, or layers, all of which you like to be
accessible at the same time. You can resize many of the
palettes by dragging the bottom right corner out to which-
ever size you prefer.

Fig 2

If you want to hide (minimize) a palette that you're not
currently using to save up on space, simply double click
that palettes tab. Likewise, you can expand a minimized
tablet by double clicking the tab again.

Closing, Opening, and Reseting Palettes

If you have some tablets open that serve no use to you for
your current work, it's possible to close out of them by
clicking the "x" in the top right corner of the palette (On a
mac, this will be the typical close button).

If you need to open a new palette, or a palette which you
have previously closed, go to Window in your menu bar,
and select the palette you'd like to reopen.

If you're ever having trouble getting your palettes back into
place, and simply want to revert to the default palette
layout, go to Window > Workspace > Reset Palette
Locations in your Menu Bar. This will reset everything
back to how you started when you first opened Photoshop.

Setting Options in Palettes

Inside palettes, you'll find all sorts of various settings from
color choices, styles, opacity, and other values. We'll
cover many of these options in detail in the future, but for
now let's go over how to operate some of these options.
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Fig 3

Drop-down Menus

To operate a drop-down menu, just click the arrow attached
to the menu. A list of available inputs will drop down. Click
any of these values to select them.

Sliders

Sliders are operated by grabbing a handle by holding down
your mouse button over one, and then dragging to your
desired value.

Swatches & Styles

To select a color swatch, or layer style, simply hover over
it with your mouse, and click once with your mouse.

Fig 4

Fig 5
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You can create brushes that apply paint to images in a
variety of ways. You select an existing preset brush, a
brush tip shape, or create a unique brush tip from part of an
image. You choose options from the Brush panel to specify
how the paint is applied.

Brush panel overview

In the Brush panel, you can select preset brushes from the
Brush Presets panel, but you can also modify existing
brushes and design new custom brushes. The Brush panel
contains the brush tip options that determine how paint is
applied to an image.

The brush stroke preview at the bottom of the panel shows
how paint strokes look with the current brush options.

Display the Brush panel and brush options

1. Choose Window > Brush. Or, select a painting, eras-
ing, toning, or focus tool, and click the panel button 
on the left side of the options bar.

2. Select an option set on the left side of the panel. The
available options for the set appear on the right side of
the panel.

Create a brush tip from an image

1. Using any selection tool, select the image area you
want to use as a custom brush. The brush shape can
be up to 2500 pixels by 2500 pixels in size.

When painting, you can't adjust the hardness of sampled
brushes. To create a brush with sharp edges, set Feather
to zero pixels. To create a brush with soft edges, increase
the Feather setting.

If you select a color image, the brush tip image is
converted to grayscale. Any layer mask applied
to the image doesn't affect the definition of the
brush tip.

2. Choose Edit > Define Brush Preset.

3. Name the brush, and click OK.

Brush panel with Brush Tip Shape options displayed

A. Locked B. Unlocked C. Selected brush tip D. Brush settings E.
Brush stroke preview F. pop up menu G. Brush tip shapes
(available when Brush Tip Shape option is selected) H. Brush
options
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Create a brush and set painting options

1. Select a painting, erasing, toning, or focus tool. Then
choose Window > Brush.

2. In the Brush panel, select a brush tip shape, or click
Brush Presets to choose an existing preset.

3. Select Brush Tip Shape on the left side of the Brush
panel, and set options.

4. To set other options for the brush, see the following
topics:

• Adding dynamic elements to brushes

• Determining the scattering in a stroke

• Creating textured brushes

• Determine how a brush changes dynamically

• Drawing or painting with a graphics tablet

5. To lock brush tip shape attributes (retaining them if you

select another brush preset), click the unlock icon .

To unlock the tip, click the lock icon  .

6. To save the brush for use later, choose New Brush
Preset from the Brush panel menu.

To save your new brush permanently or distribute
it to other users, you must save the brush as part
of a set of brushes. Choose Save Brushes from the
Brush Presets panel menu, and then save to a
new set or overwrite an existing set. If you reset
or replace the brushes in the Brush Presets panel
without saving it in a set, you could lose your new
brush.

Standard brush tip shape options

For standard brush tips, you can set the following options
in the Brush panel:

Size

Controls the size of the brush. Enter a value in pixels or drag
the slider.

Angle

Specifies the angle by which an elliptical or sampled
brush's long axis is rotated from horizontal. Type a value in
degrees, or drag the horizontal axis in the preview box.

Use Sample Size

Resets the brush to its original diameter. This option is
available only if the brush tip shape was created by
sampling pixels in an image.

Flip X

Changes the direction of a brush tip on its x axis.

Brush strokes with different diameter values

Flipping a brush tip on its x axis

A. Brush tip in its default position B. Flip X selected C. Flip X and
Flip Y selected

Flip Y

Changes the direction of a brush tip on its y axis.

Flipping a brush tip on its y axis.

A. Brush tip in its default position B. Flip Y selected C. Flip Y and
Flip X selected

Roundness

Specifies the ratio between the brush's short and long
axes. Enter a percentage value, or drag the points in the
preview box. A value of 100% indicates a circular brush, a
value of 0% indicates a linear brush, and intermediate
values indicate elliptical brushes.

Angled brushes create a chiseled stroke

Adjusting roundness to compress a brush tip shape

Hardness

Controls the size of the brush's hard center. Type a
number, or use the slider to enter a value that is a
percentage of the brush diameter. You can't change the
hardness of sampled brushes.
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Brush strokes with different hardness values

Spacing

Controls the distance between the brush marks in a stroke.
To change the spacing, type a number, or use the slider to
enter a value that is a percentage of the brush diameter.
When this option is deselected, the speed of the cursor
determines the spacing.

Brush preview

Shows brush tip that reflects changes to settings above, as
well as current pressure and stroke angle. Click the preview
window to see the brush from different sides.

Erodible tip options | CC, CS6

Erodible tip brushes behave similar to pencils and crayons,
and wear down naturally as you draw. You can see the
amount of wear with the Live Brush Tip Preview to the upper
left of the image.

Size

Controls the size of the brush. Enter a value in pixels or drag
the slider.

Softness

Controls the rate of wear. Enter a value in percentage or
drag the slider.

Shape

Controls the shape of the tip. Choose from a variety of tip
options.

Sharpen Tip

Returns the tip to the original sharpness.

Spacing

Controls the distance between the brush marks in a stroke.
To change the spacing, type a number or use the slider to
specify a percentage of the brush diameter. When this
option is deselected, the speed of the cursor determines
the spacing.

Brush preview

Shows brush tip that reflects changes to settings above, as
well as current pressure and stroke angle. Click the preview
window to see the brush from different sides.

Airbrush tip options | CC, CS6

Airbrush tips replicate spray cans with a 3D conical spray.
With a stylus, you can alter the spread of sprayed strokes
by changing pen pressure.

Size

Controls the size of the brush. Enter a value in pixels or drag
the slider.

Hardness

Controls the size of the brush's hard center.

Distortion

Controls the distortion to apply to the spray of paint.

Granularity

Controls how grainy the paint drops look.

Increasing the spacing makes the brush skip

Bristle tip shape options

Bristle tips let you specify precise bristle characteristics,
creating highly realistic, natural-looking strokes. Set the
following brush tip shape options in the Brush panel:

Shape

Determines the overall arrangement of bristles.

Bristles

Controls overall bristle density.

Length

Changes bristle length.

Thickness

Controls the width of individual bristles.

Stiffness

Controls bristle flexibility. At low settings, brush shape
deforms easily.

To vary stroke creation when using a mouse, adjust the
stiffness setting.

Spacing

Controls the distance between the brush marks in a stroke.
To change the spacing, type a number or use the slider to
specify a percentage of the brush diameter. When this
option is deselected, the speed of the cursor determines
the spacing.

Angle

When painting with a mouse, determines the brush tip
angle.
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Spatter Size

Controls the size of the paint droplets.

Spatter Amount

Controls the number of paint droplets.

Spacing

Controls the distance between the droplets. If this option is
deselected, the speed of the cursor determines the spac-
ing.

Brush preview

Shows brush tip that reflects changes to settings above, as
well as current pressure and stroke angle. Click the preview
window to see the brush from different sides.

Brush pose options | CC, CS6

Brush pose options let you achieve stylus-like effects and
let you control the angle and position of the brush.

Tilt X

Determines the tilt angle of the brush from left to right.

Tilt Y

Determines the tilt angle of the brush from front to back.

Rotation

Determines the rotation angle of the bristles.

Pressure

Determines the pressure the brush applies on the canvas.

Enable Override options to maintain a static brush pose.

Other brush options

Noise

Adds additional randomness to individual brush tips. This
option is most effective when applied to soft brush tips
(brush tips that contain gray values).

Wet Edges

Causes paint to build up along the edges of the brush
stroke, creating a watercolor effect.

Airbrush/Build-up

Applies gradual tones to an image, simulating traditional
airbrush techniques. The Airbrush option in the Brush
panel corresponds to the Airbrush option in the options bar.

Smoothing

Produces smoother curves in brush strokes. This option is
most effective when you are painting quickly with a stylus;
however, it may produce a slight lag time in stroke
rendering.

Protect Texture

Applies the same pattern and scale to all brush presets
that have a texture. Select this option to simulate a
consistent canvas texture when painting with multiple,
textured brush tips.

Brush scattering

Brush scattering determines the number and placement of
marks in a stroke.

Scatter and Control

Specifies how brush marks are distributed in a stroke.
When Both Axes is selected, brush marks are distributed
in a radial direction. When Both Axes is deselected, brush
marks are distributed perpendicular to the stroke path.

To specify the maximum percentage of scattering, enter a
value. To specify how you want to control the scattering
variance of brush marks, choose an option from the Control
pop up menu:

Off

Specifies no control over the scattering variance of brush
marks.

Fade

Fades the scattering of brush marks from maximum
scattering to no scattering in the specified number of steps.

Pen Pressure, Pen Tilt, Stylus Wheel, Rotation

Varies the scattering of brush marks based on the pen
pressure, pen tilt, position of the pen thumbwheel, or
rotation of the pen.

Count

Specifies the number of brush marks applied at each
spacing interval.

If you increase the count without increasing the
spacing or scattering values, painting perfor-
mance may decrease.

Count Jitter and Control

Specifies how the number of brush marks varies for each
spacing interval. To specify the maximum percentage of
brush marks applied at each spacing interval, enter a value.
To specify how you want to control the count variance of
brush marks, choose an option from the Control pop up
menu:

Off

Specifies no control over the count variance of brush
marks.

Fade

Fades the number of brush marks from the Count value to
1 in the specified number of steps.

Brush strokes without scattering (left) and with
scattering (right)
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Pen Pressure, Pen Tilt, Stylus Wheel, Rotation

Varies the number of brush marks based on the pen
pressure, pen tilt, position of the pen thumbwheel, or
rotation of the pen.

Clear brush options

You can clear all options that you changed for a brush
preset (except brush shape settings) at once.

• Choose Clear Brush Controls from the Brush panel
menu.

Filling and stroking selections, layers, and paths

You can fill the inside of a selection, path, or layer with a
color or pattern. You can also add color to the outline of a
selection or path, called stroking

Fill with the Paint Bucket tool

The Paint Bucket tool fills adjacent pixels that are similar
in color value to the pixels you click.

The Paint Bucket tool cannot be used with images
in Bitmap mode.

1. Choose a foreground color.

2. Select the Paint Bucket tool .

The Paint Bucket tool is grouped with the Gradi-
ent tool in the toolbar. If you can't find the Paint
Bucket tool, click and hold the Gradient tool to
access it.

3. Specify whether to fill the selection with the foreground
color or with a pattern.

4. Specify a blending mode and opacity for the paint.

5. Enter the tolerance for the fill.

The tolerance defines how similar in color a pixel must be
(to the pixel you click) to be filled. Values can range from
0 to 255. A low tolerance fills pixels within a range of color
values very similar to the pixel you click. A high tolerance
fills pixels within a broader range.

6. To smooth the edges of the filled selection, select Anti-
aliased.

7. To fill only pixels contiguous to the one you click, select
Contiguous; leave Contiguous unselected to fill all
similar pixels in the image.

8. To fill pixels based on the merged color data from all
visible layers, select All Layers.

9. Click the part of the image you want to fill. All specified
pixels within the specified tolerance are filled with the
foreground color or pattern.

If you're working on a layer and don't want to fill transparent
areas, make sure that the layer's transparency is locked in
the Layers panel.

Content-aware, pattern, or history fills

• Select the part of the image you want to fill.

• Choose Edit > Fill.

On the Background layer, press Delete or Backspace to
quickly access the Fill dialog box.

• From the Use menu, select one of the following:

Content-Aware

Seamlessly fills the selection with similar image content
nearby. For the best results, create a selection that
extends slightly into the area you want to replicate. (A
quick lasso or marquee selection is often sufficient.)

1. Color Adaptation

Algorithmically blends the color of the fill with the surround-
ing color

Pattern

Click the inverted arrow next to the pattern sample, and
select a pattern from the pop up panel. You can load
additional patterns using the pop up panel menu. Select
the name of a library of patterns, or choose Load Patterns
and navigate to the folder containing the patterns you want
to use.

(CC, CS6) You can also apply one of five included Scripted
Patterns to easily create a variety of geometic fill patterns.
Select Scripted Patterns at the bottom of the fill dialog box,
and then choose a fill pattern from the Script pop-up menu.

If Pattern is dimmed, you need to load a pattern
library prior to making a selection.

History

Restores the selected area to the source state or snapshot
set in the History panel.

Content-Aware Fill with Color Adaptation

Content-aware fill

A. Create selection that extends slightly into area you want to
replicate B. Seamlessly replace selection with Content-Aware fill
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Fill the work canvas

The work canvas surrounds the image area. You can fill the
canvas with a different color that contrasts better with a
given image.

• Right-click the work canvas, and choose Gray, Black,
or Custom. (To specify the custom color, choose
Select Custom Color.)

Stroke a selection or layer with color

You can use the Stroke command to paint a colored border
around a selection, path, or layer. When you create a
border this way, it becomes a rasterized part of the current
layer.

To create shape or layer borders that can be turned on or
off like overlays and are anti-aliased to create softer-edged
corners and edges, use the Stroke layer effect instead of
the Stroke command.

1. Choose a foreground color.

2. Select the area or layer you want to stroke.

3. Choose Edit > Stroke.

4. In the Stroke dialog box, specify the width of the hard-
edged border.

5. For Location, specify whether to place the border
inside, outside, or centered over the selection or layer
boundaries.

If the layer contents fill the entire image, a
stroke applied outside the layer will not be
visible.

6. Specify an opacity and a blending mode.

7. If you're working in a layer and want to stroke only areas
containing pixels, select the Preserve Transparency
option.

Draw a circle or square

You can draw a circle or square using the elliptical or
rectangular marquee tools, and then add a line (called a
stroke) to the selection marquee. Stroking a selection is a
quick way to add a border or frame around an object. You
can stroke any selection you create with the selection
tools.

1. In the Layers panel, click the New Layer button  to
create a new layer for the circle or square. Isolating the
circle or square on its own layer makes it easier to work
with.

2. Select the Elliptical Marquee tool or the Rectangu-

lar Marquee tool in the toolbox.

3. Drag in the document window to create the shape. Hold
down the Shift key while dragging to constrain the
shape to a circle or square.

4. Choose Edit > Stroke.

5. In the Stroke dialog box, type a value for Width, and then
click the color swatch to display the Adobe Color
Picker.

6. In the Adobe Color Picker, locate the color range you
want using the triangle sliders on the color spectrum
bar, and then click the desired color in the color field.
The color you select appears in the top half of the color
swatch. The original color remains in the bottom half.
Click OK.

7. Set the location for the stroke in relationship to the
marquee by choosing Inside, Center, or Outside. Ad-
just the other settings as desired, and click OK.
Photoshop strokes the line using the color and stroke
settings you set.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.06
Retouching and repairing images
Objectives : At the end of this lesson you shall be able to
• explain about clone stamp tool
• explain about lens distortion.

Clone Source panel

The Clone Source panel (Window > Clone Source) has
options for the Clone Stamp tools or Healing Brush tools.
You can set up to five different sample sources and quickly
select the one you need without resampling each time you
change to a different source. You can view an overlay of
your sample source to make it easier to clone the source
in a specific location. You can also scale or rotate the
sample source to better match the size and orientation of
the cloning destination.

Retouch with the Clone Stamp tool

The Clone Stamp tool paints one part of an image over
another part of the same image or over another part of any
open document that has the same color mode. You can
also paint part of one layer over another layer. The Clone
Stamp tool is useful for duplicating objects or removing a
defect in an image.

To use the Clone Stamp tool, you set a sampling point on
the area you want to copy (clone) the pixels from and paint
over another area. To paint with the most current sampling
point whenever you stop and resume painting, select the
Aligned option. Deselect the Aligned option to paint start-
ing from the initial sampling point no matter how many
times you stop and resume painting.

You can use any brush tip with the Clone Stamp tool, which
gives you precise control over the size of the clone area.
You can also use opacity and flow settings to control the
paint application to the cloned area.

Set sample sources for cloning and healing

Using the Clone Stamp or Healing Brush tool, you can
sample sources in the current document or any open
document in Photoshop.

(Photoshop Extended) When cloning video or animation,
you can set sampling points in the current frame you're
painting or sample sources in a different frame, even if the

Altering an image with the Clone Stamp tool

frame is in a different video layer or in a different open
document.

You can set up to five different sampling sources at a time
in the Clone Source panel. The Clone Source panel saves
the sampling sources until you close the document.

1. (Photoshop Extended only) To clone video or animation
frames, open the Animation panel (if you're not cloning
video or animation frames, skip to step 2). Select the
timeline animation option and move the current-time
indicator to the frame with the source you want to
sample.

2. To set the sampling point, select the Clone Stamp tool
and Alt-click in any open document window.

3. (Optional) To set another sampling point, click a differ-

ent Clone Source button in the Clone Source panel.

You can change the sampling source for a Clone Source
button by setting a different sampling point.

Scale or rotate the sample source

1. Select the Clone Stamp or Healing Brush tool and set
one or more source samples.

2. In the Clone Source panel, select a clone source and
then do any of the following:

• To scale the sample source, enter a percentage
value for W (width) or H (height) or scrub W or H. The
default is to constrain proportions. To adjust the
dimensions independently or restore the constrain
option, click the Maintain Aspect Ratio button .

• To rotate the sample source, enter a degree value or

scrub the Rotate The Clone Source icon .

• To reset the sample source to its original size and
orientation, click the Reset Transform button .

Adjust the sample source overlay options

Adjust the sample source overlay options to see the
overlay and underlying images better when painting with
the Clone Stamp and Healing Brush tools.

To temporarily display the overlay while painting with the
Clone Stamp tool, press Alt+Shift (Windows). The brush
changes temporarily to the Move Source Overlay tool. Drag
to move the overlay to another location.

• In the Clone Source panel, select Show Overlay and
do any of the following:
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• To hide the overlay while you apply the paint strokes,
select Auto Hide.

• To clip overlay to the brush size, enable the Clipped
option.

• To set the opacity of the overlay, enter a percentage
value in the Opacity text box.

• To set the appearance of the overlay, choose either
the Normal, Darken, Lighten, or Difference blending
mode from the pop up menu at the bottom of the
Clone Source panel.

• To invert the colors in the overlay, select Invert.

Specify the clone source offset

When using the Clone Stamp tool or Healing Brush tool,
you can paint with the sampled source anywhere in the
target image. The overlay options help you visualize where
you want to paint. However, if you paint in a specific
location relative to the sampling point, you can specify the
x and y pixel offset.

• In the Clone Source panel, select the source you want
to use and enter the x and y pixel values for the Offset
option.

Retouch with the Healing Brush tool

The Healing Brush tool lets you correct imperfections,
causing them to disappear into the surrounding image.
Like the cloning tools, you use the Healing Brush tool to
paint with sampled pixels from an image or pattern.
However, the Healing Brush tool also matches the texture,
lighting, transparency, and shading of the sampled pixels
to the pixels being healed. As a result, the repaired pixels
blend seamlessly into the rest of the image.

(Photoshop Extended) The Healing Brush tool can be
applied to video or animation frames.

Mode

Specifies the blending mode. Choose Replace to preserve
noise, film grain, and texture at the edges of the brush
stroke when using a soft edge brush.

Source

Specifies the source to use for repairing pixels. Sampled
to use pixels from the current image, or Pattern to use
pixels from a pattern. If you chose Pattern, select a pattern
from the Pattern pop up panel.

Aligned

Samples pixels continuously, without losing the current
sampling point, even if you release the mouse button.
Deselect Aligned to continue to use the sampled pixels
from the initial sampling point each time you stop and
resume painting.

Sample

Samples data from the layers you specify. To sample from
the active layer and visible layers below it, choose Current
And Below. To sample only from the active layer, choose
Current Layer. To sample from all visible layers, choose All
Layers. To sample from all visible layers except adjust-
ment layers, choose All Layers and click the Ignore
Adjustment Layers icon to the right of the Sample pop up
menu.

3. Set the sampling point by positioning the pointer over an
area of the image and Alt-clicking (Windows) or Option-
clicking (Mac OS).

If you are sampling from one image and apply-
ing to another, both images must be in the
same color mode unless one of the images is in
Grayscale mode.

4. (Optional) In the Clone Source panel, click a clone

source button and set an additional sampling
point.

You can set up to 5 different sampling sources. The Clone
Source panel remembers the sampled sources until you
close the document you're editing.

5. (Optional) In the Clone Source panel, click a clone
source button to select the sampled source you want.

6. (Optional) Do any of the following in the Clone Source
panel:

• To scale or rotate the source that you're cloning,
enter a value for W (width), H (height), or the rotation
in degrees .

• To show an overlay of the source that you're cloning,
select Show Overlay and specify the overlay op-
tions.

7. Drag in the image.

1. Select the Healing Brush tool  .

2. Click the brush sample in the options bar and set brush
options in the pop up panel:

If you're using a pressure-sensitive digitizing
tablet, choose an option from the Size menu to
vary the size of the healing brush over the
course of a stroke. Choose Pen Pressure to
base the variation on the pen pressure. Choose
Stylus Wheel to base the variation on the
position of the pen thumbwheel. Choose Off if
you don't want to vary the size.

Sampled pixels and healed image

IT&ITES : DTPO - Related Theory for Exercise 2.1.06



55

Retouch with the Spot Healing Brush tool

The Spot Healing Brush tool quickly removes blemishes
and other imperfections in your photos. The Spot Healing
Brush works similarly to the Healing Brush: it paints with
sampled pixels from an image or pattern and matches the
texture, lighting, transparency, and shading of the sampled
pixels to the pixels being healed. Unlike the Healing Brush,
the Spot Healing Brush doesn't require you to specify a
sample spot. The Spot Healing Brush automatically
samples from around the retouched area.

Correct lens distortion and adjust perspective

The Lens Correction filter fixes common lens flaws such as
barrel and pincushion distortion, vignetting, and chromatic
aberration. The filter works only with 8  and 16 bit-per-
channel images in RGB or Grayscale mode.

You can also use the filter to rotate an image or fix image
perspective caused by vertical or horizontal camera tilt.
The filter's image grid makes these adjustments easier and
more accurate than using the Transform command.

Automatically correct image perspective and lens
flaws

Using lens profiles, the default Auto Correction option
quickly and accurately fixes distortion. For proper automatic
correction, Photoshop requires Exit metadata that identifies
the camera and lens that created the image, and a
matching lens profile on your system.

1. Choose Filter > Lens Correction.

2. Set the following options:

Correction

Select the problems you want to fix. If corrections undesirably
extend or contract the image beyond original dimensions,
select Auto Scale Image.

The Edge menu specifics how to handle blank areas that
result from pincushion, rotation, or perspective corrections.
You can fill blank areas with transparency or a color, or you
can extend the edge pixels of the image.

Search Criteria

Filters the Lens Profiles list. By default, profiles based on
image sensor size appear first. To list RAW profiles first,
click the pop-up menu  , and select Prefer RAW Profiles.

Lens Profiles

Select a matching profile. By default, Photoshop displays
only profiles that match the camera and lens used to create
the image. (The camera model does not have to match
perfectly.) Photoshop also automatically selects a matching
sub-profile for the selected lens based on focal length, f-
stop and focus distance. To change the automatic selection,
right-click the current lens profile, and select a different
sub-profile.

If you find no matching lens profile, click Search Online to
acquire additional profiles created by the Photoshop
community. To store online profiles for future use, click the
pop-up menu , and choose Save Online Profile Locally.

Manually correct image perspective and lens flaws

You can apply manual correction alone or use it to refine
automatic lens correction.

1. Choose Filter > Lens Correction.

2. In the upper-right corner of the dialog box, click the
Custom tab.

Patch an area

The Patch tool lets you repair a selected area with pixels
from another area or a pattern. Like the Healing Brush tool,
the Patch tool matches the texture, lighting, and shading
of the sampled pixels to the source pixels. You can also
use the Patch tool to clone isolated areas of an image. The
Patch tool works with 8 bits or 16 bits-per-channel images.

Lens distortion

Barrel distortion is a lens defect that causes straight lines
to bow out toward the edges of the image. Pincushion
distortion is the opposite effect, where straight lines bend
inward.

Using the Spot Healing Brush to remove a blemish

Vignetting is a defect that darkens the corners of an image
due to light falloff around the perimeter of the lens. Chro-
matic aberration appears as a color fringe along the edges
of objects, caused by the lens focusing on different colors
of light in different planes.

Some lenses exhibit different defects at certain focal
lengths, f stops, and focus distances. With the Lens
Correction filter, you can specify the combination of set-
tings used to make the image.

Examples of barrel distortion (left) and pincushion distor-
tion (right)
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Scale

Adjusts the image scale up or down. The image pixel
dimensions aren't changed. The main use is to remove
blank areas of the image caused by pincushion, rotation,
or perspective corrections. Scaling up effectively results in
cropping the image and interpolating up to the original pixel
dimensions.

Adjust the Lens Correction preview and grid

Adjust the preview magnification and grid lines to better
judge the necessary amount of correction.

• To change the image preview magnification, use the
Zoom tool or the zoom controls in the lower left side of
the preview image.

• To move the image in the preview window, select the
Hand tool and drag in the image preview.

• To use the grid, select Show Grid at the bottom of the
dialog box. Use the Size control to adjust the grid
spacing and the Color control to change the color of the
grid. You can move the grid to line it up with your image

using the Move Grid tool .

Reduce image noise and JPEG artifacts

Image noise appears as random extraneous pixels that
aren't part of the image detail. Noise can be caused by
photographing with a high ISO setting on a digital camera,
underexposure, or shooting in a dark area with a long
shutter speed. Low end consumer cameras usually exhibit
more image noise than high end cameras. Scanned
images may have image noise caused by the scanning
sensor. Often, the film's grain pattern appears in the
scanned image.

Image noise can appear in two forms: luminance (grayscale)
noise, which makes an image look grainy or patchy, and
color noise, which is usually visible as colored artifacts in
the image.

Luminance noise may be more pronounced in one channel
of the image, usually the blue channel. You can adjust the
noise for each channel separately in Advanced mode.
Before opening the filter, examine each channel in your
image separately to see if noise is prevalent in one channel.
You preserve more image detail by correcting one channel
rather than making an overall correction to all channels.

1. Choose Filter > Noise > Reduce Noise.

2. Zoom in on the preview image to get a better view of
image noise.

3. Set options:

Strength

Controls the amount of luminance noise reduction applied
to all image channels.

3. (Optional) Choose a preset list of settings from the
Settings menu. Lens Default uses settings that you
previously saved for the camera, lens, focal length, f
stop, and focus distance used to create the image.
Previous Conversion uses the settings used in your last
lens correction. Any group of custom settings you
saved are listed at the bottom of the menu.

4. Set any of the following options to correct your image.

Remove Distortion

Corrects lens barrel or pincushion distortion. Move the
slider to straighten horizontal and vertical lines that bend
either away from or toward the center of the image. You can

also use the Remove Distortion tool  to make this
correction. Drag toward the center of the image to correct
for barrel distortion and toward the edge of the image to
correct for pincushion distortion. To compensate for any
blank image edges that result, adjust the Edge option on
the Auto Correction tab.

Fix Fringe settings

Compensate for fringing by adjusting the size of one color
channel relative to another.

Zoom in on the image preview to get a closer view of the
fringing as you make the correction.

Vignette Amount

Sets the amount of lightening or darkening along the edges
of an image. Corrects images that have darkened corners
caused by lens faults or improper lens shading.

You can also apply vignetting for a creative effect.

Vignette Midpoint

Specifies the width of area affected by the Amount slider.
Specify a lower number to affect more of the image. Specify
a higher number to restrict the effect to the edges of the
image.

Vertical Perspective

Corrects image perspective caused by tilting the camera
up or down. Makes vertical lines in an image parallel.

Horizontal Perspective

Corrects image perspective, making horizontal lines paral-
lel.

Angle

Rotates the image to correct for camera tilt or to make
adjustments after correcting perspective. You can also use

the Straighten tool to make this correction. Drag along

a line in the image that you want to make vertical or
horizontal.

To avoid unintended scaling when adjusting per-
spective or angle settings, deselect Auto Scale
Image on the Auto Correction tab.
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Preserve Details

Preserves edges and image details such as hair or texture
objects. A value of 100 preserves the most image detail, but
reduces luminance noise the least. Balance the Strength
and Preserve Details controls to fine tune noise reduction.

Reduce Color Noise

Removes random color pixels. A higher value reduces
more color noise.

Sharpen Details

Sharpens the image. Removing noise reduces image
sharpness. Use the sharpening control in the dialog box or
use one of the other Photoshop sharpening filters later to
restore sharpness.

Remove JPEG Artifacts

Removes blocky image artifacts and halos caused by
saving a image using a low JPEG quality setting.

4. If luminance noise is more prevalent in one or two color
channels, click the Advanced button and then choose
the color channel from the Channel menu. Use the
Strength and Preserve Details controls to reduce noise
in that channel.
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.07
Drawing and painting
Objectives : At the end of this lesson you shall be able to
• understanding Shapes and Paths
• explain about drawing shapes
• painting Tools
• managing Paths
• editing paths.
Understanding shapes and paths

Drawing in Adobe Photoshop involves creating vector
shapes and paths. In Photoshop, you can draw with any of
the shape tools, the Pen tool, or the Freeform Pen tool.
Options for each tool are available in the options bar.

Before you begin drawing in Photoshop, you must choose
a drawing mode from the options bar. The mode you
choose to draw in determines whether you create a vector
shape on its own layer, a work path on an existing layer,
or a rasterized shape on an existing layer.

Vector shapes are lines and curves you draw using the
shape or pen tools. Vector shapes are resolution-indepen-
dent-they maintain crisp edges when resized, printed to a
PostScript printer, saved in a PDF file, or imported into a
vector-based graphics application. You can create libraries
of custom shapes and edit a shape's outline (called a path)
and attributes (such as stroke, fill color, and style).

Paths are outlines that you can turn into selections, or fill
and stroke with color. You can easily change the shape of
a path by editing its anchor points.

A work path is a temporary path that appears in the Paths
panel and defines the outline of a shape.

You can use paths in several ways:

• Use a path as a vector mask to hide areas of a layer.
• Convert a path to a selection.
• Fill or stroke a path with color.

Designate a saved path as a clipping path to make part of
an image transparent when exporting the image to a page-
layout or vector-editing application.
Drawing modes
When you work with the shape or pen tools, you can draw
in three different modes. You choose a mode by selecting
an icon in the options bar when you have a shape or pen tool
selected.
Shape Layers
Creates a shape on a separate layer. You can use either
the shape tools or the pen tools to create shape layers.
Because they are easily moved, resized, aligned, and
distributed, shape layers are ideal for making graphics for
web pages. You can choose to draw multiple shapes on a
layer. A shape layer consists of a fill layer that defines the
shape color and a linked vector mask that defines the
shape outline. The outline of a shape is a path, which
appears in the Paths panel.

Paths

Draws a work path on the current layer that you can then
use to make a selection, create a vector mask, or fill and
stroke with color to create raster graphics (much as you
would using a painting tool). A work path is temporary
unless you save it. Paths appear in the Paths panel.

Fill Pixels

Paints directly on a layer-much as a painting tool does.
When you work in this mode, you're creating raster
images-not vector graphics. You work with the shapes you
paint just as you do with any raster image. Only the shape
tools work in this mode.

Draw a wheel shape

You cut out a shape within an existing shape so that the
layers underneath show through. This procedure shows
you how to create a doughnut shape, but you can use this
technique with any combination of the shape tools, includ-
ing custom shapes.

Draw a custom shape

You can draw custom shapes by using shapes from the
Custom Shape pop-up panel, or save a shape or path to use
as a custom shape.

Create a rasterized shape

When you create a rasterized shape, you're drawing and
rasterizing a shape and filling it with the foreground color.
You cannot edit a rasterized shape as a vector object.
Raster shapes are created using the current foreground
color.

Drawing options

A. Shape Layers B. Paths C. Fill Pixels
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Shape tool options

Each shape tool provides a unique subset of the options
below. To access these options, click the arrow to the right
of the row of shape buttons in the options bar.

Proportional

Renders a rectangle, rounded rectangle, or ellipse as a
proportional shape based on the values you enter in the
Width and Height text boxes.

Radius

For rounded rectangles, specifies the corner radius. For
polygons, specifies the distance from the center of a
polygon to the outer points.

Sides

Specifies the number of sides in a polygon.

Smooth Corners or Smooth Indents

Renders a polygon with smooth corners or indents.

Snap To Pixels

Snaps edges of a rectangle or rounded rectangle to the
pixel boundaries.

Square

Constrains a rectangle or rounded rectangle to a square.

Unconstrained

Lets you set the width and height of a rectangle, rounded
rectangle, ellipse, or custom shape by dragging.

Weight

Determines width, in pixels, for the Line tool.

Edit shapes

A shape is a fill layer linked to a vector mask. You can
easily change the fill to a different color, a gradient, or a
pattern by editing the shape's fill layer. You can also edit
the shape's vector mask to modify the shape outline, and
apply a style to the layer.

• To change the color of a shape, double-click the shape
layer's thumbnail in the Layers panel, and choose a
different color using the Color Picker.

• To fill a shape with a pattern or gradient, select the
shape layer in the Layers panel and choose Layer >
Layer Style > Gradient Overlay.

• To change stroke width, select the shape layer in the
Layers panel, and choose Layer >Layer Style > Stroke.

• To modify the outline of a shape, click the shape layer's
vector mask thumbnail in the Layers panel or Paths
panel. Then change the shape using the Direct Selec-
tion and pen tools.

• To move a shape without changing its size or propor-
tions, use the Move tool.

About painting tools, presets, and options

Adobe Photoshop provides several tools for painting and
editing image color. The Brush tool and the Pencil tool work
like a traditional drawing tool applying color with brush
strokes. Tools like the Eraser tool, Blur tool, and Smudge
tool modify the existing colors in the image. In the options

Arrowheads Start And End

Adds arrowheads to a line. Select the Line tool and then
select Start to add an arrow to the beginning of the line;
select End to add an arrow to the end of the line. Select both
options to add arrows to both ends. The shape options
appear in the pop-up dialog box. Enter values for Width and
Length to specify the proportions of the arrowhead as a
percentage of the line width (10% to 1000% for Width, and
10% to 5000% for Length). Enter a value for the concavity
of the arrowhead (from -50% to +50%). The concavity value
defines the amount of curvature on the widest part of the
arrowhead, where the arrowhead meets the line.

You can also edit an arrowhead directly using the
vector selection and drawing tools.

Circle

Constrains an ellipse to a circle.

Defined Proportions

Renders a custom shape based on the proportions with
which it was created.

Defined Size

Renders a custom shape based on the size at which it was
created.

Fixed Size

Renders a rectangle, rounded rectangle, ellipse, or custom
shape as a fixed shape based on the values you enter in the
Width and Height text boxes.

From Center

Renders a rectangle, rounded rectangle, ellipse, or custom
shape from the center.

Indent Sides By

Renders a polygon as a star. Enter a percentage in the text
box to specify the portion of the star's radius taken up by
the points. A 50% setting creates points that are half the
total radius of the star; a larger value creates sharper,
thinner points; a smaller value creates fuller points.

Accessing shape tool options in the options bar (Line
options shown)
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bar for each of these painting tools, you can set how color
is applied to an image and choose from preset brush tips.

Brush and tool presets

You can save a set of brush options as a preset so you can
quickly access brush characteristics you use frequently.
Photoshop includes several sample brush presets. You
can start with these presets and modify them to produce
new effects. Many original brush presets are available for
download on the web.

You can quickly choose presets from the Brush Preset
picker in the options bar, which lets you temporarily modify
the size and hardness of a brush preset.

Save tool presets when you want to store customized
brush tip characteristics along with settings from the
options bar such as opacity, flow, and color.

Brush tip options

Along with settings in the options bar, brush tip options
control how color is applied. You can apply color gradually,
with soft edges, with large brush strokes, with various
brush dynamics, with different blending properties, and
with brushes of different shapes. You can apply a texture
with your brush strokes to simulate painting on canvas or
art papers. You can also simulate spraying paint with an
airbrush. You use the Brush panel to set brush tip options.

If you work with a drawing tablet, you can control how color
is applied using pen pressure, angle, rotation, or a stylus
wheel. You set options for drawing tablets in the Brush
panel and options bar.

Paint with the Brush tool or Pencil tool

The Brush tool and the Pencil tool paint the current
foreground color on an image. The Brush tool creates soft
strokes of color. The Pencil tool creates hard-edged lines.

The Rotation tool rotates the canvas, which can
facilitate easier painting.

Paint tool options

Set the following in the options bar. Options available vary
with each tool.

Mode

Sets the method for blending the color you paint with the
underlying existing pixels. Available modes change with
the currently selected tool. Paint modes are similar to layer
blending modes.

Opacity

Sets the transparency of color you apply. As you paint over
an area, the opacity does not exceed the set level no matter
how many times you move the pointer over the area, until
you release the mouse button. If you stroke over the area
again, you apply additional color, equivalent to the set
opacity. Opacity of 100 percent is opaque.

Flow

Sets the rate at which color is applied as you move the
pointer over an area. As you paint over an area, keeping the
mouse button down, the amount of color builds up based

on the flow rate, up to the opacity setting. For example, if
you set the opacity to 33% and the flow to 33%, each time
you move over an area, its color moves 33% toward the
brush color. The total will not exceed 33% opacity unless
you release the mouse button and stroke over the area
again.

Press a single number key to set a tool's opacity in
multiples of 10% (pressing 1 sets it to 10%; pressing 0 sets
it to 100%). Press two number keys to set a specific
opacity. To set Flow, press Shift and number keys.

Airbrush

Simulates painting with an airbrush. As you move the
pointer over an area, paint builds up as you hold down the
mouse button. Brush hardness, opacity, and flow options
control how fast and how much the paint is applied. Click
the button to turn on or off this option.

Auto erase

(Pencil tool only) Paints the background color over areas
containing the foreground color. Select the foreground
color you want to erase and the background color you want
to change to.

Tablet pressure buttons

 

Use stylus pressure to override opacity and size settings
in the Brush panel.

The Pen tools

Photoshop provides multiple Pen tools. The standard Pen
tool draws with the greatest precision; the Freeform Pen
tool draws paths as if you were drawing with pencil on
paper, and the magnetic pen option lets you draw a path
that snaps to the edges of defined areas in your image. You
can use the pen tools in conjunction with the shape tools
to create complex shapes. When you use the standard
Pen tool, the following options are available in the options
bar:

• Auto Add/Delete, which lets you add an anchor point
when you click a line segment or delete an anchor point
when you click it.

• Rubber Band, which lets you preview path segments as
you move the pointer between clicks. (To access this
option, click the pop-up menu to the right of the Custom
Shape icon.)

Paths panel overview

The Paths panel (Window > Paths) lists the name and a
thumbnail image of each saved path, the current work path,
and the current vector mask. Turning thumbnails off can
improve performance. To view a path, you must first select
it in the Paths panel.
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Select a path

• Click the path name in the Paths panel. Only one path
can be selected at a time.

Deselect a path

• Click in a blank area of the Paths panel or press Esc.

Change the size of path thumbnails

Choose Panel Options from the Paths panel menu, and
select a size, or select None to turn off the display of
thumbnails.

Change a path's stacking order

• Select the path in the Paths panel, and drag the path up
or down. When the heavy black line appears in the
desired location, release the mouse button.

You cannot change the order of vector masks or
working paths in the Paths panel.

Create a new path in the Paths panel

• To create a path without naming it, click the Create New
Path button at the bottom of the Paths panel.

• To create and name a path, make sure no work path is
selected. Choose New Path from the Paths panel
menu, or Alt-click (Windows) the New Path button at
the bottom of the panel. Enter a name for the path in the
New Path dialog box, and click OK.

Create a new work path

1. Select a shape tool or a pen tool, and click the Paths

button  in the options bar.

2. Set tool-specific options, and draw the path.

3. Draw additional path components if desired. You can
easily switch between drawing tools by clicking a tool
button in the options bar. Choose a path area option to
determine how overlapping path components intersect:

Add To Path Area

Adds the new area to overlapping path areas.

Subtract From Path Area

Removes the new area from the overlapping path area.

Intersect Path Areas

Restricts the path to the intersection of the new area and
the existing area.

Exclude Overlapping Path Areas

Excludes the overlap area in the consolidated path.

Manage paths

When you use a pen or shape tool to create a work path,
the new path appears as the work path in the Paths panel.
The work path is temporary; you must save it to avoid losing
its contents. If you deselect the work path without saving
it and start drawing again, a new path will replace the
existing one.

When you use a pen or shape tool to create a new shape
layer, the new path appears as a vector mask in the Paths
panel. Vector masks are linked to their parent layer; you
must select the parent layer in the Layers panel in order to
list the Vector mask in the Paths panel. You can remove
a Vector mask from a layer and convert a Vector mask to
a rasterized mask.

Paths saved with an image appear when you open it again.
In Windows, JPEG, JPEG 2000, DCS, EPS, PDF, and
TIFF formats support paths in Photoshop. In Mac OS, all
available file formats support paths.

Save a work path

• To save without renaming, drag the work path name to
the New Path button   at the bottom of the Paths panel.

• To save and rename, choose Save Path from the Paths
panel menu, enter a new path name in the Save Path
dialog box, and click OK.

Rename a saved path

• Double-click the path name in the Paths panel, type a
new name, and press Enter (Windows)

Path segments, components, and points

A path consists of one or more straight or curved seg-
ments. Anchor points mark the end points of the path
segments. On curved segments, each selected anchor
point displays one or two direction lines, ending in direction
points. The positions of direction lines and points deter-
mine the size and shape of a curved segment. Moving
these elements reshapes the curves in a path.

Paths panel

A. Saved path B. Temporary work path C. Vector mask path
(appears only when shape layer is selected)

A path

A. Curved line segment B. Direction point C. Direction line
D. Selected anchor point E. Unselected anchor point

A path can be closed, with no beginning or end (for
example, a circle), or open, with distinct end points (for
example, a wavy line).

Smooth curves are connected by anchor points called
smooth points. Sharply curved paths are connected by
corner points.
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When you move a direction line on a smooth point, the
curved segments on both sides of the point are adjusted
simultaneously. By comparison, when you move a direc-
tion line on a corner point, only the curve on the same side
of the point as the direction line is adjusted.

2. To select additional path components or segments,
select the Path Selection tool or the Direct Selection
tool, and then hold down Shift while selecting additional
paths or segments.

Adjust path segments

You can edit a path segment at any time, but editing
existing segments is slightly different from drawing them.
Keep the following tips in mind when editing segments:

• If an anchor point connects two segments, moving that
anchor point always changes both segments.

• When drawing with the Pen tool, you can temporarily
activate the Direct Selection tool so that you can adjust
segments you've already drawn; press Ctrl (Windows)
or Command (Mac OS) while drawing.

• When you initially draw a smooth point with the Pen
tool, dragging the direction point changes the length of
the direction line on both sides of the point. However,
when you edit an existing smooth point with the Direct
Selection tool, you change the length of the direction
line only on the side you're dragging.

Adjust the length or angle of straight segments

1. With the Direct Selection tool  , select an anchor point
on the segment you want to adjust.

2. Drag the anchor point to the desired position. Shift-drag
to constrain the adjustment to multiples of 45°.

Adjust the position or shape of curved segments

1. With the Direct Selection tool  ,, select a curved
segment, or an anchor point on either end of the curved
segment. Direction lines appear, if any are present.
(Some curved segments use just one direction line.)

2. Do any of the following:
• To adjust the position of the segment, drag the

segment. Shift-drag to constrain the adjustment to
multiples of 45°.

Smooth point and corner point

Adjusting a smooth point and a corner point

A path does not have to be one connected series of
segments. It can contain more than one distinct and
separate path components. Each shape in a shape layer
is a path component, as described by the layer's clipping
path.

Select a path

Selecting a path component or path segment displays all
of the anchor points on the selected portion, including any
direction lines and direction points if the selected segment
is curved. Direction handles appear as filled circles, se-
lected anchor points as filled squares, and unselected
anchor points as hollow squares.

1. Do one of the following:

To select a path component (including a shape in a shape

layer), select the Path Selection tool , and click any-
where inside the path component. If a path consists of
several path components, only the path component under
the pointer is selected.

To select a path segment, select the Direct Selection tool

, and click one of the segment's anchor points, or drag

a marquee over part of the segment.

Separate path components selected

Drag a marquee to select segments

Click to select the curve segment. Then drag to adjust
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You can select and edit multiple paths simultaneously.
You can also reshape a path while adding anchor points by
clicking and dragging as you add.

Don't use the Delete or Backspace keys or the
Edit > Cut or Edit > Clear commands to delete
anchor points. These keys and commands de-
lete the point and line segments that connect to
that point.

Fill paths with color

A path created with the Pen tool does not become an image
element until you stroke or fill it. The Fill Path command fills
a path with pixels using a specified color, a state of the
image, a pattern, or a fill layer.Drag the anchor point, or drag the direction point

• To adjust the shape of the segment on either side of a
selected anchor point, drag the anchor point or the
direction point. Shift-drag to constrain movement to
multiples of 45°.

In Photoshop CC and CS6, adjusting a path
segment also adjusts the related segments,
letting you intuitively transform path shapes.
To only edit segments between the selected
anchor points, similar to earlier Photoshop
versions, select Constrain Path Dragging in the
options bar.

You can also apply a transformation, such as
scaling or rotating, to a segment or anchor
point.

Delete a segment

1. (Optional) If you're creating an opening in a closed path,

select the Add Anchor Point tool , and add two
points where you want the cut to occur.

2. Select the Direct Selection tool , and select the
segment you want to delete.

3. Press Backspace (Windows) or Delete (Mac OS) to
delete the selected segment. Pressing Backspace or
Delete again erases the rest of the path.

Delete the direction line of an anchor point

• Using the Convert Anchor Point Tool, click the anchor
point of the direction line.

Add or delete anchor points

Adding anchor points can give you more control over a path
or it can extend an open path. However, it's a good idea not
to add more points than necessary. A path with fewer
points is easier to edit, display, and print. You can reduce
the complexity of a path by deleting unnecessary points.
The toolbox contains three tools for adding or deleting

points: the Pen tool  , the Add Anchor Point tool ,

and the Delete Anchor Point tool .

By default, the Pen tool changes to the Add Anchor Point
tool as you position it over a selected path, or to the Delete
Anchor Point tool as you position it over an anchor point.
You must select Auto Add/Delete in the options bar to
enable the Pen tool to automatically change to the Add
Anchor Point or Delete Anchor Point tool.

When you fill a path, the color values appear
on the active layer. Make sure that a standard
or background layer is active before complet-
ing the steps below. (You cannot fill a path
when a mask, text, fill, adjustment, or Smart
Object layer is active)

Stroke paths with color

The Stroke Path command paints the border of a path. The
Stroke Path command allows you to create a paint stroke
(using the current settings for your painting tools) that
follows any path. This command is completely different
from the Stroke layer effect, which doesn't mimic the effect
of any of the painting tools.

When you stroke a path, the color values ap-
pear on the active layer. Make sure that a
standard or background layer is active before
completing the steps below. (You cannot stroke
a path when a mask, text, fill, adjustment, or
Smart Object layer is active)

Path selected (left) and filled (right)

Path selected (left) and stroked (right)
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.08
Basics of layers
Objectives : At the end of this lesson you shall be able to
• explain Photoshop Layers
• explain about Managing Layers
• understanding about Selecting, grouping, and linking layers
• explain about using layers for vector images.

About Photoshop layers

Photoshop layers are like sheets of stacked acetate. You
can see through transparent areas of a layer to the layers
below. You move a layer to position the content on the
layer, like sliding a sheet of acetate in a stack. You can
also change the opacity of a layer to make content partially
transparent.

Transparent areas on a layer let you see layers below

You use layers to perform tasks such as compositing
multiple images, adding text to an image, or adding vector
graphic shapes. You can apply a layer style to add a
special effect such as a drop shadow or a glow.

Organizing Photoshop layers

A new image has a single layer. The number of additional
layers, layer effects, and layer sets you can add to an
image is limited only by your computer's memory.

You work with layers in the Layers panel. Layer groups help
you organize and manage layers. You can use groups to
arrange your layers in a logical order and to reduce clutter
in the Layers panel. You can nest groups within other
groups. You can also use groups to apply attributes and
masks to multiple layers simultaneously.

Photoshop layers for non-destructive editing

Sometimes layers don't contain any apparent content. For
example, an adjustment layer holds color or tonal adjust-
ments that affect the layers below it. Rather than edit image
pixels directly, you can edit an adjustment layer and leave
the underlying pixels unchanged.

A special type of layer, called a Smart Object, contains one
or more layers of content. You can transform (scale, skew,
or reshape) a Smart Object without directly editing image
pixels. Or, you can edit the Smart Object as a separate
image even after placing it in a Photoshop image. Smart
Objects can also contain smart filter effects, which allow
you to apply filters non-destructively to images so that you
can later tweak or remove the filter effect.

Video layers

You can use video layers to add video to an image. After
importing a video clip into an image as a video layer, you
can mask the layer, transform it, apply layer effects, paint
on individual frames, or rasterize an individual frame and
convert it to a standard layer. Use the Timeline panel to play
the video within the image or to access individual frames.

Photoshop Layers panel overview

The Layers panel in Photoshop lists all layers, layer
groups, and layer effects in an image. You can use the
Layers panel to show and hide layers, create new layers,
and work with groups of layers. You can access additional
commands and options in the Layers panel menu.

Photoshop Layers panel

A. Layers panel menu B. Layer Group C. Layer D. Expand/Collapse
Layer effects E. Layer effect F. Layer thumbnail

Display the Photoshop Layers panel

• Choose Window > Layers.

Convert background and Photoshop layers

When you create a new image with a white background or
a colored background, the bottom most image in the
Layers panel is called Background. An image can have
only one background layer. You cannot change the stacking
order of a background layer, its blending mode, or its
opacity. However, you can convert a background into a
regular layer, and then change any of these attributes.

When you create a new image with transparent content,
the image does not have a background layer. The bottommost
layer is not constrained like the background layer; you can
move it anywhere in the Layers panel and change its
opacity and blending mode.
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Generate image assets from layers

You can generate JPEG, PNG, or GIF image assets from
the contents of a layer or layer group in a PSD file. Assets
are automatically generated when you append a supported
image format extension to a layer name or a layer group
name. Optionally, you can also specify quality and size
parameters for the generated image assets.

Generating image assets from a PSD file is particularly
useful for multidevice web design.

Generate image assets from layers or layer groups

To understand the image asset generator better, consider
a simple PSD file with the following layer hierarchy:

The layer hierarchy for this file has two layer groups-
Rounded_rectangles and Ellipses. Each of these layer
groups contains five layers.

Follow these steps to generate image assets from this
PSD file:

1 With the PSD file open, select File > Generate > Image
Assets.

2 Append appropriate file format extensions (.jpg, .png,
or .gif) to the names of the layers or layer groups from
which you want to generate image assets. For ex-

ample, rename the layer groups, Rounded_rectangles
and Ellipses, as Rounded_rectangles.jpg and
Ellipses.png; and the layer, Ellipse_4 as Ellipse_4.gif.

The special characters : and * are not sup-
ported in layer names.

Photoshop generates the image assets and saves them in
a subfolder alongside the source PSD file. If the source
PSD file is not saved yet, Photoshop saves the generated
assets in a new folder on your Desktop.

Work with Smart Objects

Understanding Smart Objects

Smart Objects are layers that contain image data from
raster or vector images, such as Photoshop or Illustrator
files. Smart Objects preserve an image's source content
with all its original characteristics, enabling you to perform
non destructive editing to the layer.

In Photoshop CC and CS6, you can embed the contents of
an image into a Photoshop document. In Photoshop CC,

you can also create Linked Smart Objects whose contents
are referenced from external image files. The contents of a
Linked Smart Object are updated when its source image
file changes.

Linked Smart Objects are distinct from duplicated in-
stances of a Smart Object within a Photoshop document.
With Linked Smart Objects, you can use a shared source
file across multiple Photoshop documents.

Smart Object benefits

With Smart Objects, you can:
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• Perform nondestructive transforms. You can scale,
rotate, skew, distort, perspective transform, or warp a
layer without losing original image data or quality
because the transforms don't affect the original data.

• Work with vector data, such as vector artwork from
Illustrator, that otherwise would be rasterized in
Photoshop.

• Perform nondestructive filtering. You can edit filters
applied to Smart Objects at any time.

• Edit one Smart Object and automatically update all its
linked instances.

• Apply a layer mask that's either linked or unlinked to the
Smart Object layer.

• Try various designs with low-resolution placeholder
images that you later replace with final versions.

You can't perform operations that alter pixel data-such as
painting, dodging, burning, or cloning-directly to a Smart
Object layer, unless it is first converted into a regular layer,
which will be rasterized. To perform operations that alter
pixel data, you can edit the contents of a Smart Object,
clone a new layer above the Smart Object layer, edit
duplicates of the Smart Object, or create a new layer.

When you transform a Smart Object that has a
Smart Filter applied to it, Photoshop turns off filter
effects while the transform is being performed.
Filter effects are applied again after the transform
is complete.

Managing layers

Rename a layer or layer group

As you add layers or layer groups to an image, it's helpful
to give them names that reflect their content. Descriptive
names make layers easy to identify in the Layers panel.

• Do one of the following:

• Double-click the layer name or group name in the
Layers panel and enter a new name. Press Enter
(Windows) or Return (Mac OS).

• Select the layer/group and then follow these steps:
• Select Layer > Rename Layer or Layer > Rename

Group.
• Enter a new name for the layer/group in the Layers

panel.

Press Enter (Windows)

Assign a color to a layer or group

Color coding layers and groups helps you locate related
layers in the Layers panel.

• (CC, CS6) Right-click the layer or group and choose a
color.

• (CS5) Select a layer or group, choose Layer Properties
or Group Properties from the Layers menu. Then
choose a color from the Color pop-up menu, and click
OK.

Rasterize layers

You cannot use the painting tools or filters on layers that
contain vector data (such as type layers, shape layers,
vector masks, or Smart Objects) and generated data (such
as fill layers). However, you can rasterize these layers to
convert their contents into a flat, raster image.

• Select the layers you want to rasterize, choose Layer
> Rasterize, and then choose an option from the
submenu:

Type Rasterizes the type on a type layer. It does not
rasterize any other vector data on the layer.

Shape Rasterizes a shape layer.

Fill Content Rasterizes the fill of a shape layer, leaving the
vector mask.

Vector Mask Rasterizes the vector mask on a layer,
turning it into a layer mask.

Smart Object Converts a Smart Object into a raster layer.

Video Rasterizes the current video frame to an image
layer.

3D (Extended only) Rasterizes the current view of 3D data
into a flat raster layer.

Layer Rasterizes all vector data on the selected layers.

All Layers Rasterizes all layers that contain vector and
generated data.

To rasterize linked layers, select a linked layer,
choose Layer > Select Linked Layers, and then
rasterize the selected layers.

Merging layers

When you have finalized the content of layers, you can
merge them to reduce the size of your image files. When
you merge layers, the data on the top layers replaces any
data it overlaps on the lower layers. The intersection of all
transparent areas in the merged layers remains transpar-
ent.

You cannot use an adjustment or fill layer as the
target layer for a merge.

In addition to merging layers, you can stamp them.
Stamping allows you to merge the contents of more than
one layer into a target layer while leaving the other layers
intact.

When you save a merged document, you cannot
revert back to the unmerged state; the layers are
permanently merged.

Flatten all layers

Flattening reduces file size by merging all visible layers into
the background and discarding hidden layers. Any trans-
parent areas that remain are filled with white. When you
save a flattened image, you cannot revert back to the
unflattened state; the layers are permanently merged.
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Converting an image between some color modes
flattens the file. Save a copy of your file with all
layers intact if you want to edit the original image
after the conversion.

Selecting, grouping, and linking layers

Select layers

You can select one or more layers to work on them. For
some activities, such as painting or making color and tonal
adjustments, you can work on only one layer at a time. A
single selected layer is called the active layer. The name
of the active layer appears in the title bar of the document
window.

For other activities, such as moving, aligning, transforming,
or applying styles from the Styles panel, you can select
and work on multiple layers at a time. You can select layers
in the Layers panel or with the Move tool .

You can also link layers. Unlike multiple layers selected at
the same time, linked layers stay linked when you change
the selection in the Layers panel.

Select layers in the Layers panel

Do one of the following:

• Click a layer in the Layers panel.

• To select multiple contiguous layers, click the first layer
and then Shift-click the last layer.

• To select multiple noncontiguous layers, Ctrl-click
(Windows them in the Layers panel.

When selecting, Ctrl-click (Windows) or
Command-click (Mac OS) the area outside the
layer thumbnail. Ctrlclicking or Command-
clicking the layer thumbnail selects the non-
transparent areas of the layer.

• To select all layers, choose Select > All Layers.

• To select all layers of a similar type (for example all type
layers), select one of the layers, and choose Select >
Similar Layers.

• To deselect a layer, Ctrl-click (Windows) the layer.

• To have no layer selected, click in the Layers panel
below the background or bottom layer, or choose
Select > Deselect Layers.

Select layers in the document window 1

 Select the Move tool .

2 Do one of the following:

• In the options bar, select Auto Select, then choose
Layer from the drop-down menu, and click in the
document on the layer you want to select. The top layer
containing pixels under the cursor is selected.

• In the options bar, select Auto Select, then choose
Group from the drop-down menu, and click in the
document on the content you want to select. The top
group containing pixels under the cursor is selected. If
you click an ungrouped layer, it becomes selected.

• o Right-click (Windows) in the image, and choose a
layer from the context menu. The context menu lists all
the layers that contain pixels under the current pointer
location.

Select a layer in a group

1 Click the group in the Layers panel.

2 Click the triangle to the left of the folder icon  .

3 Click the individual layer in the group.

Group and ungroup layers

1 Select multiple layers in the Layers panel.

2 Do one of the following:

• Choose Layer > Group Layers.

• Alt-drag (Windows) layers to the folder icon  at the
bottom of the Layers panel to group the layers.

3 To Ungroup the layers, select the group and choose
Layer > Ungroup Layers.

Add layers to a group

Do one of the following:

• Select the group in the Layers panel and click the
Create a New Layer button .

• Drag a layer to the group folder.

• Drag a group folder into another group folder. The group
and all of its layers move.

• Drag an existing group to the New Group button .

Link and unlink layers

You can link two or more layers or groups. Unlike multiple
layers selected at the same time, linked layers retain their
relationship until you unlink them. You can move or apply
transformations to linked layers.

1 Select the layers or groups in the Layers panel.

2 Click the link icon at the bottom of the Layers panel.

3 To unlink layers do one of the following:

• Select a linked layer, and click the link icon.

• To temporarily disable the linked layer, Shift-click
the Link icon for the linked layer. A red X appears.
Shift-click the link icon to enable the link again.

• Select the linked layers and click the Link icon. To
select all linked layers, select one of the layers and
then choose Layer > Select Linked Layers.
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Show layer edges and handles

Showing the boundary or edges of the content in a layer can
help you move and align the content. You can also display
the transform handles for selected layers and groups so
that you can resize or rotate them.

Display the edges of content in a selected layer

Choose View > Show > Layer Edges.

Display transform handles in a selected layer 1

1 Select the Move tool .

2 From the options bar, select Show Transform Controls.

You can resize and rotate layer content using the transform
handles

Masking layers

You can add a mask to a layer and use the mask to hide
portions of the layer and reveal the layers below. Masking
layers is a valuable compositing technique for combining
multiple photos into a single image or for making local color
and tonal corrections.

About layer and vector masks

You can use masks to hide portions of a layer and reveal
portions of the layers below. You can create two types of
masks:

• Layer masks are resolution-dependent bitmap images
that are edited with the painting or selection tools.

• Vector masks are resolution independent and are
created with a pen or shape tool.

Layer and vector masks are nondestructive, which means
you can go back and re-edit the masks later without losing
the pixels they hide.

In the Layers panel, both the layer and vector masks
appear as an additional thumbnail to the right of the layer
thumbnail. For the layer mask, this thumbnail represents
the grayscale channel that is created when you add the
layer mask. The vector mask thumbnail represents a path
that clips out the contents of the layer.

To create a layer or vector mask on the Back-
ground layer, first convert it to a regular layer
(Layer > New > Layer from Background).

You can edit a layer mask to add or subtract from the
masked region. A layer mask is a grayscale image, so
areas you paint in black are hidden, areas you paint in white
are visible, and areas you paint in shades of gray appear in
various levels of transparency.

A Layer mask thumbnail  B Vector mask thumbnail  C Vector Mask
Link icon  D Add Mask

A vector mask creates a sharp-edged shape on a layer and
is useful anytime you want to add a design element with
clean, defined edges. After you create a layer with a vector
mask, you can apply one or more layer styles to it, edit
them if needed, and instantly have a usable button, panel,
or other web-design element.

The Properties panel (CC, CS6) or the Masks panel (CS5)
provide additional controls to adjust a mask. You can
change the opacity of mask to let more or less of the
masked content show through, invert the mask, or refine
the mask borders, as with a selection area.

Disable or enable a layer mask

Do one of the following:

• Select the layer containing the layer mask you want to
disable or enable, and click the Disable/Enable Mask
button  in the Properties panel (CC, CS6) or the
Masks panel (CS5).

A Select the filter mask.  B Add a pixel mask.  C Add a vector mask.
D Panel menu.  E Apply Mask  F Layer mask  G Vector mask
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• Shift-click the layer mask thumbnail in the Layers
panel.

• Select the layer containing the layer mask you want to
disable or enable, and choose Layer > Layer Mask >
Disable or Layer > Layer Mask > Enable.

A red X appears over the mask thumbnail in the Layers
panel when the mask is disabled, and the layer's content
appears without masking effects.

Add layer masks

When you add a layer mask, you can hide or show all of the
layer, or base the mask on a selection or transparency.
Later, you'll paint on the mask to precisely hide portions of
the layer, revealing the layers beneath.

Add a mask that shows or hides the entire layer

1 Make sure that no part of your image is selected.
Choose Select > Deselect.

2 In the Layers panel, select the layer or group.

3 Do one of the following:

• To create a mask that reveals the entire layer, click
the Add Layer Mask  button in the Layers panel,
or choose Layer > Layer Mask > Reveal All.

• To create a mask that hides the entire layer, Alt-
click (Windows) or Option-click (Mac OS) the Add
Layer Mask button, or choose Layer > Layer Mask>
Hide All.

Create a mask from layer transparency

If you want to directly edit layer transparency, create a
mask from this data. This technique is helpful for video and
3D workflows.

1 In the Layers panel, select the layer.

2 Choose Layer > Layer Mask > From Transparency.

Photoshop converts transparency into an opaque color,
hidden by the newly created mask. The opaque color varies
greatly, depending upon the filters and other processing
previously applied to the layer.

Unlinking layers and masks

By default, a layer or group is linked to its layer mask or
vector mask, as indicated by the link icon between the
thumbnails in the Layers panel. The layer and its mask
move together in the image when you move either one with

the Move tool . Unlinking them lets you move them
independently and shift the mask's boundaries separately
from the layer.

• To unlink a layer from its mask, click the link icon in the
Layers panel.

• To reestablish the link between a layer and its mask,
click between the layer and mask path thumbnails in
the Layers panel.

Disable or enable a layer mask

Do one of the following:

• Select the layer containing the layer mask you want to
disable or enable, and click the Disable/Enable Mask
button  in the Properties panel (CC, CS6) or the
Masks panel (CS5).

• Shift-click the layer mask thumbnail in the Layers
panel.

• Select the layer containing the layer mask you want to
disable or enable, and choose Layer > Layer Mask >
Disable or Layer > Layer Mask > Enable.

A red X appears over the mask thumbnail in the Layers
panel when the mask is disabled, and the layer's content
appears without masking effects.

Revealing layers with clipping masks

A clipping mask lets you use the content of a layer to mask
the layers above it. The masking is determined by the
content of the bottom or base layer. The non-transparent
content of the base layer clips (reveals), the content of the
layers above it in the clipping mask. All other content in the
clipped layers is masked out.

You can use multiple layers in a clipping mask, but they
must be successive layers. The name of the base layer in
the mask is underlined, and the thumbnails for the overlying
layers are indented. The overlying layers display a clipping
mask icon.

The Blend Clipped Layers As Group option in the Layer
Style dialog box determines whether the blending mode of
the base affects the whole group or just the base.

Specify overall and fill opacity for selected layers

A layer's overall opacity determines to what degree it
obscures or reveals the layer beneath it. A layer with 1%
opacity appears nearly transparent, whereas one with
100% opacity appears completely opaque.

In addition to overall opacity, which affects layer styles and
blending modes applied to a layer, you can specify fill
opacity. Fill opacity affects only pixels, shapes, or text on
a layer without affecting the opacity of layer effects such as
drop shadows.

You cannot change the opacity of a background layer or a
locked layer. To convert a background layer into a regular
layer that supports transparency,
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Layer styles

Transformation

Transforming scales, rotates, skews, stretches, or warps
an image. Apply the transformations to a selection, an
entire layer, multiple layers, or a layer mask. Apply
transformations to a path, a vector shape, a vector mask,
a selection border, or an alpha channel. Transforming
affects image quality manipulates the pixels. To apply non-
destructive transformations to raster images, use Smart
Objects. Transforming a vector shape or path is always
non-destructive because changing the mathematical cal-
culations producing the object.

To make a transformation, first select an item to transform
and then choose a transformation command. If necessary,
adjust the reference point before manipulating the transfor-
mation. You can perform several manipulations in succes-
sion before applying the cumulative transformation.

Photoshop uses the interpolation method selected in the
General area of the Preferences dialog box to calculate the
color values of pixels that are added or deleted during
transformations. This interpolation setting directly affects
the speed and quality of the transformation the default, is
slowest but yields the best results.

Define the layer scale and rotate

Scale

Scale simply changes the size, scale to create a bounding
box around the selected layer and then drag any one of the
handles in any direction to make the selection bigger or
smaller. Scale proportionally holds down the shift key while
using one of the corner handles. This constrains the height
and width percentage and type a width and height percent-
age in the appropriate boxes will create the transformation
as shown in Fig.1.

Rotate

Rotate option to straighten a photo, tilt a photo in a collage,
angle text, or any number of things to create the image.
Probably don't want to use this option to turn a photo that
is lying on its site due to being taken by turning your
camera or scanning in a photo sideways. The Rotate
(1800, 900 CCW, 900 CW) Degrees option further down the
Transform sub menu are much faster.

To rotate a selected layer, a bounding box is placed around
the image and Click and drags your mouse to the left or to
the right to freely rotate the image. To constrain the rotation
to 15-degree increments, hold down the shift key while you
rotate. Option click the type a specific degree to rotate the
selection in the option bar as shown in Fig. 2.

1 In the Layers panel, select one or more layers or
groups.

2 Change the Opacity and Fill values. (If you selected a
group, only Opacity is available)

Specify a blending mode for a layer or group

A layer's blending mode determines how its pixels blend
with underlying pixels in the image. You can create a
variety of special effects using blending modes.

By default, the blending mode of a layer group is Pass
Through, which means that the group has no blending
properties of its own. When you choose a different blending
mode for a group, you effectively change the order in which
the image components are put together. All of the layers in
the group are put together first. The composite group is
then treated as a single image and blended with the rest of
the image using the selected blending mode. Thus, if you
choose a blending mode other than Pass Through for the
group, none of the adjustment layers or layer blending
modes inside the group will apply to layers outside the
group.

Group blend effects

By default, layers in a clipping mask are blended with the
underlying layers using the blending mode of the bottom-
most layer in the group. However, you can choose to have
the blending mode of the bottommost layer apply only to
that layer, allowing you to preserve the original blending
appearance of the clipped layers.

You can also apply the blending mode of a layer to layer
effects that modify opaque pixels, such as Inner Glow or
Color Overlay, without changing layer effects that modify
only transparent pixels, such as Outer Glow or Drop
Shadow.

Exclude channels from blending

You can restrict blending effects to a specified channel
when you blend a layer or group. By default, all channels
are included. When using an RGB image, for example, you
can choose to exclude the red channel from blending; in the
composite image, only the information in the green and
blue channels is affected.

Specify a tonal range for blending layers

The sliders in the Blending Options dialog box control
which pixels from the active layer and the underlying visible
layers appear in the final image. For example, you can drop
dark pixels out of the active layer or force bright pixels from
the underlying layers to show through. You can also define
a range of partially blended pixels to produce a smooth
transition between blended and unblended areas.
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Define layer skew and distort

Skew

The Skew transformation allows moving the corner handles
independently of one another to pull or push the pixels in
that corner closer to or away from the reference point. This
transformation actually morphs the pixels in the area that
is being pushed or pulled by merging them or doubling them
so it looks as if the image is still contained in its entirety
in the skewed shape.

Skewing text is more constrained. Rather than each corner
being moved independently, the sides move together to
create a sheering effect.

To skew a selection, a bounding box is created, Pull on the
corners to transform them. Type a degree of skew in the
option bar. This constrains image to being skewed as a
whole rather than one corner at a time  in order to skew just
one corner at a time, not only the skew degree, but the
relative position of the reference point changes as shown
in Fig.3.

 

 

Set skew 
Fig 3

Distort

Distorting an image works much like talking a printed
photograph and bending this way and that to make it look
different. Distorting in Photoshop works better, of course,
because you can make more dramatic distortions without
creating any wrinkles. The Distort option can make your
selection look angled, bubbled, or squished as shown in
Fig.4.
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Vectors in photoshop

The Shape Tools

Photoshop's various Shape tools are all nested together in
the same spot in the Tools panel. By default, the Rectangle
Tool is the tool that's visible, but if you click on the tool's
icon and hold your mouse button down, a fly-out menu will
appear listing the other Shape tools that are available. I'll
choose the Ellipse Tool from the list, but everything we're
about to learn applies to all of the Shape tools, not just the
Ellipse Tool: (Fig. 1)

Fig 1

Selecting the Ellipse Tool from the Shape tools fly-out
menu.

The Drawing Modes

Once we've chosen a Shape tool, we need to tell Photoshop
which type of shape - vector, path or pixels - we want to
draw, and we do that using the drawing mode options in
the Options Bar along the top of the screen.

Near the far left of the Options Bar is a set of three icons.
Each icon represents one of the three types of shapes we
can draw. The first icon (the one on the left) is the Shape
Layers option, and it's the option we choose when we want
to draw vector shapes. The second (middle) icon is the
Paths option, which is what we choose when we want to
draw paths. The third icon (the one on the right) is known
as the Fill Pixels option. We choose it when we want to
draw pixel-based shapes. (Fig. 2)

Fig 5

Define warp

Warp

Warp is different from every other transformation. Instead
of a bounding box with handles, the wrap transformation
creates a 3 x 3 grid across your image. This grid can be
adjusted at each of its conjunction points to distort the
image. The area around the point used changes the most,
with the surrounding areas being affected radiating out from
the central point. Each corner of the grid also has two
control point handles that control the curve of the grid and,
therefore, the wrap as shown in Fig.6.

Fig 6

 
Set  Distort 

Fig 4
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Define layer perspective

Perspective

The perspective transformation widens either the top or the
top or the base (or both) of image to correct perspectives
that can be warped by fish - eye lenses or simply by the
focal length of the image taken. The need for a perspective
created by the lens, the buildings actually looks as if they
are leaning toward one another. With a simple perspective
transformation, the tilt of the building is corrected and the
subject of the image becomes the focal point. Pulling on
the side handles when using the perspective transforma-
tion skews it as shown in Fig.5.
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Fig 2

From left to right - the Shape Layers, Paths, and Fill Pixels
options.

Drawing Shape Layers (Vector Shapes)

Of the three types of drawing modes, the one we almost
always want to be working with is Shape layers (vector
shapes). When most people think of drawing shapes,
they're not thinking of paths or pixels. They're thinking of
vector shapes, the same type of shapes we'd draw in
Adobe Illustrator or most other drawing programs.

Photoshop itself is not really known as a drawing program.
It's primarily a photo editor, and photos (digital photos, at
least) are made up of pixels. When we draw a pixel-based
shape by choosing the Fill Pixels option in the Options
Bar, we're creating shapes out of the same type of pixels
that make up a digital photo, and pixels have major
limitations on what we can do with them. The biggest
drawback with pixel-based images or shapes is that they
don't scale very well, at least not when we need to make
them larger than their original size. Enlarge a pixel-based
image or shape too much and it will lose its sharpness,
becoming soft and dull. Enlarge it even more and the pixels
that make up the image or shape can become visible,
resulting in a blocky appearance.

Pixel-based images and shapes also depend very heavily
on the resolution of your document if they're going to look
good when you print them. They may look great on your
computer screen, but printing high quality images requires
much higher resolution than what your monitor displays,
and if your document doesn't have enough pixels to print it
at the size you need with a high enough resolution, it will
again look soft and dull.

Vectors, on the other hand, have nothing at all to do with
pixels. They're actually made up of mathematical points,
with the points connected to each other by either straight
lines or curves. All of these points, lines and curves make
up what we see as the shape! Don't worry about the
"mathematical" part of what I just said. Photoshop handles
all the math stuff behind the scenes so we can just focus
on drawing our shapes.

Since vector shapes are essentially drawn using math,
each time we make a change to the shape, either by
resizing or reshaping it in some way, Photoshop simply
redoes the math and redraws the shape! This means we
can resize a vector shape as many times as we like,
making it any size we need, without any loss of image
quality. Vector shapes retain their crisp, sharp edges no
matter how large we make them. And unlike pixels, vector
shapes are resolution-independent. They don't care what
the resolution of your document is because they always
print at the highest possible resolution of your printer.

Let's look at some of the things we can do with vector
shapes in Photoshop, and then we'll compare it with paths
and pixel shapes. To draw vector shapes, select the
Shape Layers option in the Options Bar. (Fig. 3)

Fig 3

Clicking on the Shape Layers icon in the Options Bar.

Before I draw anything, let's take a quick look in my Layers
panel, where we see that currently my document is made
up of nothing more than a single layer - the Background
layer - which is filled with solid white. (Fig. 4)

Fig 4

The Layers panel showing the single Background layer.

I'll choose a color for my vector shape by clicking on the
color swatch in the Options Bar. (Fig. 5)

Fig 5

Clicking on the color swatch to choose a color for the vector
shape.

This opens Photoshop's Color Picker. I'll choose red from
the Color Picker, then I'll click OK to close out of it. (Fig.6)

Fig 6
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Fig 10

Two vector shapes, two Shape layers.

At the moment, both of my shapes are red, but we can
easily change the color of a vector shape at any time simply
by double-clicking on the shape's color swatch on the
Shape layer: I'll double-click on the second shape's color
swatch. (Fig. 11)

Fig 11

Double-click on a vector shape's color swatch to change its
color.

This re-opens the Color Picker so we can select a different
color. I'll choose blue this time. (Fig. 12)

Fig 12

Choosing blue as the new color of the second shape.

I'll click OK to close out of the Color Picker, and my second
shape is instantly changed from red to blue. (Fig. 13)

Choosing a color for the vector shape from the Color Picker.

With the Ellipse Tool in hand, the Shape Layers option
selected in the Options Bar and red chosen from the Color
Picker, I'll click inside my document and drag out an
elliptical shape, holding the Shift key down as I drag to
force the shape into a perfect circle. (Fig. 7)

Fig 7

A circular shape drawn with the Ellipse Tool.

Photoshop places each new vector shape we draw on its
own Shape layer, and if we look in my Layers panel, we see
the shape on a new layer named Shape 1 above the
Background layer. Shape layers are made up of two parts
- a color swatch on the left which displays the current color
of the shape and a vector mask thumbnail to the right of
the color swatch which shows us what the shape currently
looks like (the white area in the thumbnail represents the
shape). (Fig. 8)

Fig 8

Every new vector shape is given its own Shape layer in the
Layers panel.

With one shape drawn, I'll draw a second similar shape
slightly to the right of the first one. (Fig.9)

Fig 9

A second vector shape now overlaps the original.

Photoshop places this second vector shape on its own
separate Shape layer (named Shape 2) above the first one,
complete with its own color swatch and vector mask
thumbnail. (Fig.10)
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The second vector shape now appears blue.

The shape's color swatch on its Shape layer also updates
to the new color. (Fig. 14)

Fig 13

Fig 14

The vector shape's color swatch now displays the new
color.

As vector shapes, I can select them in the document very
easily using the Path Selection Tool (also known as the
black arrow). I'll choose the Path Selection Tool from the
Tools panel. It's located in the same section of the Tools
panel as the Shape Tools. (Fig. 15)

Fig 15

Selecting the Path Selection Tool.

With the Path Selection Tool in hand, if I click on the red
shape in the document, Photoshop automatically selects
it (a thin outline appears around the shape that's currently
selected). (Fig. 16)

Fig 16

The Path Selection Tool selects whichever vector shape
you click on. Here, the red shape is selected by clicking on
it.
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Photoshop also selects the shape's layer for me in the
Layers panel (selected layers are highlighted in blue).
(Fig.17)

Fig 17

When a vector shape is selected in the document, its
Shape layer is highlighted in the Layers panel.

I'll click on the blue shape in the document with the Path
Selection Tool, and now the blue shape is selected.
(Fig.18)

Fig 18

Selecting the blue shape by clicking on it with the Path
Selection Tool.

And we see that Photoshop has also selected its Shape
layer. (Fig.19)

Fig 19

The blue shape's layer is now selected.

With a vector shape selected, I could drag it around inside
the document with the Path Selection Tool to reposition it
but we can do much more interesting things with vector
shapes than simply moving them around. For example, we
can combine two or more shapes together to create
different shapes! or

Up to this point, Photoshop has been placing each new
vector shape I draw on its own Shape layer, but where
things start to get interesting is when we combined two or
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Fig 24

Fig 25

Fig 26

Fig 27

more shapes on the same Shape layer. Then, with the
shape copied, I'll delete the shape's layer by dragging it
down onto the Trash Bin at the bottom of the Layers panel.
(Fig.20)

Dragging the Shape 2 layer onto the Trash Bin to delete it.

This leaves just the original shape in the document. I'll
press Ctrl+V (Win) / Command+V (Mac) on my keyboard
to paste the copied shape into the original shape, and now
both shapes are combined into one. (Fig.21)

Fig 20

The two previously separate shapes are now combined into
a single shape.

If we look at the vector mask thumbnail in the Layers panel,
we see that both shapes are now part of the same Shape
layer. (Fig.22)

Fig 21

The two shapes with the Subtract from Shape Area option
selected.

If I choose the Intersect Shape Areas option in the
Options Bar. (Fig.26)

Fig 22

The shapes with the Intersect Shape Areas option se-
lected.

And if I choose the Exclude Overlapping Shape Areas
option. (Fig.28)
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The two shapes now share the same Shape layer.

Since they're both on the same Shape layer, I can change
how the shapes interact with each other by choosing
different behaviors from a series of options in the Options
Bar. From left to right, we have Add to Shape Area,
Subtract from Shape Area, Intersect Shape Areas,
and Exclude Overlapping Shape Areas. (Fig. 23)

Fig 23

This series of icons controls how two shapes on the same
Shape layer interact with each other.

Again, we'll look at combining vector shapes in more detail
in another tutorial, but at the moment, both shapes are
simply overlapping each other and creating the appearance
of a single larger shape. That's because the Add to Shape
Area option is currently selected. I'll click on the Subtract
from Shape Area option. (Fig. 24)

Selecting "Subtract from Shape Area".

With Subtract from Shape Area selected, the second
shape is no longer visible in the document. Instead,
Photoshop uses it to remove part of the original shape
where the two shapes overlap. (Fig.25)

Selecting "Intersect Shape Areas".

We get a different behavior. This time, only the area where
the two shapes overlap each other remains visible. (Fig.27)
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Selecting "Exclude Overlapping Shape Areas".

Again we get a different result. Both shapes are now visible
except for the area where they overlap. (Fig.29)

The shapes in Exclude Overlapping Shape Areas mode.

With the second shape (the shape on the right) still
selected, if I decide I don't want it anymore, I can delete it
by pressing Backspace (Win) / Delete (Mac) on my
keyboard, which removes it from the Shape layer and
leaves me back where I started with just my original circular
shape. (Fig.30)

The second shape has been deleted, leaving only the
original shape.

One other important feature of vector shapes we should
look at quickly before moving on to paths and pixel-based
shapes is that we can easily reshape them! Earlier I
mentioned that vector shapes are made up of points
connected by lines or curves. We've already seen how to
select an entire shape at once using the Path Selection
Tool, but we can also select the individual points, lines and
curves! For that, we need the Direct Selection Tool (also
known as the white arrow). By default, it's nested in behind
the Path Selection Tool in the Tools panel, so I'll click and
hold on the Path Selection Tool until the fly-out menu
appears, then I'll select the Direct Selection Tool from the
list. (Fig.31)

Fig 28

Fig 29

Fig 30
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Fig 31

Selecting the Direct Selection Tool.

Reshaping vector shapes is a bit of an advanced topic
which I'll cover in much more detail in another tutorial, but
with the Direct Selection Tool selected, I'll click on the
outline around the shape, which displays the shape's
anchor points (the little squares). We can also see lines
with little circles on the ends extending out from some of
the anchor points. These are known as direction handles.
We can click and drag either the anchor points or the
direction handles to change the look of the shape.

For example, I'll click on one of the anchor points with the
Direct Selection Tool and drag it towards the left. (Fig.32)

Fig 32

Click and drag any of the anchor points to change the
shape.

I'll release my mouse button to complete the edit. (Fig.33)

Fig 33

Photoshop fills the added area with color when I release my
mouse button.

We can also drag the direction handles to edit the appear-
ance of the line or curve between two anchor points. Here
I'm dragging one of the direction handles that extends out
from the anchor point at the top of the shape. (Fig. 34)
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Fig 35
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Fig 34

Dragging a direction handle reshapes the line or curve
connecting two anchor points.

And again, I'll release my mouse button to complete the
edit. Notice that even though I've made edits to the shape,
because it's a vector shape and vectors are based on math,
not pixels, it still retains its crisp, sharp edges. (Fig.35)

The shape now looks much different than it did originally.
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Using filters

You can use filters to clean up or retouch your photos,
apply special art effects that give your image the appear-
ance of a sketch or impressionistic painting, or create
unique transformations using distortions and lighting ef-
fects. The filters provided by Adobe appear in the Filter
menu. Some filters provided by third-party developers are
available as plug-ins. Once installed, these plug-in filters
appear at the bottom of the Filter menu.

Smart Filters, applied to Smart Objects, let you use filters
non-destructively. Smart Filters are stored as layer effects
in the Layers panel and can be readjusted at any time,
working from the original image data contained in the Smart
Object. For more information on Smart Filter Effects and
nondestructive editing, see Nondestructive editing.

To use a filter, choose the appropriate submenu command
from the Filter menu. These guidelines can help you in
choosing filters:

• Filters are applied to the active, visible layer or a
selection.

• For 8-bits-per-channel images, most filters can be
applied cumulatively through the Filter Gallery. All
filters can be applied individually.

• Filters cannot be applied to Bitmap-mode or indexed-
color images.

• Some filters work only on RGB images.

• All filters can be applied to 8-bit images.

IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.09
Filters and effects
Objectives : At the end of this lesson you shall be able to
• explain artistic and Blur filters
• explain Brush Stroke and Distort filters
• explain Noise, Pixelate, Render and sharpen filters
• explain Sketch, Stylize, Texture, video, and Other filters.

• The following filters can be applied to 16-bit images:
Liquify, Vanishing Point, Average Blur, Blur, Blur More,
Box Blur, Gaussian Blur, Lens Blur, Motion Blur, Radial
Blur, Surface Blur, Shape Blur, Lens Correction, Add
Noise,
Despeckle, Dust & Scratches, Median, Reduce Noise,
Fibers, Clouds, Difference Clouds, Lens Flare, Sharpen,
Sharpen Edges, Sharpen More, Smart Sharpen,
Unsharp Mask, Emboss, Find Edges, Solarize, De-
Interlace, NTSC Colors, Custom, High Pass, Maxi-
mum, Minimum, and Offset.

• The following filters can be applied to 32-bit images:
Average Blur, Box Blur, Gaussian Blur, Motion Blur,
Radial Blur, Shape Blur, Surface Blur, Add Noise,
Clouds, Lens Flare, Smart Sharpen, Unsharp Mask,
De-Interlace, NTSC Colors, Emboss, High Pass, Maxi-
mum, Minimum, and Offset.

• Some filters are processed entirely in RAM. If you don't
have enough available RAM to process a filter effect,
you may get an error message.

Filter Gallery overview

The Filter Gallery provides a preview of many of the special
effects filters. You can apply multiple filters, turn on or off
the effect of a filter, reset options for a filter, and change the
order in which filters are applied. When you are satisfied
with the preview, you can then apply it to your image. Not
all filters in the Filter menu are available in the Filter Gallery.
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A Preview  B Filter category  C Thumbnail of selected filter  D Show/Hide filter thumbnails  E Filters pop-up menu  F Options for selected
filter  G List of filter effects to apply or arrange  H Filter effect selected but not applied  I Filter effects applied cumulatively but not selected
J Hidden filter effect
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List of filters supporting 16-bit/channel and 32-bit/channel
documents

The following filters support 16-bit/channel and 32-bit/
channel documents:

• All Blur filters (except for Lens Blur and Smart Blur)
• All Distort filters
• The Noise > Add Noise filter
• All Pixelate filters
• All Render filters (except for Lighting Effects) o All

Sharpen filters (except for Sharpen Edges)
• The following filters under Filter > Stylize:
• Diffuse
• Emboss
• Trace Contour
• All Video filters
• All filters under Filter > Other

Artistic filters

Filters from the Artistic submenu help you achieve paint-
erly and artistic effects for a fine arts or commercial project.

For example, use the Cutout filter for collages or typogra-
phy. These filters replicate natural or traditional media
effects. All the Artistic filters can be applied through the
Filter Gallery.

Colored Pencil Draws an image using colored pencils on
a solid background. Edges are retained and given a rough
crosshatch appearance; the solid background color shows
through the smoother areas.

Cutout Makes an image appear as though it were con-
structed from roughly cut pieces of colored paper. High-
contrast images appear as if in silhouette, and colored
images are built up from several layers of colored paper.

Film Grain Applies an even pattern to the shadow tones
and midtones. A smoother, more saturated pattern is
added to the lighter areas. This filter is useful for eliminating
banding in blends and visually unifying elements from
various sources.

Fresco Paints an image in a coarse style using short,
rounded, and hastily applied daubs.

Neon Glow Adds various types of glows to the objects in
an image. This filter is useful for colorizing an image while
softening its look. To select a glow color, click the glow
box, and select a color from the Color Picker.

Paint Daubs Lets you choose from various brush sizes
(from 1 to 50) and types for a painterly effect. Brush types
include Simple, Light Rough, Dark Rough, Wide Sharp,
Wide Blurry, and Sparkle.

Palette Knife Reduces detail in an image to give the effect
of a thinly painted canvas that reveals the texture under-
neath.

Plastic Wrap Coats the image in shiny plastic, accentu-
ating the surface detail.

Poster Edges Reduces the number of colors in an image
(posterizes it) according to the posterization option you
set, and finds the edges of the image and draws black lines
on them. Large broad areas have simple shading, and fine
dark detail is distributed throughout the image.
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Rough Pastels Applies strokes of pastel chalk on a
textured background. In areas of bright color, the chalk
appears thick with little texture; in darker areas, the chalk
appears scraped off to reveal the texture.

Smudge Stick Softens an image using short diagonal
strokes to smudge or smear the darker areas. Lighter
areas become brighter and lose detail.

Sponge Creates images with highly textured areas of
contrasting color, simulating the effect of sponge painting.

Underpainting Paints the image on a textured back-
ground, and then paints the final image over it.

Watercolor Paints the image in a watercolor style using
a medium brush loaded with water and color, simplifying
details. Where significant tonal changes occur at the
edges, the filter saturates the color.

Blur filters

The Blur filters soften a selection or an entire image, and
are useful for retouching. They smooth transitions by
averaging the pixels next to the hard edges of defined lines
and shaded areas in an image.

When Gaussian Blur, Box Blur, Motion Blur, or
Shape Blur are applied to a selected image area,
they will sometimes produce visually unexpected
results near the edges of the selection. This is
because these blur filters will use image data
from outside the selected area to create the new,
blurred pixels inside the selected area. For ex-
ample, if the selection represents a background
area that you want to blur while keeping the
foreground sharp, the edges of the blurred back-
ground area will be contaminated with colors
from the foreground, producing a fuzzy, muddy-
looking outline around the foreground. To avoid
this effect in such cases, you can use Smart Blur
or Lens Blur

Lens Blur Adds blur to an image to give the effect of a
narrower depth of field so that some objects in the image
stay in focus and others areas are blurred.

Motion Blur Blurs in the specified direction (from -360º to
+360º) and at a specified intensity (from 1 to 999). The
filter's effect is analogous to taking a picture of a moving
object with a fixed exposure time.

Radial Blur Simulates the blur of a zooming or rotating
camera to produce a soft blur. Choose Spin to blur along
concentric circular lines, and then specify a degree of
rotation. Choose Zoom to blur along radial lines, as if
zooming into or out of the image, and specify a value from
1 to 100. Blur quality ranges from Draft (for fast but grainy
results) or Good and Best for smoother results, which are
indistinguishable from each other except on a large selec-
tion. Specify the origin of the blur by dragging the pattern
in the Blur Center box.

Shape Blur Uses the specified kernel to create the blur.
Choose a kernel from the list of custom shape presets, and
use the radius slider to adjust its size. You can load
different shape libraries by clicking the triangle and choos-
ing from the list. Radius determines the size of the kernel;
the larger the kernel, the greater the blur.

Smart Blur Blurs an image with precision. You can specify
a radius, a threshold, and a blur quality. The Radius value
determines the size of the area searched for dissimilar
pixels. The Threshold value determines how dissimilar the
pixels must be before they are affected. You also can set
a mode for the entire selection (Normal) or for the edges of
color transitions (Edge Only and Overlay Edge). Where
significant contrast occurs, Edge Only applies black-and-
white edges, and Overlay Edge applies white.

Surface Blur Blurs an image while preserving edges. This
filter is useful for creating special effects and for removing
noise or graininess. The Radius option specifies the size
of the area sampled for the blur. The Threshold option
controls how much the tonal values of neighboring pixels
must diverge from the center pixel value before being part
of the blur. Pixels with tonal value differences less than the
Threshold value are excluded from the blur.

To apply a Blur filter to the edges of a layer,
deselect the Lock Transparent Pixel option in the
Layers panel

Average Finds the average color of an image or selection,
and then fills the image or selection with the color to create
a smooth look. For example, if you select an area of grass,
the filter changes the area into a homogeneous patch of
green.

Blur and Blur More Eliminate noise where significant
color transitions occur in an image. Blur filters smooth
transitions by averaging the pixels next to the hard edges
of defined lines and shaded areas. The effect of the Blur
More filter is three or four times stronger than that of the Blur
filter.

Box Blur Blurs an image based on the average color value
of neighboring pixels. This filter is useful for creating special
effects. You can adjust the size of the area used to
calculate the average value for a given pixel; a larger radius
results in greater blurring.

Gaussian Blur Quickly blurs a selection by an adjustable
amount. Gaussian refers to the bell-shaped curve that is
generated when Photoshop applies a weighted average to
the pixels. The Gaussian Blur filter adds low-frequency
detail and can produce a hazy effect.
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Brush Stroke filters

Like the Artistic filters, the Brush Stroke filters give a
painterly or fine-arts look using different brush and ink
stroke effects. Some of the filters add grain, paint, noise,
edge detail, or texture. All the Brush Stroke filters can be
applied through the Filter Gallery.

Accented Edges Accentuates the edges of an image.
When the edge brightness control is set to a high value, the
accents resemble white chalk; when set to a low value, the
accents resemble black ink.

Angled Strokes Repaints an image using diagonal strokes,
with lighter and darker areas painted in strokes going in
opposite directions.

Crosshatch Preserves the details and features of the
original image while adding texture and roughening the
edges of the colored areas with simulated pencil hatching.
The Strength option (with values from 1 to 3) determines the
number of hatching passes.

Dark Strokes Paints dark areas with short, tight, dark
strokes, and lighter areas with long, white strokes.

Ink Outlines Redraws an image with fine narrow lines over
the original details, in pen-and-ink style.

Spatter Replicates the effect of a spatter airbrush. Increas-
ing the options simplifies the overall effect.

Sprayed Strokes Repaints an image, using its dominant
colors, with angled, sprayed strokes of color.

Sumi-e Paints an image in Japanese style, as if with a fully
saturated brush applied to rice paper. Sumi-e creates soft,
blurred edges with rich, inky blacks.

Distort filters

The Distort filters geometrically distort an image, creating
3D or other reshaping effects. Note that these filters can be
very memory-intensive. The Diffuse Glow, Glass, and
Ocean Ripple filters can be applied through the Filter
Gallery.

Diffuse Glow Renders an image as though it were viewed
through a soft diffusion filter. The filter adds see-through
white noise, with the glow fading from the center of a
selection.

Displace Uses an image, called a displacement map, to
determine how to distort a selection. For example, using a
parabola-shaped displacement map, you can create an
image that appears to be printed on a cloth held up by its
corners.

Glass Makes an image appear as if it were being viewed
through different types of glass. You can choose a glass
effect or create your own glass surface as a Photoshop file
and apply it. You can adjust scaling, distortion, and
smoothness settings. When using surface controls with a
file, follow the instructions for the Displace filter.

Ocean Ripple Adds randomly spaced ripples to the
surface of the image so that it appears to be underwater.

Pinch Squeezes a selection. A positive value up to 100%
shifts a selection toward its center; a negative value up to
- 100% shifts a selection outward.

Polar Coordinates Converts a selection from its rectan-
gular to polar coordinates, and vice versa, according to a
selected option. You can use this filter to create a cylinder
anamorphosis-an art form popular in the 18th century-in
which the distorted image appears normal when viewed in
a mirrored cylinder.

Ripple Creates an undulating pattern on a selection, like
ripples on the surface of a pond. For greater control, use the
Wave filter. Options include the number and size of ripples.

Shear Distorts an image along a curve. Specify the curve
by dragging the line in the box. You can adjust any point
along the curve. Click Default to change the curve back to
a straight line. In addition, you choose how to treat
undistorted areas.

Spherize Gives objects a 3D effect by wrapping a selec-
tion around a spherical shape, distorting the image and
stretching it to fit the selected curve.

Twirl Rotates a selection more sharply in the center than
at the edges. Specifying an angle produces a twirl pattern.

Wave Works much as the Ripple filter does, but with
greater control. Options include the number of wave gen-
erators, wavelength (distance from one wave crest to the
next), height of the wave, and wave type: Sine (rolling),
Triangle, or Square. The Randomize option applies random
values. You can also define undistorted areas.

ZigZag Distorts a selection radially, depending on the
radius of the pixels in your selection. The Ridges option
sets the number of direction reversals of the zigzag from the
center of the selection to its edge. You also specify how to
displace the pixels: Pond Ripples displaces pixels to the
upper-left or lower right, Out From Center displaces pixels
toward or away from the center of the selection, and Around
Center rotates pixels around the center.

Noise filters

The Noise filters add or remove noise, or pixels with
randomly distributed color levels. This helps to blend a
selection into the surrounding pixels. Noise filters can
create unusual textures or remove problem areas, such as
dust and scratches.

Add Noise Applies random pixels to an image, simulating
the effect of shooting pictures on high-speed film. You can
also use the Add Noise filter to reduce banding in feathered
selections or graduated fills or to give a more realistic look
to heavily retouched areas. Options for noise distribution
include Uniform and Gaussian. Uniform distributes color
values of noise using random numbers between 0 and plus
or minus the specified value, creating a subtle effect.
Gaussian distributes color values of noise along a bell-
shaped curve, creating a speckled effect. The Monochro-
matic option applies the filter to only the tonal elements in
the image without changing the colors.
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Despeckle Detects the edges in an image (areas where
significant color changes occur) and blurs all of the
selection except those edges. This blurring removes noise
while preserving detail.

Dust & Scratches Reduces noise by changing dissimilar
pixels. To achieve a balance between sharpening the
image and hiding defects, try various combinations of
Radius and Threshold settings. Or apply the filter to
selected areas in the image.

Median Reduces noise in an image by blending the
brightness of pixels within a selection. The filter searches
the radius of a pixel selection for pixels of similar bright-
ness, discarding pixels that differ too much from adjacent
pixels, and replaces the center pixel with the median
brightness value of the searched pixels. This filter is useful
for eliminating or reducing the effect of motion on an image.

Reduce Noise Reduces noise while preserving edges
based on user settings affecting the overall image or
individual channels.

Pixelate filters

The filters in the Pixelate submenu sharply define a
selection by clumping pixels of similar color values in cells.

Color Halftone Simulates the effect of using an enlarged
halftone screen on each channel of the image. For each
channel, the filter divides the image into rectangles and
replaces each rectangle with a circle. The circle size is
proportional to the brightness of the rectangle.

Crystallize Clumps pixels into a solid color in a polygon
shape.

Facet Clumps pixels of solid or similar colors into blocks
of like-colored pixels. You can use this filter to make a
scanned image look hand-painted or to make a realistic
image resemble an abstract painting.

Fragment Creates four copies of the pixels in the selec-
tion, averages them, and offsets them from each other.

Mezzotint Converts an image to a random pattern of black-
and-white areas or of fully saturated colors in a color image.
To use the filter, choose a dot pattern from the Type menu
in the Mezzotint dialog box.

Mosaic Clumps pixels into square blocks. The pixels in a
given block are the same color, and the colors of the blocks
represent the colors in the selection.

Pointillize Breaks up the color in an image into randomly
placed dots, as in a pointillist painting, and uses the
background color as a canvas area between the dots.

Render filters

The Render filters create 3D shapes, cloud patterns,
refraction patterns, and simulated light reflections in an
image. You can also manipulate objects in 3D space,
create 3D objects (cubes, spheres, and cylinders), and
create texture fills from grayscale files to produce 3D-like
effects for lighting.

Clouds Generates a soft cloud pattern using random
values that vary between the foreground and the back-
ground colors. To generate a more stark cloud pattern, hold
down Alt (Windows) or Option (Mac OS) as you choose
Filter > Render > Clouds. When you apply the Clouds filter,
the image data on the active layer is replaced.

Difference Clouds Uses randomly generated values that
vary between the foreground and background color to
produce a cloud pattern. The filter blends the cloud data
with the existing pixels in the same way the Difference
mode blends colors. The first time you choose this filter,
portions of the image are inverted in a cloud pattern.
Applying the filter several times creates rib and vein
patterns that resemble a marble texture. When you apply
the Difference Clouds filter, the image data on the active
layer is replaced.

Fibers Creates the look of woven fibers using the fore-
ground and background colors. You use the Variance
slider to control how the colors vary (a low value produces
long streaks of color, and a high value results in very short
fibers with more varied distribution of color). The Strength
slider controls how each fiber looks. A low setting produces
a loose weave, and a high setting produces short, stringy
fibers. Click the Randomize button to change how the
pattern looks; you can click the button a number of times
until you find a pattern you like. When you apply the Fibers
filter, the image data on the active layer is replaced.

Lens Flare Simulates the refraction caused by shining a
bright light into a camera lens. Specify a location for the
center of the flare by clicking anywhere inside the image
thumbnail or by dragging its cross hair.

Lighting Effects Lets you produce myriad lighting effects
on RGB images by varying 17 light styles, three light types,
and four sets of light properties. You can also use textures
from grayscale files (called bump maps) to produce 3D-like
effects and save your own styles for use in other images.
See

Sharpen filters

The Sharpen filters focus blurred images by increasing the
contrast of adjacent pixels.

Sharpen and Sharpen More Focus a selection and
improve its clarity. The Sharpen More filter applies a
stronger sharpening effect than does the Sharpen filter.

Sharpen Edges and Unsharp Mask Find the areas in the
image where significant color changes occur and sharpen
them. The Sharpen Edges filter sharpens only edges while
preserving the overall smoothness of the image. Use this
filter to sharpen edges without specifying an amount. For
professional color correction, use the Unsharp Mask filter
to adjust the contrast of edge detail and produce a lighter
and darker line on each side of the edge. This process
emphasizes the edge and creates the illusion of a sharper
image.
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Smart Sharpen Sharpens an image by letting you set the
sharpening algorithm or control the amount of sharpening
that occurs in shadows and highlights. This is the recom-
mended way to sharpen if you don't have a particular
sharpening filter in mind.

In Photoshop CC, the enhanced Smart Sharpen filter
empowers you to produce high-quality results through
adaptive sharpening technology that minimizes noise and
halo effects. The streamlined UI design for this filter offers
optimized controls for targeted sharpening. Use the sliders
for quick adjustments and advanced controls to fine-tune
your results.

Smart sharpening in Photoshop CC supports CMYK.
Additionally, you can sharpen arbitrary channels. For
example, you can choose to sharpen just the blue channel,
green channel, or the alpha channel.

lines. The charcoal is drawn in the foreground color; the
chalk, in the background color.

Charcoal Creates a posterized, smudged effect. Major
edges are boldly drawn, and midtones are sketched using
a diagonal stroke. Charcoal is the foreground color, and the
background is the color of the paper.

Chrome Renders the image as if it had a polished chrome
surface. Highlights are high points, and shadows are low
points in the reflecting surface. After applying the filter, use
the Levels dialog box to add more contrast to the image.

Conté Crayon Replicates the texture of dense dark and
pure white Conté crayons on an image. The Conté Crayon
filter uses the foreground color for dark areas and the
background color for light areas. For a true effect, change
the foreground color to one of the common Conté Crayon
colors (black, sepia, or sanguine) before applying the filter.
For a muted effect, change the background color to white,
add some of the foreground color to the white background,
and then apply the filter.

Graphic Pen Uses fine, linear ink strokes to capture the
details in the original image. The effect is especially
striking with scanned images. The filter replaces color in
the original image, using the foreground color for ink and the
background color for paper.

Halftone Pattern Simulates the effect of a halftone screen
while maintaining the continuous range of tones.

Note Paper Creates an image that appears to be con-
structed of handmade paper. This filter simplifies images
and combines the effects of the Stylize > Emboss and
Texture > Grain filters. Dark areas of the image appear as
holes in the top layer of paper, revealing the background
color.

Photocopy Simulates the effect of photocopying an im-
age. Large dark areas tend to be copied only around their
edges, and midtones fall away to either solid black or solid
white.

Plaster Molds an image from 3D plaster, and then colorizes
the result using the foreground and background color. Dark
areas are raised, and light areas are recessed.

Reticulation Simulates the controlled shrinking and dis-
tortion of film emulsion to create an image that appears
clumped in the shadows and lightly grained in the high-
lights.

Stamp Simplifies the image so that it appears to be
created with a rubber or wood stamp. This filter is best used
with black-and-white images.

Torn Edges Reconstructs the image so that it appears
composed of ragged, torn pieces of paper, and then
colorizes the image using the foreground and background
colors. This filter is particularly useful for text or high-
contrast objects.

Water Paper Uses blotchy daubs that appear painted
onto fibrous, damp paper, causing the colors to flow and
blend.

Here is a recommended approach to sharpening images
with Photoshop CC:

1 To begin, set Amount to a high value.

2 Increase the Radius to a value that introduces a halo
effect.

3 Decrease the Radius until the halo effect disappers.
You've arrived at the optimal value for Radius.

4 Now, decrease the value of Amount as necessary.

5 Adjust the Reduce Noise slider, such that the noise in
the image looks similar to how it was before you began
sharpening the image. Too much noise reduction can
result in a plasticy look. Higher Amount values require
greater noise reduction.

Sketch filters

Filters in the Sketch submenu add texture to images, often
for a 3D effect. The filters also are useful for creating a
finearts or hand-drawn look. Many of the Sketch filters use
the foreground and background color as they redraw the
image. All the Sketch filters can be applied through the
Filter Gallery.

Bas Relief Transforms an image so that it appears carved
in low relief and lit to accent the surface variations. Dark
areas of the image take on the foreground color, and light
colors use the background color.

Chalk & Charcoal Redraws highlights and midtones with
a solid midtone gray background drawn in coarse chalk.
Shadow areas are replaced with black diagonal charcoal
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Stylize filters

The Stylize filters produce a painted or impressionistic
effect on a selection by displacing pixels and by finding and
heightening contrast in an image. After using filters like
Find Edges and Trace Contour that highlight edges, you
can apply the Invert command to outline the edges of a
color image with colored lines or to outline the edges of a
grayscale image with white lines.

Diffuse Shuffles pixels in a selection to soften focus
according to the selected option: Normal moves pixels
randomly (ignoring color values), Darken Only replaces
light pixels with darker ones, and Lighten Only replaces
dark pixels with lighter ones. Anisotropic shuffles pixels in
the direction of the least change in color.

Emboss Makes a selection appear raised or stamped by
converting its fill color to gray and tracing the edges with the
original fill color. Options include an embossing angle (from
-360° to recess the surface, to +360° to raise the surface),
height, and a percentage (1% to 500%) for the amount of
color within the selection. To retain color and detail when
embossing, use the Fade command after applying the
Emboss filter.

Extrude Gives a 3D texture to a selection or layer.

Find Edges Identifies the areas of the image with signifi-
cant transitions and emphasizes the edges. Like the Trace
Counter filter, Find Edges outlines the edges of an image
with dark lines against a white background and is useful for
creating a border around an image.

Glowing Edges Identifies the edges of color and adds a
neon-like glow to them. This filter can be applied cumula-
tively.

Solarize Blends a negative and a positive image-similar to
exposing a photographic print briefly to light during devel-
opment.

Tiles Breaks up an image into a series of tiles, creating an
offset between the selection and its original position. You
can choose one of the following to fill the area between the
tiles: the background color, the foreground color, a reverse
version of the image, or an unaltered version of the image,
which puts the tiled version on top of the original and reveals
part of the original image underneath the tiled edges.

Trace Contour Finds the transitions of major brightness
areas and thinly outlines them for each color channel, for
an effect similar to the lines in a contour map.

Wind Places tiny horizontal lines in the image to create a
windblown effect. Methods include Wind; Blast, for a more
dramatic wind effect; and Stagger, which offsets the lines
in the image.

Texture filters

Use the Texture filters to simulate the appearance of depth
or substance, or to add an organic look.

Craquelure Paints an image onto a high-relief plaster
surface, producing a fine network of cracks that follow the
contours of the image. Use this filter to create an emboss-
ing effect with images that contain a broad range of color
or grayscale values.

Grain Adds texture to an image by simulating different
kinds of grain-Regular, Soft, Sprinkles, Clumped, Con-
trasty, Enlarged, Stippled, Horizontal, Vertical, and
Speckle, available from the Grain Type menu.

Mosaic Tiles Renders the image so that it appears to be
made up of small chips or tiles and adds grout between the
tiles.

(In contrast, the Pixelate > Mosaic filter breaks up an
image into blocks of different-colored pixels.)

Patchwork Breaks up an image into squares filled with the
predominant color in that area of the image. The filter
randomly reduces or increases the tile depth to replicate
the highlights and shadows.

Stained Glass Repaints an image as single-colored
adjacent cells outlined in the foreground color.

Texturizer Applies a texture you select or create to an
image.

Video filters

The Video submenu contains the De-Interlace and NTSC
Colors filters.

De-Interlace Smooths moving images captured on video
by removing either the odd or even interlaced lines in a video
image. You can choose to replace the discarded lines by
duplication or interpolation.

NTSC Colors Restricts the gamut of colors to those
acceptable for television reproduction, to prevent oversatu-
rated colors from bleeding across television scan lines.

Other filters

Filters in the Other submenu let you create your own filters,
use filters to modify masks, offset a selection within an
image, and make quick color adjustments.

Custom Lets you design your own filter effect. With the
Custom filter, you can change the brightness values of
each pixel in the image according to a predefined math-
ematical operation known as convolution. Each pixel is
reassigned a value based on the values of surrounding
pixels. This operation is similar to the Add and Subtract
calculations for channels.

You can save the custom filters you create and use them
with other Photoshop images.

High Pass Retains edge details in the specified radius
where sharp color transitions occur and suppresses the
rest of the image. (A radius of 0.1 pixel keeps only edge
pixels.) The filter removes low-frequency detail from an
image and has an effect opposite to that of the Gaussian
Blur filter.
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It is helpful to apply the High Pass filter to a continuous-
tone image before using the Threshold command or con-
verting the image to Bitmap mode. The filter is useful for
extracting line art and large black-and-white areas from
scanned images.

Maximum and Minimum The Maximum and Minimum
filters are useful for modifying masks. The Maximum filter
has the effect of applying a spread (dilation)-spreading out
white areas and choking in black areas. The Minimum filter
has the effect of applying a choke (erosion)-shrinking white
areas and spreading out the black areas. Like the Median
filter, the Maximum and Minimum filters operate on se-
lected pixels. Within a specified radius, the Maximum and
Minimum filters replace the current pixel's brightness value
with the highest or lowest brightness value of the surround-
ing pixels.

These filters, especially with larger radii, tend to promote
either corners or curves in the image contours. In Photoshop
CC, you can choose from the Preserve menu to favour
squareness or roundness as you specify the radius value.

Offset Moves a selection a specified horizontal or vertical
amount, leaving an empty space at the selection's original
location. You can fill the empty area with the current
background color, with another part of the image, or with
your choice of fill if the selection is near the edge of an
image.

Vanishing Point

The Vanishing Point feature preserves correct perspective
in edits of images that contain perspective planes (for
instance, the sides of a building or any rectangular object).
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IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.10
use an action panel and saving files in graphics formats
Objectives : At the end of this lesson you shall be able to
• explain action and action panel
• explain save in TIFF, JPEG and PNG formats
• explain save in GIF, EPS, DCS and BMP formats.

About actions

An action is a series of tasks that you play back on a single
file or a batch of files-menu commands, panel options, tool
actions, and so on. For example, you can create an action
that changes the size of an image, applies an effect to the
image, and then saves the file in the desired format.

Actions can include steps that let you perform tasks that
cannot be recorded (for example, using a painting tool).
Actions can also include modal controls that let you enter
values in a dialog box while playing an action.

In Photoshop, actions are the basis for droplets, which are
small applications that automatically process all files that
are dragged onto their icon.

Photoshop and Illustrator come with predefined actions
installed that help you perform common tasks. You can
use these actions as is, customize them to meet your
needs, or create new actions. Actions are stored in sets to
help you organize them.

You can record, edit, customize, and batch-process ac-
tions, and you can manage groups of actions by working
with action sets.

Actions panel overview

You use the Actions panel (Window > Actions) to record,
play, edit, and delete individual actions. This panel also lets
you save and load action files.

Expand and collapse sets, actions, and commands

• Click the triangle to the left of the set, action, or
command in the Actions panel. Alt-click (Windows) the
triangle to expand or collapse all actions in a set or all
commands in an action.

A Action set  B Action  C Recorded commands  D Included
command  E Modal control (toggles on or off)

View actions by name only

Choose Button Mode from the Actions panel menu. Choose
Button Mode again to return to list mode. Note: You can't
view individual commands or sets in Button mode.

Select actions in the Actions panel

Click an action name. Shift-click action names to select
multiple, contiguous actions, and Ctrl-click (Windows)
action names to select multiple, discontiguous actions.

Save in TIFF format

TIFF is a flexible raster (bitmap) image format supported by
virtually all paint, image-editing, and page-layout applica-
tions.

Bit depth (32-bit only) Specifies the bit depth (16-, 24-, or
32-bit) of the saved image.

Image Compression Specifies a method for compressing
the composite image data. If you're saving a 32-bit TIFF file,
you can specify that the file be saved with predictor
compression, but you don't have the option to use JPEG
compression. Predictor compression offers improved com-
pression by rearranging floating point values, and works
with both LZW and ZIP compression.

JPEG compression is available only for opaque
RGB and grayscale images that are 8-bits-per-
channel and no more than 30,000 pixels wide or
high.

Pixel Order Writes the TIFF file with the channels data
interleaved or organized by plane. Previously, Photoshop
always wrote TIFF files with the channel order interleaved.
Theoretically, the Planar order file can be read and written
faster, and offers a little better compression. Both channel
orders are backward compatible with earlier versions of
Photoshop.

Byte Order Selects the platform on which the file can be
read. This option is useful when you don't know what
program the file may be opened in. Photoshop and most
recent applications can read files using either IBM PC or
Macintosh byte order.

Save Image Pyramid Preserves multiresolution informa-
tion. Photoshop does not provide options for opening
multiresolution files; the image opens at the highest
resolution within the file. However, Adobe InDesign and
some image servers provide support for opening
multiresolution formats.
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Save Transparency Preserves transparency as an addi-
tional alpha channel when the file is opened in another
application. Transparency is always preserved when the
file is reopened in Photoshop.

Layer Compression Specifies a method for compressing
data for pixels in layers (as opposed to composite data).
Many applications cannot read layer data and skip over it
when opening a TIFF file. Photoshop, however, can read
layer data in TIFF files. Although files that include layer
data are larger than those that don't, saving layer data
eliminates the need to save and manage a separate PSD
file to hold the layer data. Choose Discard Layers And Save
A Copy if you want to flatten the image.

To have Photoshop prompt you before saving an
image with multiple layers, select Ask Before
Saving Layered TIFF Files in the File Handling
area of the Preferences dialog box.

Save in JPEG format

You can use the Save As command to save CMYK, RGB,
and grayscale images in JPEG (*.jpg) format. JPEG
compresses file size by selectively discarding data. You
can also save an image as one or more JPEG using the
Save For Web & Devices command.

JPEG supports only 8-bit images. If you save a 16-bit
image to this format, Photoshop automatically lowers the
bit depth.

To quickly save a medium-quality JPEG, play the Save As
JPEG Medium action on the file. You can access this
action by choosing Production from the Actions panel
menu.

Matte Offers matte color choices to simulate the appear-
ance of background transparency in images that contain
transparency.

Image Options Specifies the image quality. Choose an
option from the Quality menu, drag the Quality pop-up
slider, or enter a value between 0 and 12 in the Quality text
box.

Format Options Specifies the format of your JPEG file.
Baseline ("Standard") uses a format recognized by most
web browsers. Baseline Optimized creates a file with
optimized color and a slightly smaller file size. Progressive
displays a series of increasingly detailed versions of the
image (you specify how many) as it downloads. (Not all
web browsers support optimized and Progressive JPEG
images.)

Some applications may not be able to read a
CMYK file saved in JPEG format. Likewise, if
you find that a Java application can't read a
JPEG file, try saving the file without a thumb-
nail preview.

Save in PNG format

You can use the Save As command to save RGB, Indexed
Color, Grayscale, and Bitmap mode images in PNG
format.

You can also save an image as one or more PNG
files using the Save For Web & Devices com-
mand.

Save in GIF format

You can use the Save As command to save RGB, Indexed
Color, Grayscale, or Bitmap mode images directly in
CompuServe GIF (known as GIF) format. The image is
automatically converted to Indexed Color mode.

GIF is only available when the image is 8 Bits/
Channel (it only supports 8 Bit/Channel).

Normal Displays the image in a browser only when down-
load is complete.

Interlaced Displays low-resolution versions of the image in
a browser as the file downloads. Interlacing makes down-
load time seem shorter, but it also increases file size.

You can also save an image as one or more GIF
files using the Save For Web & Devices com-
mand.

Save in Photoshop EPS format

Virtually all page-layout, word-processing, and graphics
applications accept imported or placed EPS (Encapsu-
lated PostScript) files. To print EPS files, you should use
a PostScript printer. Non-PostScript printers will print only
the screen-resolution preview.

1 Choose File > Save As, and choose Photoshop EPS
from the Format menu.

2 In the EPS Options dialog box, select the options you
want, and click OK:

Preview Creates a low-resolution image to view in the
destination application. Choose TIFF to share an EPS file
between Windows and Mac OS systems. An 8-bit preview
is in color and a 1-bit preview is in black and white with a
jagged appearance. An 8-bit preview creates a larger file
size than a 1-bit preview. See also Bit depth.

Encoding Determines the way image data is delivered to
a PostScript output device. Encoding options are de-
scribed below.

Include Halftone Screen and Include Transfer Function
Control print specifications for high-end commercial print
jobs. Consult your printer before selecting these options.

Transparent Whites Displays white areas as transparent.
This option is available only for images in Bitmap mode.

PostScript Color Management Converts file data to the
printer's color space. Do not select this option if you plan
to place the image in another color-managed document.

Only PostScript Level 3 printers support PostScript
Color Management for CMYK images. To print a
CMYK image using PostScript Color Management
on a Level 2 printer, convert the image to Lab
mode before saving in EPS format.
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Include Vector Data Preserves any vector graphics (such
as shapes and type) in the file. However, vector data in EPS
and DCS files is available only to other applications; vector
data is rasterized if you reopen the file in Photoshop. This
option is only available if your file contains vector data.

Image Interpolation Applies bicubic interpolation to
smooth the low-resolution preview if printed.

Photoshop EPS encoding options

ASCII or ASCII85 Encodes if you're printing from a
Windows system, or if you're experience printing errors or
other difficulties.

Binary Produces a smaller file and leaves the original data
intact. However, some page-layout applications and some
commercial print spooling and network printing software
may not support binary Photoshop EPS files.

JPEG Compresses the file by discarding some image
data. You can choose the amount of JPEG compression
from very little (JPEG Maximum Quality) to a lot (JPEG Low
Quality). Files with JPEG encoding can be printed only on
Level 2 (or later) PostScript printers and may not separate
into individual plates.

Save in Photoshop DCS format

DCS (Desktop Color Separations) format is a version of
EPS that lets you save color separations of CMYK or
multichannel files.

1 Choose File > Save As, and choose Photoshop DCS
1.0 or Photoshop DCS 2.0 from the Format menu.

2 In the DCS Format dialog box, select the options you
want, and click OK.

The dialog box includes all the options available for Photoshop
EPS files. Additionally, the DCS menu gives you the option
of creating a 72-ppi composite file that can be placed in a
page-layout application or used to proof the image:

DCS 1.0 format Creates one file for each color channel in
a CMYK image. You can also create a fifth file: a grayscale
or color composite. To view the composite file, you must
keep all five files in the same folder.

DCS 2.0 format Retains spot color channels in the image.
You can save the color channels as multiple files (as for
DCS 1.0) or as a single file. The single-file option saves disk
space. You can also include a grayscale or color compos-
ite.

Save in Photoshop Raw format

The Photoshop Raw format is a file format for transferring
images between applications and computer platforms. The
Photoshop Raw format is not the same as camera raw.

1 Choose File > Save As, and choose Photoshop Raw
from the Format menu.

2 In the Photoshop Raw Options dialog box, do the
following:

• (Mac OS) Specify values for File Type and File
Creator, or accept the default values.

• Specify a Header parameter.

• Select whether to save the channels in an inter-
leaved or non-interleaved order.

Save in BMP format

The BMP format is an image format for the Windows
operating system. The images can range from black-and-
white (1 bit per pixel) up to 24-bit color (16.7 million colors).

Save in Cineon format (16-bit images only)

RGB images that are 16 bits per channel can be saved in
Cineon format for use in the Kodak Cineon Film System.

• Choose File > Save As and choose Cineon from the
Format menu.

Save in Targa format

The Targa (TGA) format supports bitmap and RGB images
with 8 Bits/Channel. It is designed for Truevision® hard-
ware, but it is also used in other applications.

1 Choose File > Save As, and choose Targa from the
Format menu.

2 Specify a filename and location, and click Save.

3 In the Targa Options dialog box, select a resolution,
select the Compress (RLE) option if you want to
compress the file, and then click OK.
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Printing basics

Whether you are printing an image to your desktop printer
or sending it to a prepress facility, knowing a few basics
about printing makes the print job go more smoothly and
helps ensure that the finished image appears as intended.

Types of printing For many Photoshop users, printing a
file means sending the image to an inkjet printer. Photoshop
can send your image to a variety of devices to be printed
directly onto paper or converted to a positive or negative
image on film. In the latter case, you can use the film to
create a master plate for printing by a mechanical press.

Types of images The simplest images, such as line art,
use only one color in one level of gray. A more complex
image, such as a photograph, has varying color tones. This
type of image is known as a continuous-tone image.

Color separation Artwork intended for commercial repro-
duction and containing more than one color must be printed
on separate master plates, one for each color. This
process, called color separation, generally calls for the use
of cyan, magenta, yellow, and black (CMYK) inks. In
Photoshop, you can adjust how the various plates are
generated.

Quality of detail The detail in a printed image depends on
image resolution (pixels per inch) and printer resolution
(dots per inch). Most PostScript laser printers have a
resolution of 600 dpi, while PostScript imagesetters have
a resolution of 1200 dpi or higher. Inkjet printers produce a
microscopic spray of ink, not actual dots, resulting in an
approximate resolution of 300 to 720 dpi.

About desktop printing

Unless you work in a commercial printing company or
service bureau, you probably print images to a desktop
printer, such as an inkjet, dye sublimation, or laser printer,
not to an imagesetter. Photoshop lets you control how your
image is printed.

Monitors display images using light, whereas desktop
printers reproduce images using inks, dyes, or pigments.
For this reason, a desktop printer can't reproduce all the
colors displayed on a monitor. However, by incorporating
certain procedures (such as a color management system)
into your workflow, you can achieve predictable results
when printing your images to a desktop printer. Keep these
considerations in mind when working with an image you
intend to print:

IT & ITES
DTPO - Photoshop                                     Related Theory for Exercise  2.1.11
Printing from photoshop
Objectives : At the end of this lesson you shall be able to
• explain about printing basics
• explain Printing with color Management
• explain Contact sheets and PDF presentation
• explain Printing spot colors
• explain Printing images to a commercial printing press
• explain print 3D objects.

• If your image is in RGB mode, do not convert the
document to CMYK mode when printing to a desktop
printer. Work entirely in RGB mode. As a rule, desktop
printers are configured to accept RGB data and use
internal software to convert to CMYK. If you send CMYK
data, most desktop printers apply a conversion any-
way, with unpredictable results.

• If you want to preview an image as printed to any device
for which you have a profile, use the Proof Colors
command.

• To reproduce screen colors accurately on the printed
page, you must incorporate color management into
your workflow. Work with a monitor that is calibrated
and characterized. Ideally, you should also create a
custom profile specifically for your printer and the paper
you print on, though the profile supplied with your printer
can produce acceptable results.

Position and scale images

You can adjust the position and scale of an image using
options in the Print dialog box. The shaded border at the
edge of the paper represents the margins of the selected
paper; the printable area is white.

The base output size of an image is determined by the
document size settings in the Image Size dialog box.
Scaling an image in the Print dialog box changes the size
and resolution of the printed image only. For example, if
you scale a 72-ppi image to 50% in the Print dialog box, the
image will print at 144 ppi; however, the document size
settings in the Image Size dialog box will not change. In the
Print dialog box, the Print Resolution field at the bottom of
the Position And Size section shows the print resolution at
the current scaling setting.

Many third-party printer drivers provide a scaling option in
the Print Settings dialog box. This scaling affects every-
thing on the page, including the size of all page marks,
such as crop marks and captions, whereas the scaling
percentage provided by the Print command affects only the
size of the printed image (and not the size of page marks).

To avoid inaccurate scaling, specify scaling using
the Print dialog box rather than the Print Settings
dialog box; do not enter a scaling percentage in
both dialog boxes.
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Print vector data

If an image includes vector graphics, such as shapes and
type, Photoshop can send the vector data to a PostScript
printer. When you choose to include vector data, Photoshop
sends the printer a separate image for each type layer and
each vector shape layer. These additional images are
printed on top of the base image, and clipped using their
vector outline. Consequently, the edges of vector graphics
print at the printer's full resolution, even though the content
of each layer is limited to the resolution of your image file.

Some blending modes and layer effects required
rasterized vector data.

Photoshop determine printed colors

If you have a custom color profile for a specific printer, ink,
and paper combination, letting Photoshop manage colors
often produces better results than letting the printer man-
age colors.

1 Choose File > Print.

2 Expand the Color Management section at right.

3 For Color Handling, choose Photoshop Manages Col-
ors.

4 For Printer Profile, select the profile that best matches
your output device and paper type. If there are any
profiles associated with the current printer, they are
placed at the top of the menu, with the default profile
selected.

The more accurately the profile describes the behavior of
the output device and printing conditions (such as paper
type), the more accurately the color management system
can translate the numeric values of the actual colors in a
document.

5 (Optional) Set any of the following options:

Rendering Intent Specifies how Photoshop converts
colors to the destination color space.

Black Point Compensation Preserves the shadow detail in
the image by simulating the full dynamic range of the output
device.

6 (Optional) Below the print preview, select any of the
following:

Match Print Colors Select to view image colors in the
preview area as they will actually print.

Gamut Warning Enabled when Match Print Colors is
selected. Select to highlight out-of-gamut colors in the
image, as determined by the selected printer profile. A
gamut is the range of colors that a color system can display
or print. A color that can be displayed in RGB may be out
of gamut for your current printer profile.

Show Paper White Sets the color white in the preview to
the color of the paper in the selected printer profile. This
produces a more accurate print preview if you're printing on
off-white paper such as newsprint or art papers that are
more beige than white. Since absolute white and black
create contrast, less white in the paper will lower the overall

contrast of your image. Off-white paper can also change
the overall color cast of the image, so yellows printed on
beige paper may appear more brown.

7 Access the color management options for the printer
driver from the Print Settings dialog box, which auto-
matically appears after you click Print.

• In Windows, click the Print Settings button to
access the printer driver options.

• In Mac OS, use the pop-up menu from the Print
Settings dialog box to access the printer driver
options.

8 Turn off color management for the printer, so the printer
profile settings won't override your profile settings.

Every printer driver has different color management op-
tions. If it's not clear how to turn off color management,
consult your printer documentation.

9 Click Print.

Let printer determine printed colors

If you don't have a custom profile for your printer and paper
type, you can let the printer driver handle the color
conversion.

1 Choose File > Print.

2 Expand the Color Management section at right.

The Document Profile entry shows the profile
embedded in the image.

3 For Color Handling, choose Printer Manages Colors.

4 (Optional) For Rendering Intent, specify how to convert
colors to the destination color space. A summary of
each option appears in the Description area at bottom.

Many non-PostScript printer drivers ignore this option and
use the Perceptual rendering intent. (For more information,
see About rendering intents)

5 Access the color management options for the printer
driver from the Print Settings dialog box, which auto-
matically appears after you click Print:

• In Windows, click Print Settings to access the
printer driver options.

• In Mac OS, use the pop-up menu from the Print
Settings dialog box to access the printer driver
options.

Every printer driver has different color management op-
tions. If it's not clear how to turn on color management,
consult your printer documentation.

6 Click Print.

Print a hard proof

A hard proof (sometimes called a proof print or match print)
is a printed simulation of your final output on a printing
press. A hard proof is produced on an output device that's
less expensive than a printing press. Some inkjet printers
have the resolution necessary to produce inexpensive
prints that can be used as hard proofs.
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1 Choose View > Proof Setup, and select the output
conditions you want to simulate. You can do this using
a preset or by creating a custom proof setup.

The view changes automatically according to the proof
you choose. Choose Custom to create custom proof
settings, which you must save so you can select them
in the Proof Setup menu of the Print dialog box.

2 After you select a proof, choose File > Print.

3 Expand the Color Management section at right.

4 For Color Handling, choose Photoshop Manages Col-
ors.

5 For Printer Profile, select the profile for your output
device.

6 From the menu above the Proof Setup menu or Render-
ing Intent menu, select Hard Proofing.

The Proofing Profile entry below should match the proof
setup you selected earlier.

7 (Optional) Set any of the following options.

Proof Setup Choose any customized proofs that exist
locally on your hard drive.

Simulate Paper Color Simulates what colors look like
on the paper of the simulated device. Using this option
produces the most accurate proof, but it is not available
for all profiles.

Simulate Black Ink Simulates the brightness of dark
colors for the simulated device. Using this option
results in more accurate proofs of dark colors, but it is
not available for all profiles.

8 Access the color management options for the printer
driver from the Print Settings dialog box, which auto-
matically appears after you click Print.

• In Windows, click the Preferences button to access
the printer driver options.

• In Mac OS, use the pop-up menu from the Print
Settings dialog box to access the printer driver
options.

9 Turn off color management for the printer so that the
printer profile settings don't override your profile set-
tings.

Every printer driver has different color management op-
tions. If it's not clear how to turn off color management,
consult your printer documentation.

10 Click Print.

Contact Sheets and PDF Presentations

Contact Sheet II and PDF Presentation plug-ins in
Photoshop CS6 and Photoshop CC are 64-bit compatible
for optimal performance on modern systems.

Creating a contact sheet

1 Do either of the following:

• (Photoshop) Choose File > Automate > Contact
SheetII.

• (Bridge) Select a folder of images or specific image
files. From the Bridge menu, choose Tools >
Photoshop> Contact Sheet II. Unless you select
specific images, the contact sheet will include all
the images currently displayed in Adobe Bridge.
You can select a different images after the Contact
Sheet II dialog box opens.

2 In the Contact Sheet II dialog box, specify the images
to include by choosing an option from the Use menu.
Note: If you select Bridge, all images currently in Bridge
are used unless you selected images before choosing
the Contact Sheet II command. Images in subfolders
are not included.

3 In the Document area, specify the dimensions and color
data for the contact sheet. Select Flatten All Layers to
create a contact sheet with all images and text on a
single layer. Deselect Flatten All Layers to create a
contact sheet in which each image is on a separate
layer and each caption is on a separate text layer.

4 In the Thumbnails area, specify layout options for the
thumbnail previews.

• For Place, choose whether to arrange thumbnails
across first (from left to right, then top to bottom) or
down first (from top to bottom, then left to right).

• Enter the number of columns and rows that you want
per contact sheet.

• Select Use Auto-Spacing to let Photoshop auto-
matically space the thumbnails in the contact sheet.
If you deselect Use Auto-Spacing, you can specify
the vertical and horizontal space around the thumb-
nails.

• Select Rotate For Best Fit to rotate the images,
regardless of their orientation, so they fit efficiently
on a contact sheet.

5 Select Use Filename As Caption to label the thumb-
nails using their source image filenames. Use the menu
to specify a caption font and font size.

6 Click OK.

Creating a PDF presentation

The PDF Presentation command lets you use a variety of
images to create a multipage document or slide show
presentation.

1 Choose File > Automate > PDF Presentation.

2 In the PDF Presentation dialog box, click Browse and
navigate to add files to the PDF presentation. Select
Add Open Files to add files already open in Photoshop.
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Drag files up or down to reorder them in the
presentation. If you want a file to appear more
than once, select the file and click Duplicate.

3 Set Output and Presentation options. Then click Save.

PDF presentations are saved as generic PDF files,
not Photoshop PDF files, and are rasterized when
you reopen them in Photoshop.

Place multiple photos into a picture package

To use the optional Picture Package plug-in described
below, first download it for Windows or Mac OS. You can
also create picture and custom packages in Photoshop
Lightroom, if you have it.

With the optional Picture Package plug-in, you can place
multiple copies of an image on a single page, much as
portrait studios do with school photos. You can also place
different images on the same page. You can choose from
a variety of size and placement options to customize your
package layout.

• Drag an image from the desktop or a folder into a
placeholder.

1 Picture Package is an optional plug-in. Download and
install it for Windows or Mac OS.

Run Photoshop in 32-bit mode (64-bit Mac OS only) .

2 Do one of the following:

• (Photoshop) Choose File > Automate > Picture
Package. If you have multiple images open, Picture
Package uses the frontmost image.

• (Bridge) Choose Tools > Photoshop > Picture Pack-
age. The Picture Package command uses the first
image listed in Bridge unless you select a specific
image before giving the Picture Package command.

If you're using only the frontmost image or a selected image
from Bridge, skip to step 3.

3 Add one or more images to the layout by doing one of
the following:

• In the Source Images area of the Picture Package
dialog box, choose either File or Folder from the Use
menu and click Browse (Windows) or Choose (Mac
OS). If you choose Folder, you can select Include All
Subfolders to include images inside any subfolders.

• Click a placeholder in the preview layout and browse
to select an image.

You can change any image in the layout by clicking a
placeholder and browsing to select an image.

4 In the Document area of the Picture Package dialog
box, select page size, layout, resolution, and color
mode. A thumbnail of the chosen layout appears on the
right side of the dialog box.

5 Select Flatten All Layers to create a picture package
with all images and label text on a single layer. Deselect
Flatten All Layers to create a picture package with
separate image layers and text layers (for labels). If you
place each image and label on a separate layer, you
can update your picture package after it's been saved.
However, the layers increase the file size of your picture
package.

6 In the Label area, choose the source for label text from
the Content menu or choose None. If you choose
Custom Text, enter the text for the label in the Custom
Text field.

7 Specify font, font size, color, opacity, position, and
rotation for the labels.

8 Click OK.

Spot colors

Spot colors are special premixed inks used instead of, or
in addition to, the process color (CMYK) inks. Each spot
color requires its own plate on the press. (Because a
varnish requires a separate plate, it is considered a spot
color, too.)

If you are planning to print an image with spot colors, you
need to create spot channels to store the colors. To export
spot channels, save the file in DCS 2.0 format or PDF.
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Note the following when working with spot colors:

• For spot color graphics that have crisp edges and knock
out the underlying image, consider creating the addi-
tional artwork in a page layout or illustration application.

• To apply spot color as a tint throughout an image,
convert the image to Duotone mode and apply the spot
color to one of the duotone plates. You can use up to
four spot colors, one per plate.

• The names of the spot colors are printed on the
separations.

• Spot colors are overprinted on top of the fully composited
image. Each spot color is printed in the order it appears
in the Channels panel, with the topmost channel print-
ing as the topmost spot color.

• You cannot move spot colors above a default channel
in the Channels panel except in Multichannel mode.

• Spot colors cannot be applied to individual layers.

• Printing an image with a spot color channel to a
composite color printer will print the spot color at an
opacity indicated by the Solidity setting.

• You can merge spot channels with color channels,
splitting the spot color into its color channel compo-
nents.

Create a new spot channel

You can create a new spot channel or convert an existing
alpha channel to a spot channel.

1 Choose Window > Channels to display the Channels
panel.

2 To fill a selected area with a spot color, make or load a
selection.

3 Do one of the following to create a channel:

• Ctrl-click (Windows) or Command-click (Mac OS)
the New Channel button  in the Channels panel.

• Choose New Spot Channel from the Channels panel
menu.

If you made a selection, that area is filled with the currently
specified spot color.

In the New Spot Channel dialog box, click the Color box.
Then in the Color Picker, click Color Libraries to choose
from a custom color system such as PANTONE or TOYO
and choose a color.

4 Enter a name for the spot channel. If you choose a
custom color, the channel automatically takes the
name of that color.

Be sure to name spot colors so they'll be recognized by
other applications reading your file. Otherwise the file might
not print.

5 For Solidity, enter a value between 0% and 100%.

This option lets you simulate on-screen the density of the
printed spot color. A value of 100% simulates an ink that
completely covers the inks beneath (such as a metallic
ink); 0% simulates a transparent ink that completely
reveals the inks beneath (such as a clear varnish). You can
also use this option to see where an otherwise transparent
spot color (such as a varnish) will appear.

The Solidity and color choice options affect
only on-screen previews and composite prints.
They have no effect on printed separations.

Preparing images for press

From Photoshop, you can prepare image files for offset
lithography, digital printing, gravure, and other commercial
printing processes.

Generally, your workflow depends on the capabilities of the
prepress facility. Before you begin a workflow for commer-
cial printing, contact the prepress staff to learn their
requirements. For example, they may not want you to
convert to CMYK at any point because they may need to
use prepress-specific settings. Here are some possible
scenarios for preparing your image files to achieve predict-
able printing results:

• Work entirely in RGB mode and make sure that the
image file is tagged with the RGB working space profile.
If your printer or prepress staff use a color management
system, they should be able to use your file's profile to
make an accurate conversion to CMYK before produc-
ing the film and printing plates.

• Work in RGB mode until you finish editing your image.
Then convert the image to CMYK mode and make any
additional color and tonal adjustments. Especially
check the highlights and shadows of the image. Use
Levels, Curves, or Hue/Saturation adjustment layers to
make corrections. These adjustments should be very
minor. Flatten the file if necessary, then send the
CMYK file to the professional printer.

• Place your RGB or CMYK image in Adobe InDesign or
Adobe Illustrator. In general, most images printed on a
commercial press are not printed directly from
Photoshop but from a page-layout program like Adobe
InDesign or an illustration program like Adobe Illustra-
tor. For more information on importing Photoshop files
into Adobe InDesign or Adobe Illustrator, see Adobe
InDesign Help or the Adobe Illustrator Help.
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A Gradient tint bar  B Label  C Registration marks  D Progressive
color bar  E Corner crop mark  F Center crop mark  G Description
H Star target

Here are a few issues to keep in mind when you work on
an image intended for commercial printing:

• If you know the characteristics of the press, you can
specify the highlight and shadow output to preserve
certain details.

• If you use a desktop printer to preview the appearance
of the final printed piece, keep in mind that a desktop
printer cannot faithfully replicate the output of a com-
mercial printing press. A professional color proof gives
a more accurate preview of the final printed piece.

• If you have a profile from a commercial press, you can
choose it with the Proof Setup command and then view
a soft proof using the Proof Colors command. Use this
method to preview the final printed piece on your
monitor.

Some printers may prefer to receive your docu-
ments in PDF format, especially if the docu-
ments need to conform to PDF/X standards.

Set output options

If you are preparing your images for commercial printing
directly from Photoshop, you can select and preview a
variety of page marks and other output options using the
Print command. Generally, these output options should be
specified only by prepress professionals or people knowl-
edgeable about the commercial printing process.

Registration Marks Prints registration marks on the
image (including bull's-eyes and star targets). These
marks are used primarily for aligning color separations on
PostScript printers.

Corner Crop Marks Prints crop marks where the page is
to be trimmed. You can print crop marks at the corners. On
PostScript printers, selecting this option will also print star
targets.

Center Crop Marks Prints crop marks where the page is
to be trimmed. You can print crop marks at the center of
each edge.

Description Prints any description text entered in the File
Infodialog box, up to about 300 characters. Description text
is always printed in 9-point Helvetica plain type.

Labels Prints the file name above the image. If printing
separations, the separation name is printed as part of the
label.

Emulsion Down Makes type readable when the emulsion
is down-that is, when the photosensitive layer on a piece
of film or photographic paper is facing away from you.
Normally, images printed on paper are printed with emul-
sion up, with type readable when the photosensitive layer
faces you. Images printed on film are often printed with
emulsion down.

Negative Prints an inverted version of the entire output,
including all masks and any background color. Unlike the
Invert command in the Image menu, the Negative option
converts the output, not the on-screen image, to a negative.
If you print separations directly to film, you probably want
a negative, although in many countries film positives are
common. Check with your print shop to determine which is
required. To determine the emulsion side, examine the film
under a bright light after it has been developed. The dull side
is the emulsion; the shiny side is the base. Check whether
your print shop requires film with positive emulsion up,
negative emulsion up, positive emulsion down, or negative
emulsion down.

Background Selects a background color to be printed on
the page outside the image area. For example, a black or
colored background may be desirable for slides printed to
a film recorder. To use this option, click Background, and
then select a color from the Color Picker. This is a printing
option only; it does not affect the image itself.

Border Prints a black border around an image. Type a
number and choose a unit value to specify the width of the
border.

Bleed Prints crop marks inside rather than outside the
image. Use this option to trim the image within the graphic.
Type a number and choose a unit value to specify the width
of the bleed.

Interpolation Reduces the jagged appearance of a low-
resolution image by automatically resampling up while
printing (on PostScript printers). Resampling may reduce
the sharpness of the image quality.

1 Choose File > Print.
2 Choose Output from the pop-up menu.
3 Set one or more of the following options:

Calibration Bars Prints an 11-step grayscale, a transition
in density from 0 to 100% in 10% increments. With a
CMYK color separation, a gradient tint bar is printed to the
left of each CMYK plate, and a progressive color bar to the
right. Note: Calibration bars, registration marks, crop
marks, and labels are printed only if the paper is larger than
the printed image.
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Create a color trap

A trap is an overlap that prevents tiny gaps in the printed
image caused by a slight misregistration on press. Contact
your service provider before you do any trapping. In most
cases, your print shop determines whether trapping is
needed. If so, the print shop staff will tell you what values
to enter in the Trap dialog box.

Print separations from Photoshop

When preparing your image for prepress and working with
CMYK images or images with spot colors, you can print
each color channel as a separate page.

Separations from CMYK, Duotone, or multi-chan-
nel documents printed on non-PostScript printers
may not be identical to those printed on PostScript
printers.

If you are printing an image from another appli-
cation and want to print spot channels to spot
color plates, you must first save the file in DCS 2.0
format. DCS 2.0 preserves spot channels. This
format is supported by applications such as Adobe
InDesign and QuarkXPress.

1 Make sure that your document is in CMYK Color,
Multichannel, or Duotone mode, and then choose File>
Print.

2 Choose Separations from the Color Handling drop-
down menu.

Depending on the designated printer and printer
drivers on your computer, these options may also
appear in the Print Settings dialog box. In Win-
dows, click the Properties button to access the
printer driver options; in Mac OS, use the pop-up
menu in the Print Settings dialog box that ap-
pears.

3 Click Print. Separations are printed for each of the
colors in the image.

Print separations from Photoshop

When preparing your image for prepress and working
with CMYK images or images with spot colors, you can
print each color channel as a separate page.

Separations from CMYK, Duotone, or multi-chan-
nel documents printed on non-PostScript printers
may not be identical to those printed on PostScript
printers.

If you are printing an image from another appli-
cation and want to print spot channels to spot
color plates, you must first save the file in DCS 2.0
format. DCS 2.0 preserves spot channels. This
format is supported by applications such as Adobe
InDesign and QuarkXPress.

Trapping is intended to correct the misalignment of solid
colors. In general, you don't need traps for continuous-tone
images such as photographs. Excessive trapping may
produce an outline effect. These problems may not be
visible onscreen and might show up only in print. Photoshop
uses standard rules for trapping:

• All colors spread under black.
• Lighter colors spread under darker colors.
• Yellow spreads under cyan, magenta, and black.
• Pure cyan and pure magenta spread under each other

equally.

Determine scan resolution for printing

You can use a number of techniques to determine the
resolution at which to scan a photograph. If you are
scanning photos to be printed, and you know the exact size
and the printing screen frequency, you can use the
following techniques to determine the scanning resolution.
Often it is easiest to scan at your scanner's maximum
optical resolution and then resize the image in Photoshop
later.

Print 3D objects

With Photoshop, you can print any compatible 3D model
without worrying about 3D printer limitations. In preparation
for printing, Photoshop automatically makes 3D models
watertight. Photoshop also generates the necessary sup-
port structures-scaffolding and rafts-to ensure that your 3D
prints are successful.

Preparing to print 3D objects

1 Select Window > Workspace > 3D to switch to the 3D
workspace.

2 Open the 3D model in Photoshop. If necessary, cus-
tomize the size of the 3D model while opening it.

A Misregistration with no trap  B Misregistration with trap
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• Adjust the Scene Volume dimensions to specify the
desired size of the printed 3D object. When you change
a value (X, Y, or Z), the other two values are scaled
proportionately. As you modify the Scene Volume
dimensions, notice that the print plate under the 3D
model scales in proportion.

1 Choose Scale To Print Volume if you want Photoshop
to auto-scale your 3D model, such that it fills up the
available print volume of the selected printer.

2 If the 3D model has normal maps, bump maps, or
opacity maps; you can choose to ignore one of more
types of these maps while printing the model. You'll
notice that the 3D model updates in real time when you
change these Surface Detail settings.

3 You may choose to not print the support structures
(scaffolds or rafts) required for the 3D object. Use this
option with caution, since the printing of the 3D model
may fail if you don't print a necessary support structure.

4 If your printer supports multiple materials, choose the
material that you want to use for printing the 3D object.

3D print utilities

Photoshop provides interactive wizard-based utilities that
you can use for configuring, calibrating, and maintaining
your 3D printer. You can use these utilities only when the
3D printer is powered on and connected to your computer.

1 Select 3D > 3D Printer Utilities.

2 Select the utility that you want to launch.

Calibrate Print Plate Helps level the print plate. This
utility performs the following broad steps:

• Prompts you to remove any leftover printing material
from the 3D printer

• Initializes the print head
• Lets you adjust/finetune the gap between the print plate

and the print head for nine nozzle positions You can use
this utility in the wizard mode or in the manual mode.

Load Filament Helps load a filament into a fused deposi-
tion modeling (FDM) 3D printer. Photoshop initiates the
headheating process and the filament-loading mechanism
for easy filament loading.
Remove Filament Helps remove a filament from an FDM
3D printer. Photoshop initiates the head-heating process
and the filament-loading mechanism for easy filament
removal.
Change Filament Helps replace the filament of an FDM 3D
printer with a new filament. Photoshop initiates the
headheating process and the filament-loading mechanism
for easy filament changing.
• Follow the onscreen instructions.
Pack objects on the ground plane
At times, you may want to print multiple instances of the
same object on the same build plate. Follow these steps:
1 Select the required objects in the 3D Panel.
2 Select 3D > Pack Objects On Ground Plane.
3 Proceed with printing the objects.

3 Select 3D > 3D Print Settings.

• In the 3D Print Settings panel, choose whether you
want to print to a printer connected to your computer
through a USB port (local printer) or use an online 3D
printing service, such as Shapeways.com or Sculpteo.

• Select a local printer or a Shapeways.com printer
profile.

• Select a unit for the printer volume-inch, centimeter,
millimeter, or pixel. The unit is reflected in the Printer
Volume dimensions as well as the print plate measure-
ments.

 
A 3D model  B Print plate  C Printer volume overlay  

1 Select a Detail Level-Low, Medium, or High-for the 3D
print. The time required to print the 3D object depends
on the detail level that you choose.

2 If you don't want to see the 3D printer volume overlaid on
the 3D model, deselect Show Printer Volume Overlay.
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IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.01
Introduction to graphic design and Corel draw
Objectives: At the end of this lesson you shall be able to
• explain graphic design and elements of design
• explain features of the CorelDraw
• state the require configuration of CorelDraw to install in your PC
• explain the CorelDraw workspace tools
• state the options to create New documents.

Basic design

Design is an organized plan for a definite purpose of
function.  Designing is not mere drawing or use of pen
pencil in a drawing to show how something is to be made
pleasing to the eye.  It is a mental activity to create an idea
for communication.  Communication by vision is the scope
of designing, particularly in printing.  Graphic design is the
communication of idea visualized in the art of printing.

The creative process underlying the fabrication of a
satisfactory pattern in visualizing an idea is called a design.
The object of design is to transfer the idea from one's mind
to that of the reader.  To this end, he selects elements and
arranges them in a structure.  Thus, design is the process
of creating, evaluating, selecting and arranging the elements
which make up a printed page.  It is an artful scheming of
ideas.

Design is a complex combination of many forces; the
designer's taste, talent, experience and his knowledge.  It
is creative and intuitive; and so it defies scientific analysis
and formulae.  It is helpful to study the broad principles of
design to form a frame of reference.  It involves various
principles and stages of work.  When we know the
principles we can use them spontaneously and effectively.
Thus the design to be produced is presented in the form of
a layout containing all the elements and the necessary
information, based on the various principles of proportion,
harmony, contrast, balance, rhythm, movements, etc.

Basic principles of design

Every job is different.  Each job is made to fit its particular
requirements.  Art and its principles should be adapted to
the specific hob at hand.  There are no absolute laws and
principles that govern the art of printing.  Printing is an art
preservative of all arts.  A till, for better judgment and
effective reproduction the following principles provide an
approximate answer to the basic rules of typography for the
production of artistic ideas and their reproduction.

Application of general principles are essential in printing as
in any form of art, like architecture, manufacturing etc.  The
basic principles that govern a typographic design while
planning for a job, are proportion, harmony, contrast,
balance, rhythm and movement.

Proportion

Proportion may be defined as the relation of width to length
or area to area as applied to typographic design.  Good

proportion is important at the start, in planning the shape
of the page or any job.  Good proportion can again be
defined as a pleasing inequality in the parts of a whole
setting.

Contrast

In many forms of communication some parts must be
stressed more than the others.  Contrast is a factor of
emphasis.  It is the most potent tool for bringing the
essential into sharp focus.  Contrast can be achieved by
applying polarities.  Polarities of shape, size, tone, texture
and direction give contrast in size, tone, texture and
direction.

Contrast is opposition, conflict or variety.  It is the dynamic
essence that dramatizes and stimulates interest in a
printed matter.  Contrast not only relieves the monotony,
but also allows for inflection and stress to impart the proper
meaning in a matter.  If there is no contrast, there would be
no display, because the entire piece would be dry or
monotonous without contrast.  Therefore we can say
contrast is display.  Contrast also extends to other
dimensions such as tone, direction, size and shape.

Contrast in tone: The dullness of a figure is brightened by
tonal accent, giving greater contrast.  For example contrast
in texture, contrast in direction.  The major aim in contrasting
direction is to guide the readers eye through the message.
Horizontal, vertical, left oblique and right oblique are the
contrast in direction applied in placing lines or masses of
elements in a job.

Contrast in values: Obtained when light colours are
placed by the side of a dark colour.  Because value shows
how strongly a colour is coloured.

Contrast in chroma: It is a dull colour placed by the side
of a bright colour.  Chroma is that property explaining the
brilliance or brightness of a colour.

Contrast in spreading effect: It is achieved when a colour
is placed against a black background or when a colour is
seen against a white background.  Because colour is
affected also by its immediate surrounding.

Balance

Balance exists when the elements are placed with a sense
of equilibrium.   That is the weight of the elements
counteract, so that they are seen settled or pleasing
wherever they are placed.  Large elements, the other
factors being equal appear heavier.  Irregular shapes give
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greater weight than regular.  Dark elements outweigh light
ones, though a small dark element can appear heavier than
a large tint; heavier than a large but lighter mass.

Two distinct styles of balance

Symmetrical and Asymmetrical balance

Symmetrical balance

Early printers, until the past century displayed type matter
by centering each line and each word to the measure.  All
units placed in equal balance of weight, shape, size and
colour on either side of the vertical axis of a page.

Thus a perfectly symmetrical and classical effect is
obtained.  This is the style of the past.  It is conventional,
static, formal, classical and traditional.  In one way man's,
orientation towards sense of balance is very much limited
in this type of balance.

Asymmetrical balance:

Unequal forces or elements are place at unequal distance
from the centre to get a asymmetrical balance.  Vertical
axis, gives asymmetrical balance.  It is obtained by
accentuating the display elements properly on either side
of the vertical axis in unequal distances and unequal
forces.

Unequal forces, elements, shapes and colours are
positioned and balanced aesthetically.  It is informal
dynamic and modern.  This is the new typography.  It is
beautifully simple, elegant and logical.  It produces and
impression of rhythm and movement.

A major difference between the two kinds of balance lies in
the use of white space.  Space in a symmetrical balance
is a passive element.  Here space on the page serves only
as a background against which type elements are placed.

More importance is given to the elements or matter.  Each
line is centered with equal amount of white space on either
side.

Space has a dominant role in asymmetrical balance.  Here
there is a more interesting and unequal division of spaces
with contrasting shapes of elements.  It is a speciality of
asymmetrical balancing to use excess white space
surrounding the matter.  It will represent an object or
element clearly and boldly, with no object to detract from
it, or to divide the observers attention.  It concentrates the
attention of the reader to the focal point.

Space cannot be used at random.  Proper, artistic and
balanced usage of space can create a marvelous effect on
the reader.

Repetition

Repetition is a common technique used in typographic
design to improve the visual impact.  Repetition of elements
or units show only difference in space, the matter being the
same.  Hence it can be monotonous.

Repetition is commonly used in printing as a background
or tint.  The name of a firm, product, or even tickets,
currencies and bank notes generally use this principle to

improve the quality and maintain a unique identity.  In
advertisement, repetition is a common principle for attracting
the viewer and to emphasize the main idea.  In a book the
name is repeated on every page as running head for
maintaining the identity.  On packages and cartons also
the name of the firm or product is repeatedly used to attract
the readers and prospective buyers.

Repeated request or vision definitely creates an impact on
the viewer.  Thus the idea will remain longer in the mind and
later prompt him to action, i.e. to buy a product or to follow
an idea or message.

Movement

Every act of reading involves the sense of movement.  The
eye moves from left to right and from top to bottom.  The
designer devotes a considerable time to individual part of
his effort, but the reader tends to scan the total layout for
an overall impression.  Still it is important to consider the
eye movement and tendencies of the reader as he scans
a page, a spread of pages or advertisement.  Intermingling
of units of varying shape, size, tone, colour etc., causes
movement of eye from one position to the other; and the
important units striking the reader than the less important
ones.  It is up to the designer to place and position the units
creating effective movements.

To be able to judge the effectiveness of typographic
designs in the light of conventional styles rules it is
advisable to have atleast an elementary knowledge of the
principles of display.

This will enable one to judge where in his works conform or
fail to conform the accepted standards of design and art.  It
is only by such study, comparison, and experimentation
that improvement is possible.  During the actual work of
designing all these principles should arise to guide the
mind and hand of the designer or typographer.

Elements of design

Photographs

Photography was invented in the early 19th century, and
the photographic industry as such, began in 1870s.  The
advent of practical photography provided two vital factors in
the field of graphic arts.

The ability to produce a factual image of subject matter and

The ability to produce a printing plate-thereby eliminating
the necessity for the artist to work directly on the printing
plate.  When type and crude woodcuts were the only
printing materials available words were of primary
importance.  Then for a long time the primary visual
treatment was hand drawn illustrations.  Gradually
photography and its reproductive techniques advanced and
it began to assume a more important role.

Advantages:

Photographs present the message in a codified form

It gives a factual documentation of the subject

It helps all methods of graphic reproduction
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Special effects can be brought about to convey a message
more effectively

It makes design production quicker, simpler and economic
Photographs can vividly and directly translate the idea from
picture to the mind of the viewer.

Enlargement, reduction, special effects, tinting etc. are
made possible in design production.

In modern printing photographs have helped the emergence
of the picture magazines and even picturesque daily
newspapers.  Thus the impact of photo-journalism and their
influence changed the face of existing publication.  The
revolution existing to almost every form of visual presentation
such as advertising, book newspaper, direct mail, hoardings
and so on.  Digital imaging has also brought in tremendous
improvements in the use of photographs in graphic
reproduction.

Enlargement and reduction

Computer adaptation in the printing industry has made
enlargement and reduction of any material instantaneous
at the click of a mouse.  Yet it is good to understand the
basic principles involved in the proportionate enlargement
or reduction.

The proportionate enlargement or reduction of a photograph
or illustration lies along its diagonal.

A photograph may be enlarged to any desired size by
drawing a diagonal line on the translucent cover sheet
placed over it.  Extend the diagonal line from the left hand
top to the right-hand bottom of the sheet across the image.
The diagonal will mark the point where the side edges of the
enlargement or reduction intersect.

Select the desired height or width and draw a straight line
from one edge to the other; where this line meets the
diagonal line will mark the cross line of the other dimension.

clarity and sometimes introduce illusory dimension to the
drawing or illustration.  But they should not be used merely
of confusion.

Texture

Texture or pattern can be created in different methods.
Patterned pen or brush stokes, special shaded films or
papers, pattern screens, etc. are some of the equipments
that have been designed to aid in the rendering of such
tonality and texture.  These are not used at random, but to
create a desired, effect in the mind of reader for easy
communication.  A texture or tone, for example, can be
used to form transition between black and white areas in
line drawing.

Photography

Photography and its techniques are widely used today in
design production along with text matter.  The following are
some of the common techniques that are employed today:

Black and white conversion, conversion of a continuous
tones; also called posterization.

Line conversion

Usage of single line screen, vertical, horizontal or concentric
mezzo tint screen, creating a random grain pattern.

Coarse dot screen

Due tone, two half tone plates are made for each colour at
two different angles and printed.

Fake due tone printing a colored tint behind a black
halftone, the screen tint being uniform

While using these aids care should be taken that the
figures do not loose their identity.  Modern computers
provide tools and operations for special effects in
photographs.

Drawing

Drawing supplements the designers work in the illustrations.
Without drawing there cannot be design and printing.
Artists employ various equipments to get drawing with
special finish; pen, nip, air-brush etc.  A drawing can be
continuous tone, fully line drawing and sometimes
combination of both line and continuous tone.

A continuous tone is the gradual flow of one tone into
another known as blending.  This can be in black and white
or in colour.  Pencil, pastel and wash drawing, oil painting
or acrylic paintings.  All fall in this category.  Full line work
is easy for reproduction, like cartoons, lettering, borders,
decorations etc.  A combination drawing has both line and
tone elements.  So it has to be printed partially as line and
partially as halftone.

"One picture is worth a thousand words," it is said.
Illustration explicitates and amplifies communication.
Illustrate people or people of low educational standards and
even those who cannot follow a particular language is able
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to understand easily the idea or message intended from an
illustration.  An illustration makes the design effective, self
explanatory and free from doubt.  Illustration has an instant
impact and lasting effect than a mere type matter.  Hence
children's books are illustrated in multi-colours.  It can
explain things which cannot be described by words.  Strip
cartoon is a very good example of effective use of illustration,
used even to communicate serious messages.

Illustrations in modern advertisements and posters are
effective selling agents.  Attractive illustrations of models
and objects make the advertisement vivid and
communication quicker.  A pictorial element on a poster
allows far greater latitude for conveying the idea than does
the lettering alone.  Sometimes pictures may represent
something old or fantastic or even absurd; such as a little
mouse chasing a lion, a lion smoking a cigar etc, with an
element of surprise.  If anything that is primarily for a "quick
look" audience, it must be designed with the aid of
illustration to arrest the attention by sheer visual impact.

Illustration in design

Picture is assuming more meaning and has become
inseparable from words.  Illustrations form part of the text
and indeed it is a close companion of printed word, we can
say.  From the history of typography itself there was an
evolution of the typographic methods of illustration from
woodcut to lithography, form lithography to planography
and to the digital graphic reproduction methods.  Today the
modern lithographic aided printing stands a boon to the
abundant use of illustrations in multi colours to convey the
message in the most effective manner.

Type, illustration and decoration and their relationship

Type, illustration and decoration are the three basic
components of any printed matter.  Types translate the
communication from idea to a visible form: illustration
makes it vivid, while ornaments stand as secondary
elements to beautify the printed matter.  Each one has its
role to play.  But it requires great ingenuity and care to
achieve maximum effect out of each, by using them in
harmony and mutual agreement.

Type

Typography has grown so much that it can translate any
idea into type.  The characters displayed today in everything,
from hand bills to bill boards, reveal the extraordinary
versatility of letter forms.  They are available in so many
varieties, degrees and combinations of spirit, timeliness
and even sex.  Some are easy to read and convey the
message meaning with its peculiar look and form.  Others
are strikingly different and ornamental.  Some depict bold
and manly characters, while the others are tender, delicate
and feminine.  They are designed to achieve all sorts of
effects.  The great variety and versatility of typography
demands a real knowledge about it and its appropriate use
in agreements with the rest of the elements with the rest of
the elements in the matter, considering the subject, scope,
the readers, their age group, the time of publication etc.

Illustration

Appropriate use of illustration can amplify the communication
and convey the message quickly.  Illustration makes the
type matter fully comprehensible and useful.  But the
problem lies in the technique of arranging the text and
picture as a flowing and continuous story.  This requires
great care and an aesthetic mind.  It is not enough that the
picture agrees with the type matter as far as its message
is concerned.  An illustration should agree with the text in
its tone, texture, balance and style.

Decorations

Ornaments and borders are decorative elements.  They
have useful purpose in typographic design, though they are
only secondary or supplementary elements.  They can
attract attention, catch the eye of the reader and can unify
individual unites into a whole.  Decoration apart from the
above function can also stand for a particular time, period
and history.

Decoration for the sake of decoration will mar the beauty
instead of making it.  A decoration should be used only if
it adds to the effectiveness of the printed message.  Modern
use of decoration is limited to simple rules, lines and light
borders.  Simplicity is the style of the day.

Only a skilled and imaginative designer can use types,
illustration and decorative elements in perfect harmony to
deliver the message of the piece and to interpret the them
to suit the aim of the printed item.  Type should be chosen
to suit the purpose of the other two items, illustration and
decoration.  And they should be in sympathy with the type
matter too.

Decorative elements

Text composition is designed for sustained for reading and
display composition for reading at a glance.  The selection
and arrangement of type for display differs in function, and
for mechanical reasons the technique of display composition
is often different from that of text design.  The very term
'display' suggests an element of show, or of decoration.
The best display work is that which fulfills the primary
object of all typography, communication and in addition is
touched (but not too heavily) with creative originality.  So
decorative elements are common in display works.

Decorative material is of several kinds.  Rules of several
varieties such as thick, thin, diamond, hyphen, wavy,
dotted or even other fancy rules, borders and ornaments
can be used to obtain special effects.

Rules are strips which print a straight line, and which may
be cast or cut to any length without affecting the design.
Plain rules, which print a single, uninterrupted straight line,
may be almost of any thickness.  A few rules are of hair-
line thickness.  Next in thickness is a column-face rule,
normally used to separate columns of text when two or
more stand side by side.  A medium rule is a point across
the printing surface, and thereafter rules are quite closely
graduated in size.  The body of a rule is usually not less
than 1.5 point, so that rules set side by side have some
space between them.
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A border is a repeated decorative design.  The origin of
some of these designs are centuries old.  Others which are
all too rarely used, have a genuinely modern appearance.
Border units tend to be unimpressive when seen singly in
a specimen book; but the most astonishing patterns can
result from an imaginative use of them.

The most neglected source of decoration for books is the
skill and invention of the graphic artist.  Display lines can
be written by a calligrapher; border, and rules drawn by
hand by an artist with a talent for decoration or from a
computer task bar.

Decorative elements can serve many useful purpose if they
are used effectively.

They attract the attention, giving the other elements
together to deliver the message well.

Give unity and individuality to a type composition, for
example, a border acts as a frame around the display and
brings the scattered elements into the picture.

They have a decorative and illustrative value.

They can create an atmosphere and mood peculiar to
them.

They can illustrate a period and historical or periodic
motifs.

They balance and counter balance in the placement of
various elements in a layout.

Computer Graphics
Computer Graphics are classified into three types Vector
Graphics, Raster Graphics and Encapsulated Post Script
Files. In Vector Graphics Illustrations are formed using
geometric shapes or mathematical expressions. The illus-
trations in Vector Graphics are also known as Drawings,
Objects or Line arts.
CorelDraw
CorelDRAW is a vector graphics editor developed and
marketed by Corel Corporation,Canada. It is also the name
of Corel's Graphics Suite, which bundles CorelDraw with a
bitmap image editor, Corel PhotoPaint, and other graphics-
related programs. The latest version is designated X6
(equivalent to version 16), and was released in March 2012.
History
In 1987, Corel hired software engineers Michel Bouillon and
Pat Beirne to develop a vector-based illustration program to
bundle with their desktop publishing systems. That pro-
gram, CorelDRAW, was initially released in 1989.
CorelDRAW 1.x and 2.x runs under Windows 2.x and 3.0.
CorelDRAW 3.0 came into its own with Microsoft's release
of Windows 3.1. The inclusion of TrueType in Windows 3.1
transformed CorelDRAW into a serious illustration pro-
gram capable of using system-installed outline fonts with-
out requiring third-party software such as Adobe Type
Manager; paired with a photo editing program (PhotoPaint),
a font manager and several other pieces of software, it was
also part of the first all-in-one graphics suite.

Features
Supported Platforms
CorelDRAW was originally developed for Microsoft Win-
dows 3 and currently runs on Windows XP, Windows Vista,
and Windows 7.[26] The current version, X6, was released
on 20 March 2012.
Versions for Mac OS and Mac OS X were at one time
available, but due to poor sales these were discontinued.
The last port for Linux was version 9 (released in 2000, it
didn't run natively; instead, it used a modified version of
Wine to run) and the last version for OS X was version 11
(released in 2001). Also, up until version 5, CorelDRAW
was developed for Windows 3.1x, CTOSand OS/2.
Problems installing or running older versions of Corel Draw
under Windows 7 may be overcome by using Microsoft's
"Troubleshoot Compatibility" - right-click on the setup.exe
file on the installation disk to select this facility (tested on
version 12 with Windows 7, where previous attempts
without Microsoft "Troubleshoot Compatibility" failed).
Characteristic features
Several innovations to vector-based illustration originated
with CorelDRAW: a node-edit tool that operates differently
on different objects, fit text-to-path, stroke-before-fill, quick
fill/stroke color selection palettes, perspective projections,
mesh fills and complex gradient fills.
CorelDRAW differentiates itself from its competitors in a
number of ways:
The first is its positioning as a graphics suite, rather than
just a vector graphics program. A full range of editing tools
allow the user to adjust contrast, color balance, change the
format from RGBto CMYK, add special effects such as
vignettes and special borders to bitmaps. Bitmaps can
also be edited more extensively using Corel PhotoPaint,
opening the bitmap directly from CorelDRAW and returning
to the program after saving. It also allows a laser to cut out
any drawings.
CorelDRAW is capable of handling multiple pages along
with multiple master layers. Multipage documents are
easy to create and edit and the Corel print engine allows for
booklet and other imposition so even simple printers can be
used for producing finished documents. One of the useful
features for single and multi-page documents is the ability
to create linked text boxes across documents that can be
resized and moved while the text itself resets and flows
through the boxes. Useful for creating and editing multi-
article newsletters etc.
Smaller items, like business cards, invitations etc., can be
designed to their final page size and imposed to the
printer's sheet size for cost-effective printing. An additional
print-merge feature (using a spreadsheet or text merge file)
allows full personalization for many things like numbered
raffle tickets, individual invitations, membership cards and
more.
CorelDRAW's competitors include Adobe Illustrator and
Xara Photo & Graphic Designer. Although all of these are
vector-based illustration programs, the user experience
differs greatly between them. While these programs will
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read their native file types and vice versa, the translation is
rarely perfect. CorelDRAW can open Adobe PDF files:
Adobe PageMaker, Microsoft Publisher and Word, and
other programs can print documents to PDF using the
Adobe PDFWriter printer driver, which CorelDRAW can
then open and edit every aspect of the original layout and
design. CorelDRAW can also open PowerPoint Presenta-
tions and other Microsoft Office formats with little or no
problem.
CorelDraw Graphic Suite
Over time, additional components were developed or ac-
quired and bundled with CorelDRAW. The list of bundled
packages usually changes somewhat from one release to
the next, though there are several mainstays that have
remained in the package for many releases now, including
PowerTRACE (a bitmap to vector graphic converter), PHOTO-
PAINT (a bitmap graphic editor), and CAPTURE (a screen
capture utility).
The current version of CorelDRAW Graphics Suite X6
(version 16), contains the following packages:

• CorelDRAW X6, an intuitive vector-illustration and page-
layout application

• Corel PHOTO-PAINT X6, an image-editing application

• Corel PowerTRACE X6, a utility to convert bitmaps into
editable vector graphics

• Corel CONNECT, a full-screen browser to search the
suite's digital content

• Corel CAPTURE X6, a screen capture utility

• Corel Website Creator X6, new website creation soft-
ware

CDR file Format
CDR file format is a proprietary file format developed by
Corel Corporation and primarily used for vector graphic
drawings. There is no publicly available CDR file format
specification.
Other CorelDRAW file formats include CorelDRAW Com-
pressed (CDX), CorelDRAW Template (CDT) and Corel
Presentation Exchange (CMX).
In December 2006 the sK1 open source project team
started to reverse-engineer the CDR format. The results
and the first working snapshot of the CDR importer were
presented at the Libre Graphics Meeting 2007 conference
taking place in May 2007 in Montreal (Canada). Later on
the team parsed the structure of other Corel formats with
the help of the open source CDR Explorer. As of 2008, the
sK1 project claims to have the best import support for
CorelDRAW file formats among open source software
programs. The sK1 project developed also the UniConvertor,
a command line open source tool which supports conver-
sion from CorelDRAW ver.7-X4 formats (CDR/CDT/CCX/
CDRX/CMX) to other formats. UniConvertor is also used in
Inkscape and Scribus open source projects as an external
tool for CorelDRAW files importing.

In 2007, Microsoft blocked CDR file format in Microsoft
Office 2003 with the release of Service Pack 3 for Office
2003. Microsoft later apologized for inaccurately blaming
the CDR file format and other formats for security problems
in Microsoft Office and released some tools for solving this
problem.
In 2012 the joint LibreOffice/re-lab team implemented
libcdr, a library for reading CDR files from v1 to the currently
latest X6 version and CMX files. The library has extensive
support for shapes and their properties, including support
for color management and spot colors, and has a basic
support for text. The library provides a built-in converter to
SVG, and a converter to OpenDocument is provided by
writerperfect package. The libcdr library is expected to be
used in LibreOffice 3.6, and thanks to public API it can be
freely used by other applications.
Support in other applications
CDR file format import is partially or fully supported in
following applications:

• Adobe Illustrator

• CorelDraw 5, 6, 7, 8, 9, 10

• Corel PaintShop Photo Pro

• Corel WordPerfect Office

• Inkscape with UniConvertor installed; partial support

• LibreOffice with libcdr installed - CorelDraw 1 to X6

• Macromedia Freehand - CorelDraw 7, 8

• Microsoft Visio 2002 - CorelDRAW! Drawing File ver-
sions 3.0, 4.0, 5.0, 6.0 and 7.0 (.cdr),

• Corel Clipart (.cmx)

• sK1 - partial support

• Xara Designer Pro and Xara Photo & Graphic Designer
- early versions of CorelDRAW CDR and CMX

The pre-requisite to install Corel Draw
CorelDRAW is an intuitive and versatile graphics applica-
tion for creating high-quality vector illustrations, logo de-
signs, and page layouts.
System Requirements
Microsoft® Windows® 7, Windows Vista®, Windows®
XP, with latest service packs installed (32-bit or 64-bit
editions)
Intel® Pentium® 4, AMD Athlon™ 64 or AMD Opteron™
512 MB RAM (1 GB recommended)
750 MB hard disk space (1 GB for typical installation
without content). Up to 6GB needed to install extra content
Mouse or tablet
1024 x 768 screen resolution (768 x 1024 on a Tablet PC)
DVD drive
Microsoft® Internet Explorer® 7 or higher

IT&ITES: DTPO - Related Theory for Exercise 2.2.01



104

Installing CorelDRAW Graphics Suite applications
The installation wizard makes it easy to install CorelDRAW
Graphics Suite applications and components. You can
choose a typical installation to quickly install the suite, or
you can customize the installation by choosing different
options.
MODIFY the current installation by adding or deleting
components

REPAIR the current installation by reinstalling all applica-
tion features

UNINSTALLCorelDRAW Graphics Suite

Repairing an installation is helpful when you encounter
problems in using the application, or when you suspect
that the installation is corrupt. Before repairing an installa-
tion, try resetting the current workspace to the default
settings by holding down F8 while starting the application.

Changing startup settings

You can specify the startup settings for CorelDRAW,
which control how the application appears when it's opened.
For example, you can start the application with the
Welcome screen open or a new blank document.

Registering Corel products

Registering Corel products is important. Registration pro-

vides you with timely access to the latest product updates,
valuable information about product releases, and access to
free downloads, articles, tips and tricks, and special offers.

You can register in one of the following ways:

online - If you are connected to the Internet, you can start
online registration when you start the Corel graphics
application. You can also register online at a later date by
clicking Help Registration. If no Internet connection is
detected, a list of options appears in a dialog box.

Updating Corel products

During product installation, you can choose the option to
download product updates and service packs. After install-
ing the product, you can view information about product
updates by clicking Help Updates.

By default, you are automatically notified when product
updates and news become available. In addition, the
application automatically downloads new product updates
and asks you for permission to install them. However, you
can change the update settings at any time.

Explain the CorelDraw workspace window

CorelDRAW terms

Before you get started with CorelDRAW, you should be
familiar with the following terms.

Term Description

Object An element in a drawing such as an image, shape, line, text, curve, symbol, or layer

Drawing The work you create in CorelDRAW; for example, custom artwork, logos, posters, and
newsletters

Vector graphic An image generated from mathematical descriptions that determine the position, length, and
direction in which lines are drawn

Bitmap An image composed of grids of pixels or dots

Docker A window that contains available commands and settings relevant to a specific tool or task

Flyout A button that opens a group of related tools or menu items

List box A list of options that drops down when a user clicks the down arrow button

Artistic text A type of text to which you can apply special effects, such as shadows

Paragraph text A type of text to which you can apply formatting options, and which can be edited in large blocks

Application window

When you launch CorelDRAW, the application window
opens containing a drawing window. Although more than
one drawing window can be opened, you can apply
commands to the active drawing window only.

The CorelDRAW application window appears below.

Circled numbers correspond to the numbers in the follow-
ing table, which describes the main components of the
application window.
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Fig 2

Part Description

1. Toolbox A docked bar with tools for creating, filling, and modifying objects in the drawing

2. Title bar The area displaying the title of the currently open drawing

3. Menu bar The area containing pull-down menu options

4. Toolbar A detachable bar that contains shortcuts to menu and other commands

5. Drawing window The area outside the drawing page bordered by the scroll bars and application
controls

6. Property bar A detachable bar with commands that relate to the active tool or object. For example,
when the text tool is active, the text property bar displays commands that create and
edit text.

7. Docker A window containing available commands and settings relevant to a specific tool or
task

8. Rulers Horizontal and vertical borders that are used to determine the size and position of
objects in a drawing

9. Document navigator The area at the bottom left of the application window that contains controls for moving
between pages and adding pages

10. Drawing page The rectangular area inside the drawing window. It is the printable area of your work
area.

11. Status bar An area at the bottom of the application window that contains information about object
properties such as type, size, colour, fill, and resolution. The status bar also shows
the current cursor position.

12. Navigator A button at the lower-right corner that opens a smaller display to help you move
around a drawing

13. Colour palette A dockable bar that contains colour swatches

The CorelDraw workspace tools

Workspace tools

Application commands are accessible through the menu
bar, toolbars, toolbox, property bar, and dockers. The
property bar and dockers provide access to commands
that relate to the active tool or current task. The property
bar, dockers, toolbars, and toolbox can be opened, closed,
and moved around your screen at any time.

You can customize many of these workspace tools to suit
your needs.

The standard toolbar, which appears by default, contains
buttons and controls that are shortcuts to many of the
menu commands.
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Click  this To
button

Start a new drawing

Open a drawing

Save a drawing

Print a drawing

Cut selected objects to the Clipboard

Copy selected objects to the Clipboard

Paste the Clipboard contents into a
drawing

Undo an action

Restore an action that was undone

Import a drawing

Click this To
button

 Export a drawing

 Start Corel applications

 Open the Welcome screen

  Set a zoom level

Enable or disable automatic

alignment for the grid, guidelines,
objects, and dynamic guides

Open the Options dialog box

More about toolbars

In addition to the standard toolbar, CorelDRAW has toolbars
for specific kinds of tasks. For example, the Text toolbar
contains commands relevant to using the Text tool. If you
use a toolbar frequently, you can display it in the workspace
at all times.

The following table describes toolbars other than the
standard toolbar.

Toolbar Description

Text Contains commands for formatting and aligning text

Zoom Contains commands for zooming in and out of a drawing page by specifying percentage of
original view, clicking the Zoom tool, and selecting a page view

Internet Contains commands for Web-related tools for creating rollovers and publishing to the Internet

Print merge Contains commands for print merge items that combine text with a drawing such as creating
and loading data files, creating data fields for variable text, and inserting print merge fields

Transform Contains commands for skewing, rotating, and mirroring objects

Macros Contains commands for editing, testing, and running macros

Exploring the toolbox

The toolbox contains tools for drawing and editing images.
Some of the tools are visible by default, while others are
grouped in fly-outs. Fly-outs open to display a set of related
CorelDRAW tools. A small fly-out arrow in the lower-right
corner of a toolbox button indicates a fly-out. You can
access the tools in a fly-out by clicking the fly-out arrow.
After you open a fly-out, you can easily scan the contents
of other fly-outs by hovering over any of the toolbox buttons
which have fly-out arrows. Fly-outs function like toolbars
when you drag them away from the toolbox. This lets you
view all the related tools while you work.

Fig 3

In the default workspace, clicking the fly-out arrow on the
Shape tool opens the Shape edit fly-out.
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Pick tool

The Pick tool lets you select, size, skew, and rotate objects.      

Shape edit tools
The Shape tool lets you edit the shape of objects.

The Smudge brush tool lets you distort a vector object by dragging along
its outline.

The Roughen brush tool lets you distort the outline of a vector object by
dragging along the outline.

The Transform tool lets you transform an object by using the Free rotation,
Freeangle reflection, Free scale, and Free skew tools.

Crop tools

The Crop tool lets you remove unwanted areas in objects.

The Knife tool lets you cut through objects.

The Eraser tool lets you remove areas of your drawing.

The Virtual segment delete tool lets you delete portions of objects that
are between intersections.

Zoom tools

The Zoom tool lets you change the magnification level in the drawing window.

The Pan tool lets you control which part of the drawing is visible in the drawing
window.
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Curve tools

The Freehand tool lets you draw single line segments and curves.

The 2-point line tool lets you draw a straight two-point line segment.

The Bézier tool lets you draw curves one segment at a time.

The Artistic media tool provides access to the Brush, Sprayer, Calligraphic,
and Pressure tools.

The Pen tool lets you draw curves one segment at a time.

The B-spline tool lets you draw curved lines by setting control points that shape
the curve without breaking it into segments.

The Polyline tool lets you draw lines and curves in preview mode.

The 3-point curve tool lets you draw a curve by defining the start, end, and
center points.

Smart tools

The Smart fill tool lets you create objects from enclosed areas and then apply
a fill to those objects.

The Smart drawing tool converts your freehand strokes to basic shapes and
smoothed curves.

Rectangle tools

The Rectangle tool lets you draw rectangles and squares.

The 3-point rectangle tool lets you draw rectangles at an angle.

Ellipse tools

The Ellipse tool lets you draw ellipses and circles.

The 3-point ellipse tool lets you draw ellipses at an angle.
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Basic Shapes tools

The Basic shapes tool lets you choose from a full set of shapes, including
hexagram, a smiley face, and a right-angle triangle.

The Arrow shapes tool lets you draw arrows of various shape, direction, and
number of heads.

The Flowchart shapes tool lets you draw flowchart symbols.

The Banner shapes tool lets you draw ribbon objects and explosion shapes.

The Callout shapes tool lets you draw callouts and labels.

Object tools

The Polygon tool lets you draw symmetrical polygons and stars.

The Star tool lets you draw perfect stars.

The Complex star tool lets you draw complex stars that have intersecting
sides.

The Graph paper tool lets you draw a grid of lines similar to that on graph
paper.

The Spiral tool lets you draw symmetrical and logarithmic spirals.

Text tool

The Text tool lets you type words directly on the screen as artistic or paragraph
text.

Table tool

The Table tool lets you draw and edit tables.
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Dimension tools

The Parallel dimension tool lets you draw slanted dimension lines.

The Horizontal or vertical dimension tool lets you draw horizontal or vertical
dimension lines.

The Angular dimension tool lets you draw angular dimension lines.

The Segment dimension tool lets you display the distance between end
nodes in single or multiple segments.

The 3-point callout tool lets you draw a callout with a three-segment leader
line.

Connector tools

The Straight-line connector tool lets you draw a straight connector line.

The Right-angle connector tool lets you draw a right angle connector line.

The Right-angle round connector tool lets you draw a right-angle connector
line with curved corners.

The Edit anchor tool lets you modify connector line anchor points.

Interactive tools

The Blend tool lets you blend two objects.

The Contour tool lets you apply a contour to an object.

The Distort tool lets you apply a Push or Pull distortion, a Zipper distortion,   or
a Twister distortion to an object.

The Drop shadow tool lets you apply a drop shadow to an object.

The Envelope tool lets you shape an object by dragging the nodes of the
envelope.
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The Extrude tool lets you apply the illusion of depth to objects.

The Transparency tool lets you apply transparencies to objects.

Eyedropper tools

The Color eyedropper tool lets you select and copy a color from an object on the
drawing window or the desktop.

The Attributes eyedropper tool lets you select and copy object properties, such
as line thickness, size and effects, from an object on the drawing window.

Outline tool

The Outline tool opens a flyout that gives you quick access to items such as the
Outline pen dialog box and Outline color dialog box.

Fill tool

The Fill tool opens a flyout that gives you quick access to items such as the fill
dialog boxes.

Interactive fill tools

The Interactive fill tool lets you apply various fills.

The Mesh fill tool lets you apply a mesh grid to an object.

Property bar

The property bar displays the most commonly used
functions that are relevant to the active tool or to the task
you're performing. Although it looks like a toolbar, the
property bar content changes depending on the tool or
task.

For example, when you click the Text tool in the toolbox,
the property bar displays text-related commands. In the
example below, the property bar displays text, formatting,
alignment, and editing tools.

Dockers

Dockers display the same types of controls as a dialog
box, such as command buttons, options, and list boxes.
Unlike most dialog boxes, you can keep dockers open
while working on a document, so you can readily access
the commands to experiment with different effects. Dock-
ers have features similar to palettes in other graphics
programs. To access a docker, click Window Dockers,
and click a docker.
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An example is the Object properties docker. When this
docker is open, you can click an object in the drawing
window and view formatting, dimensions, and other proper-
ties of the object

Dockers can be either docked or floating. Docking a docker
attaches it to the edge of the application window. Undock-
ing a docker detaches it from other parts of the workspace,
so it can be easily moved around. You can also collapse
dockers to save screen space.

If you open several dockers, they usually appear nested,
with only one docker fully displayed. You can quickly
display a docker hidden from view by clicking the docker's
tab.

Use a template for drawing designs that you want to reuse.

You can use the default template or choose one from a wide
variety of preset templates available in the application.

starting new drawings

When starting a new drawing, CorelDRAW lets you specify
page, document, and colour management settings. You
can choose from a list of preset settings, which are based
on how you intend to use the drawing. For example, you
can choose the Web option if you are creating a drawing for
the Internet or the Default CMYK option if you are creating
a document destined for commercial printing. However, if
the preset settings are not suitable for the drawing that you
want to create, you can also customize the settings and
save them for future use.

Working with lines, outlines, and brushstrokes

CorelDRAW lets you add lines and brushstrokes by using
a variety of techniques and tools. After you draw lines or
apply brushstrokes to lines, you can format them. You can
also format the outlines that surround objects.

CorelDRAW provides preset objects that you can spray
along a line. You can also create flow and dimension lines
in drawings. You can also draw lines by using shape
recognition.

Drawing lines

A line is a path between two points. Lines can consist of
multiple segments, and the line segments can be curved
or straight. The line segments are connected by nodes,
which are depicted as small squares. CorelDRAW pro-
vides various drawing tools that let you draw curved and
straight lines, and lines containing both curved and straight
segments.

Freehand and Polyline tools

The Freehand  and Polyline  tools  let you draw
freehand lines as if you were sketching on a sketchpad. If
you make a mistake while drawing freehand curves, you
can erase the unwanted part immediately and continue
drawing. When drawing straight lines or segments, you
can constrain them to straight vertical or horizontal lines.

The Freehand  tool  lets you control the smoothness
of the curved line you are drawing as well as add segments
to an existing line. However, the Polyline  tool  is
easier to use for quickly drawing a complex line that
consists of alternating curved and straight segments.

Left: Docked and nested dockers. Right: A floating docker.
To dock a floating docker, click the docker's title bar, and
drag to position the pointer on the edge of the drawing
window. To close a docker, click the X button at the top
corner; to collapse or expand a docker, click the arrow
button at the top corner.

Status bar

The status bar displays information about selected objects
(such as color, fill type, and outline, cursor position, and
relevant commands). It also displays document color
information, such as the document color profile and color
proofing status.

State the option to create New document

Starting and opening drawings

CorelDRAW lets you start a new drawing from a blank
page, a template, or an existing drawing. A blank page
gives you the freedom to specify every aspect of a drawing.
A template provides you with a starting point and leaves the
amount of customization up to you.

Working with templates

A template is a collection of styles and page layout
settings that govern the layout and appearance of a
drawing. Templates are sometimes referred to as "tem-
plets."
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You can choose settings to control how the Freehand  

and Bézier  tools behave. For example, you can
change the default smoothness of a curved line that you've
created with these tools.

State the option to saving the document

Saving drawings

By default, drawings are saved to the CorelDRAW file
format (CDR) and are compatible with the latest version of
the application. You can also save a drawing that is
compatible with an earlier version of CorelDRAW Graphics
Suite.

You can save a drawing to other vector file formats as well.
If you want to use a drawing in another application, you
must save it to a file format that is supported by that
application.

Exporting files

You can use the File → Export command to export files to
a variety of bitmap and vector file formats that can be used
in other applications. For example, you can export a file to
the Adobe Illustrator (AI) or GIF format. You can also export
a file so that it is optimized for use with a suite of office
productivity applications, such as Microsoft Word or Corel
WordPerfect Office.

When you are exporting a file, the original file is left open
in the drawing window in its existing format.

You can use the File → Save as command to save files to
various vector formats. After you save a file to a different
format, the saved file is displayed immediately in the
drawing window. It is recommended that you first save the
file as a CorelDRAW (CDR) file because some file formats
do not support all of the features found in a CorelDRAW file.

When you save a drawing, CorelDRAW lets you add
reference information so that you can easily find and
organize drawings later on. On Windows 7 and Windows
Vista, you can attach tags (also known as properties) such
as title, subject, and rating. On Windows XP, you can
assign notes and keywords to a drawing.

If your drawing will be viewed on a system that does not
have all of the fonts used in the drawing, you can embed all
fonts to ensure that text will appear as originally created.

You can also save selected objects in a drawing. For large
drawings, saving only the selected objects reduces the file
size, which can decrease the time it takes to load the
drawing.

When saving a file, you can use advanced options to
control how bitmaps, textures, and vector effects, such as
blends and extrusions, are saved with the drawing.

You can also save a drawing as a template, which lets you
create other drawings with the same properties.

You can also

Save only selected objects With objects selected, click File Save as, and enable the Selected only
check box. Locate the folder where you want to save the file, type a filename
in the File name list box, and click Save.

Add reference information Do any the following:
(Windows 7 and Windows Vista) •    Type a title, subject, tag, comment, author, or

     revision number in the corresponding box.
•    Assign a rating to the file.
•    Add copyright information.

Save notes or keywords with Type notes or keywords in the corresponding box.
the file (Windows XP)

Embed fonts in a drawing Enable the Embed fonts using TrueDoc check box.
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Opening existing drawings

Basing a new drawing on an existing drawing lets you reuse
objects and page settings. CorelDRAW lets you open
existing drawings saved to the CorelDRAW (CDR) format
as well as drawings and projects saved to various file
formats such as Corel DESIGNER (DSF or DES), Adobe
Illustrator (AI), Adobe Portable Document Format (PDF),
Encapsulated PostScript (EPS), and Computer Graphics
Metafile (CGM). However, you may not be able to open
certain files, depending on their file type and contents. In
such cases, you can try importing the files as objects in an
open drawing.

Supported file formats

A file format defines how an application stores information
in a file. If you want to use a file created in a different
application than the one you are currently using, you must
import that file. Conversely, if you create a file in one
application and want to use it in another application, you
must export the file to a different file format.

When you name a file, an application automatically ap-
pends a filename extension, usually three characters in
length (for example, .cdr, .bmp, .tif, and .eps). This
filename extension helps you and the computer differenti-
ate between files of different formats.

The following list includes all file formats used in this
application. Note that not all file format filters are installed
by default. If you cannot export or import a file from the list,
you need to update your installation of CorelDRAW Graph-
ics Suite X5.

Adobe Illustrator (AI)
Adobe Type 1 Font (PFB)
Windows Bitmap (BMP)
OS/2 Bitmap (BMP)
Computer Graphics Metafile (CGM)
Visio (VSD
CorelDRAW (CDR)
Corel Presentation Exchange (CMX)
Corel PHOTO-PAINT (CPT)
Corel Symbol Library (CSL)
Cursor Resource (CUR)
Cursor Resource (CUR)
Microsoft Word (DOC, DOCX, or RTF)
Microsoft Publisher (PUB)
Corel DESIGNER (DES, DSF, DS4, or DRW)

IT & ITES
DTPO - Coral Draw                                      Related Theory for Exercise  2.2.02
Opening and editing the existing drawing in CorelDraw
Objectives : At the end of this lesson you shall be able to
• opening and editing the existing drawing
• explain the editing tools in the CorelDraw workspace window
• explain the printing options.

AutoCAD Drawing Database (DWG) and AutoCAD Draw-
ing Interchange Format (DXF)
Encapsulated PostScript (EPS)
PostScript (PS or PRN)
GIF
JPEG (JPG)
JPEG 2000 (JP2)
Kodak Photo CD Image (PCD)
PICT (PCT)
Paint Brush (PCX)
Adobe Portable Document Format (PDF)
HPGL Plotter File (PLT)
Portable Network Graphics (PNG)
Adobe Photoshop (PSD)
Corel Painter (RIF)
Scalable Vector Graphics (SVG)
Macromedia Flash (SWF)
TARGA (TGA)
TIFF
Corel Paint Shop Pro (PSP)
TrueType Font (TTF)
WordPerfect Document (WPD)
WordPerfect Graphic (WPG)
RAW camera file formats
Wavelet Compressed Bitmap (WI)
Windows Metafile Format (WMF)
Additional file formats
Recommended formats for importing graphics
Recommended formats for exporting graphics
General notes on importing text files

If you are using Windows 7 or Windows Vista, you can
search for drawings by different criteria, such as filename,
title, subject, author, keyword, comment, text within the
file, and other properties attached to the file. For more
information about searching for files with Windows 7 or
Windows Vista, see the Windows Help. If your operating
system is Windows XP, you can use Windows Desktop
Search to find files. For more information CorelDRAW Help
line Menu

You can also display previous versions of a drawing.



115

Explain the editing tools in the CorelDraw workspace
window

Pick tool

The Pick tool lets you select, resize, skew, and rotate
object

Selecting Object

Before you can change an object, you must select it. You
can select visible objects, objects that are hidden from view
by other objects, and a single object in a group or a nested
group. In addition, you can select objects in the order in
which they were created, select all objects at once, and
deselect objects.

A bounding box appears around a selected object, and an
"X" appears at its center.

To select objects
Select an object

Click the Pick tool, and then click an object.

Select multiple objects

Click the Pick tool, hold down Shift, and click each object
that you want to select.

Select an object while reviewing objects in the order
of their creation, starting with the first object created

Click the Pick tool, and then press Shift + Tab one or more
times, until a selection box appears around the object that
you want to select.

Select an object while reviewing objects in the order
of their creation, starting with the last object created

Click the Pick tool , and then press Tab one or more times,
until a selection box appears around the object that you
want to select.

Select all objects

Click Pick tool → Edit → Select all → Objects.

Select an object in a group

 Hold down Ctrl, click the Pick tool, and then click an object
in a group.

Select an object in a nested group

Hold down Ctrl, click the Pick tool, and then click an object
one or more times, until a selection box appears around it.

Select an object hidden from view by other objects

Hold down Alt, click the Pick tool, and then click the
topmost object one or more times, until a selection box
appears around the hidden object.

Select multiple hidden objects

Hold down Shift + Alt, click the Pick tool, and then click the
topmost object one or more times, until a selection box
appears around the hidden objects.

Select a hidden object in a group

Hold down Ctrl + Alt, click the Pick tool, and then click the
topmost object one or more times, until a selection box
appears around the hidden object.

You can also select one or more objects by
clicking the Pick tool and then dragging around
the object or objects. This method is known as
marquee selecting.

To deselect objects

Deselect all objects

Click the Pick tool, and click a blank space in the drawing
window.

Deselect a single object among multiple selected
objects

Hold down Shift, click the Pick tool, and then click the
object.

Transforming objects

You can change the appearance of objects in the drawing
window by using the following transformations.

Transformation

Sizing the object

Lets you change the width and height of an object

Scaling the object

Lets you size an object to a percentage of its original size.

Skewing the object

Lets you slant an object to one side.
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Stretching the object

Lets you change the height and width of an object
nonproportionally.

Rotating the object

Lets you turn an object around its center axis or a point
relative to its position.

Mirroring lets you create a horizontal or vertical mirror
image of an object.

Transforming objects interactively

You can transform an object interactively by using the
mouse and the Pick tool. This method is the quickest, but
it is not recommended if you want to transform an object
with precision.

Other methods for transforming objects

You can transform an object in any of the following ways:

• For more precise results, you can select an object with
the Pick tool and adjust settings on the property bar.
For example, you can specify a precise rotation angle
or specify the size of an object.

• The Transformation docker lets you transform objects
with precision and apply the transformation to the
duplicate of an object, which is created automatically.
This feature lets you experiment with transformations
without affecting the original object. You can access
the Transformation docker by clicking Arrange Trans-
formations and clicking a command.

• The Transform toolbar also lets you transform objects
with precision. You can access the Transform toolbar
by clicking Windows Toolbars Transform.

Each of these methods lets you apply transformations to
a single object or to multiple objects simultaneously.

Clearing and redoing transformations

All transformations can be simultaneously cleared at any
time.

Define Group

A set of objects that behaves as one unit. Operations you
perform on a group apply equally to each of its objects.

Grouping objects

When you group two or more objects, they are treated as
a single unit but retain their individual attributes. Grouping
lets you apply the same formatting, properties, and other
changes to all the objects within the group at the same
time. In addition, grouping helps prevent accidental changes
to the position of an object in relation to other objects. You
can also create nested groups by grouping together
existing groups.
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Single objects retain their attributes when they are
grouped.

You can add objects to or remove objects from a group, and
you can delete objects that are members of a group. You
can also edit a single object in a group without ungrouping
the objects. If you want to edit multiple objects in a group
at the same time, you must first ungroup the objects. If a
group contains nested groups, you can ungroup all objects
in the nested groups simultaneously.

You can create a nested group by selecting two or more
groups of objects and clicking Arrange → Group.

You can also group objects by clicking Window →
Dockers → Object manager and dragging the name of
an object in the Object manager docker over the name
of another object
You can also ungroup objects by clicking the Un-group
button on the property bar.
You can also ungroup all nested groups within a group
by clicking the Ungroup all button on the property bar.

Smart Drawing Tool

The Smart drawing tool converts your freehand strokes to
basic shapes and smoothed curves.

smoothed. Objects and curves drawn with shape recogni-
tion are editable. You can set the level at which CorelDRAW
recognizes shapes and converts them to objects. You can
also specify the amount of smoothing applied to curves.
You can set the amount of time to elapse between making
a pen stroke and the implementation of shape recognition.
For example, if the timer is set to one second and you draw
a circle, shape recognition takes effect one second after
you draw the circle.
You can make corrections as you draw. You can also
change the thickness and line style of a shape that was
drawn by using shape recognition.

Drawing by using shape recognition

You can use the Smart drawing tool to draw freehand
strokes that can be recognized and converted to basic
shapes. Rectangles and ellipses are translated to native
CorelDRAW objects; trapezoids and parallelograms are
translated to Perfect Shapes objects; lines, triangles,
squares, diamonds, circles, and arrows are translated to
curve objects. If an object is not converted to a shape, it is

Shapes created with the Smart drawing tool are recog-
nized and smoothed.

The Smart drawing tool property bar is displayed
only when the Smart drawing tool is selected.

When you overlap lines drawn with the Smart
drawing tool, the outline thickness is determined
by the average.

Printing your work

Using CorelDRAW, you can print one or more copies of the
same drawing. You can also specify the page type and the
page range that you want to print.

Before printing a drawing, you can specify printer proper-
ties, including paper size and device options. For example,
you can specify that the printer features such as duplexing
stapling.

Certain printers support the automatic matching of
page size and orientation. To enable this option,
you need to modify the driver compatibility set-
tings for the printer by clicking Tools Options. In the
list of categories, double-clicking Global, Printing,
clicking Driver compatibility, and enabling the
Printer can match document page sizes check
box. In the Print dialog box, you can then choose
Match orientation and size from the Page list box.

Laying out print jobs

You can lay out a print job by specifying the size, position,
and scale. Tiling a print job prints portions of each page on
separate sheets of paper that you can assemble into one
sheet. You would, for example, tile a print job that is larger
than your printer paper.

Previewing print jobs

You can preview your work to show how the position and
size of the print job will appear on paper. For a detailed view,
you can zoom in on an area. You can view how the
individual color separations will appear when printed.
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Before printing your work, you can view a summary of
issues for a print job to find potential printing problems. For
example, you can check the current print job for print
errors, possible print problems, and suggestions for resolv-
ing issues.

Applying print styles

A print style is a set of saved printing options. Each print
style is a separate file. This lets you move a print style from
one computer to another, back up a print style, and keep
document-specific styles in the same directory as the
document file.

You can select an existing print style, create a new print
style, or edit a print style and save the changes. You can
also delete print styles.

Fine-tuning print jobs

You can fine-tune print jobs before to ensure printing
quality. Because problems sometimes occur when you are
printing text to a non-PostScript printing device (GDI
printer), you can decrease printing time by specifying driver
compatibility for non-PostScript printing devices.

If a printing device has difficulty processing large bitmaps,
you can divide a bitmap into smaller, more manageable
chunks by setting an output threshold. If any lines appear
when the printing device prints the chunks, you can set an
overlap value to produce a seamless image.

On occasion, you may experience difficulties with printing
complex files. To print complex files, you may need to
spend a considerable amount of time fixing and correcting
the files. Another option is to convert a page to a bitmap,
which is also known as rasterizing, which can allow you to
print complex files.

To reduce file size, you can downsample bitmaps. Be-
cause bitmaps are made up of pixels, when you downsample
a bitmap, the number of pixels per line decreases, which
decreases the file size.

Printing colors accurately

CorelDRAW allows you to manage colors when printing to
help you ensure accurate color reproduction. You can print
the document with the document colors settings applied or
you can choose alternate color settings only for printing.
You can also print a document using the color proofing
settings that you previously specified in the Color proof
settings docker.

In addition, you can choose a rendering intent to effectively
interpret the out-of-gamut colors when printing. The render-
ing intent that you choose depends on the graphical
content of the document.

Notes for GDI printers

GDI printers support only two color spaces: RGB and
Grayscale. If your document contains colors from multiple
color spaces, for example RGB, CMYK, and spot colors,
you must convert all of the colors to RGB or Grayscale
before printing.

Printing to a PostScript printer

PostScript is a page-description language that sends
printing instructions to a PostScript device. All the ele-
ments in a print job (for example, curves and text) are
represented by lines of PostScript code that the printing
device uses to produce the document. For improved
compatibility you can choose a device independent
PostScript device. You can also select a PostScript
Printer Description (PPD) file. A PostScript Printer De-
scription file describes the capabilities and features of your
PostScript printer and is available from your printer's
manufacturer.

You can automatically increase the fountain steps in a
fountain fill to decrease banding. To ensure that your print
jobs print properly, you can also reduce curve complexity
by increasing flatness. Curve flatness determines how
smooth a curve appears when printed.

A print job that contains too many fonts may not print
properly, and a print job that contains too many spot colors
increases file size. You can set the PostScript options to
warn you when a print job contains more than a set number
of fonts or spot colors.

By default, the printing device driver downloads Type 1
fonts to the printing device. You can disable the Download
Type 1 Fonts option so that fonts are printed as graphics
(either curves or bitmaps). This may be useful when the file
contains many fonts that would take an unacceptably long
time to download or would fail to download because of their
file size. Bitmap versions of TrueType fonts look better in
small print and print faster than regular fonts. You can
choose the maximum number of bitmap fonts that a print
job can contain.

Working with imposition layouts

Working with imposition layouts lets you print more than
one page of a document on each sheet of paper. You can
choose a preset imposition layout to create documents
such as magazines and books to print on a commercial
printing press; produce documents that involve cutting or
folding, such as mailing labels, business cards, pam-
phlets, or greeting cards; or print multiple thumbnails of a
document on one page. You can also edit a preset
imposition layout to create your own layout.

You can select a binding method by choosing from three
preset binding methods, or you can customize a binding
method. When you choose a preset binding method, all but
the first signature are automatically arranged.

You can arrange pages on a signature manually or auto-
matically. When you arrange the pages automatically, you
can choose the angle of the image. If you have more than
one page across or down, you can specify the size of
gutters between pages; for example, you can choose the
automatic gutter spacing option, which sizes gutters so
that the document's pages fill the entire available space in
the layout.
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When printing on a desktop printer, you can adjust the
margins to accommodate the non-printable area of a page.
If the margin is smaller than the non-printable area, the
edges of some pages or some printers' marks may be
clipped by your printer.

Printing printers' marks

Printing printers' marks lets you display information on a
page about how a document should be printed. You can
specify the position of the printers' marks on the page.

The available printers' marks are as follows:

• Crop/fold marks - represent the size of the paper and
print at the corners of the page. You can print crop/fold
marks to use as guides to trim the paper. If you print
multiple pages per sheet (for example, two rows by two
columns), you can choose to print the crop/fold marks
on the outside edge of the page so that all crop/fold
marks are removed after the cropping process, or you
can choose to add crop marks around each row and
column. Crop/fold marks ensure that marks appear on
each plate of a separated CMYK file.

• Bleed limit - determines how far an image can extend
beyond the crop marks. When you use a bleed to
extend the print job to the edge of the page, you must
set a bleed limit. A bleed requires that the paper you are
printing on is larger than the size of paper you ultimately
want, and the print job must extend beyond the edge of
the final paper size.

• Registration marks - are required to line up film for
proofing or printing plates on a color press. They print
on each sheet of a color separation.

• Color calibration bars - are color scales that print on
each sheet of a color separation and ensure accurate
color reproduction. To see calibration bars, the page
size of the print job must be larger than the page size
of the work you are printing.

• Densitometer scale - is a series of gray boxes ranging
from light to dark. These boxes are required to test the
density of halftone images. You can position the den-
sitometer scale anywhere on the page. You can also
customize the levels of gray that appear in each of the
seven squares on the densitometer scale.

• Page numbers - helps you collate pages of an image
that do not include any page numbers or do not contain
page numbers that correspond to the actual number of
pages

• File information - prints file information, such as, the
color profile; halftone settings; name, date, and time the
image was created; plate number; and job name

Printing colour separations

When you send color work to a print service provider or
printing shop, either you or the print service provider must
create color separations. Color separations are necessary
because a typical printing press applies only one color of
ink at a time to a sheet of paper. You can specify the color
separations to print, including the order in which they print.

Printing presses produce color using either process color
or spot color, or both. You can convert the spot colors to
process colors at printing time.

When setting halftone screens to print color separations,
we recommend that you use default settings; otherwise,
screens can be improperly set and result in undesirable
moiré patterns and poor color reproduction. However, if you
are using an image-setter, the screen technology should
be set to match the type of image-setter the print service
provider uses. Before customizing a halftone screen,
consult the print service provider to determine the correct
setting.

If you have overprinted areas, you can choose how you
want those areas to print.

Working with color trapping and overprinting

When colors are trapped, they are intentionally overlapped
so that misalignments of print separations are not notice-
able. In manual trapping, one color must overprint the other.
Overprinting is achieved by printing one color over another.
Overprint trapping works best when the top color is much
darker than the underlying color; otherwise, an undesirable
third color may result (for example, cyan over yellow results
in a green object). In some cases, you might actually want
to create a third color; for example, you can overprint two
spot colors to create a third color.

How overprinted colors mix depends on the type of colors
and ink you are mixing and the types of objects you are
overprinting. For example, an object that uses a CMYK
color overprints differently from an object that uses a spot
color. Bitmaps also overprint differently from vector ob-
jects. You can preview a simulation of how overprinted
colors will mix by using the Enhanced with overprints
viewing mode.  Some variation between the preview and the
printed version may occur, depending on the printer you
use.

When you are ready to print, you can choose to preserve
overprint settings if you want to trap objects in a document,
or if you want to mix the overlapping colors for effect. You
can also choose to knock out the overprinted areas so that
only the top color is visible. If you want to print a proof
version of the file, you can simulate overprints. Simulating
overprints rasterizes the file, and it prints using process
colors only.

You can set a group of objects to overprint. You can
overprint bitmaps; or each vector object's fill, or outline, or
both. You can also overprint specific color separations and
specify in which order they will print, as well as whether you
want to overprint graphics, or text, or both.

The two methods for color trapping automatically are
always overprinting black and auto-spreading. Always
overprinting black creates a color trap by causing any
object that contains 95% black or more to overprint any
underlying objects. This option is useful for artwork con-
taining a lot of black text, but it should be used with caution
on artwork with a high graphics content. You can adjust the
threshold, if the print service provider recommends a black
threshold value other than 95%.
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Auto-spreading creates color trapping by assigning an
outline to an object that is the same color as the object's
fill and having it overprint underlying objects. Auto-spread-
ing is created for all objects in the file that meet three
conditions: they do not already have an outline, are filled
with a uniform fill, and have not already been designated to
overprint.

Printing to film

You can set up a print job to produce negative images. An
image-setter produces images on film that may need to be
produced as negatives depending on which printing device
you are using. Consult your print service provider to
determine whether you can produce images on film.

You can specify to print with the emulsion down. Printing
with the emulsion down produces a backward image on
desktop printers.
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Explain the Guideline, Grid and uses

Guidelines

Guidelines are lines that can be placed anywhere in the
drawing window to aid in object placement. In some
applications, guidelines are known as guides.

There are three types of guidelines: horizontal, vertical, and
slanted. By default, the application displays guidelines
that you can add to the drawing window, but you can hide
them at any time. You can also use objects as guides.

You can set guidelines for individual pages or you can set
guidelines for the entire document.

You can add a guideline wherever you need one; however,
you can also choose to add preset guidelines. There are

IT & ITES
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Usage of guides and drawing tools in CorelDraw

Objectives : At the end of this lesson you shall be able to
• explain the Guideline, Grid and uses
• state the Freehand tool and Polyline tool
• uses of Bézier Tool and the Pen Tool
• explain the 2-point tool and Artistic media tool
• use of B-spline tool.

two types of preset guidelines: Corel presets and user-
defined presets. Examples of Corel presets include guide-
lines that appear at 1-inch margins and guidelines that
appear at newsletter column borders. User-defined presets
are guidelines whose location you specify. For example,
you can add preset guidelines that display margins at a
distance you specify or that define a column layout or grid.
After you add a guideline, you can select it, move it, rotate
it, lock it in place, or delete it.

You can have objects snap to the guidelines, so that when
an object is moved near a guideline, it can only be centered
on the guideline or lined up on either side of the guideline.

Guidelines use the unit of measure specified for rulers.

Guidelines can be placed in the drawing window to aid in
object placement.

Grid

A series of evenly spaced horizontal and vertical dots that
are used to help draw and arrange objects.

Setting up the grid

The grid is a series of non-printing intersecting lines that
you can display in the drawing window. You can use the
grid to precisely align and position objects.

You can customize the look of the grid by changing the grid
display and grid spacing. The grid display allows you to
view the grid as lines or as dots. The spacing allows you to
set the distance between the grid lines. The spacing

options are based on the unit of measure for the ruler. For
example, if the ruler unit of measure is set to inches, the
spacing options are based on inches.

If the ruler unit of measure is set to pixels, or if you enabled
the Pixel preview, you can specify the color and opacity of
the pixel grid.

You can also have objects snap to the grid or pixel grid so
that when you move the objects, they jump between grid
lines.

Curve Tools

If you want to create a your own unique shapes, you can
use one of the curve tools. Using these tools, you can draw
an almost unlimited variety of shapes



122

Drawing lines

A line is a path between two points. Lines can consist of
multiple segments, and the line segments can be curved
or straight. The line segments are connected by nodes,
which are depicted as small squares. CorelDRAW pro-
vides various drawing tools that let you draw curved and
straight lines, and lines containing both curved and straight
segments.

Freehand and Polyline Tools

The Freehand and Polyline tools share a common function,
giving you the freedom to draw as if you were sketching by
freehand on a physical sketch pad, but the tools work in
slightly different ways. Sketched lines can create a single
open or closed vector path. Both tools are located in the
Toolbox grouped with other line-creation tools, as shown
here:

Freehand Tool  and Polyline Tool 

Using either of these tools, you have control over the
smoothness of path shapes drawn using click-drag actions
by adjusting the Freehand Smoothing option in the Prop-
erty Bar before drawing your path. You can control smooth-
ness after drawing a path by selecting nodes with the
Shape Tool and then using the Reduce Nodes spin box.
Reduce Nodes has a range between 0 and 100 percent;
lower values apply less smoothing, and higher values apply
more smoothing.

3-Point Curve Tool

The 3-Point Curve Tool is used to build perfectly smooth
arcing line segments, with complete control over the
direction and steepness of the curve between two points.

You can draw a curved line by specifying its width (left), and
then specifying its height and clicking the page (right).

Using the Bézier  and Pen Tools 

The Bézier Tool and the Pen Tool are variations on the
same theme of drawing connected curves and straight
segments (unlike the 3-Point Curve Tool), through the
action of first clicking to set a path point, and then by either
dragging to define a curve behind the click point or by
clicking (not dragging) to define a straight path segment
behind the click point.

One of the less obvious differences between the two tools
is that the Pen Tool offers a "look ahead" point when you
draw with it; before you click or click-drag a point, the
proposed path between the point before you click and the
previous (already defined) point on the path is shown in light
blue. When you're just beginning with CorelDRAW, the
choice between these tools should be based on the
following:

The Pen Tool provides intuitive results when you want a
path that has both straight segments and curves. The
Bézier Tool excels at creating curved segments that are
joined smoothly, and straight segments are not your
design goal

2-point line tool 

You can draw straight lines by using the 2-point line tool.
This tool also allows you to create straight lines that are
perpendicular or tangent to objects.

Artistic Media Tools

The Artistic Media tools in CorelDraw lets, you choose from
a wide variety of new, sophisticated preset brush styles.
You can draw vector shapes, brushstrokes, Sprayed
images, calligraphic strokes and pressure sensitive strokes.
For each stroke type that is available with the Artistic
media tool, you can set preference for the level of smooth-
ing, the stroke width and other properties.

Drawing calligraphic

CorelDRAW lets you simulate the effect of a calligraphic
pen when you draw lines. Calligraphic lines vary in thick-
ness according to the direction of the line and the angle of
the pen nib. By default, calligraphic lines appear as closed
shapes drawn with a pencil. You can control the thickness
of a calligraphic line by changing the angle of the line you
draw in relation to the calligraphic angle you choose. For
example, when the line you draw is perpendicular to the
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calligraphic angle, the line is at the maximum thickness
specified by the pen width. Lines drawn at the calligraphic
angle, however, have little or no thickness.

Pressure-sensitive

CorelDRAW lets you create pressure-sensitive lines which
vary in thickness. You can create this effect using the
mouse or a pressure-sensitive pen and graphics tablet.
Both methods result in lines with curved edges and varying
widths along a path. For information about using a pres-
sure-sensitive pen on a graphics tablet, see the
manufacturer's instructions.

Preset lines

CorelDRAW provides preset lines that let you create thick
strokes in a variety of shapes. After you draw a calligraphic
or preset line, you can apply a fill to it as you would to any
other object.

Brushstrokes

CorelDRAW lets you apply a variety of preset brushstrokes,
ranging from strokes with arrowheads to ones that are filled
with rainbow patterns. When you draw a preset brushstroke,
you can specify some of its attributes. For example, you
can change the width of a brushstroke and specify its
smoothness.
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You can also create custom brushstrokes by using an
object or a group of vector objects. When you create a
custom brushstroke, you can save it as a preset.

Spraying objects along a line.

CorelDRAW lets you spray a series of objects in a line.
Besides graphic and text objects, you can import bitmaps
and symbols to spray along a line.

You can control how a sprayed line appears by adjusting
the spacing between objects, so they are closer or farther
apart from each other. You can also vary the order of
objects in the line. For example, if you are spraying a series
of objects that includes a star, a triangle, and a square, you
can change the spray order so that the square appears
first, followed by the triangle and then the star. CorelDRAW
also lets you shift the position of objects in a sprayed line
by rotating them along the path or offsetting them in one of
four different directions: alternating, left, random, or right.
For example, you can choose a left offset direction to align
the objects you spray to the left of the path.

stretching and moving the stroke on the page, and by
applying the outline and fill to the stroke.

B-spline tool

By using control points, you can easily shape a curved line
and draw B-splines, which are typically smooth, continu-
ous curved lines. B-splines touch the first and last control
points and are pulled by the points in between. However,
unlike the nodes on Bézier curves, control points don't let
you specify the points through which a curve passes when
you want to align a curve with other drawing elements.

The control points that touch the line are referred to as
"clamped". Clamped control points function as anchors.
The control points that pull the line but do not touch it are
referred to as "floating". The first and last control points are
always clamped on open-ended B-splines. The points in
between float by default, but you can clamp points if you
want to create cusps or straight lines within the B-spline.
You can edit completed B-splines by using the control
points.

Objects sprayed along a curved line (left). The objects and
line were edited after the objects were sprayed (right).

Preset mode

Using the preset mode of the Artistic media tool is perfect
when you want to create a basic stroke that can be edited.
Preset stroke vary in width and shape, and you can edit
them by applying a different preset stroke shape, by
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IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.04
Creating Ellipses, Circles, Rectangles and Squares
Objectives : At the end of this lesson you shall be able to
• explain the ellipse, circle, rectangle, and square tools
• polygon, star and complex star tools
• state the spiral and graph paper tools
• explain the shape edit tools.

Ellipses, circles, rectangle and square

Ellipse and circle

Draw an ellipse or circle by dragging diagonally with the
Ellipse tool, or draw an ellipse by using the 3-point ellipse
tool to specify its width and height. The 3-point ellipse tool
quickly create an ellipse at an angle, eliminating the need
to rotate the ellipse.

Using the 3-point ellipse tool, to draw an ellipse by first
drawing its centerline and then drawing its height. This
method to draw ellipses at an angle

To draw an ellipse or a circle from its center
outward by holding down Shift as and drag.

Arcs, and Pie

Using the Ellipse tool, draw a new arc or pie shape, or draw
an ellipse or circle and then change it to an arc or a pie
shape. Change the default properties of new objects that
are drawn with the Ellipse tool. For example, to set the
default properties so that all new shapes to draw are arcs
or pie shapes.
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To use the Shape tool to create a pie shape, drag the node
of the ellipse (left) to the inside of the ellipse (center). To
create an arc, drag the node to the outside of the ellipse
(right).

To draw an arc, the ellipse or circle must have
an outline

Rectangle and square shapes

Draw a rectangle or square by dragging diagonally with the
Rectangle tool or by specifying the width and height with
the 3-point rectangle tool. The 3-point rectangle tool lets
you quickly draw rectangles at an angle.

From left to right, to see the radius of a rounded corner and
the radius of a scalloped corner

The size value for chamfering a corner represents the
distance to set where the chamfer will begin in relation to
the original corner. Higher corner size values produce a
longer chamfered edge.

Create a 3-point rectangle by first drawing its baseline and
then drawing its height. The resulting rectangle is angled.

 

Property bar of the Rectangle tool

Draw a rectangle or square with rounded, scalloped or
chamfered corners. To modify each corner individually or
apply the changes to all corners. In addition, to specify that
all corners scale relative to the object. To also specify the
default corner size for drawing rectangles and squares.

Understanding rounded, scalloped, and chamfered
corners

Rounding produces a curved corner, scalloping replaces
the corner with an edge that has a curved notch, and
chamfering replaces the corner with a straight edge, also
known as a bevel.

From left to right, to see standard corners with no changes,
rounded corners, scalloped corners, and chamfered cor-
ners.

To draw rectangles or squares with rounded, scalloped, or
chamfered corners, need to specify the corner size. For
rounding or scalloping a corner, the corner size determines
the corner radius. The radius is measured from the curve's
center to its perimeter. Higher corner size values produce
more rounded corners or deep scalloped corners.

To draw a rectangle from its center outward by
holding down Shift as you drag. Draw also a
square from its center outward by holding
down Shift + Ctrl as you drag.

Draw a rectangle that covers the drawing page by double-
clicking the Rectangle tool.

Polygon, star and complex star tools

Draw polygons and two types of stars: perfect and com-
plex. Perfect stars are traditional-looking stars and can
have a fill applied to the entire star shape. Complex stars
have intersecting sides and produce original results with a
fill applied.

 

 

Left to right: Polygon, perfect star, and complex star,
each with a fountain fill applied

To modify polygons and stars. For example, change the
number of sides on a polygon or the number of points on a
star, and sharpen the points of a star. Also to use the
Shape tool to reshape polygons and complex stars, just as
too with any other curve object. Perfect stars can also be
reshaped, but with some restrictions.
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Left to right: The Shape tool was used to change a
polygon into a star that can be shaped as a curve object.
The line segments of the star were then converted to curves
and adjusted to produce the starfish shape.

Spiral Tool

Draw two types of spirals: symmetrical and logarithmic.
Symmetrical spirals expand evenly so that the distance
between each revolution is equal. Logarithmic spirals
expand with increasingly larger distances between revolu-
tions. You can set the rate by which a logarithmic spiral
expands outward.

A symmetrical spiral (left) and a logarithmic spiral (right)

Draw a spiral from its center outward by hold-
ing down Shift as you drag.

Also draw a spiral with even horizontal and vertical dimen-
sions by holding down Ctrl as you drag.

Graph paper tool

Draw a grid and set the number of rows and columns. A grid
is a grouped set of rectangles that you can break apart.

You can also break apart a grid by clicking the
Ungroup button on the property bar

Curve objects

A curve object has nodes and control handles, which is use
to change the object's shape. A curve object can be any

shape, including a straight or curved line. An object's nodes
are the small squares that appear along the object's
outline. The line between two nodes is called a segment.
Segments can be curved or straight. Each node has a
control handle for each curved segment connected to it.
Control handles help to adjust the curve of a segment.
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The components of a curve: control handles, segments,
and nodes

Curve objects created in CorelDRAW follow a path that
gives them their defining shape. A path can be open (for
example, a line) or closed (for example, an ellipse) and can
sometimes include subpaths.

Most objects that are added to a drawing are not curve
objects, with the exception of spirals, freehand lines, and
Bézier lines. Therefore, if you want to customize the shape
of an object or text object, it is recommended that you
convert it to a curve object.

You can also convert an object to a curve object
by selecting the object and clicking the Convert
to curves button on the property bar.

Selecting and moving nodes

Select individual, multiple, or all of the object's nodes.
Selecting multiple nodes toshape different parts of an
object simultaneously. The marquee select nodes by
enclosing them with a rectangular marquee box, or by
enclosing them with an irregularly shaped marquee box.
Freehand marquee selection is useful when you want to
select specific nodes in complex curves.

When a node is selected on curved segments, control
handles are displayed. You can adjust the shape of the
curved segments by moving the nodes and control handles.

Usually, a control handle is displayed as a solid blue
arrowhead (left). When a control handle overlaps with a
node, it is displayed as an unfilled blue arrowhead beside
the node (right).

The Shape tool is the standard tool for moving nodes. Also
set an option to use the Pick and Bézier tools for selecting
and moving nodes.

Manipulating segments

To move curved segments to change an object's shape.
Also control the smoothness of curved segments.

To change the direction of a curve object by reversing the
position of its start and end nodes. The effect is apparent
only when the ends of a curve object are different. For
example, when an arrowhead is applied to the end node of
a curve object, changing the direction results in moving the
arrowhead to the start node.

Changing the direction of a curve

Adding, removing, joining, and aligning nodes

Add nodes, to increase the number of segments and,
therefore, the amount of control you have over the shape of
the object. To delete selected nodes to simplify an object's
shape.

When curve objects contain many nodes, it is difficult to
edit and output them to devices such as vinyl cutters,
plotters, and rotary engravers. You can have the number of
nodes in a curve object reduced automatically. Reducing
the number of nodes removes overlapping nodes and can
smooth a curve object. This feature is especially useful for
reducing the number of nodes in objects imported from
other applications.

Reducing the number of nodes to smooth a curve object

To join the start and end nodes of an open path such as a
line to create a closed object. This feature is useful for filling
an object with color because you can apply fills only to the
inside of closed objects.
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Stretching nodes

Breaking the path of curve objects

Paths

Paths outline an object's shape and are often visible as one
or more line or curve segments. To disconnect line seg-
ments from one another to create subpaths. Even though
they are not connected, subpaths are still part of the
defining path of the original object; however, to extract a
subpath to create two separate objects: the extracted
subpath and the object it was extracted from.

Subpaths

Subpaths are the basic curves and shapes from which a
single curve object is constructed. For example, a single
curve object with subpaths is often created when text is
converted to curves. The letter "O," for instance, is com-
posed of two ellipses: the outside ellipse that defines the
letter's shape and the inside ellipse that defines the "hole."
The ellipses are subpaths that compose the single curve
object, "O." One of the basic reasons for creating an object
with subpaths is that can produce objects with holes in
them. In the following example, to see objects underneath
the center of the letter "O."

To align the nodes of a curve object horizontally or vertically

 

Using node types

To change the nodes on a curve object to one of four types:
cusp, smooth, symmetrical, or line. The control handles of
each node type behave differently.

Cusp nodes to create sharp transitions, such as corners or
sharp angles, in a curve object. To move the control
handles in a cusp node independently of one another,
changing only the line on one side of the node.

With smooth nodes, the lines passing through the node
take on the shape of a curve, producing smooth transitions
between line segments. The control handles of a smooth
node are always directly opposite one another, but they
may be at different distances from the node.

Symmetrical nodes are similar to smooth nodes. They
create a smooth transition between line segments, but
they also to give lines on both sides of a node the same
curve appearance. The control handles of symmetrical
nodes are directly opposite each other and at an equal
distance from the node.

Line nodes to shape curve objects by changing the shape
of their segments. To make a curved segment straight or
a straight segment curved. Making a straight segment
curved does not noticeably change the segment's appear-
ance, but it displays control handles that to move to change
the segment's shape.

Left to right: Cusp, smooth, symmetrical, and line nodes

Transforming nodes

Shape objects by stretching, scaling, rotating, and skew-
ing their nodes. For example, to scale the corner nodes of
a curve object to enlarge the curve object proportionally.
Also, a curve object or parts of a curve object can be rotated
in a counterclockwise or clockwise direction.

1) The letter "O" is converted to curves. 2) The resulting
subpaths are the outside ellipse that defines the shape of
the letter and the inside ellipse that defines the hole. 3) In
comparison, the black ellipse consists of a single path and
cannot contain a "hole."
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Mirroring changes in curve objects

To change mirror in curve objects, to edit nodes and have
the same edits take place in reverse on corresponding
nodes. For example, to move a node to the right, and its
corresponding node moves the same distance to the left.

To mirror changes, select two curve objects one of which
was created by mirroring the other, or a symmetrical
object. Next, need to choose whether to mirror changes
horizontally (along a vertical line of symmetry) or vertically
(along a horizontal line of symmetry). Finally, need to
select the appropriate corresponding nodes so that editing
changes are mirrored across the selected objects.

Stretching an object horizontally

Smudging objects

Smudging is to distort an object by dragging its outline.
When applying smudging to an object, you can control the
extent and shape of the distortion whether to activate the
controls for the graphics tablet stylus or use the settings
that apply to a mouse.

Left: Two corresponding nodes are selected in mirrored
curve objects. Right: When the blue control handles are
moved, the change is reflected in the corresponding control
handles (in red).

Skewing and stretching objects

skew and stretch objects in CorelDRAW. Change to skew
an object, to specify the degree by which you want to slant
the object. Stretching changes an object's vertical and
horizontal dimensions non- proportionally.

CorelDRAW also to change the skew and sizing anchor
point of an object from its default center position.

Skewing an object horizontally

The smudging effect responds to both the angle of rotation
- or bearing - and the tilt angle of a graphics tablet stylus.
Rotating the stylus changes the angle of the smudging
effect and tilting the stylus flattens the brush tip and
changes the shape of the smudging. If using a mouse, you
can simulate the bearing and tilt of the stylus by specifying
values. Increasing the bearing angle from 0 - 359° changes
the angle of the brushstroke. As to decrease the tilt angle
from 90° - 15°, to change the smudging shape by flattening
the brush tip.

Smudging can respond to the pressure of a stylus on a
tablet where the smudging widens with more pressure and
narrows with less. If using a mouse or want to override
stylus pressure, enter real values to simulate the pressure
of a stylus on a graphics tablet. Negative values to -10
create a narrowing distortion, 0 maintains an even stroke
width, and positive values to 10 create an expanding
distortion.

Objects placed in the foreground and background have
been shaped by outside smudging (sun's rays and blades
of grass) and inside smudging (clouds).

Whether to using a stylus or a mouse, must specify the nib
size. The nib size determines the width of the smudging
applied to an object.

To apply the smudging effect to the inside and outside of
an object

Smudging cannot apply to Internet or embed-
ded objects, linked images, grids, masks, mesh-
filled objects, or objects with blend and con-
tour effects.
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Roughening objects

The roughening effect to apply a jagged or spiked edge to
objects, including lines, curves, and text. To control the
size, angle, direction, and number of the indentations
whether you activate the graphics tablet stylus or apply
settings to a mouse.

N i b

The roughening effect is determined either by movements
of a graphics tablet stylus, by fixed settings, or by
automatically applying perpendicular spikes to the line.
Tilting the stylus toward and away from the tablet's surface
increases and decreases the size of the spikes. When
using a mouse, to specify the tilt angle from 0 - 90°.
Determine the direction of the spikes by changing the angle
of rotation (or bearing) of the stylus as to apply the
roughening effect to an object. When using a mouse, to set
the bearing angle from 0 - 359°. Also increase or decrease
the number of spikes that are applied as the drag.

The roughening effect also responds to the pressure of the
stylus on the tablet. The more pressure to apply, the more
spikes are created in the roughened area. Using a mouse,
you can specify values to simulate the stylus pressure.

To change the brush nib size

Roughening allows you to apply jags or spikes to part of an
outline or path.

To make the tilt angle and bearing angle
responsive to the graphics tablet stylus, right-
click the roughened object, and select a com-
mand from the submenu.

To get the minimum and maximum values for
the roughening controls, right-click the control
on the property bar, and click Settings

Distortion effects

To apply three types of distortion effects to shape objects.

Distortion effect  Description

Push and pull

Drag to push the edges of an object in or pull the edges of
an object out.

Zipper

Apply to saw tooth effect to the edges of the object. To
adjust the amplitude and frequency of the effect.

Twister

To rotate an object to create a swirl effect. Choose the
direction of the swirl, as well as the origin, degree, and
amount of rotation.

From left to right: Original image; Zipper and Twister
distortions applied; Pull distortion applied

After apply distort an object, to change the effect by altering
the center of distortion. This point is identified by a
diamond-shaped handle, around which a distortion ap-
pears. It is similar to a mathematical compass, where the
pencil moves around a stationary point. Place the center of
distortion anywhere in the drawing window, or choose to
center it in the middle of an object so that the distortion is
distributed evenly and the shape of the object changes in
relation to its center.

To create an even more dramatic effect by applying a new
distortion to an already distorted object. Don't lose the
effect of the original distortion if, for example, to apply a
zipper distortion on top of a twister distortion. The
CorelDRAW application also to remove and copy distortion
effects.

Center a distortion by clicking the Center distortion button
on the property bar.

Use the interactive vector controls to edit a distortion effect.
Upper left: Zipper effect applied to circle. Upper right: Zipper
effects with higher frequency (more spikes) applied. Bot-
tom: Results of applying zipper effects.
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Shaping objects by use envelopes effects

CorelDRAW  apply to shape objects, including lines,
artistic text, and paragraph text frames by applying enve-
lopes to them. Envelopes are made of multiple nodes that
you can move to shape the envelope and, as a result,

IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.05
Shaping objects
Objectives : At the end of this lesson you shall be able to
• state shaping object by use envelope effects
• explain the extrude and bevel effects
• state the Lens effects
• describe the blending and contour effects
• explain the perspective effects.

change the shape of the object. To apply a basic envelope
that conforms to the shape of an object, or to apply also a
preset envelope. After you apply an envelope, to edit it or
add a new envelope to continue changing the object's
shape. CorelDRAW also to copy and remove envelopes.

Edit an envelope by adding and positioning its nodes.
Adding nodes gives more control over the shape of the
object contained in the envelope. CorelDRAW also to
delete nodes, move multiple nodes simultaneously, change
nodes from one type to another, and change a segment of
an envelope to a line or curve.

To change the mapping mode of an envelope to specify how
the object fits to the envelope. For example, stretch an
object to fit the basic dimensions of the envelope, and then
apply the horizontal mapping mode to compress it horizon-
tally so that it fits the shape of the envelope.

Extrude effect

To make objects appear three-dimensional by creating
extrusions. Create extrusions by projecting points from an
object and joining them to create an illusion of three
dimensions. CorelDRAW also to apply a vector extrusion
to an object in a group.

After to create an extrusion, copy or clone its attributes to
a selected object. Cloning and copying transfer the extru-
sion attributes of an extruded object to another. However,
the cloned extrusion settings cannot be edited indepen-
dently from the master.

Change an extruded form by rotating it and rounding its
corners.

CorelDRAW also to remove a vector extrusion.

Bevels

Another way in which give an object a three-dimensional
appearance is by applying a beveled edge to an extrusion.
A bevel creates the illusion that an object's extruded edges
are cut on an angle. To specify the angle and depth values
of the bevel to control the effect.

Create a bevel effect without extruding an object.

Extruded fills

To apply fills to an entire extrusion or only to the extruded
surfaces. Cover each surface individually with the fill, or
drape the fill so that it blankets the entire object with no
breaks to the pattern or texture.

Left to right: A simple shape, the shape with an extruded
fill of solid color, the shape with an extruded gradient fill and
a rotation applied.
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Lighting

Enhance extrusions by applying light sources. Add up to
three light sources to project toward the extruded object
with varying intensity. No longer need light sources, you
can remove them.

Vanishing points

Create a vector extrusion in which the lines of the extrusion
converge at a vanishing point. The vanishing point of a
vector extrusion can be copied to another object so that
both objects appear to recede toward the same point.

Extrusions with the same vanishing point

Also to give two extrusions different vanishing points.

Extrusions with different vanishing points

Lens effect

Lenses change how the object area beneath the lens
appears, not the actual properties and attributes of the
objects. To  apply lenses to any vector object, such as a
rectangle, ellipse, closed path, or polygon. You can also
change the appearance of artistic text and bitmaps. When
to apply a lens over a vector object, the lens itself becomes
a vector image. Likewise, if the lens is placed over a bitmap,
the lens also becomes a bitmap.

After you apply a lens, copy it and use it with another object

The lens types applied to the original (far left): (left to right)
Heat map, Magnify, and a Custom color map

The following are the types of lenses apply to objects.

Lens Description

Brighten To brighten and darken object areas and set the rate of the brightness and darkness

Color add Simulate an additive light model. The colors of the objects beneath the lens are added to the color of the
lens as if you were mixing colors of light. Choose the color and the amount of color you want to add.

Color limit To view an object area with only black and the lens color showing through. For example, if place a green
color limit lens over a bitmap, all colors except green and black are filtered out in the lens area.

Custom color Change all the colors of the object area beneath the lens to a color ranging between two colors you
map specify. You can choose the range's start and end colors and the progression between the two colors.

The progression can follow a direct, forward, or reverse route through the color spectrum.

Fish eye To apply distort, magnify, or shrink the objects beneath the lens, according to the percentage value you
specify
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Heat map Create the effect of an infrared image by mimicking the heat levels of colors in object areas beneath the
lens

Invert Change the colors beneath the lens to their complementary CMYK colors. Complementary colors are
colors that are opposite one another on the color wheel.

Magnify Magnify an area on an object by an amount that you specify. The magnify lens overrides the original
object's fill, making the object look transparent.

Tinted Change the colors of object areas beneath the lens to their grayscale equivalents. Tinted
grayscale grayscale lenses are particularly effective for creating sepia-tone effects.

Transparency To make an object look like a piece of tinted film or colored glass

Wireframe To display the object area beneath the lens with the outline or fill color you choose. For example, set
red for the outline and blue for the fill, all areas beneath the lens appear to have red outlines and blue
fills.

Blending objects

CorelDRAW lets to create blends, such as straight-line
blends, blends along a path, and compound blends.
Blends are often used for creating realistic shadows and
highlights in objects.

The highlights and shadows in the object on the right were
created by using blends.

A straight-line blend shows a progression in shape and
size from one object to another. The outline and fill colors
of the intermediate objects progress along a straight-line
path across the color spectrum. The outlines of intermedi-
ate objects show a gradual progression in thickness and
shape.

After to create a blend, copy or clone its settings to other
objects. Copy a blend, the object takes on all the blend-
related settings, except for their outline and fill attributes.
Clone a blend, changes to make to the original blend (also
called the master) are applied to the clone.

Straight-line blends can be used to create graphics with a
glass-like appearance. The rollover button (left) contains a
blend of tightly overlapped blended objects.

Can fit objects along part or all of a path's shape, and add
one or more objects to a blend to create a compound blend.

The straight-line blend (top) is fitted to a curved path
(bottom).

Change the appearance of a blend by adjusting the number
and spacing of its intermediate objects, the blend's color
progression, the nodes the blends map to, the blend's path,
and the start and end objects. Fuse the components of a
split or compound blend to create a single object.

This compound blend consists of three blends.

To split and remove a blend

By mapping nodes, control the appearance of a blend. Two
nodes on the polygon are mapped to two nodes of a star
shape, showing a more gradual transition (bottom).

To set object and color acceleration rates by
clicking the Object and color acceleration but-
ton  on the property bar and moving the corre-
sponding slider.

Contour

An effect created by adding evenly spaced concentric
shapes inside or outside the borders of an object. This
effect can also be used for creating cuttable outlines for
devices, such as plotters, engraving machines, and vinyl
cutters
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Contouring objects

contour an object to create a series of concentric lines that
progress to the inside or outside of the object. CorelDRAW
also to set the number and distance of the contour lines.

In addition to creating interesting 3D effects, to use
contours to create cuttable outlines for output to devices,
such as plotters, engraving machines, and vinyl cutters.

After contouring an object, copy or clone its contour
settings to another object. Change the colors of the fill
between the contour lines and the contour outlines them-
selves. Set a color progression in the contour effect, where
one color blends into another. The color progression can
follow a straight, clockwise, or counterclockwise path
through the color range of your choice.

Separate an object from its contour lines.

       

Perspective to objects

Create a perspective effect by shortening one or two sides
of an object. This effect gives an object the appearance of
receding in one or two directions, thereby creating a one-
point perspective or a two-point perspective.

Perspective effects can be added to objects or grouped
objects.  Also to add a perspective effect to linked groups,
such as contours, blends, extrusions, and objects created
with the Artistic media tool. You can't add perspective
effects to paragraph text, bitmaps, or symbols.

The original graphic (left) with one-point (middle) and two-
point (right) perspective applied to it.
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Filling objects

To add colored, patterned, textured, and other fills to the
inside of objects or other enclosed areas. Customize a fill
and set it as a default, so that each object you draw has the
same fill.

Uniform fills

Apply a uniform fill to objects. Uniform fills are solid colors
that choose or create by using color models and color
palettes.

To apply a uniform fill by using the Uniform fill tool  in the
toolbox. Also apply a uniform fill by clicking the Interactive
fill tool  in the toolbox, and choosing Uniform fill from the Fill
type list box on the property bar.

Fountain fills

A fountain fill is a smooth progression of two or more colors
that adds depth to an object. Fountain fills are also known
as gradient fills.

There are four types of fountain fills: linear, radial,
conical, and square. A linear fountain fill flows in a straight
line across the object, a conical fountain fill creates the
illusion of light hitting a cone, a radial fountain fill radiates
from the center of the object, and a square fountain fill is
dispersed in concentric squares from the center of the
object.

IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.06
Fills effects
Objectives : At the end of this lesson you shall be able to
• define colours, types of colour and features of colors
• sate Uniform fills and fountain fills
• explain the Pattern fills and Texture fills
• state the Postscript fills and mesh fills
• explain the area fills
• describe the colors.

Adjust the print and display quality of the fountain fill by
specifying the number of fountain steps. By default, the
fountain step setting is locked so that the print quality of the
fountain fill is determined by the value specified in the print
settings and the display quality is determined by the
default value you set. However, Unlock the fountain steps
setting when you apply a fountain fill and specify a value
that applies to both the print and view quality of the fill.

Pattern fills

Fill objects with two-color, full-color, or bitmap pattern fills.

There four types of fountain fills (left to right): linear, radial,
conical, and square.

To apply preset fountain fills, two-color fountain fills, and
custom fountain fills to objects. Custom fountain fills can
contain two or more colors, which you can position
anywhere in the fill's progression. After you create a
custom fountain fill, save it as a preset.

When apply a fountain fill, to specify attributes for the fill
type you choose; for example, the direction of a fill's color
blend, the fill's angle, center point, midpoint, and edge pad.

Examples of bitmap pattern fills

A two-color pattern fill is composed of only the two colors
that you choose. A full-color pattern fill is a more complex
vector graphic that can be composed of lines and fills. A
bitmap pattern fill is a bitmap image whose complexity is
determined by its size, image resolution, and bit depth.

CorelDRAW provides preset pattern fills that to apply to
objects; however, to create your own pattern fills. For
example, create pattern fills from objects that you draw or
images that you import.

Change the tile size of pattern fills. To specify exactly
where these fills begin by setting the tile origin. CorelDRAW
also to set offset tiles in a fill. Adjusting the horizontal or
vertical position of the first pattern, relative to the top of the
object, affects the rest of the fill.

How the pattern fill appears by specifying whether to mirror
the fill so that alternating tiles are the reflections of one
another. If want a pattern fill to change according to actions
you perform on the filled object, to specify that to want it to
transform with the object. For example, if enlarge an object
filled with a pattern that transforms, the pattern becomes
larger while the number of tiles is not increased.
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To apply a pattern of two colors or many colors to an object.

Texture fills

A texture fill is a randomly generated fill that use to give
objects a natural appearance. CorelDRAW provides preset
textures, and each texture has a set of options that
change. Use colors from any color model or palette to
customize texture fills. Texture fills can hold only RGB
colors; however, other color models and palettes can be
used as a reference to select colors.

Change the tile size of texture fills. Increasing the resolu-
tion of a texture tile increases the accuracy of the fill. To
specify exactly where these fills begin by setting the tile
origin. CorelDRAW also offset tiles in a fill. Adjusting the
horizontal or vertical position of the first tile, relative to the
top of the object, affects the rest of the fill.

PostScript texture fills

To apply PostScript texture fills to objects. A PostScript
texture fill is created in the PostScript language. Some
textures are very complex, and large objects that contain
PostScript texture fills may take time to print or to update
on the screen. Depending on the view mode are using, the
letters "PS" - rather than the fill - may appear.

To apply a PostScript texture fill, change several param-
eters, such as the size, line width, and the amount of gray
that appears in the texture's foreground and background.

To rotate, skew, adjust the tile size, and change the center
of the texture to create a custom fill.

If want a texture fill to change according to the actions
perform on the filled object, to specify that to want the fill
to transform with the object. For example, if enlarge an
object filled with a texture that transforms, the texture
becomes larger instead of increasing the number of tiles.

Texture fills are powerful features that can enhance a
drawing. However, they also increase the size of a file and
the time it takes to print, may want to use them in
moderation.

Mesh fills

When fill an object with a mesh fill, create unique effects.
For example, to create smooth color transitions in any
direction without having to create blends or contours. Apply

a mesh fill, to specify the number of columns and rows in
the grid, and specify the grid's intersecting points. After
have created a mesh object, edit the mesh fill grid by adding
and removing nodes or intersections. Also remove the
mesh.

Mesh fills were applied to the original drawing (left) to give
it a realistic look (right).

A mesh fill can be applied only to closed objects or a single
path. Ifwant to apply a mesh fill to a complex object, first
create a mesh-filled object and combine it with the complex
object to form a PowerClip object.

To add color to a patch of a mesh fill and to the individual
intersection nodes. To also choose to mix colors for a more
blended appearance.

Left: Adding a color to a mesh fill. Right: Moving an
intersection node in a mesh fill lets you adjust the progres-
sion of colors.

In addition, can smooth the color in a mesh fill to reduce the
appearance of hard edges. Also reveal objects underneath
a selected area by applying transparency to the mesh fill.

Fills to areas

To apply fills to any enclosed area by using the Smart fill
tool. Unlike other fill tools, which fill only objects, the Smart
fill tool detects the edges of an area and creates a closed
path so that the area can be filled. For example, if draw a
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freehand line that crosses over itself to create loops, the
Smart fill tool can detect the edges of the loops and fill
them. As long as the paths of one or more objects
completely enclose an area, it can be filled.

In the example above, the original spiral object is dupli-
cated and offset, resulting in enclosed areas that can be
filled by using the Smart fill tool.

Using the Smart fill tool to fill enclosed areas

Because the Smart fill tool creates a path around the area,
it essentially creates a new object that can be filled, moved,
copied, or edited. This means the tool can be used in one
of two ways: to fill an area or to create a new object from
an area.

Although primarily used to fill areas, the Smart fill tool can
also be used to create new objects. In the example above,
the original objects - the two spirals (left) - are deleted
(right), but the fill remains because each filled area is
actually an object.

Fills

There are a number of tasks that are common to all types
of fills. You can choose a default fill color so that every
object you add to a drawing has the same fill. To also
remove any fill, copy it to another object, or use it to fill an
area surrounded by an open curve

Understanding color management

Different tools are used during the process of creating and
sharing a document. For example, to may start with a file
that was created in another application or import an image
that was captured by a digital camera or scanner. After
completing the document, to print it or e-mail it to a
colleague for review. Each of the tools that you use in your
workflow has a different way of interpreting color. In
addition, each tool has its own range of available colors,
called a color space, which is a set of numbers that define
how each color is represented.

Example of a document workflow

In other words, when defining and interpreting color, each
tool speaks a unique language. Consider a color in the
color space of your digital camera: a vivid blue RGB color

with the values Red = 0, Green = 0, and Blue =255. This
color may appear as a different color in the color space of
your monitor. In addition, the color space of the printer may
not contain a match for this color. As a result,when
document moves through the workflow, this vivid blue color
gets lost in the translation and is not accurately repro-
duced. A color management system is designed to im-
prove the communication of color in the workflow so that the
color of the output matches your intended color.

Colors are defined by their color space. 1. Lab color space.
2. sRGB color space, displayed against the Lab color
space. 3. U.S. Web Coated (SWOP) v2 color space. 4.
ProPhotoRGB color space.

What is color management?

Color management is a process that to predict and control
color reproduction, regardless of the source or destination
of the document. It ensures a more accurate color repre-
sentation when a document is viewed, modified, shared,
exported to another format, or printed.

A color management system, also known as a color
engine, uses color profiles to translate the color values from
one source to another. For example, it translates the colors
that are displayed on the monitor into the colors that a
printer can reproduce. Color profiles define the color space
of monitors, scanners, digital cameras, printers, and the
applications that you use to create or edit documents.

Why do I need color management?

If the document requires accurate color representation,
want to learn more about color management. The complex-
ity of your workflow and the ultimate destination of the
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documents are also important considerations. If the docu-
ments are destined only for online viewing, color manage-
ment may not be as important. However, if plan to open
documents in another application or if the creating docu-
ments for print or multiple types of output, then proper color
management is essential.

Color management lets you do the following:

• reproduce colors consistently across your workflow,
especially when opening documents that were created
in other applications

• reproduce colors consistently when sharing files with
others

IT&ITES: DTPO - Related Theory for Exercise 2.2.06

• preview (or "soft-proof") colors before they are sent to
their final destination, such as a printing press, a
desktop printer, or the Web

• reduce the need to adjust and correct documents when
sending them to different destinations

A color management system does not offer identical color
matching, but it greatly improves color accuracy.
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Copy, duplicate, and delete objects

CorelDRAW provides you with several ways to copy
objects. When you no longer need an object, you can
delete it.

Cutting, copying, and pasting

To cut or copy an object to place it on the Clipboard and
paste it into a drawing or another application. Cutting an
object places it on the Clipboard and removes it from the
drawing. Copying an object places it on the Clipboard but
keeps the original in the drawing.

Duplicating

Duplicating an object places a copy directly in the drawing
window and does not use the Clipboard. Duplicating is
faster than copying and pasting. Also, when duplicating an
object, to specify the distance between the duplicate and
the original object along the x and y axis. This distance is
known as the offset.

IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.07
Aligning and arranging the objects
Objectives : At the end of this lesson you shall be able to
• explain the copy, duplicate, and delete the objects
• explain the align and distribute the object
• state the combining and locking the object
• describe finding and replacing the object
• describe the barcode and symbols
• preparation of graphic design and layout.

Aligning and distributing objects

CorelDRAW lets you precisely align and distribute objects
in a drawing. Align objects with each other and with parts
of the drawing page, such as the center, edges, and grid.
When align objects with objects, line them up by their
centers or by their edges.

Align multiple objects horizontally or vertically with the
center of the drawing page. Single or multiple objects can
also be arranged along the edge of the page and to the
nearest point on a grid.

To apply a transformation, such as rotating, sizing, or
skewing, to the duplicate of an object while keeping the
original object intact. If need decide that to keep the original
object, to delete the duplicate.

Copying objects at a specified position

To create multiple copies of objects simultaneously, while
specifying their position, without using the Clipboard. For
example, to distribute object copies horizontally, to the left
or right of the original object; or you can distribute copies
of objects vertically, below or above the original object.
Specify the spacing between copies of objects, or you can
specify the offset at which copies of objects are created in
relation to each other.

Copying objects quickly

Use other methods to create copies of objects quickly,
without using the Clipboard. To use the plus sign (+) on the
numeric keypad to place a copy of an object on top of the
original object, or create copies instantly by pressing the
Spacebar or right-clicking while dragging an object.

Distributing objects automatically adds spacing between
them based on their width, height, and center points.
Distribute objects so that their center points or selected
edges (for example, top or right) appear at equal intervals.
Also distribute objects so that there is equal space
between them. To distribute objects over the extent of the
bounding box surrounding them or over the entire drawing
page.

Align an object with another object

Select the objects one at a time, the last object selected
is the reference point for aligning the other objects. If the
marquee select the objects before you align them, the
object that is positioned in the upper-left corner of the
selection is used.
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• Top - evenly spaces the top edges of the objects

• Center - evenly spaces the center points of the objects

• Spacing - places equal intervals between the selected
objects

• Bottom - evenly spaces the bottom edges of the objects

• To indicate the area over which the objects are distrib-
uted, enable one of the following options:

• Extent of selection - distributes the objects over the
area of the bounding box surrounding them

• Extent of page - distributes the objects over the drawing
page

Combining objects

Combining two or more objects creates a single object with
common fill and outline attributes. To combine rectangles,
ellipses, polygons, stars, spirals, graphs, or text so that
they are converted to a single curve object. If need to modify
the attributes of an object that has been combined from
separate objects, to break apart the combined object.
Extract a subpath from a combined object to create two
separate objects. Weld two or more objects to create a
single object.

The two objects (left) are combined to create a single object
(right). The new object has the fill and outline properties of
the last object selected.

• To align objects along the vertical axis, enable the Left,
Center, or Right check box.

• To align objects along the horizontal axis, enable the
Top, Center, or Bottom check box.

Aligning text objects, choose one of the following from the
For text source objects use list box:

• First line baseline - uses the baseline of the first line of
text as a reference point

• Last line baseline - uses the baseline of the last line of
text as a reference point

• Bounding box - uses the bounding box of a text object
as a reference point

To align objects with another object quickly,
without using the Align and distribute dialog
box, by clicking Arrange  Align and distribute
and clicking any of the first six alignment
commands. The letter next to a command
name indicates the keyboard shortcut that you
can use to align objects. For example, the
letter L next to the Align left command shows
that can press L to align objects with the
leftmost point of the object that is used as a
reference point.

Align objects by selecting them and clicking
the Align and distribute button on the property
bar.

Align an object with the page center

• Center to page - aligns all objects with the page center,
both vertically and horizontally

• Center to page vertically - aligns objects with the page
center along a vertical axis

• Center to page horizontally - aligns objects with the
page center along a horizontal axis

Also align all objects with the page center, vertically and
horizontally, by pressing P.

Align objects by selecting them and clicking the Align and
distribute button on the property bar.

Align an object with the grid by choosing Grid from the Align
objects to list box.

Distribute objects

To distribute the objects horizontally, enable one of the
following options from the top-right row:

• Left - evenly spaces the left edges of the objects

• Center - evenly spaces the center points of the objects

• Spacing - places equal intervals between the selected
objects

• Right - evenly spaces the right edges of the objects

• To distribute the objects vertically, enable one of the
following options from the column on the left:

The two objects (left) are combined to create a single
object (right). The new object has the fill and outline
properties of the last object selected.

Break apart a combined object that contains artistic text,
the text breaks apart into lines first, and then into words.
Paragraph text breaks into separate paragraphs.

Locking objects

Locking an object prevents from accidentally moving,
sizing, transforming, filling, or otherwise changing it. Lock
single, multiple, or grouped objects. To change a locked
object, need to unlock it first. Unlock one object at a time,
or all locked objects at the same time.

Cannot lock linked objects, such as blends, contours, or
text inside an object. And also cannot lock objects within
groups or linked groups

Finding and replacing objects

Using search criteria that you specify, the Find wizard
guides you step-by-step when you need to find and select
objects in a drawing. The search criteria can include object
type and its related properties, fill and outline properties,
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vector effects applied to objects, or the name of an object
or style. For example, can search for and select all
rectangles with rounded corners and without fill, or all text
on a path. Can also search for objects that contain the
same properties as a selected object. Change the search
criteria in the middle of a search. To also save search
criteria for later use.

The Replace wizard guides to through the process of
finding objects that contain the properties specify and then
replacing those properties with others. For example, can
replace all object fills of a certain color with fills of a different
color. Also replace color models and palettes, outline
properties, and text attributes, such as font and font size.

Also search for specific words and replace them with other
words.

Inserting bar codes

The Barcode wizard in CorelDRAW lets to add bar codes
to drawings. A bar code is a group of bars, spaces, and
sometimes numbers that is designed to be scanned and
read into computer memory. Bar codes are most com-
monly used to identify merchandise, inventory, and docu-
ments.

The Barcode wizard guides through the process of insert-
ing a bar code.

symbol

A reusable object or group of objects. A symbol is defined
once and can be referenced many times in a drawing.

symbols

The CorelDRAW application lets to create objects and
save them as symbols. Symbols are defined once and can
be referenced many times in a drawing. Each time to insert
a symbol into a drawing, create an instance of the symbol.
Symbol definitions, as well as information about instances,
are stored in a symbol manager, which is part of the
CorelDRAW (CDR) file. Using symbols for objects that
appear many times in a drawing helps to reduce file size.

Creating, editing, and deleting symbols

Symbols are objects that are defined once and can be
referenced many times in a drawing. Multiple instances of
a symbol in a drawing with little impact on file size.
Symbols make editing a drawing quicker and easier, as
changes made to a symbol are automatically inherited by
all instances.

Symbols are created from objects. When convert an object
to a symbol, the new symbol is added to the Symbol
manager, and the selected object becomes an instance.
Create a symbol from multiple objects. To edit a symbol;
any changes to make affect all instances in a drawing. The
selection handles for symbols differ from those for objects.
Selection handles for symbols are blue; selection handles
for objects are black. To delete a symbol instance and
purge unused symbol definitions. Purging removes all
symbol definitions that are not instanced in a drawing.

Using symbols for objects that appear many times helps
to reduce file size.

Using symbols in drawings

Insert a symbol into a drawing, which creates a symbol
instance. To modify certain properties of a symbol in-
stance, such as size and position, without affecting the
symbol definition stored in the library. To revert a symbol
instance to an object or objects while preserving its
properties. To  delete a symbol instance.

Managing collections and libraries

When create symbols, to store them in library files that are
grouped into collections. To store symbols in a local
library, so that they are only available in the current
drawing, or export symbols to a network library that can be
shared between drawings.

The Symbol manager docker always displays libraries and
collections that are in the local Symbols folder. To add
collections and libraries in the Symbols folder from else-
where on the network. When insert a local or external
symbol into a drawing, a copy of the symbol definition is
added to the document, but it remains linked to the source
symbol.

Sharing symbols between drawings

In CorelDRAW, each drawing has its own library of sym-
bols, which is part of the CorelDRAW (CDR) file. Share
symbols between drawings by copying and pasting. Copy-
ing symbols to the Clipboard leaves the originals in the
library.

To copy and paste instances of a symbol to and from the
Clipboard. Pasting a symbol instance places the symbol
in the library and also places an instance of the symbol in
the drawing. Subsequent pasting will place another in-
stance of the symbol in the drawing without adding to the
library. If a modified symbol instance is pasted into a
drawing, the new instance maintains the properties of the
original instance, and the new symbol definition in the
library maintains the properties of the original symbol.
Symbol instances are copied and pasted in the same way
other objects are.
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IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.08
Shaping object
Objectives : At the end of this lesson you shall be able to
• state the curve object and explain the use of nodes
• explain the smudging objects
• state the roughening objects
• distortion effects
• explain the weld, trim, interest and simplify the object
• describe powerclip object.

Curve objects

A curve object has nodes and control handles, which is use
to change the object's shape. A curve object can be any
shape, including a straight or curved line. An object's nodes
are the small squares that appear along the object's
outline. The line between two nodes is called a segment.
Segments can be curved or straight. Each node has a
control handle for each curved segment connected to it.
Control handles help to adjust the curve of a segment.

The components of a curve: control handles, segments,
and nodes

Curve objects created in CorelDRAW follow a path that
gives them their defining shape. A path can be open (for
example, a line) or closed (for example, an ellipse) and can
sometimes include subpaths.

Most objects that are added to a drawing are not curve
objects, with the exception of spirals, freehand lines, and
Bézier lines. Therefore, if you want to customize the shape
of an object or text object, it is recommended that you
convert it to a curve object.

You can also convert an object to a curve object
by selecting the object and clicking the Convert
to curves button on the property bar.

Selecting and moving nodes

Select individual, multiple, or all of the object's nodes.
Selecting multiple nodes toshape different parts of an
object simultaneously. The marquee select nodes by
enclosing them with a rectangular marquee box, or by
enclosing them with an irregularly shaped marquee box.
Freehand marquee selection is useful when you want to
select specific nodes in complex curves.

When a node is selected on curved segments, control
handles are displayed. You can adjust the shape of the
curved segments by moving the nodes and control handles.

Usually, a control handle is displayed as a solid blue
arrowhead (left). When a control handle overlaps with a
node, it is displayed as an unfilled blue arrowhead beside
the node (right).
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The Shape tool is the standard tool for moving nodes. Also
set an option to use the Pick and Bézier tools for selecting
and moving nodes.

Manipulating segments

To move curved segments to change an object's shape.
Also control the smoothness of curved segments.

To change the direction of a curve object by reversing the
position of its start and end nodes. The effect is apparent
only when the ends of a curve object are different. For
example, when an arrowhead is applied to the end node of
a curve object, changing the direction results in moving the
arrowhead to the start node.

Changing the direction of a curve

Adding, removing, joining, and aligning nodes

Add nodes, to increase the number of segments and,
therefore, the amount of control you have over the shape of
the object. To delete selected nodes to simplify an object's
shape.

When curve objects contain many nodes, it is difficult to
edit and output them to devices such as vinyl cutters,
plotters, and rotary engravers. You can have the number of
nodes in a curve object reduced automatically. Reducing
the number of nodes removes overlapping nodes and can
smooth a curve object. This feature is especially useful for
reducing the number of nodes in objects imported from
other applications.

Reducing the number of nodes to smooth a curve object

To join the start and end nodes of an open path such as a
line to create a closed object. This feature is useful for filling
an object with color because you can apply fills only to the
inside of closed objects.

Using node types

To change the nodes on a curve object to one of four types:
cusp, smooth, symmetrical, or line. The control handles of
each node type behave differently.

Cusp nodes to create sharp transitions, such as corners or
sharp angles, in a curve object. To move the control
handles in a cusp node independently of one another,
changing only the line on one side of the node.

With smooth nodes, the lines passing through the node
take on the shape of a curve, producing smooth transitions
between line segments. The control handles of a smooth
node are always directly opposite one another, but they
may be at different distances from the node.

Symmetrical nodes are similar to smooth nodes. They
create a smooth transition between line segments, but
they also to give lines on both sides of a node the same
curve appearance. The control handles of symmetrical
nodes are directly opposite each other and at an equal
distance from the node.

Line nodes to shape curve objects by changing the shape
of their segments. To make a curved segment straight or
a straight segment curved. Making a straight segment
curved does not noticeably change the segment's appear-
ance, but it displays control handles that to move to change
the segment's shape.

Left to right: Cusp, smooth, symmetrical, and line nodes

Transforming nodes

Shape objects by stretching, scaling, rotating, and skew-
ing their nodes. For example, to scale the corner nodes of
a curve object to enlarge the curve object proportionally.
Also, a curve object or parts of a curve object can be rotated
in a counterclockwise or clockwise direction.
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Stretching nodes

Breaking the path of curve objects

Paths

Paths outline an object's shape and are often visible as one
or more line or curve segments. To disconnect line seg-
ments from one another to create subpaths. Even though
they are not connected, subpaths are still part of the
defining path of the original object; however, to extract a
subpath to create two separate objects: the extracted
subpath and the object it was extracted from.

Subpaths

Subpaths are the basic curves and shapes from which a
single curve object is constructed. For example, a single
curve object with subpaths is often created when text is
converted to curves. The letter "O," for instance, is com-
posed of two ellipses: the outside ellipse that defines the
letter's shape and the inside ellipse that defines the "hole."
The ellipses are subpaths that compose the single curve
object, "O." One of the basic reasons for creating an object
with subpaths is that can produce objects with holes in
them. In the following example, tosee objects underneath
the center of the letter "O."

Left: Two corresponding nodes are selected in mirrored
curve objects. Right: When the blue control handles are
moved, the change is reflected in the corresponding control
handles (in red).

Skewing and stretching objects

skew and stretch objects in CorelDRAW. Change to skew
an object, to specify the degree by which you want to slant
the object. Stretching changes an object's vertical and
horizontal dimensions non- proportionally.

CorelDRAW also to change the skew and sizing anchor
point of an object from its default center position.

1) The letter "O" is converted to curves. 2) The resulting
subpaths are the outside ellipse that defines the shape of
the letter and the inside ellipse that defines the hole. 3) In
comparison, the black ellipse consists of a single path and
cannot contain a "hole."

Mirroring changes in curve objects

To change mirror in curve objects, to edit nodes and have
the same edits take place in reverse on corresponding
nodes. For example, to move a node to the right, and its
corresponding node moves the same distance to the left.

To mirror changes, select two curve objects one of which
was created by mirroring the other, or a symmetrical
object. Next, need to choose whether to mirror changes
horizontally (along a vertical line of symmetry) or vertically
(along a horizontal line of symmetry). Finally, need to
select the appropriate corresponding nodes so that editing
changes are mirrored across the selected objects.

Skewing an object horizontally

Stretching an object horizontally

Smudging objects

Smudging is to distort an object by dragging its outline.
When applying smudging to an object, you can control the
extent and shape of the distortion whether to activate the
controls for the graphics tablet stylus or use the settings
that apply to a mouse.

The smudging effect responds to both the angle of rotation
- or bearing - and the tilt angle of a graphics tablet stylus.
Rotating the stylus changes the angle of the smudging
effect and tilting the stylus flattens the brush tip and
changes the shape of the smudging. If using a mouse, you
can simulate the bearing and tilt of the stylus by specifying
values. Increasing the bearing angle from 0 - 359° changes
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the angle of the brushstroke. As to decrease the tilt angle
from 90° - 15°, to change the smudging shape by flattening
the brush tip.

Smudging can respond to the pressure of a stylus on a
tablet where the smudging widens with more pressure and
narrows with less. If using a mouse or want to override
stylus pressure, enter real values to simulate the pressure
of a stylus on a graphics tablet. Negative values to -10
create a narrowing distortion, 0 maintains an even stroke
width, and positive values to 10 create an expanding
distortion.

the bearing angle from 0 - 359°. Also increase or decrease
the number of spikes that are applied as the drag.

The roughening effect also responds to the pressure of the
stylus on the tablet. The more pressure to apply, the more
spikes are created in the roughened area. Using a mouse,
you can specify values to simulate the stylus pressure.

To change the brush nib size.

Objects placed in the foreground and background have
been shaped by outside smudging (sun's rays and blades
of grass) and inside smudging (clouds).

Whether to using a stylus or a mouse, must specify the nib
size. The nib size determines the width of the smudging
applied to an object.

To apply the smudging effect to the inside and outside of
an object

Smudging cannot apply to Internet or embed-
ded objects, linked images, grids, masks, mesh-
filled objects, or objects with blend and con-
tour effects.

Roughening objects

The roughening effect to apply a jagged or spiked edge to
objects, including lines, curves, and text. To control the
size, angle, direction, and number of the indentations
whether you activate the graphics tablet stylus or apply
settings to a mouse.

The roughening effect is determined either by movements
of a graphics tablet stylus, by fixed settings, or by
automatically applying perpendicular spikes to the line.
Tilting the stylus toward and away from the tablet's surface
increases and decreases the size of the spikes. When
using a mouse, to specify the tilt angle from 0 - 90°.
Determine the direction of the spikes by changing the angle
of rotation (or bearing) of the stylus as to apply the
roughening effect to an object. When using a mouse, to set

Roughening allows you to apply jags or spikes to part of an
outline or path.

To make the tilt angle and bearing angle responsive to the
graphics tablet stylus, right-click the roughened object,
and select a command from the submenu.

To get the minimum and maximum values for the roughen-
ing controls, right-click the control on the property bar, and
click Settings

Distortion effects

To apply three types of distortion effects to shape objects.

Distortion effect  Description

Push and pull

Drag to push the edges of an object in or pull the edges of
an object out.

Zipper

Apply a to saw tooth effect to the edges of the object. To
adjust the amplitude and frequency of the effect.

Twister

To rotate an object to create a swirl effect. Choose the
direction of the swirl, as well as the origin, degree, and
amount of rotation.

From left to right: Original image; Zipper and Twister
distortions applied; Pull distortion applied

After apply distort an object, to change the effect by altering
the center of distortion. This point is identified by a
diamond-shaped handle, around which a distortion ap-
pears. It is similar to a mathematical compass, where the
pencil moves around a stationary point. Place the center of
distortion anywhere in the drawing window, or choose to
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center it in the middle of an object so that the distortion is
distributed evenly and the shape of the object changes in
relation to its center.

To create an even more dramatic effect by applying a new
distortion to an already distorted object. Don't lose the
effect of the original distortion if, for example, to apply a
zipper distortion on top of a twister distortion. The
CorelDRAW application also to remove and copy distortion
effects.

Center a distortion by clicking the Center distortion button
on the property bar.

Use the interactive vector controls to edit a distortion effect.
Upper left: Zipper effect applied to circle. Upper right: Zipper
effects with higher frequency (more spikes) applied. Bot-
tom: Results of applying zipper effects.

Welding and intersecting objects

To create irregular shapes by welding and intersecting
objects. Weld or intersect almost any object, including
clones, objects on different layers, and single objects with
intersecting lines. However, to cannot weld or intersect
paragraph text, dimension lines, or masters of clones.

Weld objects to create one object with a single outline. The
new object uses the welded objects' perimeter as its
outline and adopts the fill and outline properties of the target
object. All intersecting lines disappear.

Weld objects regardless of whether they overlap each
other. If weld objects that do not overlap, they form a weld
group that acts as a single object. In both cases, the
welded object takes on the fill and outline attributes of the
target object.

Weld single objects with intersecting lines so that the
object breaks into several subpaths, but its appearance
remains the same

Intersecting creates an object from the area where two or
more objects overlap. The shape of this new object can be
simple or complex, depending on the shapes you inter-
sect. The new object's fill and outline attributes depend on
the object you define as the target object.

PowerClip object

An object created by placing objects (contents objects)
inside other objects (container objects). If the contents
object is larger than the container object, the contents
object is automatically cropped. Only the contents that fit
inside the container object are visible.

CorelDRAW to place vector objects and bitmaps, such as
photos, inside other objects, or containers. A container
can be any object, for example artistic text or a rectangle.
Place an object into a container that is larger than the
container, the object, called the content, is cropped to fit
the form of the container. This creates a PowerClip object.

Objects before becoming a PowerClip object: artistic text
and a bitmap

To create more complex PowerClip objects by placing one
PowerClip object inside another PowerClip object to pro-
duce a nested PowerClip object. Also to copy the contents
of one PowerClip object to another PowerClip object.

In the PowerClip object, the artistic text is the container,
and the bitmap forms the contents. The bitmap is shaped
to the letters of the artistic text.

After create a PowerClip object can modify the content and
the container. For example, to lock the content, so that
when you move the container, the content moves with it.
CorelDRAW also to extract the content from a PowerClip
object, so that to delete the content or modify it without
affecting the container.
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The Anatomy of a Font

When looking for a font that seems appropriate for a
specific design, the shape of theindividual characters
might or might not work out the way you intend; you want
the spacingbetween lines of text (called leading) to be
extremely tight, but the ascender on certaincharacters is
too high and juts into the preceding line of text. What's an
ascender? The vertical strokes in characters have names
typographers use and you should, too, whendescribing an
ideal font or when seeking one.

Character height Used to describe the overall height, which
includes not only thecharacter but also the space above
the character, this is usually coded in by theperson
designing the typeface. Character height determines how
much interlinespacing you'll need to make more than one
line of text.

Cap height

This isthe height of a capital letter in a typeface, which is
usually notthe same as character height, nor is it neces-
sarily the height of all characters (whichis called the
ascender).

Ascender

This is the height of the tallest character in a font; usually
it's the’ f’, then ‘h’ or a swash if the font contains this
embellishment.

Descender

This is the part of body of an alphabet which falls below the
baseline. This is the lowest part of a character; usually a
g or y, except when a font has swashes.

IT & ITES
DTPO - Corel Draw                                   Related Theory for Exercise  2.2.09 &10
Adding and formatting text
Objectives : At the end of this lesson you shall be able to
• sate the Anatomy of a Font
• explain the adding and formatting text
• state the fitting text to a path
• explain the formatting paragraph and wrapping the text
• embedding graphics and adding special characters.

X-height

The measurement of a lowercase character, traditionally
measured bythe letter x in the font.

Baseline

An imaginary line where all the characters should rest. In
other words, baseline is a hypothetical line connecting
lower case English alphabets which do not have de-
scender.

Artistic text

A type of text created with the Text tool. Use artistic text
to add short lines of text, such as titles, or to apply graphic
effects, such as fitting text to a path, creating extrusions
and blends, and creating all other special effects. An
artistic text object can contain up to 32,000 characters.

Adding paragraph text

A text type that allows you to apply formatting options and
directly edit large blocks of text.

Adding text

Add two types of text to drawings - artistic text and
paragraph text. Add short lines of artistic text and then
apply a wide range of effects, such as drop shadows or a
contour, to the text. Paragraph text, also known as "block
text," can be used for larger bodies of text that have greater
formatting requirements. To add both paragraph and artis-
tic text directly in the drawing window.

Add artistic text along an open or closed path. Also to fit
existing artistic and paragraph text to a path.
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Paragraph text placed inside an object. You can make the
object invisible by removing its outline.

When import or paste text, to maintain formatting, maintain
fonts and formatting, or discard fonts and formatting.
Maintaining fonts ensures that imported or pasted text
retains its original font type. Maintaining formatting pre-
serves information such as bullets, columns, and bold or
italic formatting. Preserve the text color or import black text
as CMYK black. Choose to discard fonts and formatting,
the properties of the selected text are applied to the
imported or pasted text. If no text is selected, the default
font and formatting properties are applied to the imported
or pasted text.

Selecting text

To modify text, you must first select it. Choose to select
either entire text objects or only specific characters.

Encoding text

After opening or importing a drawing that contains text in
a language different from the language of your operating
system, to find that the text is not displayed correctly. To
display text correctly,change the encoding. Encoding
determines the character set of text.

Encoding settings do not affect the display of text outside
the drawing window, such as keywords, filenames, and
text entries in the Object manager and Object data
manager dockers. For these types of text, use code page
settings in the Open or Import dialog boxes to set the
proper characters.

Changing the basic properties of text

Enhance both artistic text and paragraph text by modifying
the character properties. Change the default text style, so
that the same properties are applied to all new artistic or

When adding paragraph text, first create a text frame. By
default, paragraph text frames remain the same size
regardless of how much text to add them. Any text that
continues past the lower-right border of the text frame is
hidden and becomes red until either enlarge the text frame
or link it to another text frame. Fit text to a text frame by
automatically adjusting the point size so that the text fits
perfectly.

Also can expand and shrink text frames automatically
type, so that the text fits perfectly in the text frame.

To insert a paragraph text frame inside a graphic object.
Use the object as a container for text and, and it increases
the number of different shapes that use as text frames. Also
to separate text from an object, so that each can be moved
or modified independently and the text retains its shape.

paragraph text. For example, change the font type and
size, or change the text to bold or italic.

Finding, editing, and converting text

Find text in a drawing and replace it automatically. Also find
special characters, such as an em dash or optional
hyphen. Edit text directly in the drawing window or in a
dialog box.

Additional formatting options are available for paragraph
text. Apply these formatting options to artistic text by first
converting the text to paragraph text. Likewise, to apply
special effects to paragraph text by converting the text to
artistic text.

Can also convert both paragraph and artistic text to curves.
By transforming characters into single lines or curve
objects, to add, delete, or move the nodes of individual
characters to alter their shape.

Convert text to curves, the appearance of the text is
preserved, including font, style, character position and
rotation, spacing, and any other text settings and effects.
Any linked text objects are also converted to curves. If to
convert paragraph text in a fixed-sized text frame to curves,
any text that overflows the text frame is deleted.

Change the text format to subscript or superscript, which
is useful if a drawing contains scientific notation. Also add
underlines, strikethrough lines, and overlines to text. In
addition, change the thickness of these lines and change
the distance between the lines and the text.

Change text to lowercase or uppercase without deleting or
replacing letters. Also increase or decrease font size by a
specified increment. By default, the unit of measure is
points. Change this setting for the active drawing and all
subsequent drawings that you create, so that the new unit
of measure is used in all font settings.
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If need to increase the redraw speed for text that is smaller
than a specific font size, use lines to represent the text.
This method, called "greeking" text, is useful for creating
prototypes of documents or drawings. Make text readable
again by reducing the greeking value or by zooming in on
the text.

Aligning text

To align both paragraph text and artistic text horizontally.
Align paragraph text, the text is positioned in relation to the
paragraph text frame. Horizontally align all paragraphs, or
only selected paragraphs, in a paragraph text frame.
Alternatively, vertically align all paragraphs in a paragraph
text frame or align text with another object.

Artistic text can be aligned horizontally, but not vertically.
Align artistic text, the entire text object is aligned in relation
to the bounding box. If characters have not been shifted
horizontally, applying no alignment produces the same
result as applying left alignment.

If select the objects one at a time, the last object selected
is the reference point for aligning the other objects. If
marquee select the objects before you align them, the
object that is positioned in the upper-left corner of the
selection is used.

If have applied a linear transformation, such as rotation, to
the text and are aligning objects with a baseline, the
objects align with the baseline point of the starting edge of
the text object.

Spacing text

The space between lines of text. This spacing is known as
"leading" or "interline spacing." Changing the leading for
artistic text applies the spacing to lines of text that are
separated by a hard return. For paragraph text, leading
applies only to lines of text within the same paragraph. To
change the spacing before and after paragraphs in para-
graph text.

To change character spacing and word spacing in selected
paragraphs, or in an entire paragraph text frame or artistic
text object. Changing the spacing between characters is
also known as "tracking" or "letter spacing." You can
change the spacing between characters in an entire block
of text or in a small group of characters.

To change kern pairs of selected characters. Kerning refers
to the repositioning of two characters to balance the optical
space between them. For example, kerning is often used
to decrease the space in character pairs such as AW, WA,
VA, or TA. Such character pairs are known as "kerning
pairs." Kerning increases readability and makes letters
appear balanced and proportional, especially at larger font
sizes.

Shifting and rotating text

Artistic and paragraph text can be shifted vertically or
horizontally, or rotated, to create interesting effects.
Straighten text into its original position, and you can return
vertically shifted characters to the baseline. Also to change
mirror artistic and paragraph text.

With CorelDRAW, space text by using the Paragraph
formatting and Character formatting dockers, or by using
the Shape tool.

Fitting text to a path

To add artistic text along the path of an open object (for
example, a line) or a closed object (for example, a square).
To also fit existing text to a path. Paragraph text can be
fitted to open paths only.

After fit text to a path, to adjust the text position relative to
that path. For example, an mirror the text horizontally,
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vertically, or both. Using tick spacing, you can specify an
exact distance between the text and the path.

CorelDRAW treats text fitted to a path as one object;
however, separate the text from the object if you no longer
want it to be part of the path. When the separate text from
a curved or closed path, the text retains the shape of the
object to which it was fitted.

The text reverts to its original appearance straighten it.

When adding drop caps, bullets, tab stops, and columns,
save time by previewing all the changes make before
committing to them. When preview the changes, they are
temporarily applied directly to the text in the drawing
window. Exactly how the new settings would affect your
drawing if they were applied.

Indenting changes the space between a paragraph text
frame and the text that it contains. To add and remove
indents without deleting or retyping text. Indent an entire
paragraph, the first line of a paragraph, or all lines of a
paragraph except the first line (a hanging indent). To set
indent from the right side of the text frame.

change the formatting of selected paragraph text frames,
or of selected text frames plus the text frames with which
they are currently linked.

Combining and linking paragraph text frames

To apply combine paragraph text frames. Also to break
paragraph text frames apart into subcomponents - col-
umns, paragraphs, bullets, lines, words, and characters.
Every time to break apart a text frame, the subcomponents
are placed into separate paragraph text frames.

Linking paragraph text frames directs the flow of text from
one text frame to another if the amount of text exceeds the
size of the first text frame. If shrink or enlarge a linked
paragraph text frame, or change the size of the text, the
amount of text in the next text frame is automatically
adjusted. Link paragraph text frames before or after to type
text.

To cannot link artistic text. However, link a paragraph text
frame to an open or closed object. The link a paragraph text
frame to an open object, such as a line, the text flows along
the path of the line. Linking a text frame to a closed object,
such as a rectangle, inserts a paragraph text frame and
directs the flow of text inside the object. If text exceeds the
open or closed path, to link the text to another text frame
or object. And also link to paragraph text frames and
objects across pages.

After linking paragraph text frames, to redirect the flow from
one object or text frame to another. When to select the text
frame or object, a blue arrow indicates the direction of the
text flow.

Formatting paragraph text

CorelDRAW offers various formatting options for paragraph
text. For example, add to fit text to a paragraph text frame.
Fitting text to a text frame increases or decreases the point
size of text so that it fits the text frame exactly. Use
columns to lay out text-intensive projects, such as news-
letters, magazines, and newspapers. You can create
columns of equal or varying widths and gutters.

Applying drop caps to paragraphs enlarges the initial letter
and insets it into the body of text. To customize a drop cap
by changing its settings. For example, to change the
distance between the drop cap and the body of text, or
specify the number of lines of text that you want to appear
next to the drop cap. You can remove the drop cap at any
point, without deleting the letter.

Use bulleted lists to format information. text wrap around
bullets, or offset a bullet from text to create a hanging
indent. CorelDRAW lets you customize bullets by chang-
ing their size, position, and distance from text. To change
the spacing between items in a bulleted list.

After you add a bullet, you can remove it without deleting
the text.

To add tab stops to indent paragraph text, remove tab
stops, and change the alignment of tab stops. Also set tab
stops with trailing leader characters, so that dots automati-
cally precede the tab stops.
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To remove links between multiple paragraph text frames,
and between paragraph text frames and objects. When y
only the two linked paragraph text frames and to remove the
link, the text flows into the remaining paragraph text frame.
Removing a link between paragraph text frames with a
series of links redirects the flow of text into the next
paragraph text frame or object.

By default, paragraph formatting, such as columns, drop
caps, and bullets, is applied to the selected paragraph text
frames only. However, to change your settings so that
formatting is applied to all linked text frames, or to all
selected and subsequently linked text frames. For ex-
ample, if apply columns to the text in one text frame,
choose whether to apply columns to the text in all the
linked text frames.

Wrapping paragraph text around objects, artistic text, and
text frames

To change the shape of text by wrapping paragraph text
around an object, artistic text, or a paragraph text frame.
To apply wrap text by using contour or square wrapping
styles. The contour wrapping styles follow the curve of the
object. The square wrapping styles follow the bounding box
of the object. You can also adjust the amount of space
between paragraph text and the object or text, and to
remove any previously applied wrapping style.
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Embedding graphics and adding special characters

Embed a graphic object or bitmap in text. The graphic
object or bitmap is treated as a text character. As a result,
to apply formatting options according to the type of text in
which is to embed the graphic object. To remove an
embedded object from text, after which the object returns
to its original state.

Add special characters to text as text objects or as graphic
objects. When add special characters as text, format the
characters as to do the text. When the add special
characters as graphic objects, the characters are curves.
Consequently, to edit them as you would other graphic
objects.

Displaying nonprinting characters

To display nonprinting characters, such as spaces, tabs,
and formatting codes. For example, when the display
nonprinting characters, a space appears as a tiny black
dot, a nonbreaking space appears as a circle, and an em
space appears as a line. When enabled, nonprinting
characters are displayed only when you add or edit text.

Click→Text→Show nonprinting characters
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IT & ITES
DTPO - Corel Draw                                      Related Theory for Exercise  2.2.11
Adding and formatting the table
Objectives : At the end of this lesson you shall be able to
• explain the table format and their uses
• state the resizing table cells, rows and columns
• explain the adding text and graphics.
Tables

A table provides a structured layout that lets you present
text or images within a drawing. Draw a table, or create a
table from paragraph text. Easily change the look of a table
by modifying the table properties and formatting. In addi-
tion, because tables are objects, manipulate them in
various ways. And also import existing tables from a text
file or a spreadsheet.

A table to create a structured layout for text and graphic
elements.

Selecting, moving, and navigating table components

select a table, table rows, table columns, or table cells
before you insert rows or columns, change the table border
properties, add a background fill color, or edit other table
properties. Move the selected rows and columns to a new
location in a table. And copy or cut a row or column from
one table and paste it in another table. In addition, to move
from one table cell to another when editing the table cell
text, and set the direction in which the Tab key lets you
move around a table.
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Formatting tables and cells

Change the look of a table by modifying both table and cell
borders. For example, to change the table border width or
color.

Resizing table cells, rows, and columns

After create a table to resize table cells, rows, and columns
for the use of table tool and table menu. In addition, for

To change the table cell margins and cell border spacing.
The cell margins to increase the space between the cell
borders and the text in the cell. By default, table cell
borders overlap to form a grid. However, increase the cell
border spacing to move the borders away from each other.
As a result, the cells do not form a grid, but appear as
individual boxes (also known as "separated borders").

Text in tables

To add text to table cells, and modify this text as would any
other paragraph text. For example,change the font, add
bullets, or add indents to table text. Change the text
properties of a single table cell, or of multiple table cells
simultaneously. In addition, add tab stops to table cells so
that text is shifted away from the cell margins.

Whentype text in a new table, choose to automatically
adjust the size of table cells.

Converting tables to text

If you no longer want table text to appear in a table, convert
the table text to paragraph text.

Merging and splitting tables and cells

Change how a table is configured by merging adjacent
cells, rows, and columns. Merge table cells, the formatting
of the upper-left cell is applied to all merged cells. Alterna-
tively, unmerge cells that were previously merged. Also
split table cells, rows, or columns. Splitting to create new
cells, rows, or columns without changing the size of the
table.

Adding images, graphics, and backgrounds to tables

If need to arrange bitmap images or vector graphics in an
orderly way, add them to tables. Also change the look of
a table by adding a background color using the property bar
and table menu.

Insert a graphic or an image by holding down the right
mouse button over the image, dragging the image to a cell,
releasing the right mouse button, and then clicking Place
inside cell.

IT&ITES: DTPO - Related Theory for Exercise 2.2.11

previously changed the sizes of some rows or columns,
redistribute all rows or all columns so that they are the
same size.
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Define bitmaps

An image composed of grids of pixels or dots. To convert
a vector graphic to a bitmap and also import and crop
bitmaps in CorelDRAW. Add color masks, watermarks,
special effects, and change the color and tone of the
images.

Importing files

To import files created in other applications. For example,
import a Portable Document Format (PDF), JPEG, or
Adobe Illustrator (AI) file. To import a file and place it in the
active application window as an object. And can also resize
and center a file as you import it. The imported file becomes
part of the active file. To import a bitmap as an externally
linked image. Link to an external file, edits to the original
file are automatically updated in the imported file.

While importing a bitmap, resample it to reduce the file
size, or crop it to eliminate unused areas of the photo. And
can also crop a bitmap to select only the exact area and
size of the image you want to import.

To import a file from an earlier version of CorelDRAW that
contains text in a language different from the language of
your operating system, you can use code page settings to
ensure that object names, keywords, and notes saved with
the file are displayed correctly.

Exporting files

Use the File Export command to export files to a variety of
bitmap and vector file formats that can be used in other
applications. For example, to export a file to the Adobe
Illustrator (AI) or GIF format. And also export a file so that
it is optimized for use with a suite of office productivity
applications, such as Microsoft Word or Corel WordPerfect
Office.

When to exporting a file, the original file is left open in the
drawing window in its existing format.

And also can use the File Save as command to save files
to various vector formats. After save a file to a different
format, the saved file is displayed immediately in the
drawing window. It is recommended that to first save the file
as a CorelDRAW (CDR) file because some file formats do
not support all of the features found in a CorelDRAW file.

Specify settings for such controls as dithering, anti-
aliasing, overprinting black, background transparency, and
color profile.

IT & ITES
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Adding and formatting the Bitmap
Objectives : At the end of this lesson you shall be able to
• explain the bitmap image and formatting the bitmap images
• explain the method of changing bitmaps to the paletted color mode
• define special effects in bitmaps
• describe convert Bitmaps to black-and-white images
• explain the bitmap due tone.

When to export a file to a bitmap file format, such as TIFF,
JPEG, CPT, or PSD, the same bitmap conversion options
are available.

Converting vector graphics to bitmaps

Converting a vector graphic or object to a bitmap lets to
apply special effects to the object with CorelDRAW. The
process of converting a vector graphic to a bitmap is also
known as "rasterizing."

Convert the vector graphic, to select the color mode of the
bitmap. A color mode determines the number and kind of
colors that make up the bitmap, so the file size is also
affected.

Changing the color mode of bitmaps

The colors of the images with in CorelDRAW are based on
color modes. Color modes define the color characteristics
of images and are described by their component colors.
The CMYK color mode is composed of cyan, magenta,
yellow, and black values; the RGB color mode is com-
posed of red, green, and blue values.

Although may not be able to see the difference between an
image in the CMYK color mode and an image in the RGB
color mode on screen, the images are quite different. For
the same image dimensions, an RGB image has a smaller
file size than a CMYK image and the RGB color space, or
gamut, can display more colors. Therefore, images in-
tended for the Web or desktop printers, which require
accurate color fidelity, are generally in RGB mode. Where
accurate print reproduction is needed, such as on a
commercial printing press, images are generally created in
CMYK mode. Paletted color images attempt to preserve
color fidelity while reducing the file size, making them ideal
for on-screen uses.

Each time to convert an image, may lose color information.
For this reason, should save an edited image before you
change it to a different color mode.

CorelDRAW supports the following color modes:

o   Black and White (1-bit)
o   Duotone (8-bit)
o   Grayscale (8-bit)
o   Paletted (8-bit)
o   RGB Color (24-bit)
o   Lab Color (24-bit)
o   CMYK Color (32-bit)
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The Ordered dithering option applies more quickly than the
error diffusion options (Jarvis, Stucki, and Floyd-Steinberg)
but is less accurate.

Specifying a range-sensitivity color

Change an image to the paletted color mode and specify
a focus color and a range sensitivity for the focus color, so
that the focus color and colors that fall within the range
settings are included in the processed color palette. To
specify how much emphasis to place on the range sensi-
tivity. Because the palette has a maximum of 256 colors,
emphasizing a focus color reduces the number of colors
that fall outside the range sensitivity.

Special effects in bitmaps

You can apply a wide range of special effects to bitmaps,
such as three-dimensional (3D) and artistic effects.

Special effect category

3D Effects

To create the illusion of depth. Effects include Emboss,
Page Curl, and Perspective.

Art Strokes

To apply hand-painted techniques. Effects include Crayon,
Impressionist, Pastels, Watercolor, and Pen & Ink.

Blur

To blur an image to simulate movement, speckling, or
gradual change. Effects include Gaussian Blur, Motion
Blur, and Zoom.

Camera

To simulate the effect produced by a diffusion lens

Color Transform

Create photographic illusions by using color reduction and
replacements. Effects include Halftone, Psychedelic, and
Solarize.

Contour

To highlight and enhance the edges of an image. Effects
include Edge Detect and Trace Contour.

Creative

To apply various textures and shapes to an image. Effects
include Fabric, Glass Block, Crystallize, Vortex, and
Stained Glass.

Distort  Lets you distort image surfaces. Effects include
Ripple, Blocks, Swirl, and Tile.

Noise

To modify the graininess of an image. Effects include Add
Noise, Remove Moire, and Remove Noise.

Sharpen

Add a sharpening effect to focus and enhance edges.
Effects include Adaptive Unsharp, High Pass, and Unsharp
Mask.

Introduction to Crop the bitmap image
To cut unwanted areas of an image without affecting the
resolution of the part that remains.

Cropping objects or bitmap images
Cropping means to quickly remove unwanted areas in
objects and imported graphics, eliminating the need to
ungroup objects, break linked groups apart, or convert
objects to curves. Can also crop vector objects and
bitmaps.

When cropping objects, to define a rectangular area
(cropping area) that to want keep. Object portions outside
the cropping area are removed. To specify the exact
position and size of the cropping area, and to rotate and
resize it. And also remove the cropping area.

To crop only selected objects without affecting other
objects in a drawing, or crop all objects on the drawing
page. In either case, the affected text and shape objects
are automatically converted to curves.

Changing bitmaps to the paletted color mode

The paletted color mode, also called indexed color mode,
is sometimes used for images on the World Wide Web.
When convert an image to the paletted color mode, a fixed
color value is assigned to each pixel. These values are
stored in a compact color table, or palette containing up to
256 colors. As a result, the paletted color mode image
contains less data than a 24 bit color mode image, and it
has a smaller file size. Conversion to paletted color mode
works best on images that have a limited range of colors.

Choosing, editing, and saving a color palette

To change an image to the paletted color mode, to use a
predefined palette, or to customize a color palette by
replacing individual colors.

Saving conversion settings

After choose a color palette and set the dithering and range
sensitivity for changing an image to the paletted color
mode, can save the settings as a conversion preset that to
use with other images. Add as many conversion presets as
you want.

The color palette you use is called the processed color
palette. It can be saved for use with other images.

Dithering

Changing images to the paletted color mode to use
dithering to enhance color information. Dithering places
pixels with specific colors or values relative to other pixels
of a specific color. The relationship of one colored pixel to
another creates the appearance of additional colors that do
not exist in the color palette.

Types of dithering

Ordered dithering and error diffusion. Ordered dithering
approximates color blends using fixed dot patterns; as a
result, solid colors are emphasized and edges appear
harder. Error diffusion scatters pixels irregularly, making
edges and colors softer. Jarvis, Stucki, and Floyd-Steinberg
are conversion options that provide error diffusion.

IT&ITES: DTPO - Related Theory for Exercise 2.2.12
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Plug-ins

Use a third-party filter to apply effects to bitmaps in
CorelDRAW.An installed plug-in appears at the bottom of
the Bitmaps menu.

Adding plug-in filters to CorelDRAW provides additional
features and effects that can use to edit images. To add
plug-in filters, and to remove them when you no longer need
them.

Convert Bitmaps to black-and-white images

To change any image to a black-and-white image. In
addition to conversion settings such as threshold, screen
type, and intensity, there are seven conversion options that
affect how the converted images will look.

Line art

Produces a high-contrast, black-and-white image. Colors
with a grayscale value lower than the threshold value that
you set change to black, while colors with a grayscale
value higher than the threshold value change to white.

Ordered

Organizes the gray levels into repeating geometric pat-
terns of black and white pixels. Solid colors are empha-
sized and image edges are hard. This option is best suited
for uniform colors.

Halftone

Creates different shades of gray by varying the pattern of
black and white pixels in an image. Choose the screen
type, angle for the halftone, lines per unit, and the unit of
measure.

Cardinality-Distribution

Creates a textured look by applying a calculation and
distributing the result to the screen.

Jarvis

Applies the Jarvis algorithm to the screen. This form of error
diffusion is suitable for photographic images.

Stucki

Applies the Stucki algorithm to the screen. This form of
error diffusion is suitable for photographic images.

Floyd-Steinberg

Applies the Floyd-Steinberg algorithm to the screen. This
form of error diffusion is suitable for photographic images.

Change bitmaps to duotones

To convert an image to a duotone, change a bitmap to the
grayscale color mode and enhance it using one to four
additional colors, giving the image greater tonal depth.

The following four variations of the color mode correspond
to the number of additional inks:

Monotone

A grayscale image colored with a single tone

Duotone

A grayscale image colored with two tones. In most cases,
one is black and the other is colored.

Tritone

A grayscale image colored with three tones. In most
cases, one is black and the other two are colored.

Quadtone

A grayscale image colored with four tones. In most cases,
one is black and the other three are colored.

Adjust tone curves

To change an image to a duotone, a tone curve grid that
represents the dynamic tone curves that are used through-
out the conversion is displayed. The horizontal plane (x-
axis) displays the 256 possible shades of gray in a
grayscale image (0 is black; 255 is white). The vertical
plane (y-axis) indicates the intensity of a color (from 0 to
100 percent) that is applied to the corresponding grayscale
values. For example, a grayscale pixel with a color value of
25 is printed with a 25-percent tint of the color. By adjusting
the tone curves, to control the color and intensity of the tone
that is added to an image.

Saving and loading inks

You can save an adjusted duotone tone curve and ink
settings and then load them for use with other bitmaps.

Specifying how overprint colors display

To change an image to a duotone, specify the colors to
overprint when to print an image. Overprint colors are used
to preserve color integrity when inks overlap. When display
the image, each color is applied on the screen in sequence,
creating a layered effect.

View all instances in which the colors to choose for the
duotone conversion overlap. Associated with each in-
stance is the color that is produced by the overlap. And also
choose new overprint colors to see how they overlap.

Duotones will hold their color ink information when saving
to Encapsulated PostScript (EPS), Portable Document
Format (PDF) and CorelDRAW (CDR) file formats. Other
file formats don't support duotone images.

IT&ITES: DTPO - Related Theory for Exercise 2.2.12
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Printing the work

Print command is used to produce hard copy of documents
or produce pdf files.To print one or more copies of the same
drawing using Corel Draw,Specify the page type and the
page range that you want to print.

Before printing a drawing, to specify printer properties,
including paper size and device options. For example,
specify that the printer features such as duplexing stapling.

Certain printers support the automatic matching of page
size and orientation. To enable this option, need to modify
the driver compatibility settings for the printer by clicking
Tools Options. In the list of categories, double-clicking
Global, Printing, clicking Driver compatibility, and enabling
the Printer can match document page sizes check box. In
the Print dialog box, choose Match orientation and size
from the Page list box.

Layout print jobs

Layout a print job by specifying the size, position, and
scale. Tiling a print job prints portions of each page on
separate sheets of paper that can assemble into one
sheet. For example, tile a print job that is larger than your
printer paper.

Image position and size area, enable one of the following
options:

• As in document - maintains the image size as it is in the
document

• Fit to page - sizes and positions the print job to fit to a
printed page

• Reposition images to - lets you reposition the print job
by choosing a position from the list box

Enabling the Reposition images to option to specify size,
position, and scale in the corresponding boxes.

Previewing print jobs

Preview finished work to show how the position and size of
the print job will appear on paper. For a detailed view, zoom
in on an area. To view how the individual color separations
will appear when printed.

Before printing your work, view a summary of issues for a
print job to find potential printing problems. For example,
you can check the current print job for print errors, possible
print problems, and suggestions for resolving issues.

IT & ITES
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Printing and printer properties in CorelDraw
Objectives : At the end of this lesson you shall be able to
• describe about printing the art work
• explain the imposition layout
• explain about the Printer's Mark's
• describe the printing color separation
• explain the color trapping and overprinting.

Print styles

A print style is a set of saved printing options. Each print
style is a separate file. This lets to move a print style from
one computer to another, back up a print style, and keep
document-specific styles in the same directory as the
document file.

Select an existing print style, create a new print style, or
edit a print style and save the changes. And also delete
print styles.

Fine-tuning print jobs

Fine-tune print jobs before to ensure printing quality.
Because problems sometimes occur the printing text to a
non-PostScript printing device (GDI printer), decrease is
printing time by specifying driver compatibility for non-
PostScript printing devices.

If a printing device has difficulty processing large bitmaps,
can divide a bitmap into smaller, more manageable chunks
by setting an output threshold. If any lines appear when the
printing device prints the chunks, set an overlap value to
produce a seamless image.

On occasion, may experience difficulties with printing
complex files. Print complex files, to spend a considerable
amount of time fixing and correcting the files. Another
option is to convert a page to a bitmap, which is also known
as rasterizing, which can allow to print complex files.

To reduce file size, can down sample bitmaps. Because
bitmaps are made up of pixels, when down sample a
bitmap, the number of pixels per line decreases, which
decreases the file size.

Printing colors accurately

CorelDRAW allows to manage colors when printing to help
ensure accurate color reproduction. Print the document
with the document colors settings applied or choose
alternate color settings only for printing. Also print a
document using the color proofing settings that previously
specified in the Color proof settings docker.

In addition, to choose a rendering intent to effectively
interpret the out-of-gamut colors when printing. The render-
ing intent that choose depends on the graphical content of
the document.

Notes for GDI printers

GDI printers support only two color spaces: RGB and
Grayscale. If the document contains colors from multiple
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color spaces, for example RGB, CMYK, and spot colors,
must convert all of the colors to RGB or Grayscale before
printing.

Printing to a PostScript printer

PostScript is a page-description language that sends
printing instructions to a PostScript device. All the elements
in a print job (for example, curves and text) are represented
by lines of PostScript code that the printing device uses to
produce the document. For improved compatibility choose
a device independent PostScript device. To select a
PostScript Printer Description (PPD) file. A PostScript
Printer Description file describes the capabilities and
features of PostScript printer and is available from the
printer's manufacturer.

Imposition layouts

Impositionlayouts to print more than one page of a document
on each sheet of paper. Choose a preset imposition layout
to create documents such as magazines and books to
print on a commercial printing press; produce documents
that involve cutting or folding, such as mailing labels,
business cards, pamphlets, or greeting cards; or print
multiple thumbnails of a document on one page. And also
edit a preset imposition layout to create your own layout.

To select a binding method by choosing from three preset
binding methods, or customize a binding method. Choose
a preset binding method, all but the first signature are
automatically arranged.

Arrange pages on a signature manually or automatically.
The arrange the pages automatically, choose the angle of
the image. If have more than one page across or down,
specify the size of gutters between pages; for example,
choose the automatic gutter spacing option, which sizes
gutters so that the document's pages fill the entire available
space in the layout.

When printing on a desktop printer, adjust the margins to
accommodate the non-printable area of a page. If the
margin is smaller than the non-printable area, the edges of
some pages or some printers' marks may be clipped by the
printer.

Printing printers' marks

Printing printers' marks to display information on a page
about how a document should be printed. To specify the
position of the printers' marks on the page.

The available printers' marks are as follows:

Crop/fold marks

Represent the size of the paper and print at the corners of
the page. Print crop/fold marks to use as guides to trim the
paper. If the print multiple pages per sheet (for example,
two rows by two columns), to choose to print the crop/fold
marks on the outside edge of the page so that all crop/fold
marks are removed after the cropping process, or choose
to add crop marks around each row and column. Crop/fold
marks ensure that marks appear on each plate of a
separated CMYK file.

Bleed limit

Determines how far an image can extend beyond the crop
marks. When to use a bleed to extend the print job to the
edge of the page, must set a bleed limit. A bleed requires
that the paper printing on is larger than the size of paper to
ultimately want, and the print job must extend beyond the
edge of the final paper size.

Registration marks

Required to line up film for proofing or printing plates on a
color press. They print on each sheet of a color separation.

Color calibration bars

Color scales that print on each sheet of a color separation
and ensure accurate color reproduction. To see calibration
bars, the page size of the print job must be larger than the
page size of the work on the printing.

Densitometer scale

Densitometer is a series of gray boxes ranging from light
to dark. These boxes are required to test the density of
halftone images. Position the densitometer scale anywhere
on the page. Customize the levels of gray that appear in
each of the seven squares on the densitometer scale.

Page numbers

Page numbers helps you collate pages of an image that do
not include any page numbers or do not contain page
numbers that correspond to the actual number of pages

File information

Prints file information, such as, the color profile; halftone
settings; name, date, and time the image was created;
plate number; and job name

Maintain OPI links

Open Prepress Interface (OPI) lets to use low-resolution
images as placeholders for the high-resolution images that
appear in your final work. When a print service provider
receives the file, the OPI server substitutes the high-
resolution images for the low-resolution placeholders.

The Maintain OPI links option is available for PostScript
devices only.

Printing color separations

Printing color separations to send color work to a print
service provider or printing shop, either or the print service
provider must create color separations. Color separations
are necessary because a typical printing press applies
only one color of ink at a time to a sheet of paper. Specify
the color separations to print, including the order in which
they print.

Printing presses produce color using either process color
or spot color, or both. Convert the spot colors to process
colors at printing time.

When setting halftone screens to print color separations,
we recommend that to use default settings; otherwise,
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screens can be improperly set and result in undesirable
moiré patterns and poor color reproduction. However, if
using an imagesetter, the screen technology should be set
to match the type of imagesetter the print service provider
uses. Before customizing a halftone screen, consult the
print service provider to determine the correct setting.

If have overprinted areas, to choose how you want those
areas to print.

Change the order in which color separations print, by
enabling the Use advanced settings check box in the
Options area. In the separations list at the bottom of the
dialog box, click in the Order column next to the color
separation that to want change. Chose a new order value
from the list box.

If want to print separations using a color profile that is
different than the document color profile, click the Color
tab, and choose a color profile from the Correct colors using
color profile list box.

Color trapping and overprinting

When colors are trapped, they are intentionally overlapped
so that misalignments of print separations are not notice-
able. In manual trapping, one color must overprint the other.
Overprinting is achieved by printing one color over another.
Overprint trapping works best when the top color is much
darker than the underlying color; otherwise, an undesirable
third color may result (for example, cyan over yellow results
in a green object). In some cases, might actually want to
create a third color; for example, overprint two spot colors
to create a third color.

How overprinted colors mix depends on the type of colors
and ink are mixing and the types of objects are overprinting.
For example, an object that uses a CMYK color overprints
differently from an object that uses a spot color. Bitmaps
also overprint differently from vector objects. That can
preview a simulation of how overprinted colors will mix by
using the Enhanced with overprints viewing mode.

When ready to print, choose to preserve overprint settings
if you want to trap objects in a document, or if want to mix
the overlapping colors for effect. Choose to knock out the
overprinted areas so that only the top color is visible. If want
to print a proof version of the file, can simulate overprints.
Simulating overprints rasterizes the file, and it prints using
process colors only.

To set a group of objects to overprint. The overprint bitmaps;
or each vector object's fill, or outline, or both. And also
overprint specific color separations and specify in which
order they will print, as well as whether want to overprint
graphics, or text, or both.

The two methods for color trapping automatically are
always overprinting black and auto-spreading. Always
overprinting black creates a color trap by causing any
object that contains 95% black or more to overprint any
underlying objects. This option is useful for artwork con-
taining a lot of black text, but it should be used with caution
on artwork with a high graphics content. To adjust the
threshold, if the print service provider recommends a black
threshold value other than 95%.

Auto-spreading creates color trapping by assigning an
outline to an object that is the same color as the object's
fill and having it overprint underlying objects. Auto-spread-
ing is created for all objects in the file that meet three
conditions: they do not already have an outline, are filled
with a uniform fill, and have not already been designated to
overprint.

Specifying In-RIP trapping settings

In-RIP trapping allows you to specify advanced trapping
settings. Before selecting In-RIP trapping, ensure that your
PostScript 3 printer supports In-RIP trapping options.

Select a trap width - the amount that one color spreads into
another. Specify image trap placement, which determines
where the trap occurs. For example, specify whether the
trap is a choke or a spread, depending upon the neutral
densities of adjacent colors. Neutral density indicates the
lightness or darkness of a color and helps determine how
adjacent colors spread into one another.

Specify a threshold at which a trap is created by specifying
a step trap limit. If trap colors are of similar neutral
densities, the trap placement adjusts accordingly. The
step trap limit specifies a threshold at which a trap adjusts.

Before trapping, to set the inks; for example, set an ink to
opaque, as in the case of a metallic ink, so that nothing
shows through it. To reduce the visibility of a trap, decrease
the amount of ink color in a trap. This is especially helpful
in the case of pastel colors, contrasting colors, and colors
with similar neutral densities.

Print to film
To set up a print job to produce negative images. An
imagesetter produces images on film that may need to be
produced as negatives depending on which printing device
are using. Consult the print service provider to determine
whether the produce images on film.
Specify to print with the emulsion down. Printing with the
emulsion down produces a backward image on desktop
printers.
Print service provider

When send a file to a print service provider, the provider
takes your file and converts it directly to film or to plates.

When prepare a print job for printing, which can send
camera-ready paper output or the work on disk. If send the
work on disk, the print service provider needs either a
PostScript file or a native file from the application that to
use. Creating a file to send to an imagesetter or a plate-
setter, speak with the print service provider about the best
file format and printing device settings to use. Always
provide a final printout of the work to the print service
provider, even if it is only a black-and-white representation.
This helps the print service provider to identify and assess
any potential problems.

Before printing a drawing, choose and properly configure
the appropriate printing device driver. Consult the printing
device manufacturer instructions, or the print service pro-
vider or printing shop that to use to print the work, to find out
the best way to set up the printing device driver.
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IT & ITES
DTPO - InDesign                                          Related Theory for Exercise 2.3.01

Creating a document and column set up for a variety of publications
Objectives : At the end of this lesson you shall be able to
• learning about new document options
• learning about new print document in multiple column layout
• understanding new book work layout.

Introduction

Adobe InDesign is a desktop publishing software applica-
tion produced by Adobe Systems. InDesign is a page
layout application in which graphics (created elsewhere)
and text are combined to create layouts and prepare them
for printing. Graphics can be used to create works such as
posters, flyers, brochures, magazines, newspapers and
books. InDesign can also publish content suitable for tablet
devices in conjunction with Adobe Digital Publishing Suite.

Graphic designers and production artists are the principal
users, reating adn laying out periodical publications, post-
ers, and print media. It also supports export to EPUB and
SWF formats to create e-books and digigtal publications,
including digital magazines, and content suitable for con-
sumption on tablet computers. The Adobe InCopy word
processor uses the same formatting engine as InDesign.

InDesign is the successor to Adobe PageMaker, which
was acquired with the purchase of Aldus in late 1994.
Actually Indesign is Adobe’s replacemetn of PageMaker.
In 2002, InDesign was the first Mac OS X-native desktop
publishing software. In version 3 (InDesign CS) it received
a boost in distribution by being bundled with Photoshop,
Illustrator, and Acrobat in the Creative Suite.

InDesign exports documents in Adobe’s Portable Docu-
ment (PDF) format and has multilingual support. It was the
first DTP application to support Unicode for text process-
ing, advanced typography with OpenType fonts, advanced
transparency features, layout styles, optical margin align-
ment and cross-platform scripting using JavaScript.

Intent

If you are creating a document to be output to PDF or SWF
for the web, choosing the Web option changes several
options in the dialog box, such as turning off Facing Pages,
changing the orientation from portrait to landscape, and
using a page size based on monitor resolution. You can
edit any of these settings after the document is created.

CS6 and later: Digital publishing intent has been added for
publications aimed for the Digital Publishing Suite. You
can also change the intent of the document after it is
created.

Number of pages

Specify the number of pages to create in the new docu-
ment.

Start Page #

Specify which number the document starts on. If you
specify an even number (such as 2) with Facing Pages
selected, the first spread in the document begins with a
two-page spread.

Facing Pages

Select this option to make left and right pages face each
other in a double-page spread, such as for books and
magazines. Deselect this option to let each page stand
alone, such as when you're printing flyers or posters or
when you want objects to bleed in the binding.

After you've created a document, you can use the Pages
panel to create spreads with more than two pages or force
the first two pages to open as a spread.

Master Text Frame

CS5.5 and earlier: Select this option to create a text frame
the size of the area within the margin guides, matching the
column settings you specified. The master text frame is
added to the A Master.

The Master Text Frame option is available only when you've
chosen File > New > Document.

Primary Text Frame

CS6  and later: select this option to add a primary text
frame on the master page. When you apply a new master
page, the story in the primary text frame automatically
flows into the primary text frame of the new master page.

Page Size

Choose a page size from the menu, or type values for Width
and Height. Page size represents the final size you want
after bleeds or other marks outside the page are trimmed.

Orientation

Click Portrait  (tall) or Landscape (wide). These
icons interact dynamically with the dimensions you enter
in Page Size. When Height is the larger value, the portrait
icon is selected. When Width is the larger value, the
landscape icon is selected. Clicking the deselected icon
switches the Height and Width values.

Tip: To specify the dimensions of the bleed and slug areas,
click the Arrow button before the Bleed and Slug label in the
New Document dialog box. To make the bleed or slug areas
extend evenly on all sides, click the Make All Settings The
Same icon .
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Document window notes

Lines of other colors are ruler guides which, when present,
appear in the layer color when selected.

Column guides appear in front of margin guides. When a
column guide is exactly in front of a margin guide, it hides
the margin guide.

Create custom page sizes

You can create custom page sizes that appear in the Page
Size menu in the New Document dialog box.

1. Choose File > New > Document.

2. Choose Custom Page Size from the Page Size menu.

3. Type a name for the page size, specify page size
settings, and then click Add.

The New Doc Sizes.txt file that lets you create custom
page sizes in previous version of InDesign is not available
in InDesign CS5 or later.

Define document presets

You can save document settings for page size, columns,
margins, and bleed and slug areas in a preset to save time
and ensure consistency when creating similar documents.

1. Choose File > Document Presets > Define.
2. Click New in the dialog box that appears.
3. Specify a name for the preset and select basic layout

options in the New Document Preset dialog box.
4. Click OK twice.

You can save a document preset to a separate file and
distribute it to other users. To save and load document
preset files, use the Save and Load buttons in the Docu-
ment Presets dialog box.

Change document setup, margins, and columns

After you create a document, you may change your mind
about how you want it set up. For example, you may want
single pages instead of facing pages, or you may want to
change the page size or margin settings.

Change document setup

Changing options in the Document Setup dialog box
affects every page in the document. If you change page
size or orientation after objects have been added to pages,
you can use the Layout Adjustment feature to minimize the
amount of time needed for arranging existing objects.

1. Choose File > Document Setup.

2. Specify the document options, and then click OK.

Change page margin and column settings

You can change column and margin settings for pages and
spreads. When you change the column and margin set-
tings on a master page, you change the setting for all pages
to which the master is applied. Changing the columns and
margins of regular pages affects only those pages selected
in the Pages panel.

Bleed

The Bleed area allows you to print objects that are arranged
at the outer edge of the defined page size. For a page of the
required dimensions, if an object is positioned at its edge,
some white may appear at the edge of the printed area due
to slight misalignment during printing or trimming. For this
reason, you should position an object that is at the edge of
the page of the required dimensions a little beyond the
edge, and trim after printing. Bleed area is shown by a red
line on the document. You can set bleed area settings from
Bleed in the Print dialog box.

Slug

The slug area is discarded when the document is trimmed
to its final page size. The slug area holds printing informa-
tion, customized color bar information, or displays other
instructions and descriptions for other information in the
document. Objects (including text frames) positioned in
the slug area are printed but will disappear when the
document is trimmed to its final page size.

Objects outside the bleed or slug area (whichever extends
farther) do not print.

Preview

(Only in InDesign CC) Select this checkbox to see how
your new document will look like. Make necessary changes
to the options if the preview is not as desired.

You can also click the Save Document Preset
icon to save document settings for future use

Document window overview

Each page or spread in your document has its own
pasteboard and guides, which are visible in Normal View
mode. (To switch to Normal View, choose View > Screen
Mode > Normal.) The pasteboard is replaced with a gray
background when the document is viewed using one of the
Preview modes. You can change the color of this preview
background and guides in Guides & Pasteboard prefer-
ences.

Document and guides in Normal View Mode

A. Spread (black lines) B. Page (black lines) C. Margin
guides (magenta lines) D. Column guides (violet lines) E.
Bleed area (red lines) F. Slug area (blue lines)
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The Margins and Columns dialog box doesn't
alter columns inside text frames. Text frame
columns exist only within individual text frames,
not on the page itself. You can set up columns
within individual text frames by using the Text
Frame Options dialog box. Text frame columns
can also be affected by the Layout Adjustment
feature.

Do one of the following:

1. To change margin and column settings for one spread
or page, go to the spread you want to change, or select
one spread or page in the Pages panel.

2. To change margin and column settings for multiple
pages, select those pages in the Pages panel, or select
a master that controls the pages you want to change.

3. Choose Layout > Margins And Columns, specify the
following options, and then click OK.

Margins

Type values to specify the distance between margin guides
and each edge of the page. If Facing Pages is selected in
the New Document or Document Setup dialog box, the Left
and Right margin option names change to Inside and
Outside, so that you can specify additional inside margin
space to accommodate binding.

Columns

Specify the number of columns.

Select Horizontal or Vertical to specify the column direc-
tion. This also sets the writing direction of the document
baseline grid.

Create unequal column widths

When you have more than one column on a page, the
column guides in the middle appear in pairs. When you
drag one column guide, the pair moves. The space between
the column guides is the gutter value you specified; the pair
moves together to maintain that value.

You cannot create unequal column widths for
columns in a text frame. Instead, created
threaded, side-by-side text frames with differ-
ent column widths.

1. Go to the master or spread you want to change.

2. If column guides are locked, choose View > Grids&
Guides > Lock Column Guides to deselect it.

3. Using the Selection tool , drag a column guide. You
can't drag it past an adjacent column guide or beyond
the edge of the page.
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Dragging a column guide to create unequal column
widths

To create columns with unequal gutters, create evenly
spaced ruler guides and then drag individual guides to the
desired location.
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Identification and use of tools, rulers, guides and snap-to-guides
Objectives : At the end of this lesson you shall be able to
• learn and use of tools, rulers, guides and snap-to guides
• learn and use of transformation, modification and navigation tools
• learn about layers, rulers guide and use of smart guides
• learn and use of grids adn snapping object to grids.

Toolbox overview

Some tools in the toolbox are for selecting, editing, and
creating page elements. Other tools are for choosing type,
shapes, lines, and gradients. You can change the overall
layout of the toolbox to fit your preferred window and panel
layout. By default, the toolbox appears as a single vertical
column of tools. You can also set it up as a double vertical
column or as one horizontal row. However, you can't
rearrange the positions of individual tools in the toolbox.
You can drag the top of the toolbox to move it.

Select a tool from the default toolbox by clicking it. The
toolbox also contains several hidden tools related to the
visible tools. Hidden tools are indicated by arrows to the
right of the tool icons. Select a hidden tool by clicking and
holding the current tool in the toolbox and then selecting
the tool that you want.

The name of the tool and its keyboard shortcut appear
when you hold the pointer over the tool-this text is called the
tool tip. You can turn off tool tips by choosing None from the
Tool Tips menu in Interface preferences.

Open the Tool Hints panel (choose Window > Utilities >
Tool Hints) to see which shortcut and modifier keys work
with the selected tool.

Content Collector and Content Placer tools are
not available in CS5.5 or earlier.

Gallery of selection tools
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Gallery of drawing and type tools
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Gallery of transformation tools
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Gallery of modification and navigation tools

 

 
About layers

Each document includes at least one named layer. By
using multiple layers, you can create and edit specific
areas or kinds of content in your document without affect-
ing other areas or kinds of content. For example, if your
document prints slowly because it contains many large
graphics, you can use one layer for just the text in your
document; then, when it's time to proofread the text, you
can hide all other layers and quickly print the text layer
only. You can also use layers to display alternate design
ideas for the same layout, or versions of advertisements for
different regions.

Create layers

You can add layers at any time using the New Layer
command on the Layers panel menu or the New Layer
button at the bottom of the Layers panel. The number of
layers a document can have is limited only by the RAM
available to InDesign.

Specify layer options

1. Choose New Layer in the Layers panel menu, or double-
click an existing layer.

2. Specify the layer options, and then click OK.
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Color

Assign a color to identify the objects on that layer.

Show Layer

Select this option to make a layer visible. Selecting this
option is the same as making the eye icon visible in the
Layers panel.

Show Guides

Select this option to make the guides on the layer visible.
When this option is not selected for a layer, the guides
cannot be made visible, even by selecting View > Show
Guides for the document.

Lock Layer

Select this option to prevent changes to any objects on the
layer. Selecting this option is the same as making the
crossed-out pencil icon visible in the Layers panel.

Lock Guides

Select this option to prevent changes to all ruler guides on
the layer.

Print Layer

Select this option to allow the layer to be prevented from
printing. When printing or exporting to PDF, you can
determine whether to print hidden and nonprinting layers.

Suppress Text Wrap When Layer Is Hidden

Select this option if you want text on other layers to flow
normally when the layer is hidden and it contains objects
with text wrap applied.

Assign a layer color

Assigning a color to a layer makes it easier to distinguish
the layers of different selected objects. For each layer that
contains a selected object, the Layers panel displays a dot
in the layer's color. On the page, each object displays the
color of its layer in its selection handles, bounding box, text
ports, text wrap boundary (if used), frame edges (including
the X displayed by an empty graphics frame), and hidden
characters.

Merge layers in a document

You can reduce the number of layers in a document without
deleting any objects by merging layers. When you merge
layers, objects from all selected layers are moved to the
target layer. Of the layers you merge, only the target layer
remains in the document; the other selected layers are
deleted. You can also flatten a document by merging all
layers.

If you merge layers containing a mix of page
objects and master items, the master items
move to the back of the resulting merged layer.

Create ruler guides

Ruler guides are different from grids in that they can be
positioned freely on a page or on a pasteboard. You can
create two kinds of ruler guides: page guides, which appear
only on the page on which you create them, or spread
guides, which span all pages and the pasteboard of a

multiple-page spread. You can drag any ruler guide to the
pasteboard. A ruler guide is displayed or hidden with the
layer on which it was created.

New ruler guides always appear on the target spread. For
example, if several spreads are visible in the document
window and you drag a new guide into the window, the new
guide becomes visible only on the target spread.

A. Spread guide B. Page guide

Work with ruler guides

You can change the attributes of individual ruler guides,
and you can move, cut, copy, paste, or delete multiple ruler
guides simultaneously. Cut or copied ruler guides can be
pasted to other pages or documents, but not to other
programs. To change attributes of specific guides, you
must select the guides you want to change. When no
guides are selected, the Ruler Guides command sets the
defaults for new guides only.

Select ruler guides

Unselected ruler guides appear light blue by default.
Selected ruler guides are highlighted in their layer color.
When a guide is selected, the Reference Point icon in the
Control panel changes to  or , representing the
selected guide.

To select a single ruler guide, use the Selection tool  or
the Direct Selection tool   and click the guide to highlight
it in its layer color.

If you can't select a ruler guide and the View > Grids &
Guides > Lock Guides command is already deselected,
the guide might be on that page's master, or on a layer
where guides are locked.

To select multiple ruler guides, hold down Shift as you click
guides using the Selection or Direct Selection tool. You
can also drag over multiple guides, as long as the selection
marquee doesn't touch or enclose any other object.

To select all ruler guides on the target spread, press
Ctrl+Alt+G (Windows) or Command+Option+G (Mac OS).

Snap objects to guides and grids

To precisely align objects to guides, use the Snap To
Guides and Snap To Document Grid commands. Object
edges will snap to (be pulled toward) the nearest grid
intersection or guide when you draw, move, or resize the
objects.

Guides in the document window
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The exact range within which an object snaps to guides is
called the snap-to zone, which you can adjust. When you
select both the Snap To Guides and the Snap To Document
Grid commands, the grid takes precedence.

Keep the following guidelines in mind as you align objects
to guides and grids:

• To snap an object to a guide, drag an object toward a
guide until one or more of the object's edges is within the
guide's snap-to zone.

• Guides must be visible for objects to snap to them.
However, objects can snap to the document and baseline
grids whether the grids are visible or not.

• Objects on one layer snap to ruler guides visible on any
other layer. If you don't want objects to snap to guides
on a certain layer, hide that layer's guides.

• To snap the text baseline to the baseline grid, choose
Grid Alignment > Roman Baseline from the Control
panel menu or Paragraph panel menu. Alternatively, set
Grid Alignment to Roman Baseline from the column
style Grid Settings.

• For the baselines of text to snap to the baseline grid,
press the Align to Baseline Grid button  for individual
paragraphs or paragraph styles.

Use smart guides

The Smart Guides feature makes it easy to snap objects
to items in your layout. As you drag or create an object,
temporary guides appear, indicating that the object is
aligned with an edge or center of the page or with another
page item.

By default, the Smart Guides feature is selected. You can
turn off smart guides, or you can turn off any of the smart
guide categories:

Smart Object Alignment

Smart object alignment allows for easy snapping to page
item centers or edges. In addition to snapping, smart
guides dynamically draw to indicate which object is being
snapped to.

Smart Dimensions

Smart dimension feedback appears when you're resizing,
creating, or rotating page items. For example, if you rotate
one object on your page 24 degrees, a rotation icon
appears as you rotate another object close to 24 degrees.
This hint lets you snap the object to the same rotation angle
of the adjacent object. Similarly, as you resize an object
next to another object, a line segment with arrows at each
end lets you snap the object to the same width or height as
the adjacent object.

Smart Spacing

Smart spacing lets you quickly arrange page items with the
help of temporary guides that indicate when the spacing
between objects is even.

Smart Cursors

Smart cursor feedback appears in a gray box as X and Y
values when you're moving or resizing object or as a
measurement when you're rotating values. The Show
Transformation Values option in Interface preferences lets
you turn smart cursors on and off.

Use grids

Two kinds of nonprinting grids are available: a baseline grid
for aligning columns of text, and a document grid for
aligning objects. On the screen, a baseline grid resembles
ruled notebook paper, and a document grid resembles
graph paper. You can customize both kinds of grids.

When a grid is visible, you can observe the following
characteristics:

• The baseline grid covers entire spreads, but the docu-
ment grid covers the entire pasteboard.

• Baseline grids and document grids appear on every
spread and cannot be assigned to any master.

• The document grid can appear in front of or behind all
guides, layers, and objects, but cannot be assigned to
any layer.

Snapping objects to grids

When snapping is enabled, moving an object within the
snap zone of a grid location will cause the object to snap
to that location.

Baseline grid (left) and document grid (right)
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Formatting text and page
Objectives : At the end of this lesson you shall be able to
• explain the text, text frame and formatting the text
• explain about add text to a document and formatting the paragraph
• define Tabs and Indents
• learn the thread text frame, flow text to the text frame
• define Master, and spread and format the pages.

Create text frames

Text in InDesign resides inside containers called text
frames. (A text frame is similar to a text box in QuarkXPress
and a text block in Adobe PageMaker.)

There are two types of text frames: frame grids and plain
text frames. Frame grids are the kind of text frames specific
to Asian-language composition in which character emboxes
and spacing are displayed as grids. Empty text frames in
which no grid is displayed are plain text frames.

Like graphics frames, text frames can be moved, resized,
and changed. The tool with which you select a text frame
determines the kind of changes you can make:

• Use the Type tool to enter or edit text in a frame.

• Use the Selection tool  for general layout tasks such
as positioning and sizing a frame.

• Use the Direct Selection tool  to alter a frame's shape.

• Use the Horizontal Grid tool  or the Vertical Grid tool
 to create a frame grid.

Use the Type tool to create a plain text frame for
horizontal text, and the Vertical Type tool  to create a
plain text frame for vertical text. Use the same tools to edit
existing text in a frame.

Text frames can also be connected to other text frames so
that the text in one frame can flow into another frame.
Frames that are connected in this way are threaded. Text
that flows through one or more threaded frames is called a
story. When you place (import) a word-processing file, it
comes into your document as a single story, regardless of
the number of frames it may occupy.

Text frames can have multiple columns. Text frames can
be based on, yet independent of, page columns. In other
words, a two-column text frame can sit on a four-column
page. Text frames can also be placed on master pages and
still receive text on document pages.

If you use the same type of text frame repeatedly, you can
create an object style that includes text frame formatting
such as stroke and fill colors, text frame options, and text
wrap and transparency effects.

When you place or paste text, you don't need to create a
text frame; InDesign automatically adds frames based on
the page's column settings.

When text is pasted, a plain text frame is automatically
created. You can also create an empty plain text frame
manually and input text.

• Do any of the following:

Select the Type tool , and then drag to define the width
and height of a new text frame. Hold down Shift as you drag
to constrain the frame to a square. When you release the
mouse button, a text insertion point appears in the frame.

Using the Selection tool, click the in port or out port of
another text frame, and then click or drag to create another
frame.

Use the Place command to place a text file.

Using the Type tool , click inside any empty frame. If the
Type Tool Converts Frames To Text Frames option is
selected in Type preferences, the empty frame is converted
to a text frame.

Using text frames on master pages

When you start a new document, you can select the
Master Text Frame option so that an empty text frame is
placed on the document's default master page. This frame
has the column and margin attributes specified in the New
Document dialog box.

Follow these guidelines for using text frames on master
pages:

• Set master text frames when you want each page in
your document to contain a page-sized text frame into
which you can flow or type your text. If your document
requires more variation, such as pages with different
numbers of frames or frames of different lengths, leave
the Master Text Frame option deselected, and use the
Type tool to create text frames on masters.

Dragging to create new text frame
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• Whether or not you select the Master Text Frame
option, you can add text frames to a master page to act
as placeholders. You can thread these empty place-
holder frames together to establish a flow.

• Flow text into master text frames using the same
procedures you would use with frames created on
document pages.

• If you need to type text in a master text frame on a
document page, hold down Ctrl+Shift as you click the
text frame on the document page. Then click in the
frame using the Type tool and begin typing.

• You can use Smart Text Reflow to add or remove pages
automatically as you type and edit text. By default,
when you type text at the end of a threaded text frame
based on a master page, a new page is added, allowing
you to continue typing in the new text frame. You can
edit Smart Text Reflow settings.

• If you change the page margins, text frames adjust to
the new margins only if the Enable Layout Adjustment
option is selected.

• Selecting the Master Text Frame option does not affect
whether new pages are added when you autoflow text.

Change text frame properties

Use Text Frame Options to change settings such as the
number of columns in the frame, the vertical alignment of
text within the frame, or the inset spacing, which is the
distance of the margins between the text and the frame.

If you need to use the same text frame properties for
multiple text frames, create an object style that you can
apply to your text frames.

First baseline offset options

To change the first baseline options of a selected text
frame, choose Object > Text Frame Options, and click the
Baseline Options tab. The following options appear in the
Offset menu under First Baseline:

Ascent

The height of the "d" character in the font falls below the top
inset of the text frame.

Cap Height

The top of uppercase letters touch the top inset of the text
frame.

Leading

Use the text's leading value as the distance between the
baseline of the first line of text and the top inset of the frame.

Before (left) and after (right) setting inset and creating two columns in a text frame

X Height

The height of the "x" character in the font falls below the top
inset of the frame.

Fixed

Specify the distance between the baseline of the first line
of text and the top inset of the frame.

Min

Select a minimum value for the baseline offset. For ex-
ample, if Leading is selected and you specify a minimum
value of 1p, InDesign uses the leading value only when it's
greater than 1 pica.

If you want to snap the top of the text frame to a grid, choose
either Leading or Fixed so that you can control the location
of the first baseline of text in text frames.
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Add text to a document

Add text to a document by typing or by pasting or placing
text from a word-processing application. If your word-
processing application supports drag-and-drop, you can
also drag text into InDesign frames. For large blocks of
text, the Place command is an efficient, versatile way to
add text to your document. InDesign supports a variety of
word-processing, spreadsheet, and text file formats.
When you place or paste text, you do not need to create
a text frame first; InDesign will create one for you automati-
cally.
When you place text, you can select Show Import Options
to determine whether the imported text maintains its styles
and formatting. Before you paste text, you can select All
Information or Text Only under Clipboard Handling Prefer-
ences to determine whether the pasted text includes
additional information such as swatches and styles.
If the text you import into your document includes pink,
green, or another color of highlighting, you likely have one
or more composition preference options turned on. Open
the Composition section of the Preferences dialog box, and
notice which options are turned on under Highlight. For
example, if the pasted text is formatted with fonts not
available, the text is highlighted in pink.
Paste text
If the insertion point is not inside a text frame when you
paste text into InDesign, a new plain text frame will be
created. If the insertion point is inside a text frame, the text
will be pasted inside that frame. If you have text selected
when you paste, the pasted text will overwrite the selected
text.
About import filters

InDesign imports most character and paragraph formatting
attributes from text files but ignores most page-layout
information, such as margin and column settings (which
you can set in InDesign). Note the following:

• InDesign generally imports all formatting information
specified in the word-processing application, except
information forward-processing features not available in
InDesign.

• InDesign can add imported styles to its list of styles for
the document. A disk icon   appears next to imported
styles.

• The import options appear when you select Show
Import Options in the Place dialog box, or when you
import an Excel file. If Show Import Options is dese-
lected, InDesign uses the import options last used for
a similar document type. The options you set remain in
effect until you change them.

• If InDesign cannot find a filter that recognizes a file by
either its file type or file extension, an alert message
appears. For best results in Windows, use the standard
extension (such as .doc, .docx, .txt, .rtf, .xls, or .xlsx)
for the type of file you're importing. You may need to
open the file in its original application and save it in a
different format, such as RTF or text-only.

Formatting characters

Apply baseline shift

Use Baseline Shift to move a selected character up or down
relative to the baseline of the surrounding text. This option
is especially useful when you're hand-setting fractions or
adjusting the position of inline graphics.

Change underline or strikethrough options

Creating custom underlining is especially useful when you
want to create an even underline below characters of
different sizes, or for creating special effects, such as
background highlighting.

Apply ligatures to letter pairs

InDesign can automatically insert ligatures, which are
typographic replacement characters for certain letter pairs,
such as "fi" and "fl," when they are available in a given font.
The characters that InDesign uses when the Ligature
option is selected appear and print as ligatures, but are fully
editable, and do not cause the spell checker to flag a word
erroneously.

Before and after adjusting underlines

Individual characters (top) and ligature combinations
(bottom)

With OpenType fonts, when you choose Ligatures from the
Character panel menu or Control panel menu, InDesign
produces any standard ligature defined in the font, as
determined by the font designer. However, some fonts
include more ornate, optional ligatures, which can be
produced when you choose the Discretionary Ligatures
command.



174 IT&ITES: DTPO - Related Theory for Exercise 2.3.03

About kerning and tracking

Kerning is the process of adding or subtracting space
between specific pairs of characters. Tracking is the
process of loosening or tightening a block of text.

Values for kerning and tracking affect Japa-
nese text but normally these options are used
to adjust the aki between roman characters.

Types of kerning

You can automatically kern type using metrics kerning or
optical kerning. Metrics kerning uses kern pairs, which are
included with most fonts. Kern pairs contain information
about the spacing of specific pairs of letters. Some of these
are: LA, P., To, Tr, Ta, Tu, Te, Ty, Wa, WA, We, Wo, Ya,
and Yo.

InDesign uses metrics kerning by default so that specific
pairs are automatically kerned when you import or type
text. To disable metrics kerning, select "0".

Optical kerning adjusts the spacing between adjacent
characters based on their shapes. Some fonts include
robust kern-pair specifications. However, when a font
includes only minimal built-in kerning or none at all, or if you
use two different typefaces or sizes in one or more words
on a line, you may want to use the optical kerning option.

Optical kerning adjusts the spacing between adjacent
characters based on their shapes, and is optimized for use
with Roman glyphs. Some fonts include robust kern-pair
specifications. However, when a font includes only minimal
built-in kerning or none at all, or if you use two different
typefaces or sizes in one or more words on a line, you may
want to use the optical kerning option for the Roman text
in your document.

A. Original B. Kerning applied between "W" and "a" C.
Tracking applied

How kerning and tracking are measured

You can apply kerning, tracking, or both to selected text.
Tracking and kerning are both measured in 1/1000 em, a
unit of measure that is relative to the current type size. In
a 6 point font, 1 em equals 6 points; in a 10 point font, 1 em
equals 10 points. Kerning and tracking are strictly propor-
tional to the current type size.

Tracking and manual kerning are cumulative, so you can
first adjust individual pairs of letters, and then tighten or
loosen a block of text without affecting the relative kerning
of the letter pairs.

When you click to place the insertion point between two
letters, InDesign displays kerning values in the Character
panel and the Control panel. Metrics and optical kerning
values (or defined kern pairs) appear in parentheses.
Similarly, if you select a word or a range of text, InDesign
displays the tracking values in the Character panel and
Control panel.

Change the color, gradient, or stroke of text

You can apply colors, gradients, and strokes to characters
and continue to edit the text. Use the Swatches panel and
Stroke panel to apply colors, gradients, and strokes to
text, or change Character Color settings when creating or
editing a style.

Before applying the optical kerning option to
the "W" and "a" pair (top), and after (bottom)

You can also use manual kerning, which is ideal for
adjusting the space between two letters. Tracking and
manual kerning are cumulative, so you can first adjust
individual pairs of letters, and then tighten or loosen a block
of text without affecting the relative kerning of the letter
pairs.

Word kerning isn't the same as the Word Spacing option
in the Justification dialog box; word kerning changes the
kerning value only between a specific word's first character
and the word space preceding that character.

Kerning and tracking

Swatches
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A. Swatch affects fill or stroke B. Swatch affects container
or text C. Tint percentage

Change the case of type

The All Caps or Small Caps commands change the
appearance of text, but not the text itself. Conversely, the
Change Case command changes the case setting of
selected text. This distinction is important when searching
or spell-checking text. For example, suppose you type
"spiders" in your document and apply All Caps to the word.
Using Find/Change (with Case Sensitive selected) to
search for "SPIDERS" will not find the instance of "spiders"
to which All Caps was applied. To improve search and
spell-check results, use the Change Case command
rather than All Caps.

Change text to All Caps or Small Caps

InDesign can automatically change the case of selected
text. When you format text as small caps, InDesign
automatically uses the small-cap characters designed as
part of the font, if available. Otherwise, InDesign synthe-
sizes the small caps using scaled-down versions of the
regular capital letters. The size of synthesized small caps
is set in the Type Preferences dialog box.

A. Unscaled type B. Unscaled type in condensed font C.
Scaled type in condensed font

Adjust paragraph spacing

You can control the amount of space between paragraphs.
If a paragraph begins at the top of a column or frame,
InDesign does not honor the Space Before value. In such
a case, you can increase the leading of the first line of the
paragraph or increase the top inset of the text frame in
InDesign.

Use drop caps

You can add drop caps to one or more paragraphs at a time.
The drop cap's baseline sits one or more lines below the
baseline of the first line of a paragraph.

You can also create a character style that can be applied
to the drop cap characters. For example, you can create
a tall cap (also called a raised cap) by specifying a 1 line,
1 character drop cap and applying a character style that
increases the size of the first letter.

Scale type

You can specify the proportion between the height and
width of the type, relative to the original width and height of
the characters. Unscaled characters have a value of 100%.
Some type families include a true expanded font, which is
designed with a larger horizontal spread than the plain type
style. Scaling distorts the type, so it is generally preferable
to use a font that is designed as condensed or expanded,
if one is available.

Before (top) and after (bottom) setting BC and AD in
small caps to complement old-style numerals and
surrounding text

Scaling fonts horizontally

One-character, three-line drop cap (left), and
five-character, two-line drop cap (right)

Add rules (lines) above or below paragraphs

Rules are paragraph attributes that move and are resized
along with the paragraph on the page. If you're using a rule
with headings in your document, you may want to make the
rule part of a paragraph style definition. The width of the rule
is determined by the column width.

The offset for a rule above a paragraph is measured from the
baseline of the top line of text to the bottom of the rule. The
offset for a rule below a paragraph is measured from the
baseline of the last line of text to the top of the rule.

Placement of rules
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A. Rule above paragraph B. Rule below paragraph

Ways to control paragraph breaks

You can eliminate orphans and widows, words or single
lines of text that become separated from the other lines in
a paragraph. Orphans fall at the bottom of a column or
page, and widows fall at the top of a column or page.
Another typographic problem to avoid is a heading that
stands alone on a page with the following paragraph on the
next page. You have several options for fixing widows,
orphans, short exit lines, and other paragraph break
problems:

Discretionary hyphens

A discretionary hyphen (Type > Insert Special Character >
Hyphens And Dashes > Discretionary Hyphen) appears
only if the word breaks. This option prevents the common
typographic problem of hyphenated words, such as "care-
giver," appearing in the middle of a line after text reflows.
Similarly, you can also add a discretionary line break
character.

No Break

Choose No Break from the Character panel menu to
prevent selected text from breaking across a line.

Nonbreaking spaces

Insert a nonbreaking space (Type > Insert White Space >
[nonbreaking space]) between words you want to keep
together.

Keep Options

Choose Keep Options from the Paragraph panel menu to
specify how many lines in the following paragraph remain
with the current paragraph.

Start Paragraph

Use Start Paragraph in the Keep Options dialog box to
force a paragraph (usually a title or heading) to appear at
the top of a page, column, or section. This option works
especially well as part of a heading paragraph style.

Hyphenation Settings

Choose Hyphenation from the Paragraph panel menu to
change hyphenation settings.

Edit text

Editing text may not be an option depending on the kind of
document you work with. If you have license to rewrite, then
subtle rewording can often create a better line break.

Use a different composer

In general, use Adobe Paragraph Composer to let InDesign
compose paragraphs automatically. If a paragraph isn't
composed the way you'd like, choose Adobe Single-line
Composer from the Paragraph panel menu or Control panel
menu and adjust selected lines individually.

Create hanging punctuation

Punctuation marks and letters such as "W" can make the
left or right edges of a column appear to be misaligned.

Optical Margin Alignment controls whether punctuation
marks (such as periods, commas, quotation marks, and
dashes) and edges of letters (such as W and A) hang
outside the text margins, so that the type looks aligned.

Tabs dialog box overview

Tabs position text at specific horizontal locations in a
frame. The default tab settings depend on the Horizontal
ruler units setting in the Units & Increments preferences
dialog box.

Tabs apply to an entire paragraph. The first tab you set
deletes all default tab stops to its left. Subsequent tabs
delete all default tabs between the tabs you set. You can
set left, center, right, and decimal or special-character
tabs.

You set tabs using the Tabs dialog box.

Before (left) and after (right) applying Optical Margin
Alignment

A. Tab alignment buttons B. Tab position C. Tab Leader
box D. Align On box E. Tab ruler F. Snap above frame

When you do this in a vertical text frame, the Tabs dialog
box also becomes vertical. When the Tabs dialog box
direction is not consistent with the text frame direction,
click on the magnet icon  to snap the rulers to the current
text frame.

Add tab leaders

A tab leader is a repeated pattern of characters, such as
a series of dots or dashes, between a tab and the following
text.

1. In the Tabs panel, select a tab stop on the ruler.

2. Type a pattern of as many as eight characters in the
Leader box, and then press Enter or Return. The
characters you entered repeat across the width of the
tab.

3. To change the font or other formatting of the tab leader,
select the tab character in the text frame, and use the
Character panel or Type menu to apply formatting.

Tabs dialog box

IT&ITES: DTPO - Related Theory for Exercise 2.3.03



177

Insert right indent tabs

In one step, you can add a right-aligned tab at the right
indent, making it easier to prepare tabular text that spans
an entire column. Right indent tabs are slightly different
from regular tabs. A right indent tab:

• Aligns all subsequent text to the right edge of the text
frame. If the same paragraph includes any tabs after the
right indent tab, those tabs and their text are pushed to
the next line.

• Is a special character located in the text, not in the Tabs
dialog box. You add a right indent tab using a context
menu, not the Tabs dialog box. As a result, a right
indent tab can't be part of a paragraph style.

• Is different from the Right Indent value in the Paragraph
panel. The Right Indent value keeps the entire right edge
of the paragraph away from the right edge of the text
frame.

• Can be used with a tab leader. Right indent tabs use the
tab leader of the first tab stop past the right margin, or,
if there isn't one, the last tab stop before the right
margin.

Set indents

Indents move text inward from the right and left edges of the
frame. In general, use first line indents, not spaces or tabs,
to indent the first line of a paragraph.

A first-line indent is positioned relative to the left-margin
indent. For example, if a paragraph's left edge is indented
one pica, setting the first-line indent to one pica indents the
first line of the paragraph two picas from the left edge of the
frame or inset.

You can set indents using the Tabs dialog box, the
Paragraph panel, or the Control panel. You can also set
indents when you create bulleted or numbered lists.

When setting CJK characters, you can use the mojikumi
setting to specify the indent for the first line. However, for
text in which the first line indent was specified in the
Paragraph panel, if you specify indents in mojikumi set-
tings, you can make the text indent the sum value of both
indents.

Hanging indent

In a hanging indent, all the lines in a paragraph are indented
except for the first line. Hanging indents are especially
useful when you want to add inline graphics at the begin-
ning of the paragraph.

About masters, stacking order, and layers

A master is like a background that you can quickly apply
to many pages. Objects on a master appear on all pages
with that master applied. Master items that appear on
document pages are surrounded by a dotted border.
Changes you make to a master are automatically applied
to associated pages. Masters commonly contain repeat-
ing logos, page numbers, headers, and footers. They can
also contain empty text or graphic frames that serve as
placeholders on document pages. A master item cannot
be selected on a document page unless the master item
is overridden.

Masters can have multiple layers, just like pages in your
document. Objects on a single layer have their own
stacking order within that layer. Objects on a master page
layer appear behind objects assigned to the same layer in
the document page.

If you want a master item to appear in front of objects on the
document page, assign a higher layer to the object on the
master. A master item on a higher layer appears in front of
all objects on lower layers. Merging all layers will move
master items behind document page objects.

No indent (left) and hanging indent (right)

Master items (top left) appear behind page objects on the
same layer (bottom left); moving a master item to a higher
layer (top right) moves it in front of all objects on lower layers
(bottom right).

Create masters

By default, any document you create has a master page.
You can create additional masters from scratch or from an
existing master page or document page. After you apply
master pages to other pages, any changes made to the
source master carry forward to the masters and document
pages that are based on it. With careful planning, this
provides an easy way to make layout changes to multiple
pages across your document.

Base one master on another

You can create a master variation that is based on and
updates with another master (called the parent master)
within the same document. The master spreads based on
the parent master are called child masters. For example,
if your document has ten chapters that use master spreads
that vary only slightly, base all of them on a master spread
that contains the layout and objects common to all ten.
This way, a change to the basic design requires editing just
the parent master instead of editing all ten separately. Vary
the formatting on your child masters. You can override
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To base one master on another, in the Masters section of
the Pages panel, do either of the following:

• Select a master spread, and choose Master Options for
[master spread name] in the Pages panel menu. For
Based On Master, choose a different master, and click
OK.

• Select the name of the master spread you want to use
as the base and drag it onto the name of another master
to apply it.

Master items on a document page have a
dotted border. If you cannot view master items
on a document page, the master item may be
hidden on a lower layer or the master items
may be hidden. Choose Show Master Items
from the Pages panel menu.

Move, duplicate, and delete pages and spreads

You can use the Pages panel to freely arrange, duplicate,
and recombine pages and spreads. Keep the following
guidelines in mind when adding, arranging, duplicating, or
removing pages within a document:

• InDesign preserves the threads between text frames.

• InDesign redistributes pages according to how the
Allow Document Pages To Shuffle command is set.

• An object that spans multiple pages stays with the
page on which the object's bounding box covers the
most area.

Control spread pagination

Most documents use two-page spreads exclusively. When
you add or remove pages before a spread, the pages shuffle
by default. However, you may want to keep certain pages
in a spread together. For example, you can create gatefold
or accordion foldouts by creating a multiple-page spread
(also called an island spread) and adding pages to it. By not
allowing pages to shuffle, you can ensure that pages are
kept in the same spread.

parent master items on a child master to create variations
on a master, just as you can override master items on
document pages. This is a powerful way to keep a
consistent yet varied design up to date.

Original parent and child masters (left); when the
parent master is modified, the child masters are

automatically updated (right)

B-Master based on A-Master

Apply master pages

If your document contains custom spreads (such as a 3-
or 4 page foldout in a magazine), any master you apply
should contain the same number of pages.

If your master page has a different page size than the layout
page, applying the master page changes the size of the
layout page. If the layout page has a custom page size, you
can specify whether to keep the custom layout page size
or apply the size of the master page.

A. One-page spread B. Four-page spread, identified by
brackets around page numbers C. Entire two-page spread
selected

Rotate the spread view

In some instances, you need to edit rotated content.
Instead of turning your head sideways to look at the rotated
content, you can rotate the spread view. This option is
especially useful for working on rotated calendars and
tables.

Rotating the spread view does not affect printing or output.

Pages panel
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Rotating the spread

A. Before rotating spread B. Rotated spread view C. Rotate
icon in Pages panel

Use multiple page sizes

You can define different page sizes for pages within a single
document. This feature is especially useful when you want
to manage related designs in one file. For example, you
can include business card, postcard, letterhead, and
envelope pages in the same document. Using multiple
page sizes is also useful for creating gate-fold layouts in
magazines.

Multiple page sizes in same document

A. Magazine page B. Gate-fold page C. Spine page

IT&ITES: DTPO - Related Theory for Exercise 2.3.03



180

IT & ITES
DTPO - InDesign                                          Related Theory for Exercise 2.3.04

Placing and editing graphics
Objectives : At the end of this lesson you shall be able to
• explain Place and control the graphics
• reusing graphics and text
• use Content Collector and Managing graphics links
• wrapping text around objects.

Place (import) graphics

The Place command is the primary method used to insert
graphics into InDesign because it provides the highest level
of support for resolution, file formats, multipage PDF and
INDD files, and color. To place graphics is also referred to
as import images and insert pictures.

If you're creating a document in which those characteris-
tics aren't critical, you can copy and paste to import
graphics InDesign. Pasting, however, embeds a graphic in
a document; the link to the original graphic file is broken
and doesn't appear in the Links panel, and you can't update
the graphic from the original file. However, pasting Illustra-
tor graphics allows you to edit paths in InDesign

The options available to you when you place a graphics file
depend on the type of graphic. These options appear when
you select Show Import Options in the Place dialog box. If
you don't select Show Import Options, InDesign applies the
default settings or the last settings used in placing a
graphics file of that type.

The names of graphics you've placed (imported) appear in
the Links panel

If you place or drag a graphic from a removable
media, such as a CD, the link will break when
you remove that media from your system.

Import options for graphics

When you place an EPS graphic (or a file saved with
Illustrator 8.0 or earlier) and select Show Import Options in
the Place dialog box, you'll see a dialog box containing
these options:

Read Embedded OPI Image Links - This option tells
InDesign to read links from OPI comments for images
included (or nested) in the graphic.

Deselect this option if you're using a proxy-based workflow
and plan to have your service providers perform the image
replacement using their OPI software. When this option is
deselected, InDesign preserves the OPI links but does not
read them. When you print or export, the proxy and the
links are passed on to the output file. Select this option if
you're using a proxy-based workflow and you want InDesign,
instead of your service provider, to perform image replace-
ment when you output the final file. When you select this
option, the OPI links appear in the Links panel.

Also select this option when you import EPS files contain-
ing OPI comments that are not part of a proxy-based
workflow. For example, if you import an EPS file containing
OPI comments for an omitted TIFF or bitmap image, you'll
want to select this option so that InDesign can access the
TIFF information when you output the file.

Apply Photoshop Clipping Path - Regardless of whether
this option is selected, a placed EPS file includes a
clipping path in InDesign. However, deselecting this option
may result in a different bounding box size.

Proxy Generation - This creates a low-resolution bitmap
representation of an image when drawing the file to the
screen. The following settings control how the proxy will be
generated:

Use TIFF Or PICT Preview - Some EPS images contain
an embedded preview. Select this option to generate the
proxy image of the existing preview. If a preview does not
exist, the proxy will be generated by rasterizing the EPS
to an offscreen bitmap.

Rasterize The PostScript - Select this option to ignore
the embedded preview. This option is typically slower but
provides the highestquality results.

When you import more than one single file into
the same document, all instances share the
proxy setting of the first instance of the im-
ported file.

Bitmap import options

You can apply color-management options to individual
imported graphics when using color-management tools
with a document. You can also import a clipping path or an
alpha channel saved with an image created in Photoshop.
Doing so lets you directly select an image and modify its
path without changing the graphics frame.

When you place a PSD, TIFF, GIF, JPEG, or BMP file and
select Show Import Options in the Place dialog box, you'll
see a dialog box containing these options:

Apply Photoshop Clipping Path If this option isn't
available, the image wasn't saved with a clipping path, or
the file format doesn't support clipping paths. If the bitmap
image doesn't have a clipping path, you can create one in
InDesign.

Alpha channel Select an alpha channel to import the area
of the image saved as an alpha channel in Photoshop.
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InDesign uses the alphachannel to create a transparent
mask on the image. This option is available only for images
that contain at least one alpha channel.

Portable Network Graphics (.png) import options

When you place a PNG image and select Show Import
Options in the Place dialog box, you'll see a dialog box with
three sections of import settings. Two sections contain the
same options available for other bitmap image formats. The
other section, PNG Settings, contains the following set-
tings:

Use Transparency Information This option is enabled by
default when a PNG graphic includes transparency. If an
imported PNG file contains transparency, the graphic
interacts only where the background is transparent.

White Background If a PNG graphic does not contain a
file-defined background color, this option will be selected
by default. However, it is only enabled if Use Transparency
Information is activated. If this option is selected, white is
used as the background color when applying transparency
information.

File Defined Background Color If a PNG graphic was
saved with a non-white background color, and Use Trans-
parency Information is selected, this option is selected by
default. If you don't want to use the default background
color, click White Background to import the graphic with a
white background, or deselect Use Transparency Informa-
tion to import the graphic without any transparency (dis-
playing areas of the graphic that are currently transparent).
Some image-editing programs can't specify a non-white
background color for PNG graphics.

Apply Gamma Correction Select this option to adjust the
gamma (midtone) values of a PNG graphic as you place it.
This option lets you match image gamma to the gamma of
the device you will use to print or display the graphic (such
as a low-resolution or non-PostScript printer or computer
monitor). Deselect this option to place the image without
applying any gamma correction. By default, this option is
selected if the PNG graphic was saved with a gamma value.

Gamma Value This option, available only if Apply Gamma
Correction is selected, displays the gamma value that was
saved with the graphic. To change the value, type a positive
number from 0.01 to 3.0. When PNG files are imported, the
settings in the Image Import Options dialog box are always
based on the selected file, not on the default or lastused
settings.

Acrobat (.pdf) and Illustrator (.ai) import options

The layout, graphics, and typography in a placed PDF are
preserved. As with other placed graphics, you cannot edit
a placed PDF page within InDesign. You can control the
visibility of layers in a layered PDF. You can also place
more than one page of a multipage PDF.

When you place a PDF that was saved with passwords,
you'll be prompted to enter the required passwords. If the
PDF file was saved with usage restrictions (for example, no
editing or printing), but no passwords, you can place the
file.

When you place a PDF (or a file saved with Illustrator 9.0
or later) and select Show Import Options in the Place dialog
box, you'll see a dialog box containing the following
options:

Show Preview Preview a page in the PDF before you
place it. If you're placing a page from a PDF that contains
multiple pages, click the arrows, or type a page number
under the preview image to preview a specific page.

Pages Specify the pages you want to place: the page
displayed in the preview, all pages, or a range of pages. For
Illustrator files, you can specify which artboard to place.

If you specify multiple pages, hold down Alt (Windows) or
Option (Mac OS) while placing the file to place them all at
the same time, overlapping each other.

Crop To Specify how much of the PDF page to place:

Bounding Box Places the PDF page's bounding box, or the
minimum area that encloses the objects on the page,
including page marks. The Bounding Box (Visible Layers
Only) option uses the bounding box only of the visible
layers of the PDF file. The Bounding Box (All Layers) option
places the bounding box of the entire layer area of the PDF
file, even if layers are hidden.

Art Places the PDF only in the area defined by a rectangle
that the author created as a placeable artwork (for ex-
ample, clip art).

Crop Places the PDF only in the area that is displayed or
printed by Adobe Acrobat.

Trim Identifies the place where the final produced page will
be physically cut in the production process, if trim marks
are present.

Bleed Places only the area that represents where all page
content should be clipped, if a bleed area is present. This
information is useful if the page is being output in a
production environment. Note that the printed page may
include page marks that fall outside the bleed area.

Media Places the area that represents the physical paper
size of the original PDF document (for example, the
dimensions of an A4 sheet of paper), including page marks.

Transparent Background Select this option to reveal text
or graphics that fall beneath the PDF page in the InDesign
layout. Deselect this option to place the PDF page with an
opaque white background.

If you make the background transparent in a frame contain-
ing a PDF graphic, you can make it opaque later by adding
a fill to the frame.

InDesign (.indd) import options

InDesign preserves the layout, graphics, and typography in
a placed INDD file. However, the file is treated as an object,
and you can't edit it, although you can control the visibility
of layers and choose which pages of a multi-page INDD file
to import.

When you place an InDesign file and select Show Import
Options in the Place dialog box, you'll see a dialog box
containing the following options:
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Show preview Preview a page before you place it. You
can type a page number or click the arrows to preview a
page in a multi-page document.

Pages Specify the pages you want to place: the page
displayed in the preview, all pages, or a range of pages.

Crop to Specify how much of the page or pages to place,
the page itself or the bleed or slug areas on the pasteboard.

Control layer visibility in imported images

When you import Photoshop PSD files, layered PDFs, and
INDD files, you can control the visibility of top-level layers.
Adjusting layer visibility in InDesign lets you vary an
illustration depending on context. For example, in a
multilanguage publication, you can create a single illustra-
tion that includes one text layer for each language.

You can adjust layer visibility either when you place a file
or by using the Object Layer Options dialog box. In
addition, if the Photoshop file contains layer comps, you
can display the desired comp.

Paste or drag graphics

When you copy and paste or drag a graphic into an
InDesign document, some attributes of the original object
may be lost, depending on the limitations of the operating
system and the range of data types the other application
makes available for transfer, and the InDesign Clipboard
preferences. Pasting or dragging Illustrator graphics lets
you select and edit paths within the graphic.

Copying and pasting or dragging between two InDesign
documents, or within a single document, however, pre-
serves all of the graphics attributes that were imported or
applied. For example, if you copy a graphic from one
InDesign document and paste it into another, the new copy
will be an exact duplicate of the original, even including the
original's link information, so that you can update the
graphic when the file on disk changes.

Copy and paste graphics

When copying and pasting a graphic from another docu-
ment into an InDesign document, InDesign does not create
a link to the graphic in the Links panel. The graphic may be
converted by the system clipboard during the transfer, so
both image quality and print quality may be lower in
InDesign than in the graphic's original application.

Drag and drop graphics

The drag-and-drop method works like the Place command,
with images appearing in the Links panel after they're
imported. You cannot set import options for the files you
drag and drop; however, you can drag and drop multiple
files at once (the files are loaded in the graphics icon when
you drag and drop more than one).

Select a graphic from Adobe Illustrator, Adobe Bridge,
Explorer (Windows), the Finder (Mac OS), or your desktop,
and drag it into InDesign. The image must be in a format
that InDesign can import.

After dragging and dropping a file from any location other
than Illustrator, it appears in the Links panel in InDesign.
Using the Links panel, you can control versions and update
as necessary.

Pasting Illustrator graphics into InDesign

When you paste a graphic from Illustrator 8.0 or later into
an InDesign document, the artwork appears in InDesign as
a grouped collection of editable objects. For example, if
you paste an Illustrator drawing of a soccer ball with
individually created patches into InDesign, the patches are
pasted as a group, which can be ungrouped and edited
using tools in InDesign. You cannot change the visibility of
layers within the illustration.

Before pasting a graphic, make sure that Illus-
trator is configured to copy as AICB (see Illus-
trator Help). In InDesign, make sure that Prefer
PDF When Pasting isn't selected in the Clip-
board Handling preferences. If these options
aren't set properly, the Illustrator graphic can-
not be edited in InDesign.

Issues you may encounter when pasting or dragging
art from Illustrator to InDesign

Color

Illustrator supports the Grayscale, RGB, HSB, CMYK, and
Web Safe RGB color models. InDesign supports LAB,
CMYK and RGB. When you paste or drag artwork from
Illustrator into InDesign, RGB and CMYK colors convert in
the expected color model. Grayscale colors are converted
to the appropriate K value in a CMYK color in InDesign.
HSB and Web Safe RGB objects are converted to RGB
color in InDesign. Colors in smooth shades and gradients
can be edited in InDesign.

Gradients

Linear or radial gradients created in Illustrator can be
modified using the Gradient tool or Gradient panel in
InDesign. Gradients with multiple spot colors or complex
patterns may appear as non editable items in InDesign. If
your illustration contains complex gradients, import it
using the Place command instead.

Transparency

Transparency is flattened when Illustrator art is pasted or
dragged into InDesign.

Graphic styles

Illustrator Graphic Styles don't become InDesign Object
Styles when art is pasted or dragged into InDesign.

Illustration of soccer ball in Illustrator (left) and same
illustration pasted into InDesign (right)
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Patterns

Illustrator objects filled or stroked with patterns become
embedded EPS images when pasted or dragged into
InDesign.

Text

If you drag text from Illustrator into InDesign, it's converted
to outlines and isn't editable with the Text tool. If you select
text using the Text tool in Illustrator, and then copy it into
a text frame in InDesign, the text loses its formatting but is
editable. If you drag the text into InDesign without a frame
selected, the text loses all formatting and isn't editable.

When you paste text from Illustrator, the text is imported
as one or more objects that can be transformed and
colorized in InDesign, but not edited. For example, if you
create text on a path in Illustrator and paste it into InDesign,
the text can be colorized, rotated, and scaled, but it cannot
be edited using the Type tool. If you want to edit the text,
use the Type tool and paste it into a text frame.

Artwork

Artwork copied from Illustrator and pasted into InDesign is
embedded in the InDesign document. No link to the original
Illustrator file is created.

Importing Adobe Photoshop (.PSD) files

You can place graphics created in Adobe Photoshop 4.0
and later directly into an InDesign layout.

Layers and layer comps

You can adjust the visibility of the top-level layers in
InDesign, as well as view different layer comps. Changing
layer visibility or layer comps in InDesign does not alter the
original Photoshop file.

Paths, masks, or alpha channels

If you save paths, masks, or alpha channels in a Photoshop
file, InDesign can use them to remove backgrounds, or to
wrap text around graphics. Graphics that contain paths,
masks, or alpha channels act as transparent objects when
imported.

ICC color management profile

If you place a Photoshop image with an embedded ICC
color management profile, InDesign reads the embedded
profile, provided that color management is active. You can
override the embedded profile for the image using the
Import Options dialog box or assign a different color profile
to the graphic in InDesign. Overriding the color profile in
InDesign will not remove or alter the profile embedded in the
Photoshop image.

Spot-color channels

Spot-color channels in Adobe Photoshop PSD or TIFF files
appear in InDesign as spot colors in the Swatches panel.
If the image uses a spot color that InDesign does not
recognize, the spot color may appear gray in the InDesign
document and print incorrectly as a composite. (The image
will print correctly on color separations, however.) To
simulate the graphic as a composite, you can create a spot

color with the correct color values, and then alias the PSD
color to this new spot color. The graphic will then print
correctly as composite and display correctly on screen
when Overprint Previewis turned on (choose View > Over-
print Preview). Be sure to remove the alias before printing
separations, so that the image prints on the plate you
expect.

Importing PDF pages

Using the Place command, you can specify which pages
you want to import from a multipage PDF or an Illustrator
file with multiple artboards. You can place a single page,
a range of pages, or all pages. Multipage PDF files let
designers combine illustrations for a publication into a
single file.

The page range options appear when you select Show
Import Optionsin the Place dialog box. The dialog box
includes a preview, so you can view a thumbnail of the
pages before you place them. If you place multiple pages,
InDesign reloads the graphics icon with the next page,
letting you place the pages one after the next. InDesign
doesn't import movies, sound, links, or buttons when you
place a PDF file.

Importing InDesign (.indd) pages

Using the Place command, you can import pages from one
InDesign document into another. You can import a page,
a page range, or all of the pages in the document. The
pages are imported as objects (much the same way that
PDFs are imported).

Add pages in your document to hold the pages you want
to import. After you choose File > Place and select an INDD
file, you can choose Show Import Options and then choose
which pages to import, which layers to make visible, and
how to crop the imported pages. You can scroll in the
Preview window to examine the thumbnail pages closely.
The page or pages you select are loaded in the graphics
icon. If you place multiple pages, InDesign loads the
graphics icon with the following page so you can import
pages one after the other.

The Links panel lists the names of each page you
imported. If a page you imported contains a
graphic or other item that was imported into it,
this item is listed as well in the Links panel. The
names of these secondary imported items are
listed under a disclosure triangle in the Links
panel to distinguish them from imported pages.

Importing other graphics formats

InDesign supports a variety of graphics formats, including
bitmap formats such as TIFF, GIF, JPEG, and BMP, and
vector formats such as EPS. Other supported formats
include DCS, PICT, WMF, EMF, PCX, PNG, and Scitex CT
(.sct). You can import an SWF file as a movie file.

TIFF (.tif) files

TIFF is a flexible bitmap image format supported by virtually
all painting, image-editing, and page-layout applications.
Also, virtually all desktop scanners can produce TIFF
images.
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The TIFF format supports CMYK, RGB, grayscale, Lab,
indexed-color, and bitmap files with alpha and spot-color
channels. You can select an alpha channel when you place
a TIFF file. Spot-color channels appear in InDesign as spot
colors in the Swatches panel.

You can use an image-editing program such as Photoshop
to create a clipping path to create a transparent back-
ground for a TIFF image. InDesign supports clipping paths
in TIFF images and recognizes encoded OPI comments.

Graphics Interchange Format (.gif) files

Graphics Interchange Format (GIF) is a standard for
displaying graphics on the World Wide Web and other
online services. Because it compresses image data with-
out losing detail, its compression method is called lossless.
Such compression works well with graphics that use a
limited number of solid colors such as logos and charts;
however, GIF cannot display more than 256 colors. For this
reason it is less effective for displaying photographs online
(use JPEG instead) and is not recommended for commer-
cial printing. If an imported GIF file contains transparency,
the graphic interacts only where the background is trans-
parent.

JPEG (.jpg) files

The Joint Photographic Experts Group (JPEG) format is
commonly used to display photographs and other continu-
ous-tone images in HTML files over the web and in other
online media. The JPEG format supports CMYK, RGB, and
grayscale color modes. Unlike GIF, JPEG retains all of the
color information in an RGB image.

JPEG uses an adjustable, lossy compression scheme
that effectively reduces file size by identifying and discard-
ing extra data not essential to the display of the image. A
higher level of compression results in lower image quality;
a lower level of compression results in better image quality,
but a larger file size. In most cases, compressing an image
using the Maximum quality option produces a result that is
indistinguishable from the original. Opening a JPEG image
automatically decompresses it.

JPEG encoding, which can be performed on an
EPS or DCS file in an image-editing application
such as Photoshop, does not create a JPEG file.
Instead, it compresses the file using the JPEG
compression scheme explained above.

JPEG works well for photographs, but solid-color JPEG
images (images that contain large expanses of one color)
tend to lose sharpness. InDesign recognizes and supports
clipping paths in JPEG files created in Photoshop. JPEG
can be used for both online and commercially printed
documents; work with your prepress service provider to
preserve JPEG quality in printing.

Bitmap (.bmp) files

BMP is the standard Windows bitmap image format on
DOS and Windows-compatible computers. However, BMP
does not support CMYK, and its color support is limited to
1, 4, 8, or 24 bits. It is less than ideal for commercially
printed or online documents, and it is not supported by

some web browsers. BMP graphics can provide accept-
able quality when printed on low-resolution or non-PostScript
printers.

Encapsulated PostScript (.eps) files

The Encapsulated PostScript (EPS) file format is used to
transfer PostScript language artwork between applica-
tions, and is supported by most illustration and page-
layout programs. Typically, EPS files represent single
illustrations or tables that are placed into your layout, but
an EPS file can also represent a complete page.

Because they are based on the PostScript language, EPS
files can contain text, vector, and bitmap graphics. Since
PostScript cannot normally be displayed on screen,
InDesign creates a bitmap preview for an EPS file for on
screen display. InDesign recognizes clipping paths in
Photoshop-created EPS files.

When you import an EPS file, any spot colors it contains
are added to the Swatches panel in InDesign. EPS allows
for prepress-quality resolution, precision, and color. This
format includes all of the color and image data required to
color-separate DCS images embedded in the EPS graphic.
EPS isn't ideal for online publishing in HTML, but it works
well for online publishing in PDF.

EPS files can contain Open Prepress Interface (OPI)
comments, which let you use fast, low resolution versions
(proxies) of images for positioning on a page. For final
output, either InDesign or your prepress service provider
can automatically replace the proxies with high-resolution
versions.

Desktop Color Separations (.dcs) files

Desktop Color Separations (DCS), developed by Quark, is
a version of the standard EPS format. The DCS 2.0 format
supports multichannel CMYK files with multiple spot
channels. (These spot channels appear as spot colors in
the Swatches panel in InDesign.) The DCS 1.0 format
supports CMYK files without spot channels. InDesign
recognizes clipping paths in Photoshop-created DCS 1.0
and DCS 2.0 files.

DCS files are intended to be used in a preseparated, host-
based workflow. In most cases, color separations files
associated with a DCS image are excluded when you
export or print a composite to a PDF, EPS, or PostScript
file. (The sole exception is made for 8 bit DCS files that were
created in Photoshop and that do not contain vector
graphics)

InDesign can rebuild a composite image from DCS 2.0 or
1.0 separations files, if the files were created in Photoshop.
For best results, do not include DCS 1.0 files or DCS 2.0
files created in programs other than Photoshop when you
are creating high-resolution color composite proofs or
separating a document in RIP or from a composite file.

Macintosh PICT (.pict) files

The Macintosh PICT (or Picture) format is used for Mac OS
graphics and page-layout applications, and for transferring
files between applications. The PICT format compresses
images that contain large areas of solid color. InDesign can
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import PICT files created from Mac OS screenshots and a
variety of other applications, including clip art collections.
However, PICT files are not recommended for high-resolu-
tion commercial printing.

InDesign supports RGB PICT images with variable resolu-
tions and embedded QuickTime images. PICT graphics do
not support color separations, are device-dependent, and
are not recommended for high-resolution commercial print-
ing. The PICT format can provide acceptable quality only
when printed on low-resolution or non-PostScript printers.

Windows Metafile Format (.wmf) and Enhanced Metafile
Format (.emf) files

Windows Metafile Format (WMF) and Windows Enhanced
Metafile Format (EMF) are native Windows formats used
primarily for vector graphics, such as clip art, shared
between Windows applications. Metafiles may contain
raster image information; InDesign recognizes the vector
information and provides limited support for raster opera-
tions. Color support is limited to 16 bit RGB, and neither
format supports color separations. As a general rule, avoid
using Metafile formats for commercially printed docu-
ments.

PCX (.pcx) files
The PCX format is commonly used in Windows systems.
Most Windows software supports version 5 of the PCX
format.

The PCX format supports RGB, indexed-color, grayscale,
and bitmap color modes, as well as the RLE compression
method, which is lossless. It does not support alpha
channels. Images can have a bit depth of 1, 4, 8, or 24 bits.
However, PCX is not ideal for commercially printed or online
documents. PCX graphics can provide acceptable quality
only when printed on low-resolution or non-PostScript
printers.

Portable Network Graphics (.png) files
The Portable Network Graphics (PNG) format uses adjust-
able, lossless compression to display 24 bit photographs
or solid-color images on the World Wide Web and in other
online media. PNG was developed as a patent-free alterna-
tive to the GIF file format. It supports transparency in an
alpha channel or a designated color. PNG is best used for
online documents. Color PNG graphics placed in an
InDesign document are RGB bitmap images.

Scitex CT (.sct) files
The Scitex Continuous Tone (CT) format is used for high-
end image processing on Scitex computers. Scitex CT
files often come from Scitex scanners, which produce high-
quality scans for commercial printing. The Scitex CT
format supports CMYK, RGB, and grayscale files, but
does not support alpha channels. Contact Scitex to obtain
utilities for transferring files saved in the Scitex CT format
to a Scitex system.

Fixing low-resolution images

Graphics you place in your document may appear pixelated
or fuzzy or grainy. In most cases, it's because InDesign
displays images in low resolution by default to improve
performance.

Check the display settings

To display graphics in high resolution, choose View   Dis-
play Performance   High Quality Display. For more details
on changing these display performance settings, see
Control graphics' display performance.

Use Place instead of Paste

The image may still be low resolution even though you
changed the display performance settings. For these
images, make sure that you use the Place command to
insert the image into InDesign. In some instances, pasting
an image from another application may result in the preview
image being inserted instead of the original file.

Check your print settings

If your image appears in low resolution in print, check your
print settings to make sure graphics are printing properly.
In the Graphics section of the Print dialog box, choose
Send Data   All.

Avoid transformations in images of borderline quality

In addition, scaling or rotating an image could reduce its
quality. You may want to choose Clear Transformations
from the Control panel menu.

Improve the image resolution

In some cases, such as with an image copied from a web
page, you may need to replace a low-resolution image with
a high-resolution image.

Control graphics' display performance

You can control the resolution of graphics placed in your
document. You can change the display settings for the
entire document or for individual graphics. You can also
change a setting that either allows or overrides the display
settings for individual documents.

Change a document's display performance

A document always opens using the default Display
Performance preferences. You can change the display
performance of a document while it is open, but the setting
won't be saved with the document.

If you've set the display performance of any images
separately, you can override the settings so all objects use
the same settings.

1. Choose View > Display Performance, and select an
option from the submenu.

2. To force objects that you have set individually to display
using the document setting, deselect View > Display
Performance > Allow Object-Level Display Settings. (A
check mark indicates it is selected)

Ways to reuse graphics and text

InDesign offers several different ways to repurpose graph-
ics and text.

Snippets A snippet is a file that contains objects and
describes their location relative to one another on a page
or spread.
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Object libraries An object library provides a convenient
place to store items such as logos, sidebars, pull-quotes,
and other repeating items.

Templates A template is a document that includes
placeholder text and graphics.

Use snippets

A snippet is a file that holds objects and describes their
location relative to one another on a page or page spread.
Use snippets to conveniently reuse and position page
objects. Create a snippet by saving objects in a snippet file,
which has the .IDMS extension. (Previous InDesign ver-
sions use the .INDS extension.) When you place the
snippet file in InDesign, you can determine whether the
objects land in their original positions or where you click.
You can store snippets in the Object library and in Adobe
Bridge as well as on your hard disk.

Snippets contents retain their layer associations when you
place them. When a snippet contains resource definitions
and these definitions are also present in the document to
which it is copied, the snippet uses the resource definitions
in the document.

Snippets you create in InDesign CS5 can be opened in
InDesign CS4 but not in any other previous version of
InDesign.

Choose how to place snippets

Rather than place snippet objects according to where you
click on a page, you can place them in their original
locations. For example, a text frame that appeared in the
middle of a page when it was made part of a snippet can
appear in the same location when you place it as a snippet.

In File Handling preferences, choose Original Location
from the Position At menu to preserve objects' original
locations in snippets. Choose Cursor Location from the
Position At menu to place snippets according to where you
click a page.

You can press Alt (Windows) or Option (Mac) to override
the Position setting you selected for handling snippets. For
example, if you selected Position at Cursor Location but
you want to place snippet objects in their original locations,
hold down the Alt/Option key when you click the loaded
snippet cursor on the page.

Use object libraries

Object libraries help you organize the graphics, text, and
pages you use most often. You can also add ruler guides,
grids, drawn shapes, and grouped images to a library. You
can create as many libraries as you need-for example, you
can create different object libraries for varied projects or
clients.

During a work session, you can open as many libraries as
system memory will allow. Object libraries can be shared
across servers, and across platforms, but only one person
can have the library open at a time. If an object library
includes text files, make sure that the file's fonts are
available and active on all systems that will access the
library.

When you add a page element, such as a graphic, to an
object library, InDesign preserves all attributes that were
imported or applied. For example, if you add a graphic from
an InDesign document to a library, the library copy will
duplicate the original, including the original's link informa-
tion, so that you can update the graphic when the file on
disk changes.

If you delete the object from the InDesign document, the
object's thumbnail will still appear in the Library panel, and
all of the link information will remain intact. If you move or
delete the original object, a missing link icon will appear
next to the object's name in the Links panel the next time
you place it in your document from the Library panel.

Within each object library, you can identify and search for
an item by title, by the date it was added to the library, or
by keywords. You can also simplify the view of an object
library by sorting the library items and displaying their
subsets. For example, you can hide all items except EPS
files.

Linked Content

Replicating content across various pages is no easy task;
copy-pasting can be cumbersome and time consuming.
Use linked content features to manage multiple versions of
content. You can place and link content within the same
document or even across different documents. Linked
content makes it easier to support emerging workflows,
where for example, you design for vertical and horizontal
layouts. Linked content also works well for traditional print
and publishing workflows, where you synchronize boilerplate
text on different pages or documents.

Linked content behaves similar to traditional links. You can
designate an object as parent, and then place it at other
places as child objects. Whenever you update the parent
object, the child objects are flagged and you can update
them to synchronize with the parent.

You can place and link objects using either the Content
Collector tools, or choose Edit   Place and Link menu
command.

The icon displays on the upper-left corner of linked object.
The item is displayed as linked object in the Links panel.

Content Collector tools

Content Collector and Placer tools let you duplicate page
items and place them on open InDesign documents. As
content is collected, it is displayed in the Content Con-
veyor. Use Content Conveyor to easily and quickly place
and link multiple page items within and across open
documents.

Click in the toolbox to open the Content Conveyor.

Use Content Collector tool to select an object and add it to
the conveyor

Use Content Placer to place page object on a page

Press B to toggle between Content Collector and Content
Placer tool.
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Content Collector

Use the Content Collector to add page items to the Content
Conveyor.

Content Placer

Use the Content Placer to place the items from the Content
Conveyor to the document. When you select this tool, the
current item is added to the place gun.

Create Link

Enable Create Link to link the placed item to the original
location of the collected item. You can manage the links
using the Links panel.

Map Styles

Map paragraph, character, table, or cell styles, between
the original and placed items. By default, style names are
used for mapping

Edit Custom Style Mapping

Define custom style mapping between the original and
placed items. Map the styles to automatically replace
original styles in the placed item.

Place Options

Specify the Conveyor options while placing items.

Remove items from the conveyor after you place them

Place the current item multiple times. The item remains
loaded in the place gun.

Place the item and move to the next item. The item is
however kept in the conveyor

Browse

Navigate through the items in the Content Conveyor.

Collect All Threaded Frames

Enable this option to collect all threaded frames. The story
and all frames are collected. If this option is disabled, the
story is collected in a single frame.

Load Conveyor

Use to load the conveyor with items.

Selection: Use this option to load all selected items

Pages: Use this option to load all items on the specified
pages

All: Use this option to load items from all pages and
pasteboard

Enable Create Single set to group all the items in a single
set.

You can collect individual page items, or collect related
items as "sets." In some cases InDesign automatically
creates sets to preserve the relational integrity of the page
items.

The following are a few method of collecting items as sets,
some manual and some automatic:

Marquee select a number of items Use the Load Conveyor
option and then select range of pages or all document
content or selected items and items will be accordingly
collected in a set.

Collect an item that has related content such as a part of
an interactive button that has other items and states
associated with it, it will collect all related items in a set
(this set will always drop in one gesture)

Collect a text box with threaded text spanning into other
objects and 'collect All Threaded Text Frames' checkbox
is checked on the conveyor, it will pick all threaded text
boxes into a set.

Link options

Preserve Local Edits while Updating Object Links Select
from the available categories to preserve local edits while
updating links.

Appearance

Object style attributes such as Stroke, Fill, Effects. This
excludes any text or text frame related attributes, such as
overprinting, non-printing settings etc

Size and Shape

Height, width, transforms, text frame attributes, and other
column size attributes

Interactivity

Animation, object States, button actions

Frame Content

Image, video, content placed or pasted into frames, and
effects and settings applied directly to such objects.
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Others

Attributes excluded from other categories, such as text
wrap on frames, object export options; text frame attributes
such as , baseline options, auto-size options, vertical
justification and so on.

About links and embedded graphics

When you place a graphic, you see a screen-resolution
version of the file in the layout so that you can view and
position it. However, the actual graphic file may be either
linked or embedded.

Linked artwork is connected to, but remains independent
of, the document, resulting in a smaller document. You can
modify linked artwork using transformation tools and ef-
fects; however, you cannot select and edit individual
components in the artwork. You can use the linked graphic
many times without significantly increasing the size of the
document; you can also update all links at once. When you
export or print, the original graphic is retrieved, creating the
final output from the full resolution of the originals.

Embedded artwork is copied into the document at full
resolution, resulting in a larger document. You can control
versions and update the file whenever you like; as long as
the artwork is embedded, your document is self-sufficient.

To determine if artwork is linked or embedded, or change
its status from one to the other, use the Links panel.

If the bitmap image you place is 48K or smaller, InDesign
automatically embeds the full resolution image instead of
the screen-resolution version in your layout. InDesign
displays these images in the Links panel, so that you can
control versions and update the file whenever you like;
however, the link is not necessary for optimal output.

If you move a document to another folder or
disk (for example, if you take it to a service
provider), be sure that you also move the linked
graphics files; they are not stored inside the
document. You can copy all related files auto-
matically, using the Preflight and Package

Links panel overview

All files placed in a document are listed in the Links panel.
These include both local (on disk) files and assets that are
managed on a server. However, files that are pasted from
a website in Internet Explorer do not display in this panel.

In InCopy, the Links panel also displays linked stories.
When you select a linked story in the Links panel, the Link
Info section displays information such as the number of
notes, the managed status, and the status of tracked
changes.

A. Category columns B. Show/Hide Link Information
C. Modified icon D. Missing-link icon E. Embedded-link
icon

When the same graphic appears several times in the
document, the links are combined under a disclosure
triangle in the Links panel. When a linked EPS graphic or
InDesign document contains links, the links are also
combined under a disclosure triangle.

A linked file can appear in the Links panel in any of the
following ways:

Up to Date

An up-to-date file is blank in the Status column.

Modified

This icon means that the version of the file on disk is more
recent than the version in your document. For example,
this icon appears if you import a Photoshop graphic into
InDesign, and then you or someone else edits and saves
the original graphic in Photoshop.

A slightly different version of the Modified icon appears
when a graphic is modified and one or more instances are
updated while others are not.

Missing

The graphic is no longer in the location from which it was
imported, although it may still exist somewhere. Missing
links can happen if someone deletes the original file or
moves it to a different folder or server after it's been
imported. You can't know whether a missing file is up to
date until its original is located. If you print or export a
document when this icon is displayed, the file may not print
or export at full resolution.

Embedded

Embedding the contents of a linked file suspends manage-
ment operations for that link. If the selected link is currently
in an "edit in place" operation, this option is not enabled.
Unembedding the file restores management operations to
the link.

Links panel
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If a linked object does not appear on a specific document
page, the following codes indicate where the object ap-
pears: PB (pasteboard), MP (master page), OV (overset
text), and HT (hidden text).

Update, restore, and replace links

Use the Links panel to check the status of any link, or to
replace files with updated or alternate files.

When you update or reestablish (relink) a link to a file, any
transformations performed in InDesign are preserved (if you
choose Relink Preserved Dimensions in the File Handling
preferences). For example, if you import a square graphic
and rotate it 30°, and then you relink it to an unrotated
graphic, InDesign rotates it 30° to match the layout of the
graphic it's replacing.

Placed EPS files may contain OPI links, which
appear in the Links panel. Don't relink OPI links
to files other than those originally intended by
the creator of the EPS file; doing so can cause
problems with font downloading and color
separations

Relink to a different folder

When you use the Relink To Folder command, you can
point to a folder that contains files with the same names as
your out-of-date links. For example, if your current links
point to low-resolution images, you can specify a different
folder that contains high-resolution images.

Edit original artwork

The Edit Original command lets you open most graphics in
the application in which you created them so that you can
modify them as necessary. Once you save the original file,
the document in which you linked it is updated with the new
version.

In InDesign, if you check out and select a
managed graphics frame (one that has been
exported to InCopy), rather than the graphic
itself, the graphic opens in InCopy.

Wrap text around objects

You can wrap text around any object, including text
frames, imported images, and objects you draw in InDesign.
When you apply a text wrap to an object, InDesign creates
a boundary around the object that repels text. The object
that text wraps around is called the wrap object. Text wrap
is also referred to as runaround text.

Keep in mind that text wrap options apply to the object
being wrapped, not the text itself. Any change to the wrap
boundary will remain if you move the wrap object near a
different text frame.

Wrap Around Bounding Box

Creates a rectangular wrap whose width and height are
determined by the bounding box of the selected object,
including any offset distances you specify.

Wrap Around Object Shape

Also known as contour wrapping, creates a text wrap
boundary that is the same shape as the frame you've
selected (plus or minus any offset distances you specify).

Jump Object

Keeps text from appearing in any available space to the
right or left of the frame.

Jump To Next Column

Forces the surrounding paragraph to the top of the next
column or text frame

Wrap text around imported images

To wrap text around an imported image, save the clipping
path in the application where you created the image, if
possible. When you place the image in InDesign, select
the Apply Photoshop Clipping Path option in the Image
Import Options dialog box.

A. No text wrap B. Wrap around bounding box C. Wrap
around object shape D. Jump object E. Jump to next
column F. Panel menu

Bounding Box

Wraps text to the rectangle formed by the image's height
and width.
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Detect Edges

Generates the boundary using automatic edge detection.
(To adjust edge detection, select the object and choose
Object  Clipping Path   Options.)

Alpha Channel

Generates the boundary from an alpha channel saved with
the image. If this option isn't available, no alpha channels
were saved with the image. InDesign recognizes the default
transparency in Adobe Photoshop (the checkerboard pat-
tern) as an alpha channel; you must otherwise use
Photoshop to delete the background or create and save
one or more alpha channels with the image.

Photoshop Path

Generates the boundary from a path saved with the image.
Choose Photoshop Path, and then choose a path from the
Path menu. If the Photoshop Path option isn't available, no
named paths were saved with the image.

Graphic Frame

Generates the boundary from the container frame.

Same As Clipping

Generates the boundary from the imported image's clip-
ping path.

Apply text wrap on master page items

If the Apply To Master Page Only option is selected, you
must override a master page item on a document page to
wrap text around it. If this option is deselected, text on both
master pages and document pages can wrap around the
master page items without the master page items being
overridden.

1. Select the object on the master page.

2. From the Text Wrap panel menu, select or deselect
Apply To Master Page Only.

This option is available only when an object on a master
page is selected and has a wrap applied to it.

Wrapping text around anchored objects

If you apply text wrap to an anchored object, the wrap
affects the lines of text in the story that follow the anchor
marker. However, the wrap doesn't affect the line of text that
includes the anchor marker or any lines before it. When you
paste an object as an inline object, its text wrap boundaries
are preserved.

Suppress text wrap on hidden layers

When you hide a layer that contains a wrap object, the text
frames on other layers wrap around the object, unless you
select the Suppress Text Wrap When Layer Is Hidden
option in the Layer Options dialog box. If this option is
selected, hiding a layer can cause text on other layers to
be recomposed.

1. In the Layers panel, double-click the layer that contains
the wrap object.

2. Select Suppress Text Wrap When Layer Is Hidden.

Justify text next to wrap objects

When you specify how text is justified next to wrap objects,
the change applies to the entire document.

1. Choose Edit→Preferences→Composition.
2. Select one of the following options, and click OK:

Justify Text Next To An Object

Justifies text next to wrap objects that separate a column
of text. This setting takes effect only when the text wrap
completely interrupts lines of text so that each line is
divided into two or more parts.

Text adjacent to an object is aligned to the left
or top of the object when set to Align Left, to the
right or bottom of the object when set to Align
Right, or evenly aligned to both edges when set
to Full Justify.
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Skip By Leading

Moves wrapped text to the next available leading increment
below a text-wrapped object. If this option isn't selected,
lines of text may jump below an object in a way that
prevents text from lining up with text in neighboring col-
umns or text frames. Selecting this option is especially
useful when you want to make sure that the text aligns to
the baseline grid.

Text Wrap only Affects Text Beneath

Text stacked above the wrapped object isn't affected by the
text wrap. Stacking order is determined by layer position
in the Layers panel and by the stacking order of objects on
a layer.
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IT & ITES
DTPO - InDesign                                          Related Theory for Exercise 2.3.05

Drawing and painting objects
Objectives : At the end of this lesson you shall be able to
• understanding paths and shapes
• explain drawing with the line or shape tools
• understand about to Drawing with the Pencil tool
• drawing with the Pen tool
• editing paths
• applying line (stroke) settings
• change corner appearance
• compound paths and shapes.

Types of paths and shapes

You can create paths and combine them in a variety of
ways in InDesign. InDesign creates the following types of
paths and shapes:

Simple paths

Simple paths are the basic building blocks of compound
paths and shapes. They consist of one open or closed
path, which may be self-intersecting.

Compound paths and shapes

Types of paths and shapes

You can create paths and combine them in a variety of
ways in InDesign. InDesign creates the following types of
paths and shapes:

Simple paths

Simple paths are the basic building blocks of compound
paths and shapes. They consist of one open or closed
path, which may be self-intersecting.

Compound paths

Compound paths consist of two or more simple paths that
interact with or intercept each other. They are more basic
than compound shapes and are recognized by all PostScript-
compliant applications. Paths combined in a compound
path act as one object and share attributes (such as colors
or stroke styles).

Compound shapes

Compound shapes consist of two or more paths, com-
pound paths, groups, blends, text outlines, text frames, or
other shapes that interact with and intercept one another
to create new, editable shapes. Some compound shapes
appear as compound paths, but their component paths can
be edited on a path-by-path basis and do not need to share
attributes.

About paths

As you draw, you create a line called a path. A path is made
up of one or more straight or curved segments. The
beginning and end of each segment are marked by anchor
points, which work like pins holding a wire in place. A path
can be closed (for example, a circle), or open, with distinct
endpoints (for example, a wavy line).

You change the shape of a path by dragging its anchor
points, the direction points at the end of direction lines that
appear at anchor points, or the path segment itself.

A. Selected (solid) endpoint B. Selected anchor point C.
Unselected anchor point D. Curved path segment E.
Direction line F. Direction point

Paths can have two kinds of anchor points: corner points
and smooth points. At a corner point, a path abruptly
changes direction. At a smooth point, path segments are
connected as a continuous curve. You can draw a path
using any combination of corner and smooth points. If you
draw the wrong kind of point, you can always change it.
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A. Four corner points B. Four smooth points C. Combina-
tion of corner and smooth points

A corner point can connect any two straight or curved
segments, while a smooth point always connects two
curved segments.

Don't confuse corner and smooth points with
straight and curved segments.

A path's outline is called a stroke. A color or gradient
applied to an open or closed path's interior area is called a
fill. A stroke can have weight (thickness), color, and a dash
pattern (Illustrator and InDesign) or a stylized line pattern
(InDesign). After you create a path or shape, you can
change the characteristics of its stroke and fill.

In InDesign, each path also displays a center point, which
marks the center of the shape but is not part of the actual
path. You can use this point to drag the path, to align the
path with other elements, or to select all anchor points on
the path. The center point is always visible; it can't be
hidden or deleted.

About direction lines and direction points

When you select an anchor point that connects curved
segments (or select the segment itself), the anchor points
of the connecting segments display direction handles,
which consist of direction lines that end in direction points.
The angle and length of the direction lines determine the
shape and size of the curved segments. Moving the
direction points reshapes the curves. Direction lines don't
appear in the final output.

After selecting an anchor point (left), direction lines appear
on any curved segments connected by the anchor point
(right).

A smooth point always has two direction lines, which move
together as a single, straight unit. When you move a
direction line on a smooth point, the curved segments on
both sides of the point are adjusted simultaneously,
maintaining a continuous curve at that anchor point.

In comparison, a corner point can have two, one, or no
direction lines, depending on whether it joins two, one, or
no curved segments, respectively. Corner point direction
lines maintain the corner by using different angles. When
you move a direction line on a corner point, only the curve
on the same side of the point as that direction line is
adjusted.

Adjusting direction lines on a smooth point (left) and a
corner point (right)

Direction lines are always tangent to (perpendicular to the
radius of) the curve at the anchor points. The angle of each
direction line determines the slope of the curve, and the
length of each direction line determines the height, or
depth, of the curve.

In Illustrator, you can show or hide anchor
points, direction lines, and direction points by
choosing View > Show Edges or View > Hide
Edges.

Draw with the Pencil tool

The Pencil tool works primarily the same way in Adobe
Illustrator and InDesign. It lets you draw open and closed
paths as if you were drawing with a pencil on paper. It is
most useful for fast sketching or creating a hand-drawn
look. Once you draw a path, you can immediately change
it if needed.

Anchor points are set down as you draw with the Pencil
tool; you do not determine where they are positioned.
However, you can adjust them once the path is complete.
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The number of anchor points set down is determined by the
length and complexity of the path and by tolerance settings
in the Pencil Tool Preferences dialog box. These settings
control how sensitive the Pencil tool is to the movement of
your mouse or graphics-tablet stylus.

Pencil tool options

Double-click the Pencil tool  to set any of the following
options:

Fidelity

Controls how far you have to move your mouse or stylus
before a new anchor point is added to the path. The higher
the value, the smoother and less complex the path. The
lower the value, the more the curves will match the pointer's
movement, resulting in sharper angles. Fidelity can range
from 0.5 to 20 pixels.

Smoothness

Controls the amount of smoothing applied when you use
the tool. Smoothness can range from 0% to 100%. The
higher the value, the smoother the path. The lower the
value, the more anchor points are created, and the more the
line's irregularities are preserved.

Fill New Pencil Strokes

(Illustrator only) Applies a fill to pencil strokes you draw
after selecting this option, but not to existing pencil
strokes. Remember to select a fill before you draw the
pencil strokes.

Keep Selected

Determines whether to keep the path selected after you
draw it. This option is selected by default.

Edit Selected Paths

Determines whether or not you can change or merge a
selected path when you are within a certain distance of it
(specified with the next option).

Within: _ pixels

Determines how close your mouse or stylus must be to an
existing path in order to edit the path with the Pencil tool.
This option is only available when the Edit Selected Paths
option is selected.

Draw straight line segments with the Pen tool

The simplest path you can draw with the Pen tool is a
straight line, made by clicking the Pen tool to create two
anchor points. By continuing to click, you create a path
made of straight line segments connected by corner
points.

Draw curves with the Pen tool

You create a curve by adding an anchor point where a curve
changes direction, and dragging the direction lines that
shape the curve. The length and slope of the direction lines
determine the shape of the curve.

Curves are easier to edit and your system can display and
print them faster if you draw them using as few anchor
points as possible. Using too many points can also
introduce unwanted bumps in a curve. Instead, draw widely
spaced anchor points, and practice shaping curves by
adjusting the length and angles of the direction lines.

Editing paths

Select paths, segments, and anchor points

Before you can reshape or edit a path, you need to select
the path's anchor points, segments, or a combination of
both.

Select anchor points

If you can see the points, you can click them with the Direct
Selection tool to select them. Shift-click to select multiple
points.

Select the Direct Selection tool and drag a boundary
around the anchor points. Shift-drag around additional
anchor points to select them.

You can select anchor points from selected or unselected
paths. Move the Direct Selection tool over the anchor point
until the pointer displays a hollow square for unselected
and filled square for selected paths in a magnified state,
and then click the anchor point. Shift-click additional
anchor points to select them.

(Illustrator only) Select the Lasso tool, and drag around the
anchor points. Shift-drag around additional anchor points
to select them.

Adjust path segments

You can edit a path segment at any time, but editing
existing segments is slightly different from drawing them.
Keep the following tips in mind when editing segments:

If an anchor point connects two segments, moving that
anchor point always s changes both segments.

When drawing with the Pen tool, you can temporarily
activate the Direct Selection tool (InDesign and Photoshop)
so that you can adjust segments you've already drawn;
press Ctrl (Windows) or Command (Mac OS) while draw-
ing. In Illustrator, pressing Ctrl or Command while drawing
activates the last-used selection tool.

When you initially draw a smooth point with the Pen tool,
dragging the direction point changes the length of the
direction line on both sides of the point. However, when you
edit an existing smooth point with the Direct Selection tool,
you change the length of the direction line only on the side
you're dragging.

Add or delete anchor points

Adding anchor points can give you more control over a path
or it can extend an open path. However, it's a good idea not

Clicking Pen tool creates straight segments
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to add more points than necessary. A path with fewer
points is easier to edit, display, and print. You can reduce
the complexity of a path by deleting unnecessary points.

The toolbox contains three tools for adding or deleting
points: the Pen tool , the Add Anchor Point tool , and the
Delete Anchor Point tool .

By default, the Pen tool changes to the Add Anchor Point
tool as you position it over a selected path, or to the Delete
Anchor Point tool as you position it over an anchor point.
(In Photoshop, you must select Auto Add/Delete in the
options bar to enable the Pen tool to automatically change
to the Add Anchor Point or Delete Anchor Point tool.)

You can select and edit multiple paths simultaneously in
Photoshop and InDesign; however, you can add or delete
points to only one path at a time in Illustrator. In Photoshop
and InDesign, you can reshape a path while adding anchor
points by clicking and dragging as you add.

Don't use the Delete, Backspace, and Clear
keys or the Edit > Cut or Edit > Clear commands
to delete anchor points: these keys and com-
mands delete the point and the line segments
that connect to that point.

Convert between smooth points and corner points

Paths can have two kinds of anchor points-corner points
and smooth points. At a corner point, a path abruptly
changes direction. At a smooth point, path segments are
connected as a continuous curve. The Convert Direction
Point tool . lets you change an anchor point from a corner
point to a smooth point or visa versa.

Split a path

You can split a path, graphics frame, or empty text frame
at any anchor point or along any segment. When you split
a path, keep the following in mind:

If you want to split a closed path into two open paths, you
must slice in two places along the path. If you slice a closed
path only once, you get a single path with a gap in it.

Any paths resulting from a split inherit the path settings of
the original path, such as stroke weight and fill color. You
may need to reset stroke alignment from inside to outside.

Set strokes

You can apply strokes, or line settings, to paths, shapes,
text frames, and text outlines. The Stroke panel provides
control over the weight and appearance of the stroke,
including how segments join, start and end shapes, and
options for corners. You can also select stroke settings in
the Control panel when a path or frame is selected.

Create type on a path

You can format text to flow along the edge of an open or
closed path of any shape. Apply options and effects to type
on a path: Slide it along the path, flip it over to the other side
of the path, or use the shape of the path to distort the
characters. Type on a path has an in port and an out port
just like other text frames, so you can thread text to and
from it.

You can include only one line of type on a path, so any type
that won't fit on the path will be overset (hidden), unless
you've threaded it to another path or text frame. You can
add inline or above line anchored objects to type on a path.
You can't create type on a path using compound paths,
such as those that result from using the Create Outlines
command.

A. Start bracket B. In port C. Center bracket D. End bracket
E. Out port indicating threaded text

Edit or delete type on a path

You can apply character and paragraph options to type on
a path. However, paragraph rules and paragraph spacing
options have no effect on type on a path. The alignment
setting in the Paragraph panel controls the alignment of
type on a path.

Tighten character spacing around sharp turns and acute
angles

1. Using the Selection tool or the Type tool, select the type
on a path.

2. Choose Type > Type on a Path > Options, or double-
click the Type On A Path tool.

3. For Spacing, type a value in points. Higher values
remove the extra space from between characters posi-
tioned on sharp curves or angles.

Type on a path

The Spacing value compensates for the way
characters fan out around a curve or sharp
angle. It has no effect on characters positioned
on straight segments. To change spacing of
characters anywhere along the path, select
them, and then apply kerning or tracking.

Adjust the type on a path position

You can change the start or end position of type on a path,
slide type, and change the path position in other ways.

Type on a path before (left) and after (right) applying
spacing adjustment
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Change the start or end position of type on a path

1. Using the Selection tool , select the type on a path.

2. Position the pointer over the path type's start or end
bracket until a small icon appears next to the pointer

. Do not position it over the bracket's in port or out
port.

Zoom in on the path to more easily select the bracket.

3. Drag the start or end bracket along the path.

2. Choose Type > Type on a Path > Options, or double-
click the Type On A Path tool.

3. Choose one of the following in the Effect menu, and then
click OK.

• To keep the center of each character's baseline
parallel to the path's tangent, choose Rainbow. This
is the default setting.

Position the pointer on start or end bracket, and then
drag to reposition boundary of type on a path.

If you apply a paragraph indent value, it's
measured from the start and end brackets.

Flip type on a path

1. Click the Selection tool  , and select the type on a path.

2. Position the pointer over the type's center bracket until
a center bracket icon appears next to the pointer  .

3. Drag the center bracket across the path.

You can also flip type on a path using a dialog box. Using
the Selection tool or the Type tool, select the type on a
path. Choose Type > Type on a Path > Options. Select the
Flip option, and then click OK.

Apply an effect to type on a path

1. Using the Selection tool or the Type tool, select the type
on a path.

Position pointer on center bracket, and then drag across
path to flip type.

A. Rainbow effect B. Skew effect C. 3D Ribbon effect D.
Stair Step effect E. Gravity effect

• To keep characters' vertical edges perfectly vertical
regardless of the path shape, while letting characters'
horizontal edges follow the path, choose Skew. The
resulting horizontal distortion is useful for text that
appears to follow waves or go around a cylinder, as on
a beverage can label.

• To keep characters' horizontal edges perfectly horizon-
tal regardless of the path shape, while keeping each
character's vertical edge perpendicular to the path,
choose 3D Ribbon.

• To keep the left edge of each character's baseline on the
path without rotating any characters, choose Stair
Step.

• To keep the center of each character's baseline on the
path while keeping each vertical edge in line with the
path's center point, choose Gravity. You can control
this option's perspective effect by adjusting the arc of
the text's path.

Stroke panel options
Miter Limit
Specifies the limit of point length to stroke width before a
mitered join becomes a beveled square join. For example,
a value of 9 requires the point length to be 9 times the stroke
width before the point becomes beveled. Type a value
(between 1 and 500) and press Enter or Return. The Miter
Limit does not apply to a round join.

Type on a path effects
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You can include miter limit and stroke alignment settings
in a paragraph or character style. Click the Character Color
section, and then click the stroke icon to make the options
available.

Cap

Select a cap style to specify the appearance of both ends
of an open path:

Butt cap

 Creates squared ends that abut (stop at) the endpoints.

Round cap

Creates semicircular ends that extend half the stroke
width beyond the endpoints.

Projecting cap

Creates squared ends that extend half the stroke width
beyond the endpoints. This option makes the stroke weight
extend evenly in all directions around the path.

You can specify a cap option for a closed path,
but the cap will not be visible unless the path is
opened (for example, by cutting with the Scis-
sors tool). Also, cap styles are easier to see at
thicker stroke weights.

Join

Specify the appearance of the stroke at corner points:

Miter join

 Creates pointed corners that extend beyond the endpoint
when the miter's length is within the miter limit.

Round join

 Creates rounded corners that extend half the stroke
width beyond the endpoints.

Bevel join

 Creates squared corners that abut the endpoints.

You can specify miter options for a path that
doesn't use corner points, but the miter options
will not apply until you create corner points by
adding them or by converting smooth points.
Also, miters are easier to see at thicker stroke
weights.

Align Stroke

Click an icon to specify the position of the stroke relative
to its path.

Type

Choose a stroke type in the menu. If you choose Dashed,
a new set of options appears.

Start

Choose for the beginning of the path.

End

Choose for the end of the path.

Gap Color

Specify a color to appear in the space between dashes,
dots, or multiple lines in a patterned stroke.

Gap Tint

Specify a tint (when a gap color is specified).

Although you can define dashed strokes in the Stroke
panel, it's easier to create a dashed stroke using a custom
stroke style.

Add start and end shapes

Keep the following guidelines in mind as you work with start
and end shapes:

You can't edit the available start and end shapes, but if
you've obtained plug in software that adds more options,
the Start and End menus in the Stroke panel can include
additional shapes.

Start and end shapes are sized in proportion to the stroke
weight. However, adding a start or end shape does not
change the length of the path.

Start and end shapes automatically rotate to match the
angle of an endpoint's direction line.

Start and end shapes appear at endpoints of open paths
only; they won't appear on individual dashes of a dashed
stroke.

If you apply start and end shapes to a compound path that
includes open subpaths, each open subpath will use the
same start and end shapes.

You can apply start and end shapes to a closed path, but
they won't be visible unless you open the path.

Define custom stroke styles

You can create a custom stroke style using the Stroke
panel. A custom stroke style can be dashed, dotted, or
striped; in the style, you can define the stroke's pattern,
cap, and corner attributes. You specify other stroke
attributes, such as weight, gap color, and start and end
shapes, after the custom stroke style has been applied to
an object.

Sample start and end shapes
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A. Dashed B. Dotted C. Striped

Change corner appearance

You can use the Corner Options command to quickly apply
corner effects to any path. Available corner effects range
from simple, rounded corners to fancy ornamentation.

Custom stroke styles

Compound paths and shapes

About compound paths

You can combine several paths into a single object, called
a compound path. Create a compound path when you want
to do any of the following:

Add transparent holes to a path.

Preserve the transparent holes within some text charac-
ters, such as o and e, when you convert characters to
editable letterforms using the Create Outlines command.
Using the Create Outlines command always results in the
creation of compound paths.

Apply a gradient, or add contents that span multiple paths.
Although you can also apply a gradient across multiple
objects using the Gradient tool, applying a gradient to a
compound path is often a better method because you can
later edit the entire gradient by selecting any of the
subpaths. With the Gradient tool, later editing requires
selecting all of the paths you originally selected.

Best practices for editing compound paths

Keep the following guidelines in mind as you edit com-
pound paths:

Changes to path attributes (such as stroke and fill) always
alter all subpaths in a composite path-it doesn't matter
which selection tool you use, or how many subpaths you
select. To preserve the individual stroke and fill attributes
of the paths you want to combine, group them instead.

Effects of different line weights on corner shapes

A. Fancy corner effect with no stroke B. Same effect with
1-point stroke C. Same effect with 4- point stroke

In a compound path, any effect that is positioned relative to
a path's bounding box-such as a gradient, or an image
pasted inside-is actually positioned relative to the bound-
ing box of the entire compound path (that is, the path that
encloses all of the subpaths).

Create compound shapes

If you make a compound path, then change its properties
and release it, using the Release command, the released
paths inherit the compound path's properties; they don't
regain their original properties.

If your document contains compound paths with many
smooth points, some output devices may have problems
printing them. If so, simplify or eliminate the compound
paths, or convert them to bitmap images using a program
such as Adobe Photoshop.

If you apply a fill to a compound path, holes sometimes
don't appear where you expect them to. For a simple path
like a rectangle, the inside, or the area you can fill, is easy
to see-it's the area within the enclosed path. However, with
a compound path, InDesign must determine whether the
intersections created by a compound path's subpaths are
inside (filled areas) or outside (holes). The direction of each
subpath-the order in which its points were created-deter-
mines whether the area it defines is inside or outside. If a
subpath is filled when you want it to be a hole, or vice versa,
click Reverse Path in the Pathfinder panel to reverse the
direction of that subpath.

Compound path containing two subpaths with same path
directions (left) and opposite path directions (right)

Create compound shapes

You create compound shapes using the Pathfinder panel
(Window > Object & Layout > Pathfinder). Compound
shapes can be made up of simple or compound paths, text
frames, text outlines, or other shapes. The appearance of
the compound shape depends on which Pathfinder button
you choose.
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A. Original objects B. Add C. Subtract D. Intersect
E. Exclude Overlap F. Minus Back

Add Traces the outline of all objects to create a single
shape.

Subtract Objects in the front "punch holes" in the backmost
object.

Intersect Creates a shape from overlapping areas.

Exclude Overlap Creates a shape from areas that do not
overlap.

Minus Back Objects in the back "punch holes" in the
frontmost object.

In most cases, the resulting shape adopts the attributes
(fill, stroke, transparency, layer, and so on) of the frontmost
object. When you subtract shapes, however, objects in the
front are deleted. The resulting shape takes on the at-
tributes of the backmost object instead.

When you include a text frame in a compound shape, the
shape of the text frame changes, but the text itself stays
the same. To alter the text itself, create a compound path
using text outlines.

Create paths from text outlines

Use the Create Outlines command to convert selected text
characters into a set of compound paths that you can edit
and manipulate as you would any other path. The Create
Outlines command is useful for creating effects in large
display type, but it is rarely useful for body text or other
smaller-size type.

If you simply want to apply a color stroke, or a gradient fill
or stroke to text characters, you don't need to convert the
text to outlines. You can use the toolbox and the Swatches,
Color, or Gradient panels to apply colors and gradients
directly to the strokes or fills of selected characters.

The Create Outlines command gets its font outline informa-
tion from the actual Type 1, TrueType, or OpenType files.
When you create outlines, characters are converted in their
current positions, retaining all graphics formatting, such as
stroke and fill.

Some font manufacturers block the informa-
tion needed to create outlines. If you select
such a protected font and choose Type > Create
Outlines, a message will explain that the font
cannot be converted

When you convert type to outlines, the type loses its hints-
instructions built into outline fonts for adjusting their
shapes, so that your system displays or prints them
optimally at small sizes. Therefore, type converted to
outlines may not display as well when rendered in small
sizes or at low resolutions.

After converting type to outlines, you can do any of the
following:

Alter the letterforms by dragging individual anchor points
using the Direct Selection tool.

Copy the outlines and use the Edit > Paste Into command
to mask an image by pasting it into the converted outlines.

Use the converted outlines as text frames, so that you can
type or place text in them.

Change the stroke attributes of letterforms.

Use text outlines to create compound shapes.

Compound shape used as a text frame (left) compared to
one created from a text outline (right)

A. Type character before conversion to text outline B. Text
outline with image pasted into it C. Text outline used as a
text frame
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Because converted text outlines become sets of com-
pound paths, you can edit individual subpaths of converted
outlines by using the Direct Selection tool. You can also
break the character outlines into independent paths by
releasing them from the compound path.

Align panel overview

You use the Align panel (Window > Object & Layout >
Align) to align or distribute objects horizontally or vertically
along the selection, margins, page, or spread. Consider
the following when working with the Align panel:

• The Align panel doesn't affect objects to which you've
applied the Lock Position command, and doesn't change
the alignment of text paragraphs within their frames.

• Text alignment is not affected by the Align Objects
optionsYou can use the Keyboard Shortcuts dialog box
(Edit > Keyboard Shortcuts) to create custom align and
distribute shortcuts. (Under Product Area, select Ob-
ject Editing.)

To show or hide additional panel options, choose Show
Options or Hide Options from the panel menu.
3. From the menu at the bottom of the panel, specify

whether you want to align or distribute objects based on
the selection, margins, page, or spread.

4. Do one of the following:

• To align objects, click the button for the type of
alignment you want.

• To distribute objects, click the button for the type of
distribution you want. For example, if you click the
Distribute Left Edges button when Align To Selec-
tion is turned on, InDesign makes sure that there is
an equal amount of space from left edge to left edge
of each selected object.

Align panel

A. Vertical alignment buttons B. Vertical distribution but-
tons C. Use Spacing distribution D. Horizontal alignment
buttons E. Horizontal distribution buttons F. Alignment
location options

Align or distribute objects

You can use the Align panel to align or space selected
objects horizontally or vertically to the selection, margins,
page, or spread.

1. Select the objects to align or distribute.

2. Choose Window > Object & Layout > Align to display
the Align panel.

Objects distributed horizontally to selection (top) and to
margins (bottom)

A. Creates even spacing between the centers of each
object B. Keeps the overall width the same as before the
transformation

• To set the space between objects, either center to
center or edge to matching edge, select Use Spacing
under Distribute Objects, and then type the amount of
space you want to apply. Click a button to distribute the
selected objects along their horizontal or vertical axis.

Using the Distribute Horizontal Centers option for
even spacing

Using the Distribute Horizontal Centers option and
adding a value for Use Spacing
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A. Spaces the objects evenly from their centers by a
specified value B. Changes the overall width of the objects
as a whole

• To set the space between objects (facing edge to facing
edge), under Distribute Spacing, select Use Spacing
and type the amount of space you want between the
objects. (If Distribute Spacing is not visible, choose
Show Options in the Align Panel menu.) Then, click the
Distribute Spacing button to distribute the objects
along their horizontal or vertical axis.

A. Creates spaces of a specified value between each
object B. Changes the overall width of the objects as a
whole

When you use spacing with vertical distribution, selected
objects are spaced from top to bottom, starting with the
top-most object. When you use spacing with horizontal
distribution, selected objects are spaced from left to right,
starting from the left-most object.

You can also use the Smart Spacing feature to align or
distribute objects while moving them. For example, if two
vertical objects are 12 points apart, moving a third object 12
points below the second object causes temporary guides
to appear, allowing you to snap the object into alignment.

Using the Distribute Horizontal Space option and adding a
value for Use Spacing

Align objects using the Gap tool

The Gap tool provides a quick way to adjust the size of a
gap between two or more objects. It also lets you resize
several objects that have commonly aligned edges simul-
taneously, while keeping the gaps between them fixed. It's
a one-step way to adjust your layout by directly manipulat-
ing the space between objects.

The Gap tool ignores locked objects and master page
items.

1 Select the Gap tool .

2 Move the pointer between two objects, and do any of the
following actions:

• Drag to move the gap and resize all objects aligned
along the gap.

• Shift-drag to move the gap between only the two
nearest objects.

• Ctrl-drag (Windows) or Command-drag (Mac OS) to
resize the gap instead of moving it. Adding the Shift
key resizes the gap between only the two nearest
objects.

• Alt-drag (Windows) or Option-drag (Mac OS) to
move the gap and objects in the same direction.
Adding the Shift key moves only the two nearest
objects.

• Ctrl+Alt-drag (Windows) or Command+Option-drag
(Mac OS) to resize the gap and move the objects.
Adding the Shift key to resize the gap and move only
the two nearest objects.

To view hints on using the Gap tool, select the Gap tool and
open the Tool Hints panel (Window > Utilities > Tool Hints).
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Creating tables

A table consists of rows and columns of cells. A cell is like
a text frame in which you can add text, anchored frames,
or other tables. Create tables in Adobe InDesign CS5 or
export them from other applications.

Create tables

A table consists of rows and columns of cells. A cell is like
a text frame in which you can add text, inline graphics, or
other tables. You can create tables from scratch or by
converting them from existing text. You can also embed a
table within a table.

When you create a table, the new table fills the width of the
container text frame. A table is inserted on the same line
when the insertion point is at the beginning of the line, or
on the next line, when the insertion point is in the middle
of a line.

Tables flow with surrounding text just as inline graphics do.
For example, a table moves through threaded frames when
the text above it changes in point size or when text is added
or deleted. However, a table cannot appear on a text-on-
path frame.

Importing tables from other applications

When you use the Place command to import a Microsoft
Word document that includes tables, or a Microsoft Excel
spreadsheet, imported data is an editable table. You can
use the Import Options dialog box to control the formatting.

You can also paste data from an Excel spreadsheet or a
Word table into an InDesign or InCopy document. The
Clipboard Handling preference settings determine how text
pasted from another application is formatted. If Text Only
is selected, the information appears as unformatted tabbed
text, which you can then convert to a table. If All Information
is selected, the pasted text appears in a formatted table.

If you're pasting text from another application into an
existing table, insert enough rows and columns to accom-
modate the pasted text, select the Text Only option in
Clipboard Handling preferences, and make sure that at
least one cell is selected (unless you want to embed the
pasted table into a cell).

If you want more control over formatting the imported table,
or if you want to maintain spreadsheet formatting, use the
Place command to import the table. If you want to maintain
a link to the spreadsheet, select the Create Links When
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Creating and formatting tables
Objectives : At the end of this exercise you shall be able to
• create and edit the table
• select and Edit tables
• formatting the tables
• tables strokes and fills
• table and cell styles.

Placing Text And Spreadsheet Files option in File Han-
dling preference settings.

You can also copy and paste tabbed text across a
selection of table cells. This technique is a great way to
replace content while preserving formatting. For example,
suppose you want to update the content of a formatting
table in a monthly magazine. One possibility is to link to
an Excel spreadsheet. However, if your content comes
from a different source, you can copy the tabbed text
containing the new content, select the range of cells in the
formatted InDesign table, and paste.

Add text to a table

You can add text, anchored objects, XML tags, and other
tables to table cells. The height of a table row expands to
accommodate additional lines of text, unless you set a
fixed row height. You cannot add footnotes to tables.

Using the Type tool , do any of the following:

Position the insertion point in a cell, and type text. Press
Enter or Return to create a new paragraph in the same cell.
Press Tab to move forward through cells (pressing Tab in
the last cell inserts a new row). Press Shift+Tab to move
backwards through cells.

Copy text, position the insertion point in a cell, and then
choose Edit > Paste.

Position the insertion point in a cell where you want to add
text, choose File > Place, and then double-click a text file.

Add graphics to a table

Do any of the following:

Position the insertion point where you want the graphic,
choose File > Place, and then double-click the graphic's
filename.

Position the insertion point where you want the graphic,
choose Object > Anchored Object > Insert, and then
specify settings. You can later add a graphic to the
anchored object.

Copy a graphic or a frame, position the insertion point, and
then choose Edit > Paste.

When you add a graphic that is larger than the cell, the cell
height expands to accommodate the graphic, but the width
of the cell doesn't change-the graphic may extend beyond
the right side of the cell. If the row in which the graphic is
placed is set to a fixed height, a graphic that is taller than
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the row height causes the cell to be overset.

To avoid an overset cell, place the image outside the table,
resize the image, and then paste it into the table cell.

Add table headers and footers

When you create a long table, the table can span more than
one column, frame, or page. You can use headers or
footers to repeat the information at the top or bottom of each
divided portion of the table.

You can add header and footer rows when you create the
table. You can also use the Table Options dialog box to add
header and footer rows and change how they appear in the
table. You can convert body rows to header or footer rows.

To number tables sequentially, such as Table 1A, Table
1B, add a variable to the table header or footer.

Select table cells, rows, and columns

When you select part or all of the text in a cell, that
selection has the same appearance as would text selected
outside a table. However, if the selection spans more than
one cell, the cells and their contents are both selected.

If a table spans more than one frame, holding the mouse
pointer over any header or footer row that is not the first
header or footer row causes a lock icon to appear,
indicating that you cannot select text or cells in that row.
To select cells in a header or footer row, go to the beginning
of the table.

Insert a row or column by dragging

When adding columns, if you drag more than one and one-
half times the width of the column being dragged, new
columns are added that have the same width as the original
column. If you drag to insert only one column, that column
can have a narrower or wider width than the column from
where you dragged. The same behavior is true of rows,
unless the Row Height for the row being dragged is set to
At Least. In this case, if you drag to create only one row,
InDesign will resize the new row, if necessary, so that it's
tall enough to contain text.

Formatting tables

Use the Control panel or Character panel to format text
within a table-just like formatting text outside a table. In
addition, two main dialog boxes help you format the table
itself: Table Options and Cell Options. Use these dialog
boxes to change the number of rows and columns, to
change the appearance of the table border and fill, to
determine the spacing above and below the table, to edit
header and footer rows, and to add other table formatting.

Header rows repeated once per frame

Use the Table panel, the Control panel, or the context menu
to format the table structure. Select one or more cells and
then right-click (Windows) or Control-click (Mac OS) to
display a context menu with table options.

Resize the entire table

Using the Type tool , position the pointer over the lower-
right corner of the table so that the pointer becomes an
arrow shape , and then drag to increase or decrease the
table size. Hold down Shift to maintain the table's height
and width proportions.

If the table spans more than one frame in a
story, you cannot use the pointer to resize the
entire table.

Break tables across frames

Use Keep options to determine how many rows should
remain together, or to specify where a row breaks, such as
at the top of a column or frame.

When you create a table that is taller than the frame in
which it resides, the frame is overset. If you thread the
frame to another frame, the table continues in that frame.
Rows move into threaded frames one at a time-you can't
break a single row across multiple frames. Specify header
or footer rows to repeat information in the new frame.

Add text before a table

A table is anchored to the paragraphs that immediately
precede and follow it. If you insert a table at the beginning
of the text frame, you can't click above the table to place
an insertion point. Instead, use the arrow keys to move the
insertion point before the table.

Work with overset cells

In most cases, a table cell will expand vertically to
accommodate new text and graphics being added. How-
ever, if you set a fixed row height and add text or graphics
that are too large for the cell, a small red dot appears in the
lower-right corner of the cell, indicating that the cell is
overset.

You cannot flow overset text into another cell. Instead, edit
or resize the contents, or expand the cell or the text frame
in which the table appears.

In the case of inline graphics or text with fixed leading, it is
possible for the cell contents to extend beyond cell edges.
You can select the Clip Contents To Cell option, so that any
text or inline graphics that otherwise extend beyond any
cell edge are clipped to the cell boundary. However, when
inline graphics are overset to extend beyond cell bottom
edges (Horizontal), this does not apply.

Display the contents of an overset cell

Do one of the following:

Increase the size of the cell.

Change the text formatting. To select the cell's contents,
click in the overset cell, press Esc, and then use the
Control panel to format the text.
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About table strokes and fills

You can add strokes and fills to your tables in a number of
ways. Use the Table Options dialog box to change the
stroke of the table border, and to add alternating strokes
and fills to columns and rows. To change the strokes and
fills of individual cells or header/footer cells, use the Cell
Options dialog box, or use the Swatches, Stroke, and
Color panels.

By default, the formatting you select using the Table
Options dialog box overrides any corresponding formatting
previously applied to table cells. However, if you select the
Preserve Local Formatting option in the Table Options
dialog box, the strokes and fills applied to individual cells
are not overridden.

If you use the same formatting repeatedly for tables or
cells, create and apply table styles or cell styles.

Add stroke and fill using Cell Options

You can determine which cell lines are formatted with a
stroke or fill by selecting or deselecting lines in the Preview
proxy. If you want to change the appearance of all rows or
columns in the table, use an alternating stroke or fill pattern
in which the second pattern is set to 0.

Table stroke and fill options

When selecting strokes and fills for the table or cells, use
the following options:

Weight

Specifies the line thickness for the table or cell border.

Type

Specifies the line style, such as Thick - Thin.

Color

Specifies the color of the table or cell border. The choices
listed are those available in the Swatches panel.

Tint

Specifies the percentage of ink of the specified color to be
applied to the stroke or fill.

Gap Color

Applies a color to the areas between the dashes, dots, or
lines. This option is not available if Solid is selected for
Type.

Gap Tint

Applies tint to the areas between the dashes, dots, or lines.
This option is not available if Solid is selected for Type.

Overprint

When selected, causes the ink specified in the Color drop-
down list to be applied over any underlying colors, rather
than knocking out those inks.

Alternate strokes and fills in a table

You can alternate strokes and fills to enhance readability
or improve the appearance of your table. Alternating
strokes and fills in table rows does not affect header and

footer rows. However, alternating strokes and fills in col-
umns does affect header and footer rows.

Alternating stroke and fill settings override cell stroke
formatting, unless you select the Preserve Local Format-
ting option in the Table Options dialog box.

If you want to apply a fill or stroke to every body cell in the
table, and not just alternating patterns, you can still use the
alternating stroke and fill settings to create such non-
alternating patterns. To create such an effect, specify 0 for
Next in the second pattern.

Before (left) and after (right) alternating fills in a table

About table and cell styles

Just as you use text styles to format text, you can use table
and cell styles to format tables. A table style is a collection
of table formatting attributes, such as table borders and row
and column strokes, that can be applied in a single step.
A cell style includes formatting such as cell insets,
paragraph styles, and strokes and fills. When you edit a
style, all tables or cells to which the style is applied are
updated automatically.

Basic [Table] and [None] styles

By default, each new document contains a [Basic Table]
style that can be applied to tables you create and a [None]
style that can be used to remove cell styles applied to cells.
You can edit the [Basic Table] style, but you can't rename
or delete either [Basic Table] or [None].

Using cell styles in table styles

When you create a table style, you can specify which cell
styles are applied to different regions of the table: header
and footer rows, left and right columns, and body rows. For
example, for the header row, you can assign a cell style
that applies a paragraph style, and for the left and right
columns, you can assign different cell styles that apply
shaded backgrounds.

A. Header row formatted with cell style that includes
paragraph style B. Left column C. Body cells D. Right
column

Cell styles applied to regions in table style
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Cell style attributes

Cell styles do not necessarily include all the formatting
attributes of a selected cell. When you create a cell style,
you can determine which attributes are included. That way,
applying the cell style changes only the desired attributes,
such as cell fill color, and ignores all other cell attributes.

Formatting precedence in styles

If a conflict occurs in formatting applied to a table cell, the
following order of precedence determines which formatting
is used:

Cell style precedence

1. Header/Footer 2. Left column/Right column 3. Body
rows. For example, if a cell appears in both the header and
the left column, the formatting from the header cell style is
used.

Table style precedence

1. Cell overrides 2. Cell style 3. Cell styles applied from a
table style 4. Table overrides 5. Table styles. For example,
if you apply one fill using the Cell Options dialog box and
another fill using the cell style, the fill from the Cell Options
dialog box is used.

Table/Cell Styles panels overview

Use the Table Styles panel (Window > Styles >Table
Styles) to create and name table styles, and to apply the
styles to existing tables or tables you create or import. Use
the Cell Styles panel (Window > Styles > Cell Styles) to
create and name cell styles, and to apply the styles to table
cells. Styles are saved with a document and appear in the
panel each time you open that document. You can save
table and cell styles in groups for easier management.

When you position the insertion point in a cell or table, any
style that is applied is highlighted in either of the panels.
The name of any cell style that is applied through a table
style appears in the lower left corner of the Cell Styles area.
If you select a range of cells that contains multiple styles,
no style is highlighted and the Cell Styles panel displays
"(Mixed)."

Open the Table Styles or Cell Styles panel

Choose Window > Styles, and choose Table Styles or Cell
Styles.

Change how styles are listed in the panel

Select Small Panel Rows to display a condensed version
of the styles.

Drag the style to a different position. You can also drag
styles to groups that you create.

Choose Sort By Name from the panel menu to list the
styles alphabetically.

Load (import) table styles from other documents

You can import table and cell styles from another InDesign
document into the active document. During import, you can
determine which styles are loaded and what should occur
if a loaded style has the same name as a style in the current
document. You can also import styles from an InCopy
document.

Apply table and cell styles

Unlike paragraph and character styles, table and cell
styles do not share attributes, so applying a table style
does not override cell formatting, and applying a cell style
does not override table formatting. By default, applying a
cell style removes formatting applied by any previous cell
style, but does not remove local cell formatting. Similarly,
applying a table style removes formatting applied by any
previous table style, but does not remove overrides made
using the Table Options dialog box.

In the Styles panel, a plus sign (+) appears next to the
current cell or table style if the selected cell or table has
additional formatting that isn't part of the applied style.
Such additional formatting is called an override.
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Using the color, color libraries and color separation
Objectives : At the end of this lesson you shall be able to
• about spot and process colors
• applying the color
• blending colors
• working with swatches
• managing color
• preparing to print color separation.
About spot and process colors

You can designate colors as either spot or process color
types, which correspond to the two main ink types used in
commercial printing. In the Swatches panel, you can
identify the color type of a color using icons that appear
next to the name of the color. When applying color to paths
and frames, keep in mind the final medium in which the
artwork will be published, so that you apply color using the
most appropriate color mode.

About spot colors

A spot color is a special premixed ink that is used instead
of, or in addition to, process inks, and that requires its own
printing plate on a printing press. Use spot color when few
colors are specified and color accuracy is critical. Spot
color inks can accurately reproduce colors that are outside
the gamut of process colors. However, the exact appear-
ance of the printed spot color is determined by the
combination of the ink as mixed by the commercial printer
and the paper it's printed on, not by color values you specify
or by color management. When you specify spot color
values, you're describing the simulated appearance of the
color for your monitor and composite printer only (subject
to the gamut limitations of those devices).

Keep the following guidelines in mind when specify-
ing a spot color:

For best results in printed documents, specify a spot color
from a color-matching system supported by your commer-
cial printer. Several color-matching system libraries are
included with the software.

Minimize the number of spot colors you use. Each spot
color you create will generate an additional spot color
printing plate for a printing press, increasing your printing
costs. If you think you might require more than four colors,
consider printing your document using process colors.

If an object contains spot colors and overlaps another
object containing transparency, undesirable results may
occur whenexporting to EPS format, when converting spot
colors to process colors using the Print dialog box, or when
creating color separations in an application other than
Illustrator or InDesign. For best results, use the Flattener
Preview or the Separations Preview to soft proof the effects
of flattening transparency before printing. In addition, you
can convert the spot colors to process colors by using the
Ink Manager in InDesign before printing or exporting.

You can use a spot color printing plate to apply a varnish
over areas of a process color job. In this case, your print job
would use a total of five inks-four process inks and one spot
varnish.

About process colors
A process color is printed using a combination of the four
standard process inks: cyan, magenta, yellow, and black
(CMYK). Use process colors when a job requires so many
colors that using individual spot inks would be expensive or
impractical, as when printing color photographs.

Keep the following guidelines in mind when specifying a
process color:

For best results in a high-quality printed document, specify
process colors using CMYK values printed in process color
reference charts, such as those available from a commer-
cial printer.

The final color values of a process color are its values in
CMYK, so if you specify a process color using RGB (or
LAB, in InDesign), those color values will be converted to
CMYK when you print color separations. These conver-
sions differ based on your color-management settings and
document profile.

Don't specify a process color based on how it looks on your
monitor, unless you are sure you have set up a color-
management system properly, and you understand its
limitations for previewing color.

Avoid using process colors in documents intended for
online viewing only, because CMYK has a smaller color
gamut than that of a typical monitor.

Illustrator and InDesign let you specify a process color as
either global or non-global. In Illustrator, global process
colors remain linked to a swatch in the Swatches panel, so
that if you modify the swatch of a global process color, all
objects using that color are updated. Non-global process
colors do not automatically update throughout the docu-
ment when the color is edited. Process colors are non-
global by default. In InDesign, when you apply a swatch to
objects, the swatch is automatically applied as a global
process color. Non-global swatches are unnamed colors,
which you can edit in the Color panel.

Global and non-global process colors only affect
how a particular color is applied to objects, never
how colors separate or behave when you move
them between applications.



207

Using spot and process colors together

Sometimes it's practical to use process and spot inks in
the same job. For example, you might use one spot ink to
print the exact color of a company logo on the same pages
of an annual report where photographs are reproduced
using process color. You can also use a spot color printing
plate to apply a varnish over areas of a process color job.
In both cases, your print job would use a total of five inks-
four process inks and one spot ink or varnish.

In InDesign, you can mix process and spot colors together
to create mixed ink colors.

Blending mode options

The blending modes control how the base color, the
underlying color in the artwork, interacts with the blend
color, the color of the selected object or group of objects.
The resulting color is the color resulting from the blend.

Normal

Colors the selection with the blend color, without interac-
tion with the base color. This is the default mode.

Multiply

Multiplies the base color by the blend color. The resulting
color is always a darker color. Multiplying any color with
black produces black. Multiplying any color with white
leaves the color unchanged. The effect is similar to drawing
on a page with multiple magic markers.

Screen

Multiplies the inverse of the blend and base colors. The
resulting color is always a lighter color. Screening with
black leaves the color unchanged. Screening with white
produces white. The effect is similar to projecting multiple
slide images on top of each other.

Overlay

Multiplies or screens the colors, depending on the base
color. Patterns or colors overlay the existing artwork,
preserving the highlights and shadows of the base color
while mixing in the blend color to reflect the lightness or
darkness of the original color.

Soft Light

Darkens or lightens the colors, depending on the blend
color. The effect is similar to shining a diffused spotlight on
the artwork.

If the blend color (light source) is lighter than 50% gray, the
artwork is lightened, as if it were dodged. If the blend color
is darker than 50% gray, the artwork is darkened, as if it
were burned in. Painting with pure black or white produces
a distinctly darker or lighter area, but does not result in pure
black or white.

Hard Light

Multiplies or screens the colors, depending on the blend
color. The effect is similar to shining a harsh spotlight on
the artwork.

If the blend color (light source) is lighter than 50% gray, the
artwork is lightened, as if it were screened. This is useful
for adding highlights to artwork. If the blend color is darker
than 50% gray, the artwork is darkened, as if it were
multiplied. This is useful for adding shadows to artwork.
Painting with pure black or white results in pure black or
white.

Color Dodge

Brightens the base color to reflect the blend color. Blending
with black produces no change.

Color Burn

Darkens the base color to reflect the blend color. Blending
with white produces no change.

Darken

Selects the base or blend color-whichever is darker-as the
resulting color. Areas lighter than the blend color are
replaced, and areas darker than the blend color do not
change.

Lighten

Selects the base or blend color-whichever is lighter-as the
resulting color. Areas darker than the blend color are
replaced, and areas lighter than the blend color do not
change.

Difference

Subtracts either the blend color from the base color or the
base color from the blend color, depending on which has
the greater brightness value. Blending with white inverts the
base color values; blending with black produces no change.

Exclusion

Creates an effect similar to, but lower in contrast than, the
Difference mode. Blending with white inverts the base color
components. Blending with black produces no change.

Hue

Creates a color with the luminance and saturation of the
base color and the hue of the blend color.

Saturation

Creates a color with the luminance and hue of the base
color and the saturation of the blend color. Painting with
this mode in an area with no saturation (gray) produces no
change.

Color

Creates a color with the luminance of the base color and the
hue and saturation of the blend color. This preserves the
gray levels in the artwork, and is useful for coloring
monochrome artwork and for tinting color artwork.

Luminosity

Creates a color with the hue and saturation of the base
color and the luminance of the blend color. This mode
creates an inverse effect from that of the Color mode.
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Isolate blending modes

When you apply a blending mode to an object, its colors
blend with all objects beneath it. If you want to limit the
blending to specific objects, you can group those objects
and then apply the Isolate Blending option to the group. The
Isolate Blending option confines the blending to within the
group, preventing objects beneath the group from being
affected. (It is useful for objects that have a blending mode
other than Normal applied to them.)

The blending space is applied only to those spreads that
contain transparency.

Choose Edit > Transparency Blend Space, and then
choose one of the document's color spaces.

For a typical print workflow, choose the Docu-
ment CMYK color space.

Swatches panel overview

The Swatches panel (Window > Color > Swatches) lets
you create and name colors, gradients, or tints, and
quickly apply them to your document. Swatches are
similar to paragraph and character styles; any change you
make to a swatch affects all objects to which the swatch
is applied. Swatches make it easier to modify color
schemes without having to locate and adjust each indi-
vidual object.

When the fill or stroke of selected text or an object contains
a color or gradient applied from the Swatches panel, the
applied swatch is highlighted in the Swatches panel.
Swatches you create are associated only with the current
document. Each document can have a different set of
swatches stored in its Swatches panel.

When working with a prepress service provider, swatches
let you clearly identify spot colors. You can also specify
color settings in a preflight profile to determine which color
settings work with your printer.

Six CMYK-defined colors appear in the default Swatches
panel: cyan, magenta, yellow, red, green, and blue.

Swatch types

The Swatches panel stores the following types of swatches:

Colors

Icons on the Swatches panel identify the spot  and
process  color types, and LAB , RGB , CMYK ,
and Mixed Ink  color modes.

Tints

A percentage value next to a swatch in the Swatches panel
indicates a tint of a spot or process color.

Gradients

An icon on the Swatches panel indicates whether a
gradient is radial  or linear .

None

The None swatch removes the stroke or fill from an object.
You can't edit or remove this swatch.

Paper

Paper is a built in swatch that simulates the paper color on
which you're printing. Objects behind a paper-colored
object won't print where the paper-colored object overlaps
them. Instead, the color of the paper on which you print
shows through. You can edit the Paper color to match your
paper stock by double-clicking it in the Swatches panel.
Use the Paper color for previewing only-it will not be printed
on a composite printer or in color separations. You can't

Group (star and circle) with Isolate Blending option dese-
lected (left) compared to selected (right)

It is important to understand that you apply the blending
modes to the individual objects, but apply the Isolate
Blending option to the group. The option isolates blending
interactions within the group. It doesn't affect blending
modes applied directly to the group itself.

Knock out objects within a group

You use the Knockout Group option in the Effects panel to
make the opacity and blending attributes of every object in
the selected group knock out-that is, visually block out-
underlying objects in the group. Only objects within the
selected group are knocked out. Objects beneath the
selected group are still affected by the blending or opacity
that you apply to objects within the group.

It is important to understand that you apply the blending
modes and opacity to the individual objects, but apply the
Knockout Group option to the group.

Group with Knockout Group option deselected (left)
compared to selected (right)

Specify a color space for blending transparent ob-
jects

To blend the colors of transparent objects on a spread,
InDesign converts the colors of all objects to a common
color space using either the CMYK or RGB color profile for
the document. This blending space enables objects of
multiple color spaces to blend when interacting transpar-
ently. To avoid color mismatches between different areas
of the objects on screen and in print, the blending space is
applied for screen and in the flattener.
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remove this swatch. Do not apply the Paper swatch to
remove color from an object. Use the None swatch instead.

If the Paper color is not working as described, and
you are printing to a non-PostScript printer, try
switching your printer driver to Raster Graphics
mode

Black

Black is a built in, 100% process color black defined using
the CMYK color model. You can't edit or remove this
swatch. By default, all occurrences of Black overprint (print
on top of) underlying inks, including text characters at any
size. You can disable this behavior.

Registration

Registration  is a built in swatch that causes objects to
print on every separation from a PostScript printer. For
example, registration marks use the Registration color, so
that printing plates can be aligned precisely on a press.
You cannot edit or remove this swatch.

You can also add colors from any color library to the
Swatches panel so that they are saved with your docu-
ment.

Create color swatches

Swatches can include spot or process colors, mixed inks
(process colors mixed with one or more spot colors), RGB
or Lab colors, gradients, or tints.

When you place an image that contains spot colors, the
colors are automatically added as swatches to the Swatches
panel. You can apply these swatches to objects in your
document, but you cannot redefine or delete the swatches.

Before you create swatches, learn which settings are
appropriate for your printer service provider. You can
specify color settings in a preflight profile to highlight color
settings that don't work with your printer.

Add unnamed colors to the Swatches panel

While you can create colors using the Color panel or Color
Picker, unnamed colors are more difficult to edit later and
to use consistently. Use the Add Unnamed Colors option
to search for unnamed colors applied to objects within the
document, and then add them to the Swatches panel.
Colors are automatically named according to their CMYK,
RGB, or Lab components.

In the Swatches panel, choose Add Unnamed Colors.

Manage swatches

You can edit, duplicate, and delete swatches in the
Swatches panel.

Edit the default colors in the Swatches panel

You can change the swatches that appear by default in new
documents.

1. Close all open documents.

2. Edit the swatches you want to change in the Swatches
panel.

Duplicate a swatch

Duplicating swatches can be useful when you want to
create a warmer or cooler variation of an existing color.
Note that duplicating a spot color will result in an additional
spot color printing plate.

Do one of the following:

Select a swatch, and choose Duplicate Swatch in the
Swatches panel menu.

Select a swatch, and click the New Swatch button   at the
bottom of the panel.

Drag a swatch to the New Swatch button at the bottom of
the panel.

Control swatch names

By default, the name of a process color swatch is derived
from the values of the color's components. For example, if
you create a red process color using 10% cyan, 75%
magenta, 100% yellow, and 0% black, its swatch will be
named C=10 M=75 Y=100 K=0 by default. This makes it
easier to identify the composition of process colors.

By default, the name of a process color swatch automati-
cally updates when you change its CMYK values; you can
switch this option off or on for individual swatches as
needed. As with any swatch you define, you can change
the name of a process color swatch at any time.

1. Double-click a process color in the Swatches panel.

2. Do one of the following, and click OK:

To let InDesign rename the swatch when you adjust its
CMYK percentages, make sure that the Name With Color
Value option is selected.

To rename a swatch when you adjust its CMYK values,
make sure that the Name With Color Value option is
deselected.

The new swatch is automatically renamed
New ColorSwatch (this has a number following
it if more than one New ColorSwatch exists)
when this option is deselected. You can change
this name manually.

Import swatches

You can import colors and gradients from other docu-
ments, adding either all or some of the swatches to the
Swatches panel. You can load swatches from InDesign
files (.indd), InDesign templates (.indt), Illustrator files (.ai
or .eps), and Adobe Swatch Exchange files (.ase) created
by InDesign, Illustrator, or Photoshop. Adobe Swatch
Exchange files contain swatches saved in the Adobe
Swatch Exchange format.

InDesign also includes color libraries from other color
systems, such as the PANTONE Process Color Sys-
tem®.

Spot colors used by imported EPS, PDF, TIFF,
and Adobe Photoshop (PSD) files are also
added to the Swatches panel.
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Copy swatches between InDesign documents

You can copy or drag a swatch (or objects with a swatch
applied) from one document to another. When you do so,
the swatch is added to the destination document's Swatches
panel. If you want to copy the swatch's tints and gradients
as well, you need to copy the original object, not just the
swatch.

Do one of the following:

Copy an object into the current document using drag-and-
drop or copy-and-paste.

Select the swatches you want to copy and drag them from
the Swatches panel to the document window of another
InDesign document.

If you drag a swatch that has an identical name
as an existing swatch (including capitalization)
but has different color values, InDesign re-
names the swatch "[original swatch name] 2."

Color libraries installed with InDesign

InDesign installs color libraries for the color matching
systems described below. You can install additional color
libraries and load swatches from them in InDesign.

ANPA Color

Consists of 300 colors selected by ANPA (American
Newspaper Publishers Association). Colors in this library
are primarily used as spot colors in newspapers.

DIC Color

Provides 1280 CMYK spot colors from the DIC Process
Color Note. Colors may be matched against the DIC Color
Guide, published by Dainippon Ink & Chemicals, Inc. For
more information, contact Dainippon Ink & Chemicals,
Inc., in Tokyo, Japan.

Focoltone

Consists of 763 CMYK colors. You can use Focoltone
colors to help avoid prepress trapping and registration
problems by viewing the Focoltone charts that show the
overprints that make up the colors.

A swatch book with specifications for process and spot
colors, overprint charts, and a chip book for marking up
layouts are available from Focoltone. For more information,
contact Focoltone International, Ltd., in Stafford, United
Kingdom.

HKS

Use when your job specifies colors from the HKS color
system, which is used in Europe.

PANTONE®

PANTONE® Colors are the worldwide standards for spot
color reproduction. In 2000, a major revision was made to
the PANTONE MATCHING SYSTEM® Color guides. 147
new solid colors and seven additional metallic colors have
been added to the System to now include a total of 1,114
colors. PANTONE Color guides and chip books are now
printed on coated, uncoated, and matte paper stocks to

ensure accurate visualization of the printed result and
better on-press control.

You can print a solid PANTONE Color in CMYK. To
compare a solid PANTONE Color to its closest process
color match, use the PANTONE solid to process guide.
The CMYK screen tint percentages are printed under each
color. The guide is now printed on a brighter coated stock
and includes comparisons of the 147 new solid colors to
CMYK.

PANTONE process guides let you choose from over 3,000
process combinations now printed on coated and un-
coated stocks. Displayed in chromatic order in fan-guide
format, it's easy to select colors and specify CMYK screen
values.

System (Windows)
Includes 256 colors of the Windows default 8 bit panel,
which is based on a uniform sampling of RGB colors.

System (Mac OS)
Includes 256 colors of the Mac OS default 8 bit panel, which
is based on a uniform sampling of RGB colors.

Toyo Color Finder
Includes 1050 colors based on the most common printing
inks used in Japan. You can use the Toyo 94 Color Finder
or the newer Toyo Color Finder. Consult the color guide that
illustrates printed samples of Toyo Ink. This color guide is
available at print publishers and graphic arts supply stores.
For more information, contact Toyo Ink Manufacturing Co.,
Ltd., in Tokyo, Japan.

Trumatch
Provides predictable CMYK color matching with over 2000
achievable, computer-generated colors. Trumatch colors
cover the visible spectrum of the CMYK gamut in even
steps. The Trumatch Color Finder displays up to 40 tints
and shades of each hue, each originally created in four-
color process and each reproducible in four colors on
electronic imagesetters. In addition, four-color grays using
different hues are included. For more information, contact
Trumatch Inc., in New York, New York, U.S.A.

Web
Includes the 216 RGB web safe colors most often used by
web browsers to display 8 bit images. This library helps you
create artwork for the web using colors that display
consistently across Windows and Macintosh systems.

Use color management when printing
When you print a color-managed document, you can
specify additional color management options to keep color
consistent in the printer output. For example, suppose that
your document currently contains a profile tailored for
prepress output, but you want to proof the document colors
on a desktop printer. In the Print dialog box, you can
convert the document's colors to the color space of the
desktop printer; the printer profile will be used instead of the
current document profile. If you select the Proof color
space and target an RGB printer, InDesign converts color
data to RGB values using the selected color profiles.
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When printing to a PostScript printer, you also have the
option of using PostScript color management. In this
instance, InDesign sends the document's color data in a
calibrated version of its original color space, along with the
document profile, directly to the PostScript printer and lets
the printer convert the document to the printer color space.
The printer's color space is stored at the device as a color
rendering dictionary (CRD); this makes device-indepen-
dent output possible. CRDs are PostScript equivalents of
color profiles. The exact results of the color conversion can
vary among printers. To use PostScript color manage-
ment, you must have a printer that uses PostScript Level
2 or higher; it is not necessary to install an ICC profile for
the printer on your system.

While working on a color-managed document,
you can use the Preflight panel to make sure that
your colors conform to the guidelines you specify.

Color output options for composites

In the Output area of the Print dialog box, you can
determine how composite color in the document is sent to
the printer. When color management is enabled (the
default), the Color setting defaults result in calibrated color
output. Spot color information is preserved during color
conversion; only the process color equivalents convert to
the designated color space. If you're not sure which color
choice to use, consult your prepress service provider.

Composite modes only affect rasterized images and ob-
jects created using InDesign; placed graphics (such as
EPS and Adobe PDF files) are not affected unless they
overlap transparent objects.

Note: The options available for non-PostScript printing
depend on the color model the printer uses, which is
usually RGB.

When you print as composite, automatic trapping is
disabled; however, you can select the Simulate Overprint
option to proof overprinting for text, strokes, or fills.

The Output area in the Print dialog box includes the
following Color options. Additional options may also be
available, depending on your printer.

Composite Leave Unchanged

Sends a full-color version of specified pages to the printer,
preserving all color values in the original document. When
this option is selected, Simulate Overprint is disabled.

Composite Gray

Sends grayscale versions of specified pages to the printer
when, for example, you are printing to a monochrome
printer without making separations.

Composite RGB

Sends a full-color version of specified pages to the printer
when, for example, you are printing to an RGB color printer
without making separations.

Composite CMYK

Sends a full-color version of specified pages to the printer
when, for example, you are printing to a CMYK color printer

without making separations. (This option is available only
for PostScript printers.)

Separations

Creates PostScript information for each of the separations
required for the document, and sends that information to
the output device. (This option is available only for PostScript
printers.)

In-RIP Separations

Sends separation information to the output device's RIP.
(This option is available only for PostScript printers.)

Text As Black

Select this option to print all text created in InDesign in
black, unless it has the color None or Paper or a color value
that equals white. This option is useful when you're creating
content for both print and PDF distribution. For example, if
hyperlinks were blue in the PDF version, they would print
black on a grayscale printer, rather than in halftone
patterns that would be difficult to read.

About halftone dots and printer dots

Most printers simulate gray by using halftone dots printed
on a grid; the grid cells are called halftone cells, and the grid
rows are called lines or line screens. Each halftone dot is
made up of printer dots. As the halftone cell fills up with
printer dots, the halftone dot gets larger, resulting in a
darker shade of gray.

Printer resolution determines the number of dots available
to create the halftone dot. A printer with smaller dots can
produce a wider variety of halftone dot sizes, allowing more
shades of gray. Screen frequency also plays a role: As
screen frequency increases, the halftone cell gets smaller,
and so can hold fewer printer dots, resulting in fewer
possible shades of gray. As a result, there is a trade-off
between the number of possible gray levels and image
coarseness.

Simulating continuous tone with printer dots

A. Continuous tone simulated by line screen B. Line
screen consisting of halftone dots in rows C. Halftone dots
consisting of printer dots

Creating separations

To reproduce color and continuous-tone images, printers
usually separate artwork into four plates-one plate for each
of the cyan (C), yellow (Y), magenta (M), and black (K)
portions of the image. When inked with the appropriate
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color and printed in register with one another, these colors
combine to reproduce the original artwork. The process of
dividing the image into two or more colors is called color
separating, and the films from which the plates are created
are called the separations.

Print an object on all color plates

If you want an object to print on all plates in the printing
process, including spot color plates, you can apply regis-
tration color to the object. Registration color is used for
crop marks and trim marks. For composite output, objects
with registration color applied will print as C 100, M 100, Y
100, and K 100. For separations, these objects will print as
100% on each plate.

1. Select the objects to which you want to apply registra-
tion color.

2. Choose Window > Swatches.

3. In the Swatches panel, click the Registration color
swatch .

Printing gradients as separations

Consider the following when producing separations for
documents with gradients:

A gradient created in InDesign that contains a combination
of spot and process colors will be separated onto both the
process and spot plates.

A gradient that contains process colors will be separated
onto the process plates.

A gradient that contains two tints of the same spot color will
be separated onto a single spot color plate.

To create a gradient that separates on one piece of film
between a spot color and white, create a gradient fill
between the spot color and the Paper swatch in the
Swatches panel.

If you create a gradient between two spot colors, you
should assign different screen angles to those spot colors.
If two spot colors have the same screen angle, they will
overprint each other. If you're not sure what the angles
should be, consult with your prepress service provider.

Printing a composite

You can print a color or grayscale composite proof to check
colors in your document. A composite image can help you
design and proof your layout before you print final (and
costly) separations.

When InDesign prints a composite, it prints all of the colors
used in the file on one plate, regardless of whether any
individual colors are selected.

Consider the following issues when printing composites:

While no proof will give you an exact representation of your
final output, you can greatly improve its accuracy by
calibrating all the devices you use to create a document
(such as scanners, monitors, and printers). If the devices
are calibrated, the color management system can help you
get predictable and consistent color.

Any overprinting options that you've selected in the docu-
ment will print correctly on a printer that supports overprint-
ing. Since most desktop printers don't support overprinting,
you can simulate the effects of overprinting by selecting
Simulate Overprint in the Output section of the Print dialog
box.

Separation workflows

Adobe InDesign CS4 supports two common PostScript
workflows; the main difference is where separations are
created-at the host computer (the system using InDesign
and the printer driver), or at the output device's RIP (raster
image processor). Another alternative is a PDF workflow.

Host-based separations

In the traditional host-based, preseparated workflow,
InDesign creates PostScript information for each of the
separations required for the document, and sends that
information to the output device.

In RIP separations

In the newer RIP-based workflow, a new generation of
PostScript RIPs performs color separations, trapping, and
even color management at the RIP, leaving the host
computer free to perform other tasks. This approach takes
less time for InDesign to generate the file, and minimizes
the amount of data transmitted for any given print job. For
example, instead of sending PostScript information for four
or more pages to print host-based color separations,
InDesign sends the PostScript information for a single
composite PostScript file for processing in the RIP.

Outputting spot colors

You can use custom inks, called spot colors, in addition to,
or in place of, process colors. For example, instead of
using the four process colors to reproduce artwork consist-
ing of black text and bluish-green line drawings, you could
use two spot colors-one of black, and one representing the
exact shade of green. You can also use spot color inks to
produce colors not reproducible by CMYK inks, such as
varnishes or fluorescent and metallic colors. In addition,
you can mix two or more spot colors together or mix spot
colors with process colors to create mixed inks.

You can color artwork with process colors, spot colors, or
a combination of both. When printing separations, you can
convert spot colors to their process color equivalents so
that they will be printed on the CMYK plates.

Composite (left) and separations (right)
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Selecting Simulate Overprint will convert spot
colors to process colors for printing. If you
intend to use a file for separations on a RIP, or
for final output, do not select this option.

When you print to a black-and-white printer, InDesign
produces a grayscale composite version of the pages. If the
document contains color, InDesign prints visually correct
grays to simulate that color. For example, the gray that
simulates a 20% tint of yellow is lighter than a 20% tint of
black, since yellow is visually lighter than black.

When you print a book with chapters containing conflicting
spot inks or trap styles, you can instruct InDesign to
synchronize settings with the master document.

If you're using color management with the Book feature,
make sure that each document in the book uses the same
color management settings in the Color Settings dialog
box.

Remember that, like monitors, color printers
vary greatly in color reproduction quality; thus,
proofs from your service provider are the best
way to verify how the finished piece will look.

Preview color separations

You can preview color separations, ink coverage limits, and
overprinting using the Separations Preview panel. Preview-
ing separations on your monitor lets you check the
following:

Varnishes and other coatings

Since varnishes are transparent, they can be difficult to
preview on screen. When you preview a varnish separation
by itself, the varnished areas appear in black.

Rich black

Previewing separations lets you identify areas that will print
as rich black, or process black (K) ink mixed with color inks
for increased opacity and richer color.

Ink coverage

Too much ink on the paper can cause drying problems. Ask
your commercial printer for the maximum ink coverage of
the press you will be printing on. You can then preview the
document to identify areas where ink coverage exceeds
the press's limit.

Overprinting

You can preview how blending, transparency, and over-
printing will appear in color-separated output.

You can also see overprinting effects when you
output to a composite printing device. This is
useful for proofing color separations.

While previewing separations on your monitor can help you
detect problems without the expense of printing separa-
tions, it does not let you preview trapping, emulsion
options, printer's marks, and halftone screens and resolu-
tion. Work with your commercial printer to verify these
settings using integral or overlay proofs.

Objects on hidden layers are not included in an
on screen preview.
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About character and paragraph styles

A character style is a collection of character formatting
attributes that can be applied to text in a single step. A
paragraph style includes both character and paragraph
formatting attributes, and can be applied to a paragraph or
range of paragraphs. Paragraph styles and character
styles are found on separate panels. Paragraph and
characters styles are sometimes called text styles.

A named grid format can be applied to a frame grid in the
Frame Grid format settings. (See Named Grids panel
overview.) You can also use create an object style with grid
characteristics.

When you change the formatting of a style, all text to which
the style has been applied will be updated with the new
format.

You can create, edit, and delete styles in stand-alone
Adobe InCopy documents or in InCopy content that is
linked to an Adobe InDesign CS4 document. When the
contents are updated in InDesign, new styles are added to
the InDesign document, but any style modifications made
in InCopy will be overridden by the InDesign style. For
linked content, it is usually best to manage your styles in
InDesign.

[Basic Paragraph] styles

By default, each new document contains a [Basic Para-
graph] style that is applied to text you type. You can edit
this style, but you can't rename or delete it. You can
rename and delete styles that you create. You can also
select a different default style to apply to text.

Character style attributes

Unlike paragraph styles, character styles do not include all
the formatting attributes of selected text. Instead, when
you create a character style, InDesign makes only those
attributes that are different from the formatting of the
selected text part of the style. That way, you can create a
character style that, when applied to text, changes only
some attributes, such as the font family and size, ignoring
all other character attributes. If you want other attributes to
be part of the style, add them when editing the style.

Next Style

You can automatically apply styles as you type text. If, for
example, your document's design calls for the style "body
text" to follow a heading style named "heading 1," you can
set the Next Style option for "heading 1" to "body text."
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After you've typed a paragraph styled with "heading 1,"
pressing Enter or Return starts a new paragraph styled with
"body text."

If you use the context menu when applying a style to two
or more paragraphs, you can cause the parent style to be
applied to the first paragraph and the Next Style to be
applied to the additional paragraphs.

Styles panel overview

Use the Character Styles panel to create, name, and apply
character styles to text within a paragraph; use the
Paragraph Styles panel to create, name, and apply para-
graph styles to entire paragraphs. Styles are saved with a
document and display in the panel each time you open that
document.

When you select text or position the insertion point, any
style that has been applied to that text is highlighted in
either of the Styles panels, unless the style is in a
collapsed style group. If you select a range of text that
contains multiple styles, no style is highlighted in the
Styles panel. If you select a range of text to which multiple
styles are applied, the Styles panel displays "(Mixed)."

Add paragraph and character styles

If the styles you want already exist in another InDesign,
InCopy, or word-processing document, you can import
those styles for use in your current document. If you are
working with a stand-alone story, you can also define
character and paragraph styles in InCopy.

Base one paragraph or character style on another

Many document designs feature hierarchies of styles
sharing certain attributes. The headings and subheads, for
example, often use the same font. You can easily create
links between similar styles by creating a base, or parent,
style. When you edit the parent style, the child styles will
change as well. You can then edit the child styles to
distinguish them from the parent style.

Import styles from other documents

You can import paragraph and character styles from
another InDesign document (any version) into the active
document. During import, you can determine which styles
are loaded and what should occur if a loaded style has the
same name as a style in the current document. You can
also import styles from an InCopy document.
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You can import paragraph styles and character styles from
an InDesign or InCopy document into a stand-alone InCopy
document or InCopy content that is linked to InDesign. You
can determine which styles are loaded, and what should
occur if a loaded style has the same name as a style in the
current document.

If you import styles into linked content, new styles
are added to the InDesign document when the
content is updated, and any style with a name
conflict is overridden by the InDesign style with
the same name.

1. In the Character Styles or Paragraph Styles panel, do
one of the following:

• Choose Load Character Styles or Load Paragraph
Styles in the Styles panel menu.

• Choose Load All Text Styles in the Styles panel
menu to load both character and paragraph styles.

2. Double-click the InDesign document containing the
styles you want to import.

3. In the Load Styles dialog box, make sure that a check
mark appears next to the styles you want to import. If
any existing style has the same name as one of the
imported styles, choose one of the following options
under Conflict With Existing Style, and then click OK:

Use Incoming Style Definition

Overwrites the existing style with the loaded style and
applies its new attributes to all text in the current document
that used the old style. The definitions of the incoming and
existing styles are displayed at the bottom of the Load
Styles dialog box so that you can view a comparison.

Auto-Rename

Renames the loaded style. For example, if both docu-
ments have a Subheading style, the loaded style is
renamed "Subheading copy" in the current document.

You can also use the Books feature to share styles.

Convert Word styles to InDesign styles

While importing a Microsoft Word document into InDesign
or InCopy, you can map each style used in Word to a
corresponding style in InDesign or InCopy. By doing so,
you specify which styles format the imported text. A disk
icon   appears next to each imported Word style until you
edit the style in InDesign or InCopy.

1. Do one of the following:

• To add the Word document to existing text in
InDesign or InCopy, choose File > Place. Select
Show Import Options, and then double-click the
Word document.

• To open the Word document in a stand-alone
InCopy document, start InCopy, choose File >
Open, and then double-click the Word file.

2. Select Preserve Styles And Formatting From Text And
Tables.

3. Select Customized Style Import, and then click Style
Mapping.

4. In the Style Mapping dialog box, select the Word style,
and then select an option from the menu under InDesign
style. You can choose the following options:

• If there is no style name conflict, choose New
Paragraph Style, New Character Style, or choose
an existing InDesign style.

• If there is a style name conflict, choose Redefine
InDesign Style to format the imported style text with
the Word style. Choose an existing InDesign style
to format the imported style text with the InDesign
style. Choose Auto Rename to rename the Word
style.

5. Click OK to close the Style Mapping dialog box, and
then click OK to import the document.

Apply sequential styles to multiple paragraphs

The Next Style option specifies which style will be auto-
matically applied when you press Enter or Return after
applying a particular style. It also lets you apply different
styles to multiple paragraphs in a single action.

For example, suppose you have three styles for formatting
a newspaper column: Title, Byline, and Body. Title uses
Byline for Next Style, Byline uses Body for Next Style, and
Body uses [Same Style] for Next Style. If you select an
entire article, including the title, the author's byline, and the
paragraphs in the article, and then apply the Title style
using the special "Next Style" command in the context
menu, the article's first paragraph will be formatted with the
Title style, the second paragraph will be formatted with the
Byline style, and all other paragraphs will be formatted with
the Body style.

Override character and paragraph styles

When you apply a paragraph style, character styles and
other previous formatting remain intact. After you apply a
style, you can override any of its settings by applying
formatting that's not part of the style. When formatting that
is not part of a style is applied to text with that style applied,
it is called an override or local formatting. When you select
text with an override, a plus sign (+) appears next to the
style name. In character styles, an override is displayed
only if the applied attribute is part of the style. For example,
if a character style only changes text color, applying a
different font size to the text does not appear as an override.

You can clear character styles and formatting overrides
when you apply a style. You can also clear overrides from
a paragraph to which a style has been applied.

If a style has a plus sign (+) next to it, hold the mouse
pointer over the style to view a description of the override
attributes.

Preserve or remove overrides when applying paragraph
styles
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• To apply a paragraph style and preserve character
styles, but remove overrides, hold down Alt (Windows)
or Option (Mac OS) as you click the name of the style
in the Paragraph Styles panel.

• To apply a paragraph style and remove both character
styles and overrides, hold down Alt+Shift (Windows) or
Option+Shift (Mac OS) as you click the name of the
style in the Paragraph Styles panel.

Right-click the style in the Paragraph Styles panel, and
then choose an option from the context menu. You can
then clear overrides, character styles, or both while apply-
ing the style.

Convert style bullets and numbering to text

When you create a style that adds bullets or numbering to
paragraphs, these bullets and numbers may be lost if the
text is copied or exported to a different application. To avoid
this problem, convert the style bullets or numbering to text.

Apply a character style to a drop cap

You can apply a character style to the drop-cap character
or characters in a paragraph. For example, if you want a
drop-cap character to have a different color and font than
the rest of the paragraph, you can define a character style
that has these attributes. Then you can either apply the
character style directly to a paragraph, or you can nest the
character style in a paragraph style.

italics. If both set conflicting settings of the same attribute,
such as red and blue, the nested style takes precedence
over the nested line style.

Loop through nested styles

You can repeat a series of two or more nested styles
throughout a paragraph. A simple example would be to
alternate red and green words in a paragraph. Or, in nested
line styles you could alternate red and green lines in a
paragraph. The repeating pattern remains intact even if you
add or remove words in the paragraph.

Nested style character style options

To determine how a nested character style ends, select
any of the following:

If you don't want the character to be included in the nested
style formatted, choose Up To instead of Through when you
define the nested style.

Sentences

Periods, question marks, and exclamation points indicate
the end of a sentence. If a quotation mark follows the
punctuation, it is included as part of the sentence.

Words

Any space or white space character indicates the end of a
word.

Characters

Any character other than zero-width markers (for anchors,
index markers, XML tags and so on) is included.

If you select Characters, you can also type a
character, such as a colon or a period, to end
the nested style. If you type multiple charac-
ters, any of those characters will end the style.
For example, if your run-in headings end with
a hyphen, colon, or question mark, you can
type -:? to end the nested style where any of
these characters appears.

Letters
Any character that does not include punctuation, white
space, digits, and symbols.

Digits
The Arabic numerals 0-9 are included.

End Nested Style Character
Extends the nested style up to or through the appearance
of the End Nested Style character you insert. To insert this
character, choose Type > Insert Special Character > Other
> End Nested Style Here.

Tab Characters
Extends the nested style up to or through the tab character
(not the tab setting).

Forced Line Break
Extends the nested style up to or through the forced line
break. (Choose Type > Insert Break Character > Forced
Line Break.)

Create nested styles

You can specify character-level formatting for one or more
ranges of text within a paragraph or line. You can also set
up two or more nested styles to work together, one taking
over where the previous one ends. For paragraphs with
repetitive and predictable formatting, you can even loop
back to the first style in the sequence.

Nested styles are especially useful for run-in headings. For
example, you can apply one character style to the first
letter in a paragraph and another character style that takes
effect through the first colon (:). For each nested style, you
can define a character that ends the style, such as a tab
character or the end of a word.

Create nested line styles

You can apply a character style to a specified number of
lines in a paragraph. As with nested styles, you can set up
two or more nested line styles to work together, and you
can create a repeating sequence.

Attributes applied by nested line styles can co-exist with
attributes applied by nested styles. For example, a nested
line style can apply a color while a nested style can apply
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Indent To Here Character

Extends the nested style up to or through the Indent To
Here character. (Choose Type > Insert Special Character
> Other > Indent To Here.)

Em Spaces, En Spaces, or Non-breaking Spaces

Extends the nested style up to or through the space
character. (Choose Type > Insert White Space > [space
character].)

Anchored Object Marker

Extends the nested style up to or through an inline graphic
marker, which appears where an inline graphic is inserted.

Auto Page Number / Section Marker

Extends the nested style up to or through the page number
or section name marker.

Create GREP styles

GREP is an advanced, pattern-based search technique.
You can use GREP styles to apply a character style to text
that conforms to the GREP expression you specify. For
example, suppose you want to apply a character style to
all the phone numbers in text. When you create a GREP
style, you select the character style and specify the GREP
expression. All paragraph text that matches the GREP
expression is formatted with the character style.

About object styles

Just as you use paragraph and character styles to quickly
format text, you can use object styles to quickly format
graphics and frames. Object styles include settings for
stroke, color, transparency, drop shadows, paragraph
styles, text wrap, and more. You can assign different
transparency effects for the object, fill, stroke, and text.

You can apply object styles to objects, groups, and frames
(including text frames). A style can either clear and replace
all object settings or it can replace only specific settings,
leaving other settings unchanged. You control which set-
tings the style affects by including or excluding a category
of settings in the definition.

You can also apply object styles to frame grids. By default,
any frame grid you create uses the [Basic Grid] object
style. You can edit the [Basic Grid] style or you can apply
other object styles to the grid. When you create or edit an
object style for a frame grid, use the Story Options section
to specify writing direction, frame type, and named grid.

When creating styles, you might find that several styles
share some of the same characteristics. Rather than
setting those characteristics each time you define the next
style, you can base one object style on another. When you
change the base style, any shared attributes that appear
in the "parent" style change in the "child" style as well.

Object Styles panel overview

Use the Object Styles panel to create, edit, and apply
object styles. For each new document, the panel initially
lists a default set of object styles. Object styles are saved
with a document and display in the panel each time you

open that document. The Text Frame icon  marks the
default style for text frames; the Graphics Frame icon 
marks the default style for graphics frames and drawn
shapes.

Use the Object Styles panel to create, name, and apply
object styles. For each new document, the panel initially
lists a default set of object styles. Object styles are saved
with a document and display in the panel each time you
open that document. The Text Frame icon  marks the
default style for text frames; the Graphics Frame icon 
marks the default style for graphic frames; the Grid icon

 marks the default style for frame grids.

Object style categories

If you want the style to apply only certain attributes, leaving
any other settings untouched, make sure that the catego-
ries you want the style to control are in the appropriate
state. You can use any of three states for each category:
turned on, turned off, or ignored. For example, checking the
Drop Shadow box will include drop shadow formatting in the
object style. Deselecting the Drop Shadow box will indi-
cate that drop shadow is turned off as part of the style - any
drop shadow applied to an object appears as an override.
Setting the Drop Shadow box to "ignore" (a small box in
Windows or a hyphen in Mac OS) will leave drop shadow
out of the style, so any drop shadow applied to the style
does not appear as an override.

Object style categories

A. Turned on B. Ignored C. Turned off

Categories in which the settings can be turned on
or off individually, such as Fill, Stroke, and Trans-
parency, have only two states. They can either be
turned on or ignored.

The Paragraph Styles category is ignored by default, even
if you're creating a text frame. This category is applicable
only if the object is an unthreaded text frame.

Apply object styles

If you apply an object style to a group of objects, the object
style is applied to each object in the group. To apply an
object style to a group of objects, nest the objects within
a frame. (The Edit > Paste Into command is one way to
paste an object into a frame.)

Clear object style overrides

When formatting is applied to an object that differs from part
of the style definition applied to that object, it is called an
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override. When you select an object with an override, a plus
sign (+) appears next to the style name.

Use the Clear Overrides command to override any format-
ting that is either turned on or off in the object style; use the
Clear Attributes Not Defined By Style to clear ignored
attributes.

About tables of contents

A table of contents (TOC) can list the contents of a book,
magazine, or other publication; display a list of illustra-
tions, advertisers, or photo credits; or include other infor-
mation to help readers find information in a document or
book file. One document may contain multiple tables of
contents-for example, a list of chapters and a list of
illustrations.

Each table of contents is a separate story consisting of a
heading and a list of entries sorted either by page number
or alphabetically. Entries, including page numbers, are
pulled directly from content in your document and can be
updated at any time-even across multiple documents in a
book file.

The process for creating a table of contents requires three
main steps. First, create and apply the paragraph styles
you'll use as the basis for the TOC. Second, specify which
styles are used in the TOC and how the TOC is formatted.
Third, flow the TOC into your document.

Table of contents entries can be automatically added to the
Bookmarks panel for use in documents exported as Adobe
PDF.

Tips for planning a table of contents

Consider the following when planning a table of contents:

Some tables of contents are built from content that does
not actually appear in the published document, such as a
list of advertisers in a magazine. To do this in InDesign,
enter content on a hidden layer and include it when
generating a TOC.

You can load TOC styles from other documents or books
to build new tables of contents with the same settings and
formatting. (You might need to edit an imported TOC style
if the names of paragraph styles in the document do not
match those in the source document.)

You can create paragraph styles for the table of contents'
title and entries, including tab stops and leaders, if desired.
You can then apply these paragraph styles when you
generate the table of contents.

You can create character styles to format the page
numbers and the characters separating them from the
entries. For example, if you want the page numbers to be
in bold, create a character style that includes the bold
attribute, and then select that character style when you
create the table of contents.

Creating tables of contents in books

For best results, be sure to do the following before creating
a table of contents for a book:

Before you create a table of contents, verify that the book
list is complete, that all documents are listed in the correct
order, and that all headings have been formatted with the
appropriate paragraph styles.

Be sure to use paragraph styles consistently throughout
the book. Avoid creating documents with styles that have
identical names but different definitions. If multiple styles
have the same name but different style definitions, InDesign
uses the style definition in the current document (if a
definition exists there), or the first occurrence of the style
in the book.

If the necessary styles do not appear in the pop up menus
in the Table of Contents dialog box, you may need to
synchronize the book so that the styles are copied to the
document containing the table of contents.

If you want number prefixes (such as 1-1, 1-3, and so on)
to appear in your table of contents, use section numbering
rather than chapter numbering. Section number prefixes
can be included in a table of contents.

Generate a table of contents

Before you generate a table of contents, decide which
paragraphs should be included (such as chapter titles and
section headings), and then define paragraph styles for
each. Make sure that these styles are applied to all
appropriate paragraphs in the document or booked docu-
ments.

When you generate the table of contents, you can also use
paragraph and character styles to format the table of
contents.

If paragraphs that are to be included in the table of contents
appear in different stories on the same page, their order in
the TOC is determined by their position on the page.

Create TOC styles for multiple lists

Use TOC styles if you need to create different tables of
contents in your document or book. For example, you can
use one TOC style for a list of contents and another for a
list of advertisers, illustrations, or photo credits. Create a
TOC style for each type of list.

Creating TOC styles are also useful if you want to use the
same TOC formatting in another document.

Table of contents without paragraph styles (left) and with
paragraph styles applied to entries (right)
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Don't confuse TOC styles with paragraph styles
that have a "TOC" prefix. TOC-prefixed para-
graph styles (for example "TOC title") are used to
format the table of contents entries themselves. In
contrast, a TOC style is a collection of settings
used to automatically create a table of contents.

Options for formatting a table of contents

When generating or editing a table of contents, use these
options to determine the appearance of the generated table
of contents text. Some of these options are available only
when you click More Options in the dialog box.

The settings in the Style section apply only to the
style currently selected under Include Paragraph
Styles. You can specify different formatting op-
tions for each style.

Entry Style

For each style in Include Paragraph Styles, choose a
paragraph style to apply to the associated table of contents
entries.

Page Number

You might want to create a character style that formats the
page number. You can then select this style in the Style
pop up list to the right of Page Number.

Between Entry And Number Specify which characters you
want between the table of contents entry and its page
number. The default is ̂ t, which tells InDesign to insert a
tab. You can choose other special characters, such as
Right Indent Tab or Em Space, in the pop up list.

Select the existing text in the box before you choose a
different special character, to make sure that you don't
include both characters.

You might want to create a character style that formats the
space between the entry and the page number. You can
then select this style in the Style pop up list to the right of
Between Entry And Number.

If the entry's paragraph style includes a tab leader setting,
and if the tab character (^t) is selected, a tab leader appears
in the generated table of contents.

Editing a table of contents

If your table of contents requires editing, edit the actual
paragraphs in the document-not the table of contents
story-and then generate a new table of contents. If you edit
the table of contents story, you'll lose your revisions when
you generate a new table of contents. For the same reason,
you should edit the styles used to format the table of
contents entries, rather than formatting the table of con-
tents directly.

You can specify a character that separates an entry and
page number, as well as a style to apply to a character.

Sort Entries in Alphabetical Order

Select this option to sort table of contents entries in the
selected style alphabetically. This option is useful for
creating simple lists, such as lists of advertisers. Nested
entries (Level 2 or 3) sort alphabetically within their group
(Level 1 or 2, respectively).

The sort order for a table of contents is deter-
mined by the document's default language set-
ting. To change the default language setting,
make sure nothing is selected and then choose a
language from the Language menu in the Char-
acter panel.
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Level

By default, each item added to the Include Paragraph
Styles box is set one level lower than the item immediately
above it. You can change this hierarchy by specifying a
new level number for the selected paragraph style. This
option adjusts only the display in the dialog box. It has no
effect on the final table of contents unless the list is
alphabetized, in which case the entries are sorted by level.

Create PDF Bookmarks

Select this option if you want the table of contents entries
to appear in the Bookmarks panel of Adobe Acrobat or
Adobe Reader® when the document is exported to PDF.

Run-in

Select this option if you want all TOC entries to be run into
a single paragraph. A semicolon followed by a space (;)
separates the entries.

Include Text On Hidden Layers

Select this option only if you want the paragraphs on hidden
layers to be included in your table of contents. This is useful
when creating a list of advertisers or illustrations that may
not appear as visible text in the document itself. Deselect
this option when you've used layers to store various
versions or translations of the same text.

Numbered Paragraphs

If your table of contents includes a paragraph style that
uses numbering, specify whether the TOC entry includes
the full paragraph (both number and text), only the num-
bers, or only the paragraph.

Frame Orientation

Specify the writing direction for the text frame you will use
to create a table of contents.

About indexing

You can create a simple keyword index or a comprehen-
sive, detailed guide to the information in your book. You can
create only one index for a document or book. To create an
index, you first place index markers in the text. You
associate each index marker with the word, called a topic,
that you want to appear in the index.

When you generate the index, each topic is listed, along
with the page on which it was found. The topics are sorted
alphabetically, typically under section headings (A, B, C,
and so on). An index entry consists of a topic (the term
readers look up) paired with either a page reference (page
number or range) or a cross-reference. A cross-reference,
preceded by "See" or "See also," points the reader to other
entries in the index, rather than to a page number.

A. Title B. Section heading C. Index entry D. Subentry E.
Topic F. Page reference G. Cross-reference

Tips for creating an index
Creating a well-planned and complete index can help make
the information in your document immediately accessible
to your readers. Here are a few guidelines to consider:

Think about how you want your index to look. How many
topic levels will it have? Will it refer the reader to other
related topics? Will a simple keyword index suffice, or do
you want a more complex index with cross-references to
related topics and a well researched list of equivalent
terms?

Anticipate the variety of ways by which your readers might
look up information. For instance, one reader may search
for information on animals by looking under beasts; another
may look for wildlife or fauna.

Add index entries when the content of your document is
fairly stable. If you delete large portions of your text later,
you may lose some of your indexing work.

A well-planned index presents topics consistently. Com-
mon indexing problems include mixing uppercase and
lowercase (cats and Cats) and singular and plural forms
(cat and cats). Use a topic list to keep terms consistent.

Review your index several times before you generate the
final index. Look for duplicate entries, weak subject areas,
misspellings, and inconsistencies in capitalization and
wording; for example, InDesign treats Cheetah, cheetah,
and cheetahs as separate entries.

Workflow for creating an index
To create an index, follow these basic steps:
1. Create a topic list (optional)

A topic list helps you maintain consistency in your
index entries

2. Add index markers.
Add index markers on the pages in your document that
you want the index entries to refer to.

3. Generate the index.
Generating the index creates a set of entries for
markers and their accompanying page numbers.

4. Flow the index story.
Use the loaded text cursor to flow the index into a text
frame. In most cases, you'll want the index to start on
a new page. After you flow the index, you can format the
pages and index.

Parts of an index
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You'll likely repeat these steps several times as you refine
your index prior to publication.

Index panel overview

You create, edit, and preview the index using the Index
panel (Window > Type & Tables > Index). The panel
includes two modes: Reference and Topic. In Reference
mode, the preview area displays complete index entries for
the current document or book. In Topic mode, the preview
area displays only topics, not page numbers or cross-
references. Topic mode is used primarily for creating the
index structure, whereas Reference mode is where you
add your index entries.

In Reference mode, index entries are alphabetized and
divided into sections by letter. Triangles next to entries let
you expand or collapse the entry to view subentries, page
numbers, and cross-references.

The following codes appear in place of page references to
indicate index entries that may not be included in the
generated index. You may need to choose Update Preview
in the Index panel to view the codes.

PB

Indicates index entries on the pasteboard. These entries
will not appear in the generated index.

HL

Indicates index entries on a hidden layer. When you
generate the index, you have the option of including index
entries on a hidden layer.

HT

Indicates index entries in a hidden condition. Index entries
in hidden conditions are not included in the index.

PN

Indicates index entries in overset text. When you include
these entries in the generated index, they appear without
page numbers.

Master

Indicates index entries on a master page. These entries will
not appear in the generated index.

Click a triangle to expand or collapse an individual entry.
Alt-click (Windows) or Option-click (Mac OS) a triangle to
expand or collapse all subentries under an entry. Ctrl-click
(Windows) or Command-click (Mac OS) a triangle to
expand or collapse all entries.

Choose Update Preview in the Index panel menu to update
the preview area. This option is especially useful if you've
edited your document extensively or moved index markers
in the document window.

Create a list of topics for an index

You can create or import a list of topics to use as a starting
point when creating index entries. Later, when you add
entries to the index, you can select topics from the topic
list (instead of typing them each time) to ensure that
information is indexed consistently throughout your docu-
ment or book.

You create and edit a topic list using the Index panel in
Topic mode. Note that Topic mode displays topics only; to
preview index entries, with their associated page numbers
and cross-references, use Reference mode instead.

Topics in the topic list appear in the New Page Reference
dialog box as well. To create an index entry, simply select
a topic and then associate it with a page or cross-
reference. Unused topics (those without page or cross-
references) are excluded when you generate an index.

Creating a topic list before you add index entries is
optional. Each time you create an index entry, its topic is
automatically added to the topic list for future use.

By default, topics you add to the Topics list do not appear
in the Reference list, which displays only the topics that
have been associated with a page. However, to display the
topics in the Reference list, you can choose Show Unused
Topics from the Index panel menu in Reference mode.

Page range options in indexes

You can create index entries that include a page range
(such as cats 82-87) instead of a single page number. The
Type pop up menu in the New Page Reference dialog box
includes the following page-range options:

Current Page

The page range does not extend beyond the current page.

To Next Style Change

The page range extends from the index marker to the next
change of paragraph style.

To Next Use Of Style

The page range extends from the index marker to the page
where the next occurrence of the paragraph style specified
in the adjacent paragraph style pop up menu appears.

To End Of Story

The page range extends from the index marker to the end
of the current thread of text frames that contain text.

To End Of Document

The page range extends from the index marker to the end
of the document.

Index panel in Reference mode (left) and Topic
mode (right)
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To End Of Section

The page range extends from the index marker to the end
of the current section as defined in the Pages panel.

For Next # Of Paragraphs

The page range extends from the index marker to the end
of the number of paragraphs specified in the adjacent box,
or to the end of as many paragraphs as exist.

For Next # Of Pages

The page range extends from the index marker to the end
of the number of pages specified in the adjacent box, or to
the end of as many pages as exist.

Generate an index

Once you've added index entries and previewed them in the
Index panel, you're ready to generate an index story to
place in your document for publication.

An index story can appear as a separate document or in an
existing document. When you generate an index story,
InDesign compiles index entries and updates page num-
bers across your document or book. If you add or delete
index entries or update numbering in your document,
however, you'll need to regenerate the index to update it.

Index formatting options

When you click More Options in the Generate Index dialog
box, formatting options appear that let you determine the
style and appearance of the generated index. InDesign
includes a number of built in paragraph and character
styles that you can select to format the generated index,
or you can create and select your own styles. After you
generate the index, you can edit these styles in the
Paragraph Styles and Character Styles panels.

Include Index Section Headings

Select this option to generate section headings consisting
of alphabet characters (A, B, C, and so on) representing the
section that follows.

Include Empty Index Sections

Select this option to generate section headings for all
letters of the alphabet, even if the index lacks any first-level
entries that begin with a particular letter.

Level Style

For each index level, choose a paragraph style to be
applied to each level of index entries. You can edit these
styles in the Paragraph Styles panel after you generate the
index.

Section Heading

Select the paragraph style that determines the appearance
of the section headings (A, B, C, and so on) in the
generated index.

Page Number

Select the character style that determines the appearance
of the page numbers in the generated index. This setting
does not affect index entries you formatted using the
Number Style Override option.

Cross-reference

Select the character style that determines the appearance
of cross reference prefixes (such as See and See also) in
the generated index.

Cross-referenced Topic

Select the character style that determines the appearance
of the topic being referred to (such as beasts in See also
beasts) in the generated index.

Following Topic

Type or select a special character to separate the entry
from the page number (such as Animals  38). The default
is two spaces. Determine formatting for this character by
editing the corresponding Level Style, or by selecting
another.

Between Page Numbers

Type or select a special character to separate one page
number or range from another. The default is a comma
followed by an en space.

Between Entries

If Run-in is selected, type or select a special character to
determine how entries and subentries are separated. If
Nested is selected, this setting determines how two cross-
references under a single entry are to be separated.

Before Cross-reference

Type or select a special character that appears between a
reference and a cross-reference, as in Animals. See also
beasts. The default is a period followed by a space.
Determine formatting for this character by switching or
editing the corresponding level style.

A. Title B. Section heading C. Level 1 entry D. Level 2
subentry E. Topic F. Cross reference

To replace the entry separators (such as the values for
Following Topic or Between Entries), select the existing
separator and then type or choose a replacement charac-
ter.

Nested or Run-in

Select Nested if you want the index formatted in the default
style, with subentries nested under an entry as separate
indented paragraphs. Select Run-in if you want all levels of
an entry to appear in a single paragraph. The Between
Entries option determines which character separates the
entries.

Index with nested entries
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Page Range

Type or select a special character to separate the first and
last numbers in a page range (such as Animals 38-43). The
default is an en dash. Determine formatting for this charac-
ter by switching or editing the Page Number style.

Entry End

Type or select a special character to appear at the end of
entries. If Run-in is selected, the specified character
appears at the end of the last cross-reference. The default
is no character.

Create a book file

A book file is a collection of documents that can share
styles, swatches, master pages, and other items. You can
sequentially number pages in booked documents, print
selected documents in a book, or export them to PDF. One
document can belong to multiple book files.

One of the documents added to a book file is the style
source. By default, the style source is the first document
in the book, but you can select a new style source at any
time. When you synchronize documents in a book, the
specified styles and swatches from the style source
replace those in other booked documents.

Manage book files

Each open book file appears on its own tab in the Book
panel. If multiple books are open at the same time, click a
tab to bring that book to the front and access its panel
menu.

Icons in the Book panel indicate a document's current
status, such as open , missing  (the document was
moved, renamed, or deleted), modified   (the document
was edited or its page or section numbers changed while
the book was closed), or in use  (if someone else has the
document open in a managed workflow). No icon appears
next to closed documents.

To view the pathname of any document in a book, hold the
mouse pointer over the document name until a tooltip
appears. Or, choose Document Information from the Book
panel menu.

Save a book file

Book files are separate from document files. For example,
when you choose the Save Book command, InDesign
saves the changes to the book, not the documents in the
book.

To save a book under a new name, choose Save Book As
in the Book panel menu, specify a location and filename,
and click Save.

To save an existing book under the same name, choose
Save Book in the Book panel menu, or click the Save button

 at the bottom of the Book panel.

If you are sharing book files over a server,
make sure that you have a file management
system in place so that you don't save over
each other's changes accidentally.

Add basic page numbering

You can add a current page number marker to your pages
to specify where a page number sits on a page and how it
will look. Because a page number marker updates auto-
matically, the page number it displays is always correct-
even as you add, remove, or rearrange pages in the
document. Page number markers can be formatted and
styled as text.

Change the page numbering style

By default, pages are numbered using Arabic numerals (1,
2, 3...); however, you can number pages using upper or
lowercase Roman (i, ii, iii...) or alphanumeric (a, b, c...)
numbering. You can also number pages using preceding
zeros. Each part of the document that uses a different
numbering style is called a section.

In Japanese, Chinese, or Korean versions, by default,
Arabic numerals are used for page numbers. However, if
you use the Numbering & Section Options command, you
can specify the style of numbering, such as Roman
numerals, Arabic numerals, Kanji, and so on. The Style
option allows you to select the number of digits in the page
number, for example, 001 or 0001. Each part of the
document that uses a different numbering style is called a
section.

Use the Numbering & Section Options dialog box to
change the page numbering style to use a different format.
You can also use this dialog box to restart page numbering
or to start page numbering at a number you specify

Number pages, chapters, and paragraphs in a book

You can determine how pages, chapters, and paragraphs
are numbered in a book. In a book file, the numbering styles
and starting numbers for pages and chapters are deter-
mined by each document's settings in the Numbering &
Section Options dialog box or the Document Numbering
Options dialog box. You can open one of these dialog
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boxes by choosing Layout > Numbering & Section Options
in the document or by choosing Document Numbering
Options in the Book panel menu.

For numbered paragraphs (such as lists of figures), num-
bering is determined by the numbered list style definition
contained by the paragraph style.

The page range appears beside each document name in
the Book panel. By default, InDesign updates page and
section numbering in the Book panel when you add or
remove pages in booked documents, or when you make
changes to the book file, such as reordering, adding, or
removing documents. If you turn off the setting to automati-
cally update page and section numbers, you can update
numbering in a book manually.

If the book is updated and the numbering seems incorrect,
the problem may be that absolute numbers are displayed
instead of section numbers in General preferences.

If a document is missing or cannot be opened, the page
range is shown as "?" from the place where the missing
document should be to the end of the book, indicating that
the true page range is unknown. Remove or replace the
missing document before you update numbering. If the In
Use icon  appears, someone using a different computer
has opened the document in a managed workflow; the
person must close the document before you can update
numbering.
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About printing

Whether you are providing a multicolored document to an
outside service provider, or just sending a quick draft of a
document to an inkjet or laser printer, knowing a few basics
about printing will make the print job go more smoothly, and
help to ensure that the finished document appears as
intended.

Types of printing

When you print a file, Adobe InDesign sends it to a printing
device-either to be printed directly on paper or to a digital
printing press, or to be converted to a positive or negative
image on film. In the latter case, the film can then be used
to create a master plate for printing by a commercial press.

Types of images

The simplest types of images, such as text, use only one
color in one level of gray. A more complex image is one with
color tones that vary within the image. This type of image
is known as a continuous-tone image. A photograph is an
example of a continuous-tone image.

Halftoning

To create the illusion of continuous tone, images are
broken down into a series of dots. This process is called
halftoning. Varying the sizes and densities of the dots in a
halftone screen creates the optical illusion of variations of
gray or continuous color in the printed image.

Color separation

Artwork that will be commercially reproduced and that
contains more than a single color must be printed on
separate master plates, one for each color. This process
is called color separation.

Getting detail

The detail in a printed image results from a combination of
resolution and screen frequency. The higher an output
device's resolution, the finer (higher) the screen frequency
you can use.

Duplex printing

Printer-specific features such as duplex printing are avail-
able when you click the Printer button in the Print dialog
box. Duplex printing is available only if the printer supports
it. For information on duplex printing, see your printer
documentation.
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Objectives : At the end of this lesson you shall be able to
• understanding about print document
• learning about set ink, separations and screen frequency
• learning about postscript and EPS file.

Transparent objects

If the artwork contains objects with transparency features
that you added using the Effects panel or the Drop Shadow
or Feather commands, the transparent artwork will be
flattened according to settings in the flattener preset you
choose. You can affect the ratio of rasterized images to
vector images in the printed artwork.

Page printing options

You can print all pages, even or odd pages only, a series
of individual pages, or a contiguous range.

Range

Specifies the range of pages to print in the current docu-
ment. Indicate numbers in a range by using a hyphen, and
indicate multiple pages or ranges by using commas or
spaces.

If the document includes pages with different page sizes,
you can use the options above the Range field to select all
pages of the same size.

Sequence

Choose All Pages to print all pages of a document. Choose
Even Pages Only or Odd Pages Only to print only those
pages within the specified range. These options are un-
available when you are using the Spreads or Print Master
Pages options.

Spreads

Prints pages together, as if they were bound, or printed on
the same sheet. You can print only one spread per sheet.
If the new page is larger than the currently selected paper
size, InDesign prints as much as it can, but won't automati-
cally scale the page to fit the imageable area, unless you
select Scale To Fit in the Setup area of the Print dialog box.
You may also want to specify landscape orientation.

If different trapping styles are applied to pages
in the spread, InDesign resolves the differ-
ences.

Print Master Pages

Prints all master pages, rather than document pages.
Selecting this option makes the Ranges option unavail-
able.
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Examples of page ranges
Page range Pages printed

11- Page 11 to the last page of the document.

-11 All pages up to and including page 11.

+11 Page 11 only.

-+11 All pages up to and including page 11.

+11- All pages from the eleventh page to the end of document.

1, 3-8 Page 1, plus pages 3 to 8.

+1, +3-+8 Page 1, plus pages 3 to 8.

Sec1 All pages in section labeled "Sec1".

Sec2:7 Page numbered 7 (not necessarily the seventh page of that section)
in section labeled "Sec2."

PartB:7- Page numbered 7 in section labeled "PartB" to last page of section.

Chap2:7-Chap3 Page 7 in section labeled "Chap2" to end of section labeled "Chap3".

Sec4:3-Sec4:6, Sec3:7 Pages 3-6 in "Sec4" and page 7 in "Sec3".

Options for printing objects

The General area of the Print dialog box contains options
for printing elements usually visible only on-screen, such
as grids and guides. Choose from the following options:

Print Layers

Determine which layers are printed.

Print Non-printing Objects

Prints all objects, regardless of your settings to selectively
prevent individual objects from printing.

Print Blank Pages

Prints all pages in the specified page range, even if no text
or objects appear on a page. This option is unavailable
when you are printing separations. If you are using Print
Booklet for composite printing, use the Print Blank Printer
Spreads option to print blank spreads added to fill out
composite signatures.

Print Visible Guides and Baseline Grids

Prints visible guides and grids in the same color as shown
in the document. You can control which guides and grids
are visible in the View menu. This option is unavailable
when you are printing separations.

Specify paper size and page orientation

It's important to distinguish between page size (as defined
in the Document Setup dialog box for your document) and
paper size (the sheet of paper, piece of film, or area of the
printing plate you'll print on). Your page size might be US
Letter (8.5-by-11 inches), but you might need to print on a
larger piece of paper or film to accommodate any printer's
marks or the bleed and slug areas.

The list of paper sizes available to InDesign comes from the
PPD (PostScript printers) or from the printer driver (non-
PostScript printers). If the printer and PPD you've chosen

for PostScript printing support custom paper sizes, you'll
see a Custom option in the Paper Size menu.

Most imagesetters can accommodate regular paper sizes,
such as letter and tabloid, as well as transverse orienta-
tion, where the regular page size is rotated 90° when
printed. The transverse orientation is often a more efficient
use of imagesetter media.

Page size and orientations for imagesetters

A. Letter (tall orientation) B. Custom page size (tall
orientation) C. Letter (transverse orientation)

Paper sizes are listed by familiar names (such as Letter).
The dimensions define the limits of the imageable area-the
total paper size, less any unprintable border used by the
printer or imagesetter. Most laser printers cannot print to
the exact edge of a page.

If you select a different paper size (for example, if you
change from Letter to Legal), the document is rescaled in
the preview window. The preview window displays the
entire imageable area of the selected page; when the
preview size is changed, the preview window automatically
rescales to include the imageable area.
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The imageable area will vary by PPD file, even
for the same paper size (for example, Letter),
because different printers and imagesetters
define the sizes of their imageable areas differ-
ently.

Comparison of printing a letter-size page on Letter,
Letter.extra, or Tabloid paper

The preview in the lower-left area of the Print
dialog box indicates whether you have enough
space to include all printer's marks and the bleed
and slug areas.

Printing to non-PostScript language printers

You can print a document on a non-PostScript language
printer. However, because PostScript is the standard
page-description language for professional publishing, many
high-end color and graphics features, such as screen
frequencies or color separations, cannot be reproduced on
non-PostScript printers. Most imported graphics file for-
mats print acceptably. In general, a document printed to a
non-PostScript printer should look the way it appears on-
screen when you view the document using Preview Mode.

Some vendors sell software programs that add PostScript-
language capability to a non-PostScript language printer.
Check with your software reseller for availability and
compatibility.

Preview documents

You can view how the document's pages fit on the chosen
paper size before you print to a PostScript printer. A
preview in the lower-left area of the Print dialog box shows
whether your paper and orientation settings will work for
your page size. When you select different options in the
Print dialog box, the preview updates dynamically with the
combined effects of your print settings.

1. Choose File > Print.

2. Click the preview image in the lower-left area of the Print
dialog box.

The preview has three views:

Standard view

Displays the relationship of a document page to the media.
It shows the effects of various options such as paper size
to imageable area, bleed and slug areas, and page marks,
as well as the effects of tiling and thumbnails.

A. Default B. Spreads C. Orientation D. 2-by-2 Thumbnails

Text view

Lists the numerical values for certain print settings.

Custom page/Cut sheet views

Displays the effects of different print settings, depending on
your page size. For custom page sizes, the preview shows
how the media fits on the custom output device; the
maximum supported media dimensions of the output
device; and the settings for offset, gap, and transverse. For
cut sheets, such as Letter and Tabloid, the preview shows
the relationship of the imageable area to the media size.

In both the custom page and cut sheet views, the preview
also indicates the output mode using an icon: Separations

, Composite Grayscale , Composite CMYK , or
Composite RGB .

Four different page-fit settings in Standard view

Custom page view (left) and cut sheet view (right)
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A. Direction of media travel B. Transverse deselected C.
Paper size D. Media E. Imageable area F. Media

Select a PPD file

A PPD file (PostScript Printer Description file) customizes
the behavior of the driver for your specific PostScript printer.
It contains information about the output device, including
printer-resident fonts, available media sizes and orienta-
tion, optimized screen frequencies, screen angles, resolu-
tion, and color output capabilities. It's important to set up
the correct PPD before you print. Selecting the PPD that
corresponds to your PostScript printer or imagesetter
populates the Print dialog box with the available settings for
the output device. You can switch to a different one to suit
your needs. Applications use the information in the PPD
file to determine which PostScript information to send to
the printer when printing a document.

For best printing results, Adobe recommends that you
obtain the latest version of the PPD file for your output
device from the manufacturer. Many print service providers
and commercial printers have PPDs for the imagesetters
they use. Be sure to store PPDs in the location specified
by the operating system. For details, consult the docu-
mentation for your operating system.

In Windows and in Mac OS, you select a PPD file in the
same way you add a printer. The steps for selecting a PPD
file are different for each platform. See your operating
system documentation for details.

Ink Manager overview

The Ink Manager provides control over inks at output time.
Changes you make using the Ink Manager affect the
output, not how the colors are defined in the document.

Ink Manager options are especially useful for print service
providers. For example, if a process job includes a spot
color, a service provider can open the document and
change the spot color to the equivalent CMYK process
color. If a document contains two similar spot colors when
only one is required, or if the same spot color has two
different names, a service provider can map the two to a
single alias.

In a trapping workflow, the Ink Manager lets you set the ink
density for controlling when trapping takes place, and it lets
you set the correct number and sequence of inks.

InDesign and Acrobat share the same Ink Man-
ager technology. However, only InDesign has
the Use Standard Lab Values For Spots option.

Ink Manager

A. Process ink B. Aliased Spot ink C. Spot ink

Open the Ink Manager

Do one of the following:

From the Separations Preview panel menu (Window >
Output > Separations Preview), choose Ink Manager.

Choose File > Print, and click Output. In the Output
section, click Ink Manager.

Display or output spot colors using Lab values

Some predefined spot colors, such as colors from the
TOYO, PANTONE, DIC, and HKS libraries, are defined
using Lab values. For backward compatibility with previous
versions of InDesign, colors from these libraries also
include CMYK definitions. Lab values, when used in
conjunction with the correct device profiles, give you the
most accurate output across all devices. If color manage-
ment is critical to your project, you might prefer to display,
export, and print spot colors using their Lab values. The Ink
Manager option Use Standard Lab Values For Spots lets
you control which color mode InDesign uses for these
predefined spot colors: Lab or CMYK. If you need the
output to match earlier versions of InDesign, you should
use the CMYK equivalent values.

To improve on screen accuracy, InDesign uses
the Lab values automatically if Overprint Pre-
view is on. It also uses Lab values when print-
ing or exporting if you've selected Simulate
Overprint in the Output area of either the Print
or Export Adobe PDF dialog box.

1. Choose Ink Manager in the Separations Preview panel
menu.

2. Do one of the following:

• For Lab values, select Use Standard Lab Values For
Spots.

• For CMYK values, deselect Use Standard Lab
Values For Spots.
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About halftone screen frequency
In commercial printing, continuous tone is simulated by
dots (called halftone dots) printed in rows (called lines or
line screens). Lines are printed at different angles to make
the rows less noticeable. The Screening menu in the
Output section of the Print dialog box displays the recom-
mended sets of line screens in lines per inch (lpi), and
resolution in dots per inch (dpi), based on the currently
selected PPD. As you select inks in the ink list, the values
in the Frequency and Angle boxes change, showing you
the halftone screen frequency and angle for that ink.
A high line-screen ruling (for example, 150 lpi) spaces the
dots closely together to create a finely rendered image on
the press; a low line-screen ruling (60 lpi to 85 lpi) spaces
the dots farther apart to create a coarser image. The size
of the dots is also determined by the line screen. A high
line-screen ruling uses small dots; a low line-screen ruling
uses large dots. The most important factor in choosing a
line-screen ruling is the type of printing press your job will
use. Ask your service provider how fine a line screen its
press can hold, and make your choices accordingly.

Before creating your own halftone screens,
check with your service provider for the pre-
ferred frequencies and angles. Also, be aware
that some output devices override the default
frequencies and angles.

About emulsion and image exposure

Depending on the type of printing press used and how
information is transferred from the film to the printing plates,
you may need to give your service provider film negatives
or positives, with emulsion side up or down. Emulsion
refers to the photosensitive layer on a piece of film or paper.
Typically, print service providers require negative film in the
United States and positive film in Europe and Japan. Check
with your service provider to determine which emulsion
direction they prefer.

To tell whether you are looking at the emulsion side or the
nonemulsion side (also referred to as the base), examine
the final film under a good light. One side appears shinier
than the other. The dull side is the emulsion side; the shiny
side is the base.

Line screens

A. 65 lpi: Coarse screen for printing newsletters and
grocery coupons B. 85 lpi: Average screen for printing
newspapers C. 133 lpi: High-quality screen for printing four-
color magazines D. 177 lpi: Very fine screen for printing
annual reports and images in art books

The PPD files for high-resolution imagesetters offer a wide
range of possible screen frequencies, paired with various
imagesetter resolutions. The PPD files for low-resolution
printers typically have only a few choices for line screens,
usually coarser screens of between 53 lpi and 85 lpi. The
coarser screens, however, give optimum results on low
resolution printers. Using a finer screen of 100 lpi, for
example, actually decreases the quality of your image
when you use a low-resolution printer for final output.

Specify a halftone screen frequency and resolution

• In the Output section of the Print dialog box, choose one
of the following options:
o To select one of the preset screen frequencies and

printer resolution combinations, choose an option in
the Screening menu.

o To specify a custom halftone screen frequency,
select the plate to be customized, and then enter
the lpi value in the Frequency text box and a screen
angle value in the Angle text box.

Emulsion options

A. Positive image B. Negative C. Negative with emulsion
side down

The emulsion and image exposure settings in
the Print dialog box override any conflicting
settings in the printer driver. Always specify
print settings using the Print dialog box.

Proofing color separations

Create a hard proof to verify that colors will print on the
correct separations, or a soft proof to preview how your
document's colors will look when reproduced on a particu-
lar output device.

While no proof will give you an exact represen-
tation of your final output, you can greatly im-
prove its accuracy by calibrating all the devices
you use to create a document (such as scanners,
monitors, and printers). If the devices are cali-
brated, the color management system can help
you get predictable and consistent color.

The hard proof represents your expectation of the way the
final separations will appear, and helps the service provider
to verify that the output is correct. Be sure to print proofs
on a PostScript printer; you cannot reliably proof color
separations printed from a non-PostScript printer.

For assurance that the file will print correctly, consider
saving the separations as a PostScript file, converting the
PostScript file to Acrobat 8 PDF using Acrobat Distiller,
and then viewing the PDF document in Acrobat. By viewing
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the PDF document in Acrobat, you can inspect high-
quality PostScript output on screen at a high level of detail.

Producing in RIP separations

To produce in RIP separations, you need the following
software and hardware:

A PPD file that supports in RIP separations.

Any PostScript 3 output device, or a PostScript Level 2
device whose RIP supports in RIP separations. If the
document contains duotones from Photoshop 5.0 or later,
a PostScript 3 device is required to generate in RIP
separations.

Depending on the prepress software available, a
service provider may be able to perform such
prepress activities as trapping, imposition, sepa-
rating, and OPI replacement at the output device's
RIP. Therefore, your service provider may prefer
to receive a composite PostScript file of the
document optimized for in RIP separations, rather
than a preseparated PostScript file.

Creating PostScript or EPS files

As an alternative to printing a document to a printer, you
can save a PostScript-language description of the docu-
ment as a .PS file for printing on remote printers-for
example, by a prepress service provider. A service provider
can send a .PS file directly to the imagesetter. The size of
a PostScript file is usually larger than the original InDesign
document, because the graphics and fonts are embedded.

You can also export a document page or spread to an EPS
(Encapsulated PostScript) file and place it in other applica-
tions.

About device- and driver-dependent PostScript files

Select a printer and a supported driver in the Printer menu.
A device- and driver-dependent PostScript file has the
following characteristics:

• It is driver-dependent. The PostScript file will contain
code generated by InDesign and by the driver. The
InDesign code is primarily responsible for the page
content, including font downloading, and for setting
basic device information, such as media size, resolu-
tion, and screening. The driver is primarily responsible
for setting special driver features, such as watermarks,
and for enabling or controlling special device features.
Since InDesign doesn't have complete control over
creating the PostScript file, the level of DSC compli-
ance isn't quite as high as it is with driver independent
PostScript files. The level of DSC compliance, and
therefore the PostScript file's suitability for prepress
tasks, depends on the printer driver used.

• It is device-dependent. It contains code for enabling and
controlling specific device features, making it less
compatible with devices other than the target device.

• It can be composite or separated (all of the color output
methods that InDesign supports are available).

• It can be trapped by InDesign (either by using Applica-
tion Built-In or Adobe In-RIP Trapping).

• It can be printed directly to the device, or to file.

A device- and driver-dependent PostScript file is ideally
suited for proofing (by the designer) to desktop PostScript
printers. It can also be used by service providers who don't
plan to do any prepress tasks to the job outside of InDesign
or the RIP system. In other words, if trapping is done, it
happens in InDesign or at the RIP.

Create a device-independent PostScript file

Select PostScript File in the Printer menu, and select
Device Independent in the PPD menu. A device-indepen-
dent PostScript file has the following characteristics:

• It is 100% DSC-compliant, making it ideal for such post-
processing tasks as trapping and imposition.

• All device and driver dependencies are removed, so that
the file will print to almost any output device. However,
special printer features found in PPD files, such as
image exposure, available media sizes, and optimized
screen frequencies, aren't available in device-indepen-
dent output.

• The color output is always composite CMYK, but it also
includes spot colors. As a result, it has to be separated
in post-processing software, or at the RIP using in-RIP
separations.

• It cannot be trapped by InDesign; trapping must occur
at the RIP, or in post-processing software.

• It can only be printed to file (not directly to a device or
application) from InDesign.

• A device-independent PostScript file is ideal for com-
posite prepress workflows, where the file will be trapped
and separated later in the production process, such as
during imposition, trapping, or at the RIP (if the output
device supports in-RIP separations).

Export pages in EPS format

Use the Export command to export InDesign pages in EPS
format, which you can import into another program. If you
export multiple pages, each page is exported as a separate
file with a number appended to the end of the filename. For
example, if you export pages 3, 6, and 12, and specify the
filename News.eps, InDesign will create three files named
News_3.eps, News_6.eps, and News_12.eps.

When you export to EPS, you can specify the following
options:

PostScript®

Specifies a level of compatibility with the interpreters in
PostScript output devices. Level 2 will often improve the
printing speed and output quality of graphics printed only
on a PostScript Level 2 or greater output device. Level 3
provides the best speed and output quality, but requires a
PostScript 3 device.
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Color

Specifies how color is represented in the exported file. The
options below are similar to the Color settings in the Print
dialog box.

Leave Unchanged

Leaves each image in its original color space. For example,
if the document contains three RGB images and four
CMYK images, the resulting EPS file will contain the same
RGB and CMYK images.

CMYK

Creates a separable file by representing all color values
using the gamut of cyan, magenta, yellow, and black
process color inks.

Gray

Converts all color values to high-quality black-and-white
images. The gray levels (shades) of the converted objects
represent the luminosity of the original objects.

RGB

Represents all color values using the red, green, and blue
color space. An EPS file with RGB color definitions is
better suited for on-screen viewing.

PostScript®Color Management

Uses the document's color data in a calibrated version of
its original color space.

Preview

Determines the characteristics of the preview image that is
saved in the file. The preview image is displayed in
applications that cannot display EPS artwork directly. If
you don't want to create a preview image, choose None in
the format menu.

Embed Fonts

Specifies how to include fonts used in the pages you
export.

None

Includes a reference to the font in the PostScript file that
tells the RIP or a post processor where the font should be
included.

Complete

Downloads all fonts required for the document at the
beginning of the print job. All glyphs and characters in a font
are downloaded even if they don't appear in the document.
InDesign automatically subsets fonts that contain more
than the maximum number of glyphs (characters) specified
in the Preferences dialog box.

Subset

Downloads only the characters (glyphs) used in the docu-
ment.

Data Format

Specifies how InDesign sends the image data from your
computer to a printer: as ASCII or Binary data.

Images

Specifies how much image data in placed bitmap images
to include in the exported file.

All

Includes all available high-resolution image data in the
exported file and requires the most disk space. Choose
this option if the file will be printed on a high-resolution
output device.

Proxy

Includes only screen-resolution versions (72 dpi) of placed
bitmap images in the exported file. Choose this option in
conjunction with the OPI Image Replacement option, or if
the resulting PDF file will be viewed on-screen.

OPI Image Replacement

Enables InDesign to replace low-resolution EPS proxies of
graphics with high-resolution graphics at output time.

Omit For OPI

Selectively omits imported graphics when sending image
data to a printer or file, leaving only the OPI links (com-
ments) for later handling by an OPI server.

Transparency Flattener

Select a flattener preset in the Preset menu to specify how
transparent objects appear in the exported file. This option
is the same as the Transparency Flattener option that
appears in the Advanced area of the Print dialog box.

Ink Manager

Corrects any ink options without changing the design of the
document.
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Costing and Estimating

Current pricing practices

As a mature industry, today's print market place has
clearly - defined price ceilings. There is slight pricing
latitude, but higher prices must be intensely justified to
customers.  For this reason, it is vital that pricing be based
on actively researched competitive information.  A well-
defined pricing strategy, combined with aggressive cost
reduction plans, is critical for supporting reasonable profit
margins in commercial printing.

Growth for traditional commercial color printing has been
stagnant and margins have generally been poor in recent
years.  In 2005, the average lithographer made just 2.5
percent returns on sales2. This number is projected to be
3 percent for 2006.  Price premiums, when justified, help to
increase profit margins on individual jobs and lead to
greater profitability as a whole.  Value - added services -
services beyond core printing products that provide unique
significance to the customer - are generally perceived as
the means for increasing price, market share, and profit
margins.  Successful commercial printers intimately know
their customer's business, are properly equipped to offer
unique solutions for their customer's problems, and focus
on services and products that provide distinct, substantial,
and well - documented value to their customers - a
challenging feat in a competitive market.

Cost estimating

Commercial printers have been cost estimating for many
years.  Estimating costs prior to producing a job provides
multiple benefits.  Primarily, a cost estimate can be the
basis for pricing decisions.  When a client requests a price
quotation, a customized cost estimate is prepared using
the specifications provided. This information is forwarded to
sales management who analyzes the anticipated produc-
tion costs against competitive pricing information to derive
a price quotation.  In ideal scenarios, the cost estimate and
price quotation have a wide margin for profit. However, in
competitive markets, pricing may be determined indepen-
dently from the cost estimate.

It could be argued that cost estimating is no longer
necessary for pricing.  Since pricing is substantially
market - driven, then why is it necessary to estimate? Why
not simply use a price matrix or competitive pricing? Any
managerial accounting system will accurately track rev-
enues and expenses.  Yearly profit and loss statements
can be developed without a job estimating system.  Even
if cost estimating is never performed, accurate projections
and reports can be generated related to expenses and
revenues.

The response to that argument is that knowing anticipated
costs prior to negotiating price is extremely helpful. It
provides key information to the printing sales representa-
tive to know the break - even point on production - the price
point at which there is both zero profit and zero loss.
Further, this detail provides useful information about pro-
duction processes or operations that are particularly prof-

itable or especially costly to the business.  Cost estimating
empowers the sales staff with knowledge about where they
can be aggressive and where they need to hold the line on
price.

For low-margin work, cost estimating takes on an increas-
ingly important role.  In most situations, companies should
not price work below their costs.  However, without a cost
estimate, that break - even point is not known until after
production.  Further, it is quite useful to know that the
marketplace simply will not support the cost associated
with performing certain processes. For example, if the
market rate for perfect binding is extremely competitive, it
may make sense to outsource these functions to low-cost
trade binders instead of trying to keep the operations in-
house.  The cost estimate helps to expose those cost
prohibitive operations.

What about digital printing? Is cost estimating still relevant
when dealing with digital printing? Why not simply price
estimate, using simplified formulas with built-in profit to
calculate price? In some cases, the customer can price the
work directly by consulting a pricing matrix. For printing
that is highly uniform, price estimating makes sense.
Digital printing often produces standard sizes, on standard
paper, with standard inks and toners. When simple, low-
complexity work is produced, pricing tables make sense,
whether published or private. When complicated, valued-
added processes are involved, however, cost estimating is
helpful in managing the pricing and production functions.3

What are these complicating factors that necessitate an
estimate? When simply running standard paper through a
print engine-print-on-demand (POD) or short-run color
printing the cost is fairly uniform and can be easily
predicted.  However, when variable data, digital asset
management, digital coatings, variable finishing, or other
non-standard processes are involved, the complexity and
unpredictability of the job increases.  A customized cost
estimate is necessary.

How is cost estimating performed?

The estimating process

Cost estimating follows a well-defined workflow. The pro-
cess begins with the request for estimate, provided to the
estimator by a sales representative or the customer
directly. When completed thoroughly, the request for
estimate form contains the specifications to accurately
estimate the cost of production.  An alternate to a request
for estimate form is a web portal, where the customer or
sales representative completes the necessary fields for the
estimate.  Most web portals are integrated with estimating
software, facilitating easy transfer of specifications directly
to the software.  The web has also ushered the era of the
unknown customer.  Today, it is common to estimate jobs
for businesses where no established relationship previ-
ously exists.

After the estimator receives the request for estimate, he or
she begins the estimating process.  To estimate correctly,
the job's production must be accurately planned.  Produc-
tion planning involves mapping the production steps and
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materials needed to complete a project. The estimator
breaks down the production planning by cost center. A
cost center is an area of production, such as digital
prepress, which has defined costs associated with it
including equipment, labour, supplies, and facilities. One
or more operations may be performed in a cost center. For
example, digital prepress may include operations such as
preflighting, image manipulation, color correction, imposi-
tion or proofing, and might have an hourly cost rate of $85
per hour.

more work involved in establishing an ABC estimating
system and completing the estimate. Most commercial
MIS or accounting systems are not easily adaptable to an
Activity Based Costing system.

Job costing

Cost estimating is performed prior to printing a job. In
commercial lithography, it is completed prior to the price
quotation. Job costing, on the other hand, is the function of
tracking and applying actual costs to a job after production.
Its purpose is two-fold: compare actual cost to estimated
cost; and ensure all change-orders are applied and cor-
rectly billed to the customer. Job costing usually requires
all customer changes to be initiated in written form,
ensuring a paper trail for billing purposes.

Commercial printers may link job costing to their payroll
system.  This requires employees to accurately track their
time against a job in order to get paid.  Consumables must
also be tracked to give accurate results.  Most commercial
printers put some emphasis on their job costing efforts,
largely because change-orders can go unbilled unless an
effort is made to track all costs associated with each job.
Job costing also reveals trends that can help identify
ongoing production problems.

One very important benefit of accurate job costing is
continuous improvement. The estimating process needs
feedback in order to ensure the most accurate outcomes,
which means that production standards must be continu-
ally monitored. Improved production efficiencies, if not
reflected in the estimate, will result in fewer print contracts
awarded than possible.  Alternatively, an optimistic esti-
mate that doesn't reflect actual production may secure a
job, but result in lost revenues when production takes
longer than expected.

When the estimating manager gets repeated feedback
from the job cost report that a particular process is
outperforming or underperforming expectations, he or she
can refine the production standards and consumables
used.  This refinement is an ongoing process, and when
diligently preformed, results in a very accurate estimating
system.

Publishers often refer to books as folio and quarto editions.
A folio edition commonly means an oversized book that is
larger than a quarto which is in turn larger than an 8vo.

Books are produced in signatures collections of pages
sewn or glued together in the binding. The arrangement of
the signature pages is known as the imposition. The
imposition of a 32 page signature is that page 32 faces
page 1. page 31 faces page 2. page 30 faces page 3. and
so on. An easy way to remember imposition is to remem-
ber that the sum of the facing pages will be one greater than
the total number of pages in the signature. (N+1) The best
way to certain about an imposition is to create a dummy,
a set of pages folded and numbered in exactly the same
way as the signature. After the dummy, one can make
certain of the imposition.

Rules of  book composition

The typographer should decide whether a book should be
set justified or ragged right, choose the appropriate type
face, select type size and line space, determine the width
of the measure. These decisions form the crux (criticism)
of book design.

The basic rules of book composition

Line length

Research decided optimum line lengths. The 2½ rules
suggests that 10 pt type is most legible on a measure 25
picas long.  If the book is large a two column format should
be considered.

Typesize

A common sense rule is to use sizes that are large enough
to be read.  The most popular type sizes are 10 pt and 12
pt.  Chapter heads should not overpower the body type.  If
10pt / 12pt type is specified for the main body 8 pt should
be used for foot notes.

Book composition

The golden section/progressive margins

The book typographer's first job is to prepare a layout for
two facing pages. The typographer works with two bits of
knowledge the size of the book and the nature of the book.
Keeping this points he/she must create an overall concept
presents and complements the author's ideas.

One of the first significant design decision is the width of the
margins.  Margins serve four functions they frame the text,
provide a space for illustrations and folios, enable the
reader to hold the book without hiding the text and allow for
trimming.  The typographer should specify margins that are
at the very least 3/8" of an inch wide.

Different books require different margins.  Mass market
paperbacks have narrow margins to reduce the number of
pages and keys cost low.  Quality books tend to have wider
margins for elegant appearance.  The typographer should
discuss general economic considerations with the pub-
lisher before beginning to design the work.
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There are several classical theories.  The oldest is known
as the Golden Section. Jan tschichold, one of the most
innovative book designers discovered that the inner.  outer.
head and foot margins were determined according to the
formula 2:3:4:6.  The inner margin was 2". the head was 3",
the outer margin was 4" and the foot was 6".  According to
the golden section, the width of the page should be
proportional to its depth by ratio of 2:3, meaning that a 6 by
9" book conforms perfectly with this proportion.  The ratio
of text to page area is also 2:3, so the text area of a 6 by
9" book that is 4"-24 picas wide should be 6"-36 picas
deep. The final rule of the golden section is that the text
should be as deep as the sheet is wide.

The golden section proportions determine then the text
dimensions of a 6 by 9" book will be 24 picas wide and 36
picas deep.

A newer theory is the idea of program margins.  Progressive
margins become larger beginning with the inner margin and
working counter-clock-wise on verso pages and
anticlockwise on recto pages.  Classic difference between
the golden section and progressive margins is the absence
of a uniform proportion.

Book production

The grid theory

Grid theory is the most valuable frame work for production
of a book.  The typographer first examines the text and
illustration and their shapes and sizes.  Then dimensions
of the grid cell decided.  The size of the cell is determined.
Every textual element, folios, running heads, captions,
body copy and chapter heads must be specified to fit into
the cellular pattern.

The grid is a structure providing a proportional relationship.
The typographer designs the pattern to fit the demands of
the project.  This is the greatest advantages of the grid
theory.

After typographic decisions are made the typeset pages
are checked for errors while the typographer prepares the
layout.  The complete layout of each page the dummy is the
neat step. Each page is dummied on an individual sheet,
which is usually printed in non-reproducible blue ink.  The
layout sheets should be imprinted with two pages to allow
for the design of facing pages spread.

Book composition

Rules and theories

There are some basic rules for legible typesetting of a book:

Line length

Research suggests the 21/2 rule, which means that 10 pt
type is most legible on a measure 25 picas long.  If the book
is large a two-column format should be selected.

Type size

A common sense rule is to use sizes that are large enough
to be read.  The most popular type sizes are 10pt or 12pt.
Chapter heads should not overpower the body type.  For
10pt or 12pt body type.  8pt should be used for footnotes.

Line space

Normally use 1 or 2pts for leading.  Line that are "aired out"
more than 2 pts may appear disjoined. Whereas less than
1 pt of lead may result in an extremely black and illegible
page.

Typeface

Common sense and good taste are the two rules for
selecting typeface.  In general, regular type versions are
more legible than variations, italics and bold should be
used only for emphasis, serifs tend to be more legible than
sanserifs.

Designing books

The shape of a book

Jan Tschichold-one of the greatest typographers, defines
the proportions of the pages rational and irrational page
proportions.  Irrational page proportions of 1:1,618 (Golden
rule), 1: root2. 1:root3, 1:root 5, 1:1.538 and rational page
proportions 1:2, 2:3, 3:4, 5:8, and 5:9. These are clearly
intended and defined.  All others are unclear and arbitrary.

Proportions for book pages

There are two factors to decide area devoted to type on the
pages.  The type area proportions will vary.  Very fine books
have the type cover only one half the area of the page. A
good general rule is to set the type so that it measures 0.71
of the width and depth of the page.  The type area is figured
y multiplying the width and depth by 0.71.

width 36 by 0.71 = 25.56 or 26 picas.

deep 54 by 0.71 = 38.34 or 38 picas.

The type will be set to a measure of 26 by 38 picas.

Selecting and using type

Common

The selection of the type for a job requires the serious
attention of the graphic designer.  There are some ideas the
designer uses in selecting type.

1 Pick a type face to match with the mood of the design.
A thin light face gives a different image than a thick bold
face.

2 Headlines are the major captions set above a newspa-
per or magazine articles. Headlines in colour should be
a little larger than those in black.

3 Variety is obtained by changes in type size and
blackness.  The use of condensed and expanded types
also gives variety. Italics are used for interest.

4 A talented designer can mix typefaces-one for head-
lines and another for the body.

5 Type mixing is a matter of taste.  Old roman and modern
roman do not go together well.

6 San serif are a neutral type. They go well with almost
any other type.

7 Old English should be combined only with roman faces.

IT&ITES: DTPO - Related Theory for Exercise 2.3.09



235

8 Type spaces selected should be readable.

9 Words made/set from caps and lower case letters are
more readable than all capitals.

Type running from left to right is more readable than in
vertical/diagonal rows.

10 Extra spaces between the lines of the body will improve
readability-1pt leading is common.

11 The size of the type affects the width of the body
columns. The bigger the type, the wider the column
needed. A general rule is the width of the column is
equal to 39 lower case characters.

12 Display types are those larger than 14pt sizes. They are
used for newspaper, magazines, headlines, posters
requiring a large attention getting face. Display type can
be crowded, standard, or positioned any way to be
effective.

13 Spacing between words and letters is vital typographic
design.  The spacing should be decided by a designer
rather than a printer.

Book composition

Books represent the oldest form of the graphic art.  Books
become the most valued one because of their permanence.
Books have been the major vehicle for the shaping of
education, culture, the recording of history and the inter-
change of information.  Books have convenience, authority,
economy, intimacy when comparing will electronic media.

Books require a length production time.  The book has long
been appreciated as an art form by serious collectors.

Book design can be categorized into various specializa-
tion. Designers of scientific text books are more concerned
with the legible design of characters, graphs than the
designer of navels.

Format

The size, shape and general appearance of a printed piece
constitutes its "format'. The format is decided by the
author.

Publisher and the designer. Choice of format depends on
objectives of the place and on customary format for each
information. For example a poster is the customary format
for announcing an arts, fair and the one for which people will
look.

Another influence for format is ease of use. A form must be
convenient to fill out, to file, and to refer to later. A self-
mailing catalogue must meet postal requirements.

Donot gues how a printed piece will be used or assume that
its principal use is its only use.

The way a printed piece reaching its audience is another
factor to be considered when deciding on format.

Page design

The pages of a book should be a coherent whole.  Designer
should apply a consistent formula so that the design of
each page appears to have been inevitable. By far most

valuable frame work used in the layout of a book is the grid
theory.

The grid is universal today, the typographer first examines
the text and illustration requirements, taking note of the
sizes and shapes of any photographs, logos, etc. The
dimensions of the grid cell are then decided. The cell is a
carefully formalized vertical and horizontal unit. After the
size of the cell is determined the typographer makes
tangible grid and uses in laying out the pages.

Every textual element, including folios running heads,
captions, body copy and chapter heads must be specified
to fit into the cellular pattern.  As the typographer lays out
the book, the parts of the page will inevitably align into a
unified design.

The grid governs both the position and the size of all design
elements.  If the typographer has determined that the grid
cell of an 8.5 x 11 inches book will be 1" wide and 1/2" high,
the measure used to set every part of the copy must be a
variable of 6 picas (1"). Text type can be set 12 picas (2
cells), 18 picas (three cells), or 24 picas (four cells) wide,
but it must not be set 16 picas wide, illustrations are sized
according to the grid.  All photographs will be reproduced
in variations of 1 x 1 ½". A photograph may be scaled to 6
x 4 ½". but a 6 x 4 1/8"  photograph would isolate the
integrity of the grid.

The grid is a structure providing a proportional relationship.
The grid theory does not constrain the typographer to a
given pattern as golden section.  Rather, the typographer
designs the pattern to fit the demands of the project.  This
is the greatest advantage of grid theory.  The grid system
is at the same time quite adaptable, unifying a variety of
unequal (desperate) elements.  After the initial typographic
decisions are made, the typography of the book is common
place (explained later).  The typeset pages are checked for
errors while the typographer prepares the layout. A com-
plete layout of each page called dummy, is the next step.
Each page is dummied on an individual sheet usually
printed in non-reproducible blue ink.  The layout sheets
should be imprinted with two pages to allow for the design
of facing pages a spread.

Margins

Margins are white spaces around the printed matter on a
page.  Each margin has specific name according to its
position on the sheet; as back, head, fore-edge and tail.
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The back margin is the space between two adjacent pages
of type or illustration.  This produces the white space at the
inner edge of the printed leaf.  The head margin is the space
at the top of the printed page. Fore-edge is the space at the
outer edge of the printed page which is the opposite to the
back.  The tail is the space at the bottom of the printed
page.

Among the different margins, the back margin has the least
and the tail the highest margin, the head a little more than
the back and the fore-edge a little less than the tail, but
more than the head.  If the back margin is one unit then the
head margin can be one and a half unit, the fore edge two
units and the tail two and a half units.  Normally the back
and the fore-edge margins are allotted in the ratio of 2:3 in
the available space.  The same ratio is followed for the head
and tail margins in the available space.

Golden section is the most pleasing proportion between
the text and the blank space.  Progressive margins use
more white space.

Planning for margins

Margins are necessary for the following reasons

• for binding, sewing, and stitching purposes.

• to provide the trimming allowance and gripper allow-
ance during printing on the machine.

• for printing the signature, headings, notes etc.

• to form a frame around printed matter to ease the strain
on the eyes.

• to protect the printed matter while handling and turning
the pages.

• for trimming during rebinding.

• wider margins are allotted sometimes in books of
research and studies for the purpose of taking notes.

• white space around the matter is also a decoration.

Golden section

According to the golden section the width of the page
should be proportional to its depth by a ratio of 2:3, meaning
that a 6 x 9" book conforms with this proportion.  The ratio
of text to page area is also 2:3. The final rule of the golden
section is that the text should be as deep as the sheets
wide. The typographer has to work with two bits of knowl-
edge: the size of the book and what the book is about, with
this information typographer should, create an overall
concept that presents and complements the author's
ideas.

First significant design decision is the width of the margins.
Margins serve at least four functions.  They frame the text;
provide a space for illustrations and folios; enable the
reader to hold the book without hiding the text; and allow
for trimming.

Different books require different margins. Mass market
paper backs have narrow margins to reduce the number of
pages and keep costs low. Quality books tend to have
wider margins, which result in a more elegant appearance
and higher production costs.

There are several classic theories as to how margins
should be designed. The oldest is known as the Golden
section. JAN TSCHICHOLD discovered that many medi-
eval manuscripts and INCUNABULA shared a uniform
proportion. The inner, outer, head and foot margins were
determined according to the formula 2:3:4:6 if the inner
margin was 2", the head was 3", the outer margin 4", and
the foot 6".

These golden section proportions determine that the text
dimensions of a 6 x 9 inch book will be 24 picas wide and
36 picas deep. There will be a 2 inch margin at the foot. 1
3/8" at the outer margin. 1 inch at the head, and 5/8 of an
inch at the inner margin.

Allotting margins depends upon the class of work (whether
cheap, moderate or deluxe), type of binding etc. The
margin are allotted as wide or narrow depending on the
nature of the publication such as, cheap, moderate or
costly edition and the purpose of publication.  For cheap
works very narrow margins will be sufficient so that the
printing area may be increased to reduce the cost of
production by bringing down the number of pages and
quantity of paper. For deluxe and costlier editions the
printing area is made lesser, allowing a wider margin
around.

The smaller the size and more solid the page, the smaller
the margin may be while large, widely-spaced setting
requires liberal margins. The margin may also be deter-
mined by the necessity for getting a large quantity of text
into comparatively few pages, then the margin must
obviously be as limited as possible.
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A newer, closely related theory is the idea of progressive
margins.  Progressive margins become larger beginning
with the inner margin and working counter clockwise on
verso page and clockwise on recto pages.  The proportions
can vary.  For example, if the inner margin is 1 inch, the
head margin could be 2 inches, the outer margin 3 inches,
and the bottom margin 4 inches. The basic difference
between golden section and progressive margins is the
absence of a uniform proportion.

Advantages of margins

Margins help the eye to focus of the type area. There should
be more margins at the bottom of a page than at the top
otherwise the type has the appearance of falling out of the
page.

The inner margins should be less than the outer margins.
Enough space should be left on the side margins for easy
handling without obscuring type matters. The bottom
margin should be large enough for the comfortable placing
of the reader's thumb when the last lines of the page are
being read, Good margins are an aid to legibility.  The larger
amount of margin on sides, head, and tail allows for
subsequent cutting and rebinding without injury to the type
idea. Ample margins also give room to the reader for
annotation.

Body type size and leadings

"Body type" is normally no larger than 12 pt. used for the
text or main part of a printed piece.  "Leading" is the space
between lines of type. Type may be "set solid" with no extra
space or air between lines, making compact, or set spaced
apart.  Thus both size and leading affect the length of a
column of type.  If for example specified, it means that body
type is 9 pt 10 pts of space, allowing 1 pt of leading lines.

Column width

Column width is specified in picas.  "pica' is a common unit
of measure in the printing industry and equivalent to 1/6 of
an inch. 6 picas make 1 inch.  "Column" is a vertical block
of type made of two lines all set to the same width.

Depth

"Depth" is howlong a column of type will be, if depth has
been estimated as 10 inches then add extra space
between paragraphs or additional lines to compensate for
anticipated changes after type is set.

Headlines and subheads

A "headline" or "head" identifies the subject of an accom-
panying article or block of copy.  It is usually larger than the
body type and often of a different weighter type style. A
"subhead" is smaller than headline and appears as further
introduction to the text/within the text to break into sec-
tions.

Book typeface selection

Type the voice of the printed page, should be legible and
fascinating.  Book-lover loves readability and legibility. A
esthetic considerations are the dominant factors to prefer
a classic types for printing a book. The choice of type is
dependent on practical considerations as the kind of book,
public, its length, its size, type area, the type size and
leading, paper is another primary factor to decide type.
Monotype book laces have high degree of legibility and
grace of their letterforms.  Leading has the optical effect of
altering the colour values of the type on the printed page.
The colour value (weight) of type is effected by the kind/
colour of paper used. Types like Casion, Garamond and
perpetua attain their flowering in their larger sizes whilst
fournier, plantain and imprint are most successful in
smaller sizes.

Book-typography

Book design continuous to be vital part of the printing
industry.  Typography is important to the book in three
distinct areas, the cover and jacket design, the text and the
illustrative material.

Text face in chosen far less for it emotional impact than for
simple legibility. The typographer selects a type face the
best reflects what the book is about, charts, tables, and
graphs are exempt.

From any debate regarding emotional appeal. Typeset
illustration material is designed to present information that
can be interpreted.  A well designed graphic an convey
statistical information.

Book typography must be emotive, legible and informative
as the situation demands. These three functions offer a
constant into which all typography must fit. Design strat-
egies an discussed and executed either by in-house
graphic personnel or by free-lance designers.

Book Jacket

Book jacket is an extraneous to the book. It demand the
most careful, injenious treatment.

Book jacket is the loose paper wrapper placed round the
binding case after the book is bound.

The original purpose is to protect the case before sale
against handling and exposure to light and atmosphere.
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The jacket is still referred to as the dust-wrapper. Accord-
ing to Rosner, "jacket is a poster wrapped round a
commodity". Jacket is a sales device.

The book jacket should appeal to prospective buyers at a
first impression when they see from 8 -10" distance and 3'
high.  The excellence of a jacket will play a competitive.

Jacket must have a recognizable style to invite the buyers.
The best jacket designs are to be planned and executed by
illustrators and art editors.

Wrapping in the reverse of inserting: here the pages go
around the outside of the text signature, mechanically the
operation same as inserting.

Case binding

This is the conventional method of making a book.  Where
by the signatures are enclosed in a rigid cover to the inside
of which they are attached by pasting the endpapers or the
first and last pages (self-lining). There are several variations
in case binding.  The pages may be held together.

A By sewing the signatures together.
B By use of wire stables or
C By adhesives (perfect binding)

There are two sewing methods:

Smyth sewing

The most common method used for trade books. If the book
has only one signature and the stitching goes through the
gutter. It is called saddle-stitching.

Side sewing

The thread is passed through the entire book about 1/8"
from the back. For books over ¾" bulk machine sewing is
used.

Wite stitching or stabling

This is a cheaper method of holding pages together when
there is just one signature. Two or three wire stables are
passed through the gutter as in a pamphlet. Side wire
stitching is smaller to side sewing.

Perfect-binding (adhesive binding)

This process consists of trimming off the folds at the back
of the book and applying an adhesive to hold the pages
together. A more sophisticated type of perfect-binding is
done by electronically welding the molecules of paper
together. The perfect binding is commonly used on direc-
tories. Catalogues and large reports and now-a-days
costly text books of limited pages. A soft cover-weight-
paper is used to a hard cover.

A type of perfect binding may be done by office equipment
or a bindery.

Preliminary matter
A book consists of three basic parts:

A Front matter
B Body and
C Back matter

The cover/jacket of a book is an exterior which includes
endpapers and spine.
The preliminary matter is otherwise called as front matter
or prelims.  Preliminary matter consists of all or a combi-
nation of the following.
1 Half-title (bastard title)
2 Announcement (fact title) or frontispiece
3 Title page
4 Copy right page

Types for jacket design

one of the following typefaces can be selected for jacket
printing.

Suggested faces

Chisel, fat face, shaded ultra Bodoni, ultra bodoni con-
densed condensed-Roman, Times heavy titling, Gillsans
bold sanserifs shadow and camco ruled.

Binding styles

The term "binding" means conventional book binding.
There are basically three kinds of binding. (a) case or hard
binding, or hard cover, (b) paper or paper back or soft cover.
and (c) mechanical including "spiral" binding.

Tipping, wrapping & inserting:

Signature are bundled and sent to the gathering, depart-
ment where they are assembled into books. Before they
are gathered the end papers are tipped onto the first and
last signatures and any illustrations are upped, inserted, or
wrapped at the proper place.

Tipping means pasting onto a page with about 1/8" of
pasted along the inside or gutter, edge.

Inserting into a signature means placing four or more pages
in the middle or elsewhere.
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5 Dedication
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9 List of illustrations
10 Acknowledgements

Half-title page

The Half-title page is the first page to contain type.  Always
a recto, it features only the title of the book. This should
appear on the upper fourth of the page.  Half title type should
be below 18pt often it is the same size as the type used for
chapter openings.

Announcement

Appears opposite the title page. The announcement, fact
title or card is a list of books previously written by the
author. This element is a new member of the front matter,
replacing the frontispiece, a photograph that is related to
the topic of the book. Announcement type should be set
same size as the text type used in the body.

Title page

The title page includes the full title of the book; the authors
name, the publisher's name, place of business and logo or
emblem. This page is always a recto.

Typographically, the title page sets the tone and artistic
style for the entire book. The important point is that the
entire books have been devoted to the design of this page
alone.

The publisher's place of business and the date of publica-
tion merit the smallest type size -10, 12 pt is adequate.  The
typographer must not commit one mistake setting the word
by in the same size as the author's name and thereby
calling undue attention to an insignificant proposition.
There are possible solutions cite the author's name without
the use of word; Set the word by on a separate line in a
smaller size, de-emposize the word in the same line by
setting a lower case 'b', or combine the last two sugges-
tions and a set by in smaller type on its own line.

The title page design should not exceed the dimensions of
the text type specified for the body and should reflect the
typography of the book as the whole. If illustrations are
important part of the book, an illustration might be used on
the title page.

Type selected for title should reflect the relative importance
of the title page elements. The optical center and upper
third of the page with the author's name below but still in the
top off.

Wide white space should be left between the author's name
the publishers name and emblem.

The last line on the title page should be in the bottom
margin of the book and should align with the last line of type
on text page.  When possible, the title should align with the
top line of a text page.

Today's title pages may contain a single hairline rule to
demarcate the publishers imprint.  Any  additional decora-
tion-borders, rules, is probably a  poor choice.

Copy right page

The copy right page is located on the reverse-opposite of
the title page (verso). Copy right contains the following
information: a copy right notice, the date of publication, the
name and address of the publisher; the edition number, a
copyright warning, cataloging in publication (CIP) data, and
the books FS ISBN International Standard Book Number.

Dedication

Appears either on the copyright page or directly opposite
on its own page.  If a full page is allotted to the dedication,
the page should be a recto.

The type should be same size used for the announcement
and text.  Dedication should be placed at the head of the
page or in the optical center.  If it will be set on several lines,
the first line should align with the top of a text page.

Table of contents

The contents page is a numbered recto. The table must
show the relationships between the  various parts of the
text castly and quickly.  The contents should be displayed
in a text size (10-12pt). The header-Table of contents, list
of contents, should be in the same size as the chapter
opening heads.

Chapter number should be displayed at the left, followed by
the chapter title.  If there are more than nine chapters an en
space should be set before the number in chapters 1
(through 9, so that single digit numerals will align with the
second digit numerals 10 and above.
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Chapter titles must be absolutely accurate. The page
numbers are set after the mechanicals for the book are
completed. Only there will be the exact sequence of pages
be known. The page number of each chapter should be
checked and rechecked.  The chapter numbers, chapter
titles and page numbers can be visually connected in many
ways.  Popular methods include the use of leaders, extra
leading between chapter titles and bold faces.

The typography of the table of contents should not over-
power the text.

Foreword

The foreword is the written by an authority on the subject
matter, who explains why the book is an important contri-
bution and appraises the author's standing in his/her field.

The foreword should be designed to be consistent with
chapter opening pages. The first foreword page is usually
a recto, but this decision may depend on the length of the
foreword.

Preface

There is much confusion among the words the preface the
foreword and the introduction.  In general, the preface is a
short preamble that may serve to acknowledge the help of
other individuals/organizations/may summarize the meth-
ods used to collect information.  Most important the
preface should give the reader an idea of the book's
purpose.

The design of the preface should echo the foreword and the
chapter openings.  The section should open an a recto.

List of illustrations

A list of illustrations tends to be added at the editor's
discretion, believing that it will assist the reader.  I should
briefly identify the book's illustrations and include the page
number on which each illustration appears.  If an illustration
appears on an unnumbered page.  It should be identified by
the number of the page that it faces/follows as facing page
124 or following page 124.  If plate numbers or figs are used
in the text they should be included in the list of illustrations.

This section directly follows the table of contents either on
a verso or recto.  The typographic style should closely
follow that of the contents page.

Acknowledgements

Acknowledgements are made to persons and organiza-
tions helpful to the authors in preparing the manuscript.  In
a work discussing art or photography.  Acknowledgements
will also be made to museums and individuals who permit-
ted the author to reproduce art work.

Other possible front matter include list of abbreviations
(may be included as back matter), lists of contributors
(short bio graphics), lists of symbols and errata.  The errata
is a list of all mistakes made in the book.

When designing the front matter, the typographer should
not include more than one section on a single page.
Acknowledgements should be either included in the pref-
ace or set as an acknowledgements page.

The body

For 350 years all typography was book typography and
most book typography concerned body text.  The typogra-
pher is concerned with several problems in designing the
book proper the introduction, part-title pages. chapter
openings, headers and footers, folios, heads and sub-
heads, Captions, and footnotes. If the book is to be
aesthetically successful, all elements must be treated
uniformly and coherently.

Introduction and part-title pages

The introduction is treated exactly like a chapter. The
introduction opening should be designed in the same way
as a chapter opening.

Part-title pages separate sections consisting of several
chapters within a book.  Part title pages usually feature the
same display type used on the title page and in chapter
openings and may contain a decorative emblera  or
illustration that ties in with the overall design or theme of the
work.

Chapter openings

Chapter openings should form a consistent pattern to
secure the parts of the book together into a visual whole.
Recto chapter openings were obligatory at one time, recto
pages are noticed first by those leafing through a book and
a verso chapter opening was avoided at all costs. The
typographer should try to manipulate his/her design so that
chapters regularly open on right hand pages.

After the title page, the chapter head is the one constant
display element in all books, the only part of the body that
is set in display type.  It should typographically define the
beginning of the chapter.

The typeface selected for the chapter number and title
usually belongs to the same family as that chosen for the
text.  The type should be set in a size at least twice as large
as the text type-bold face is rarely necessary.  The title and
chapter number are often placed in the optical center of the
chapter opening page.

The typographer must decide how to design the text
opening.  The first letter/words of each chapter may receive
special treatment so that they will be visually emphasized.
For example, a raised initial simply involves setting the first
letter in a type size larger than that used for the rest of the
text.  The more complicated hung initial involves indenting
upto four lines of text.  Finally, the first two words of the
chapter may be set in small caps for an understated effect.

Heads and subheads

Captions that introduce sections of material within a
chapter are called headings or heads. Subheads corre-
spond to divisions within each main section. All heads and
subheads should be separated from the text by the use of
white space and by a distinct treatment of type. There
should be more white space above heads and subheads
than below. If equal space is used, it will be more difficult
to discern the organization of the chapter.
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Heads may be set as much as two to three points larger
than the text type size.  They may also be set in boldface,
italics, or all caps, the main heads and various levels of
subheads must all be distinct from one another.  If a main
head is set in boldface type two points larger than the text
size, the first subhead may be set in upper and lowercase
boldface that is the same size as the text and a second
subhead may be set with identical specifications in roman.
The typographer should specify heads to be set in the
same family as the face used for the body.

Running heads

A running head is set along the top of each text page to
identify basic information about the book.  The three most
common varieties of running heads include the book title on
every page, the book title on the verso and the chapter title
on the recto and the chapter title on the verso and an
indication of the pages contents on the recto. In a volume
of poetry, the repetition of the book's title throughout is
perfectly appropriate, whereas in a technical reference
work, the reader expects some help in locating specific
pages.

Running heads not only aid the reader in finding particular
parts of a book, but they also form a visual bond between
two facing pages.  A book without running heads will appear
typographically disjointed.

The running head is sometimes placed along the outside
margin or at the front of the page, whenever its location, it
must be separated from the text either by some decorative
device (a rule is common) or by white space.  Page
numbers can be incorporated into the running head in a
variety of ways.  When placed at the bottom of the page,
the running head becomes footer and the page number
becomes a drop folio.

If white space is used to separate the heads from the text,
a minimum of six points should be specified.  Running
heads should be set in small caps/italics to distinguish
them from the text.  The type face should be from the same
family as the text type.  Overall, the running head should
be a visual, strong enough to be easily seen the more
important elements of the book.

Folios

Folios, or page numbers, are often designed in conjunction
with the running head.  The folio is usually placed on the
outer edge of verso and recta page.  Folios should never be
placed in the gutter adjacent to the spine, because the
reader will have difficulty in finding them there.

Folios are set in regular/italic type, boldface variations are
rarely used.  Like the running head the folio should be
apparent when needed.  If the folio is not part of the running
head, it may be placed.

• In the outer margin at the approximate optical center.

• At the foot of the book in the outer margin , or

• At the foot of the book, centered wherever the folio is
placed, it should be clearly discernible from the main
body.

The folio on the chapter opening page receives special
attention.  Folios demand well-considered treatment be-
cause they are very important to the text.

After determining the position of the page the designer
must consider whether to use old style/lining figures.  If the
folio is part of a running head set in small caps, an old style
figure should be used.  In general, old type figures have
more serious tone and are less conspicuous than lining
figures.  It catches the eye prominent.

Captions

Captions describe/identify illustrations. They can also
serve as a credit line that acknowledges the supplier of
illustrative material.  Caption typography should be inter-
nally consistent. They typographer should decide upon
one measure for all captions.  If that measure is less than
a dozen picas the captions should be set ragged right.  The
ragged right lines will be much less noticeable than the
CHOPPY lines created by a too-short justified measure.  A
caption should never be set longer than the width of the
illustration.

Captions should be set at least two points size smaller
than the text, but the type should be no larger than 8 point.
If the illustration is a full bleed, place the caption on the
opposite page, if the illustration takes up two facing pages
place the caption on the next page.  A MORTISE (a hole)
or white box cutout the illustration with type dropped in, is
unsightly, and should be avoided. The standard location of
caption is below the illustration, flush left.

There are a few situations in which captions (in maga-
zines), legends (in books), and cutlines (in news paper) are
unnecessary.

Captions should do more than just describe what the
picture shows or give the name of the person in it, because
readers look at illustrations first, before they start to read
the page.  Their interest is aroused by images which ought,
therefore, to be utilized as hooks to pull the readers into the
story.

The caption should be closely attached to the picture so
they are perceived together.  Alignment and closeness are
the two obvious techniques to make them appear that way.

Quotations

Quotations are either set as an integral part of the text or
separated from the text by white space and an indent. The
decision of when to segregate quotation is a matter of
publishing house style. A general rule is that if the
quotation is longer than fine text lines, it should be
indented. Extracts may be set in a smaller size/italic.
Extracts should be line spaced at least on a full text line
before and after the quotation and indented two to four picas
from both margins.

Footnotes and endnotes

Notes should be set atleast two points smaller than the text
but no larger than 8 points.  Footnotes are necessary only
in scholarly we should be grouped either at the ends of  as
back matter.
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Long footnotes may dominate the page.  pographically, it
would be better to eliminate foot-notes altogether but that
would require readers to flip back and forth as they were
reading, endnotes are the better typographic choice.

If notes appear in the back matter, they should be listed
according to chapters as well as pages for easy cross-
reference.  Several different systems are used to identify
footnotes-a  series of asterisks and daggers on each page,
sequential numbering in each chapter and sequential
numbering throughout the text.  If sequential numbering is
used, one small error may mean that the entire book will
have to be reset.

Back matter

The back matter consists of reference material helpful to
the reader, including appendices, endnotes, glossary,
bibliography, contributor's list index and colophon.

Appendix

An appendix contains information helping some readers.
Explanations of research methods, text is of documents,
tables of technical data are some examples.  Typographi-
cally, the appendix is treated exactly as a chapter.  If
chapter opening pages are rectos, appendices should
open on the recto.  Type sizes should be the same as in
the body copy.

Glossary
The glossary defines technical terms used in the text with
which the reader may be unfamiliar.

Glossaries are often set in type that is one or two points
smaller than the type used in the main body of the book.
It is permissible to set the glossary in two columns.  The
glossary should be arranged in alphabetical order.  If it is
quite long the typographer should consider marking the
beginning of each letter in the alphabet.  This will break the
monotony of uninteresting pages and it will help the readers
to locate a word in the list.

Bibliography
The bibliography opening page should be consistent with
the opening page of the glossary adn index.  The type size
may be one or two points smaller than the body copy size.
The use of boldface and italics depends on the guidelines
provided in the publisher's house style manual.

Index
The index is the last portion of the book to be designed and
prepared.  The index can we prepared only after the book
is completely set and pasted upto pages.

The typography of the index with depend entirely upon how
many pages the typographer has to devote to this portion
of the book.  Indexes may be set in four columns of 6 pt type
or in two columns of 10 pt type if many back matter pages
remain.  It is the responsibility of the typographer to design
the index before it is done.

The alphabetical divisions of the index should be made
explicit with an initial letter or with whites pace less than
twice the linespace being used. A regular type face,
smaller than the text, should be used in index citations.

Textual references should be clearly distinguished from
references to illustrations. A good strategy is to set textual
references in regular type and illustrations reference either
in italic or bold.

The footnotes, glossary, bibliography and index are de-
signed as a whole and often only after the remainder of the
book has been set.  At that point, the publishing house and
the typographer know how many printed pages must be
allotted for the front matter, body, and appendices.  Often
the remaining back matter is then "assigned" a specific
number of pages.

Colophon

Colophon is appearing on either the copyright page or the
last page of the book, the colophon includes the names of
the designer, illustrator, printer, and binder, along with
such information as the typeface, typesize, and paper
used and other production details.

Tabular composition

Tables vary greatly in their nature and their relationship to
the text and the ways of setting them vary accordingly.  In
general, they are set 2 or 3 sizes smaller than the text.
When tables are set on slug-machines the use of horizon-
tal rules usually presents no problems, but vertical rules
may be vary expensive if it is necessary to cut slugs.  In
simple tables, each column can be set on its own measure,
with vertical rules dropped in between.  Complicated table
which require both horizontal and vertical rules can be more
economically set by photocomposition.  It may be neces-
sary to turn tables the other way of the page (side turn) if
there are too many columns for the width.

Illustrations

Book production of a hundred years ago was capable of
much memorable, but the purposes and methods of
illustration were more limited and formal in those days than
they are now. Today's pictures look different, describe
different subject and appears in greater variety than in the
past.

As a conspicuous element of the book's appearance,
illustration deserves the designer's skill. Knowledge of
reproduction methods and ability to adopt and manage
pictures for presentation in book form are essential to
success. Much illustrate is textual in purpose rather than
decorative the decision of having more illustration is re-
served by author or editor.

Position

The position of illustration is relation to each other to the
text to the page, and to the rest of the book is regulated by
the designer in every illustrator opening of a book. Illustra-
tions area a conspicuous part of the book and their
arrangement is conspicuous part of the book and their
arrangement is conspicuous part of design. The position of
each is a subeditorial matter which is best decided in terms
of book design. The appearance of illustrated opening
benefits from vertical/horizontal alignment between the
various illustrations and other elements printed on it.
Illustrate can be sized to align at one edge, with each other
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and with the text area. At the other side drawings can be
scattered across page or opening.

Illustrations of irregular outline need to be in balance rather
than in alignment.

A rectangular squared-up half-tone, is placed with one/
more of its edges in exact alignment with other elements
of the opening.  The hard straight edges then seem to have
been arranged with indent, parallel with edges of illustra-
tions or text.  Of halftones tones are two close to each other
or to text, the leader may name difficulty in identifying as
depart items.  They may even appear to blend into a single
picture from the text distract the reader or every picture is
improved by a frame of white space and when text and
illustration approach within a pica of each other, technical
problem of page assembly may begin to appear.  When
halftone or solids are placed back-to-back on the same
leaf, there is a risk that each will show through the paper
to confuse the other.  The printer may be cautious with his
inking, too thick a film of ink causes set off on the printed
sheet.

When illustration are printed as sections of plates they are
usually backed, and when they are printed in the text, a
textually appropriate position is usually to be prepared.

If text is to be divided by an illustration in mid page, the act
of reading will be favoured by placing the illustration
between two paragraphs, rather than in mid sentence
within a paragraph. The division a paragraph into two parts
on one page. Above and below an illustration, is now
custom but dividing a word immediately before and after
and illustration is clumsy.

When a typographic reference to a half page illustration
appears in the lower half of a recto page, the illustration ill
have to be placed in the next opening. Text reference to
illustration as appearing above or below are likely to need
amendment after makeup. Above and below books have to
mean further back and further on.  Marginal illustration
tends to reduce the measure throughout the book.  Placing
illustrations in the margin has the advantage that through-
out the book a number of a small or at least narrow pictures
can be placed beside the actual reference to each, without
extending the text or interrupting the reader.  A recto pages
are often preferred for full page illustration when they are
few.

As a rule, lettering on any illustration should start from the
top and read downwards, unless it is horizontal. Any
lettering which reads upwards on the illustration will be
printed up side down if the illustration is turned. Illustration
should not, as a rule be printed on endpaper papers can be
made tinted paper and printed a colour other than black,
and they are always easy for the reader to find.

Kinds of illustration

There is a wide range of visual material included in
illustration. The illustration are divided by function.

There are four kinds:

(a) Informative, (b) Suggestive, (c) Decorative and

d) Representative.

Informative

Illustration which explains or depicts facts circumstances
characters, things and places. The realistic, drawings
commonly used in teenage fictions the photographs,
drawings, diagrams found in many technical and fiction
books.

Suggestive

Suggestive illustration included all graphic elements de-
signed to establish or enhance mood or atmosphere.

Decorative

These graphic element are meant simply to ornament the
page.

Representative

These are works of art, used the purpose of producing
pleasure of seeing the original.

Illustration Captions

Captions are elements of page design as pictures/text. If
captions consist of a line/two they may be used to contrast
with a large block of text/picture.

Captions must be readable but must contrast with the text
sufficiently to avoid confusion.  They may be set 1.2 or 3
sizes smaller than text and still be readable.  It helps to set
them in italics/in another face.  In crowded layouts/texts,
there is often a need to set captions in narrow measures.

When placing captions above and below illustrations
remember that there are usually more ascenders and caps
than descenders.  There optically more space below a line
than above necessary to specify a little more space 2pts)
between pictures and captions place than those placed
above.

Legends

Legend is a name given for the descriptive matter printed
below an illustration.  The custom of printing and publishing
establishments is to prefer the term caption.

Caption or legends belongs under picture to which it refers.
To put it in some other position above or besides the picture
is to force the reader to search for it and perhaps to loose
interest.

The size of the caption is frequently determined not by the
extent of the ideas to be exposed. but by the space
allocated to a picture text to it or in a similar position on the
same or facing page.  Pictures occupying adjacent/related
positions are usually given identical space for captions.

Captions/legends that accompany photographs, charts,
cartoons, and art work should be written carefully with a
view to their purpose and the space available.  Writing an
effective caption takes more time and thought than its
length would indicate caption must have some punch and
be the proper length to fit the space limitations.

The caption writer is responsible for the line giving credit to
the photographer/source of the chart/art work reproduced.
This credit line may appear immediately below the picture,
i.e. above the caption itself or as a final pharase in the last
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line of the caption.

Casting off copy

Estimating the number of columns or pages a manuscript
will make when set in type is defined as "Casting off".

"Casting off" in copy fitting, is considering or counting every
letter, numeral, punctuation mark, word space as a char-
acter. Word processing system makes cast off simple.
There are two kinds of cast off justified and unjustified.

Justified

To make a justified castoff, use revised gallery proofs if
possible.  Unrevised proofs may be used if the corrections
are minor and the master proofs are at hand, so that the
effect of the text changes can be taken into account. A
difference of a line/two and a word/two may have a serious
effect when number of pages is very close to the limit.

In a justified cast off, the pages should come out exactly
as in the makeup, which means that all problems must be
solved in detail.

The problems include: a) linal determination of the space
to be used for illustrations. (b) Disposition of  odd amounts
of space resulting from matter set in lines of various depths.
c) Provisions for widows and d) disposition of the various
problems caused by running breaks that fall at the ends of
pages.

Unjustified castoff

This is simply a linear measurement without allowance for
alignment of short/long pages due to widows/other make
up problems.  An unlucky sequence of widows can throw
a chapter over to another pages by adding several lines and
this can affect the overall length. For this reason, an
unjustified east off has limited value.

The quick-and-dirty method, used for longer manuscripts,
is to find the average length of type written line by sampling
several pages and multiplying the result by the number of
lines in the copy.

A more precise method involves several steps.

First find the shortest full line on each page ignoring short
end of paragraph lines.  Then draw a vertical line through the
copy.

Count the number of characters in the short line and
multiply the result by the number of lines in the page.  Next,
count "leftover" characters to the right of the cut off line and
add that total to the first total.  Add a character to every line
ending with a complete word. If we forget to account for the
"invisible" word spaces.  The count will be off by about 25
characters per page. Ignore end-of-line hyphens, because
this is not  to be hyphenated again.

The quickest and safest way to count characters is to
make a character-gauge by typing a row of numerals along
the edge of a sheet of paper.

Haber rule has gauges for elite and pica type and gauges
for common text type sizes.  It is an invaluable tool for the
type designer.

Special setting-lists, indented quotations, must be cast off

separately.  Add additional line spacing above and below
special settings.

There is no accurate method for counting variably spaced
copy apart from counting, every character individually.

There are several different styles of character count tables;
the most common is a character per- pica scale.

This chart indicates that 11 pt. perpetua sets at 2.81
characters per pica.  This works for metal/phototypesetting
systems. It will not work for digital systems:

The final step is to compute the vertical space and the
depth of the type.  Formula is depth of line X number of lines
= depth of type.

Cast - off- problems

The treatment of space, breaks, run- in chapter titles, and
subheads that fall at the bottom of pages are major problem
of the castoff.

Copy fitting principles

Copy fittings or copy casting means calculating the area
that copy will take up when it is converted into type.

There are several methods, some more, precise than
others. The shorter the copy, the more, accurate the
calculations must be

There are three common steps in copy fitting to proceed:

1 Casting off/computing the number of chargeters on the
original copy.

2 Calculating the number of lines of type represented by
the castoff.

3 Calculating the depth of the text block.

Copy fitting determines how much space body type will
consume after it is typeset.  This information is necessary
when the typographer works with large amounts of type
because the typeface, typesize, line space and line length
selections have a significant impact upon the ultimate
length of the printed work.

The decisions of the typographer are most often based on
two considerations: Space and Cost in the first case,
Particularly in advertising typography, copy fitting will
determine what parameter may be specified to fit a given
number of characters successfully in a given space.  In
second case, manuscript set in 8 pt type will take up less
space than the same pages set in 12 pt.  The selection of
typographic parameters will be significantly influenced by
the publisher's decision as to how many pages should be
promoted.  Copyfitting in the only way in which the
typographer can be certain the chosen book length will be
realised.

Every typographer must know how to copyfit.  Designers
and art directors often write the notation set to fit, meaning
that the type setter should fit the copy into the block that
has been created.

Before determining space for typesetting, one must as-
sess how long type written manuscripts is. To do this, we
must count the characters in the manuscript.  Usually the
copy has been typed consistently in one of the two
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standard typewriter styles: Pica and Elite, pica type has
ten characters to the inch; Elite typewriting is slightly
smaller there are twelve characters to the inch.

Counting one line

The first step in copyfitting is to count the number of
characters in a single line.  We can do this either by
counting the number of characters in one inch and multiply-
ing the figure by the number of inches in the line, or simply
by counting each character.

Pick a line of average length.  The character count
computing is an average. A very short very long line will
skew the average either high/low. Remember also that
when counting characters for copy fitting, count letters,
figures, punctuation marks, and spaces between words.
When finished counting oneline, write down the number.

The page count

After counted the number of characters in one line, it is
easy to compute the number of characters on one page.
Count the number of lines on the page, ignoring very short
lines.  Multiply that number by the character count deter-
mined in step one.  This is the page character count.  If the
manuscript has more than a single page, the page charac-
ter count is first computed as outlined above.  Then
determine the number of full pages of manuscript.  Pages
will one/two lines may be ignored; if two characters each
end with a half page, the two half pages are counted as a
single page.  After determining the number of full pages,
multiply the page character count by the number of full
pages to obtain the manuscript character count, the
number of characters in the complete manuscript.

Copy fitting charts

Before going further in copy fitting, the typesetting speci-
fications must be established.  Assume that the type is to
be set in 10pt Helvetica with an 11 pt line space on a 20 pica
measure.

the copy fitting chart-the character for 10pt type is 2.68.
write this down.

If the measure is 20 picas, how many type characters will
be in one line of type? As you know there are 2.68
characters in every pica and there are 20 picas.  Multiply
the character-per-pica value by the measure.  The result
will be the number of characters that will appear in each line
of typesetting.

Number of typeset lines

To determine the number of lines, divide the number of
typeset characters one line into the total page character
count.  Remember that we are concerned with typeset
characters.  Use the value determined in step three using
the copyfitting chart.  As a simple example, if a document
has 100 characters and there are 20 typeset characters in
each line, the typeset job will have five lines.  Refer this with
copy and copy fitted text (chart).

Vertical depth

After determining the number of typeset line the copy fitting
exercise is basically complete layout artist could now draw

the number of puted typeset lines.  But there are more
steps to round out the job.

First, remember that the linespace has been specified as
11 pts.  To make certain that the type will fit the layout, we
must compute the total depth of the typesetting.  If oneline
takes up 11pts, multiply the number of typeset lines
determined in step four to compute the total depth is points.
It is difficult to visualize what a depth of 351 points means.
For better comprehension, the copyfitter should convert
depth in points into depth in picas.  Since there are 12
points in a pica, the conversion is quite simple; divide the
depth is points by 12. If it is necessary convert the measure
in to inches by dividing the depth is picas by 6.

Copy fitting prevents the page from designing itself. The
type should not consume whatever space it happens to
require.  The typographer control the page.

Copyfitting

Here is a roundup of the copyfitting steps:

1 Count the number of characters in an average line of
type writing.

2 Count the number of lines in the manuscript.

3 Multiply the  number of characters in one the number of
lines. That is the total typewritten characters.

4 After specifying type, consult a copy fitting chart. Find
the per pica value for type face and type size chosen.

5 Multiply the character per pica value by the measure
specified. This is the number of characters in one
typeset line.

6 Divide the number of characters in one typeset line by
the total number of typewritten characters in the manu-
script.  This is the number of typeset lines.

7 Multiply the number of typeset lines by the line space.
This is total depth in points.

8 Convert depth in points in to depth in picas by dividing
by 12. If necessary convert depth in picas in to depth in
inches by dividing by 6.

Points and picas

Points and picas are the printer's until of measure, and this
measure is used with all typesetting systems for practical
purpose note that;

Six picas make one inch.

One pica makes 12 points.

The standard typewriter produces six single spaced lines
per inch, hence each line is a pica.

It is simple to convert any number of pica lines to points.
For instance six inches equal to 36 picas and 36 picas
equal to 432 points.  If you were going to set type in nine
point solid you need only divide 432 by nine, and you would
get a result of 48.(432/9) Thus 48 lines of nine point type
would fit into 36 picas.
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To save time, a line guage, will visually indicate the number
of lines in a given amount of space.

Method of copyfitting

To determine how many lines of type will be set from a
manuscript, you should have knowledge of some system
of quick and simple.  Let's examine a system called the
Character Count Method:

Every size and style of type will have a character count
which refers to the average number of characters that will
fit into one pica.  This count is referred to as "Character per
pica" or "CPP". (REFER XEROX COPY)

There are 26 letters in the alphabet, let us add 2.5 more
characters for punctuation marks we have figure 26+2.5 =
28.5 - we can call "K" (Constant).

Simple formula for character per pica for the modern type
style:

CPP
picasinlengthalphbetcaselower

)K(constant
=

The measurement of modern typeface lower case line is
14.25 picas.

To figure the character per pica for modern type,

CPP2
14.25

28.5
=

To determine the characters per picas, first measure the
lower case line from the left of the 'A' to the right of the 'Z',
use picas scale for accuracy for greatest accuracy a point-
scale should be used.

Let us assume a manuscript contains 30,000 characters.
It is to be set in eight point type, 12 picas wide.  The
character count is 2.5 CPP for our type style.

If our type is to be set 12 picas wide, we can multiply 12 by
2.5 which tells us that one line will require 30 characters.

12 picas by 2.5 CPP = 30 characters in one line.   30,000
character manuscripts will require 1000 lines of type.

Lines in manuscript 19

Average characters per manuscript 65

Characters in manuscript 12.35

Type character per pica 2.5

Type line width in picas 17

Characters in one line 45.9

The square inch method

Square inch method is another method of estimating copy
fit which is not as accurate as the character count method.
It can be convenient for quick estimating.

Determine the number of words in the manuscript.  Deter-
mine the number of words of type to be set in one inch.

Divide as:

=
inch square 1 in  wordsof Number

manuscript in  wordsof Number
 Number of square

inches job will make for example

ncompositio

ofinchsquare2
inch square per  words20

manuscript in  words40,000
000=

To find the number of square inches you merely multiply the
length times the width.  If the type area is 4" by 5" then the
number of square inches would be 20.

They balance and counter balance in the placement of
various elements in a layout.

Whatever be the advantages of the decorations they are
never as important as the type; and the designer should not
allow their beauty or importance to die with the message
for the sake of attention. A precaution in the use of
decoration is, "Decorate constructions; do not construct
decorations." Decoration for the sake of decoration can
spoil the beauty of the design, instead of creating it. Any
exclamation from the reader relating to the beauty of the
decorative elements is sure proof that they are interfering
with the effectiveness of the message.  Remove all rules,
borders and ornaments then if you feel that something is
wanting, then use them.

Excessive ornaments may interfere with the legibility of the
letters. For this reason designers tend to prefer those
ornamental series which in their fundamental form are
close to the conventional proportions of the roman or italic
printed letters.  The only kind of ornamental letter which has
no place in book is that which is ambiguous or difficult to
recognize at a glance.

Remember that simplicity is the style of modern typogra-
phy.  It is not a must that we fill every blank space with some
decoration or ornaments.  Modern typography considers
that, white space is the bes decoration.
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Preparation of originals

Any matter to be reproduced graphically can be called an
original. It includes a wide variety of items such as,
manuscript, art pulls of types, india ink drawings, painting,
photographs slides, transparencies etc.  Great care and
accuracy is required in the preparation of the originals to
ensure precision and good result in reproduction.

Adhering to suggested ground rules, for good preparation
of the original, may prevent costly mistakes:

• Use clean, white, standard size paper to prepare
original according to the nature of the work.

• If manuscript, it should be legible. Typing should be
double-spaced, clean and on one side of the paper
alone and wide margins should be used.

• Corrections should be neatly made, using standard
proof reader's marks to prevent misunderstandings.

• Sheet should be numbered consecutively. If any addi-
tion or removal is done, proper notation should be made
on the preceding and succeeding page.

• Illustrations should be neatly drawn in india ink on white
drawing paper.  An art work in black and white should
not be rolled, folded, pinned or clipped as these marks
will appear in the reproduction. An over-flap or flap of thin
paper is pasted over for protection from dirt and dust.

• Glossy photographs are more suitable for reproduction
and scanning as they reflect light better.  Matt prints
reproduce badly.  Special care is needed to be keep
them devoid of pin arks, finger prints, scratches etc.
This applies also to transparencies.

• Squaring up, adding register marks, centre marks, trim
marks etc., are also essential steps in the preparation
of the original for reproduction.

• All originals should be prepared in a size proportionate
to that of the reproduction.

A particular process may require great contrast and tone
values of the original, while others may not demand so
much.  In certain cases excess enlargement or reduction
may take away the details of the original. Very small
original when unduly enlarged, will show graininees and
other defects magnified. So size and nature of the original
is also important. All these points must be taken into
consideration in assessing the suitability of originals for
reproduction.

Copy preparation

The copy for setting and reproduction should be typed in
double spacing, with ample margins.  Space for illustra-
tions is marked up.  Clear instructions regarding the size,
face, line measure, page depth, indention, notes, captions
etc., are also given specially. Copy preparation also
includes the careful checking of house style and consis-
tency in English usage, such as capitalization, italiciza-
tion, the treatment of affixes, punctuation, indention etc.
The illustration and photographs to be reproduced  also are
supplied along with the type script. While  the type-script
is clear and well spaced the photographs also should be
devoid of defects such as, folds, crease, pin marks,
scratches etc.

A copy prepare should edit the manuscript so thoroughly
that changes will be kept to an absolute minimum.  Fre-
quent changes, corrections or resetting can be time
consuming and costly.

 The following are points to be borne in mind while preparing
a copy:

• Correcting all misspelled words.

• Copy preparer should be proficient in spelling and
possess a good dictionary.

• Use consistent capitalization according to a set style.

• Correcting faulty punctuations.

• Compounding of words correctly and consistently

• Watch for coordination between reference in the text
and corresponding footnotes.

• Maintain uniformity and consistency throughout the
text.

• Checking the correct numerical order of figures and
alphabetical order of letters.

• See to illustrations to make sure that they are properly
placed, all accounted for and identified correctly.

• Observe rules on the use of number, whether they are
to be shown as figures or spelled out.

• Indicate styles of type, indention, length of line and
other markings.
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Preparation of Master
Master paper is a polyester plate for sheet-fed small offset
printing. It can be imaged on both sides directly through a
laser printer or copier and does not require any exposing or
processing. Just mount the plate on the press and print.
Master paper or poly master  is ideally suitable for long run
print applications such as Newsletters, Book Publication,
Forms and Literatures.

Features & Benefits
• Double sided plate to facilitate imaging & printing on

either side

• Inventive surface coating to give long run-length upto
10,000 impressions from each side of the plate

• scum-free background during start-up and press stop-
pages

• Innovative AntiGrease layer safeguards the surface
from finger prints or marks

• User-friendly QuicK cleaning treatment that ensures
that the plate fits closely around the cylinder, facilitating
quick make readies

• Universally compatible with most laser printers and
photo copiers#

Conventional v/s CtPoli Laser System

Poly master 

Press Proofs
Press proofs are the most accurate proofs, since they
simulate the final printed product using the actual ink and
paper stock you have selected for your job. They are
produced with actual plates mounted on a proofing press.
The two other options, digital off-press proofs and analog
off-press proofs, either are produced with products other
than printing ink--such as films or powders (for analog
proofs such as Matchprints and Cromalins) or dyes,
toners, or ink-jet inks (for digital proofs). Furthermore, they
are usually printed on paper stocks that differ in color or
surface texture from that used for the final product.

Press proofs can show how the color of the actual printing
paper will alter the ink colors and how the paper's texture
will affect the "feel" of the printed product. They also reflect
actual dot gain as well as show the true color of a duotone
(since digital proofing devices only simulate PMS colors
with 4-color process inks or toners).
Prepress
Prepress is the term to describe all of the processes that
occur before printing and finishing. Since many publica-
tions nowadays are published both in print and electroni-
cally, many refer to the shared processes as premedia
services instead.

Prepress Overview
The prepress processes that are listed below may take
place at one single location, such as a large publishing and
printing company, or at a variety of places. Usually some
tasks happen at a publisher while others take place at a
printer or a dedicated prepress company (which are some-
times referred to as service bureaus or trade shops).
Design: Since the advent of desktop publishing, many
people in the printing industry no longer consider design to
be a prepress task. The design process includes:
• Preparing data, which includes copyediting and prod-

uct photography, such as for a mail order catalog.

• Creating the layout is done using one of the leading
design application such as Adobe InDesign or
QuarkXPress. People outside the graphic arts commu-
nity may use tools like Microsoft Office or Publisher.
There is also a wide range of specialized applications
for tasks like database publishing.

• The correction cycle includes processes such as proof
reading and image retouching, for which Adobe
Photoshop is the leading application.

Preflighting: Before finished pages go through the re-
maining processes, a validation is done to check if all the
data meet the necessary production requirements.

Proofing: During the design phase there are already page
proofs being created. Proofs are usually also made by the
company that is responsible for the printing. This can be
done for internal checks of the impositioning (imposition
proofs) as well as for their customer who needs to sign off
the proofs for approval. More and more such proofs are soft
proofs that are evaluated on a monitor. Hardcopy proof-
ing remains popular when there is sufficient time for it and
for color critical or expensive jobs.

Imposition: Depending on the final output device a number
of pages will be combined into signatures.

Output to the final output device such as a digital press,
filmsetter or CtP device. To output data, pages or complete
flats have to be ripped or rendered. This process usually
also includes:
• transparency flattening: transparency effects such

as drop shadows behind text need to be resolved.

• color separation
• color management
• trapping
• screening
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Some people prefer to delay the above destination specific
conversions to the very last moment. This is commonly
referred to as late binding. Once a job is printed, its data
usually go into an archive.
Many of the above steps are nowadays heavily automated,
by either stand-alone applications or prepress workflow
systems. The automation also allows for more elaborate
communication processes:
• Exchanging data such as the final layout may still

happen using a physical carrier such as a DVD. In the
past people usually submitted the native data, meaning
the original layout file(s) and all associated images,
fonts and other data. Nowadays PDF files are often
used instead.

• Increasingly the internet is used for submitting jobs.
This is referred to as web-to-print.
• When the data exchange focuses purely on page

content, solutions range from using an FTP server or
e-mail system to using file sharing tools such as
DropBox or YouSendIt. A more sophisticated web
portal can add functions such as preflighting and
page approval.

• A digital storefront enables a printer to not just
capture page content but also order related informa-
tion. Such a system can also facilitate reorders and
allow print buyers to customize documents on-line.

• Job related data such as the job ID or run length are
exchanged between systems such as an MIS (Man-
agement Information System), a prepress workflow,
press control system and finishing equipment. Proto-
cols such as JDF allow systems from different vendors
to exchange the necessary data.

• Many projects nowadays are published using other
media besides print as well. The content of a magazine
may also be published on the web while the content of
a book is repurposed for e-books. There are special
tools and protocols such as XML to facilitate cross
media publishing.
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IT-ITES
DTPO - Bi-Lingual Software              Related Theory for Exercise 2.4.01

Installation of Multilingual Software
Objectives: At the end of this lesson you shall be able to
• practice installing Multilingual Sofware for Windows O/S
• practice Configuring for a particular script.

India is a unique country in the world having 22 scheduled
languages besides heritage languages and over one
hundred widely used languages with different scripts.
Despite a very impressive growth of computers and the
Internet over the past few decades, most of the content on
the Internet and most of the ICT based solutions in India
are still available only in English. This is in stark contrast
to hardly 10% of Indians who can use English as a
language for communication. It is realized long ago that
penetration of IT to masses is possible in India only if we
develop tools and technologies to overcome this language
barrier. Hence, for the last 25 years, it has been pursuing
pioneering research in Language Technology and Heritage
Computing. Technology Development for Indian Languages
(TDIL) Programme initiated by the Department of
Electronics & Information Technology (DeitY), Govt. India
has the objective to develop information processing tools
to facilitate human machine interaction in Indian languages
and to develop technologies to access multilingual
knowledge resources. Department of Information
Technology launched another major initiative called National
Rollout Plan to aggregate these software tools and to
make these available through a web based Indian Language
Data Centre (ILDC). This activity is being executed in
close coordination with CDAC, GIST, Pune, Maharashtra.
Under this user friendly software tools and fonts are being
made available free for public through language CDs and
web downloads for the benefit of masses.

Most of us require a lot of typing in regional language
scripts, for printing and emailing. Although there are
different methods for inputting Regional Language Script in
computer, the most widely used and favourite is undoubtedly
ISM, which is created by the C-DAC. It has to be said here
that the current Regional Language script typing standard
is UNICODE Fonts.

The availability of these software tools, fonts and resources
in local languages at no cost is intended to motivate
general public to use ICT tools and technology in their day
to day work like Word Processing, Presentation
preparation, Spread Sheets preparation, Web Page Surfing
& Designing, Messaging etc. in local languages. Further,
the consolidated availability of linguistic resources and
tools at one place will help researchers to carry out their
research in a smooth and efficient manner. Establishing
standards such as ISCII, Unicode, ISFOC, etc. for Indian
language applications on computers and electronic media.
It is also working for standardization of W3C (Languages
on Web), Internationalized Domain names, Governance,
linguistics formats, storage, input, display fonts, etc.

developed several True Type Fonts (TTFs) and Open Font
Format for various Indian Languages. For UNICODE support
in various applications, it has developed Open Type Fonts
for various scripts in all 22 official languages. Over 8000
fonts consisting of True Type, Open Type and Bitmap have
been produced so far.

Indian Language Tools

For printing most of the Indian scripts, one needs hundreds
of shapes, which may need to overlapped with each other.
The Matras can be attached on the top, bottom, left or right
of a character. It is possible to create all this variety easily
by hand. How easy would this be through a keyboard?

An English typewriter keyboard just had to provide for 26
keys for accommodating the lower-case and upper-case
alphabet, and a few more for punctuations, numerals and
special characters. A computer keyboard provides 47
keys for accommodating these English characters. Is it
possible to provide an overlay on these keys, for typing
characters in Indian scripts?

If a different overlay is required for each Indian script, how
will a person be able to learn different overlays for typing
the different scripts which he knows. Wouldn’t this create
a barrier in the use of different Indian scripts-hindering
national integration itself? Although we have declared
Hindi as our national language, it has not been accepted
as a functional language in several states.

The In-script keyboard overlay has achieved, what was
earlier thought as not possible. It allows all the Indian
scripts, to be typed in a uniform manner. This means that
a person knowing how to type in one script can immediately
typing any other, since the keystrokes remain the same.
The inscript overlay always generation of hundreds or
thousands of character combination which may exist in a
script, by typing just the basic alphabet which gets easily
accommodated on an English keyboard.

The inscript overlay could achieve this miracle, by making
use of the fact that there are less than 70 basic letters in
any Indian script. Although the exact number of letters
may vary in each script, they are all similar, since they
originated from the same ancient script Brahmi. Brahmi
letters, had the vowels and consonants, categorized on a
scientific and phonetic basis.

To enable development of Indian language applications
with greater ease, there are several tools
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• Intelligent Script Manager (ISM) for 19 Indian
Languages

• Sree Lipi for 12 Indian Languages

• Font Suvitha Professional for many Indian
Languages

• PATRIKA for many Indian Languages

• iLEAP for many Indian Languages

• LEAP Office for many Indian Languages

• ISM Office for many Indian Languages

• ISM Publisher for many Indian Languages

• ISM Soft for many Indian Languages

• INDICA for many Indian Languages

• ELANGO for Tamil

• PONMOZHI for Tamil

• VANAVIL for Tamil

• BARAHA for many Indian Languages

• THOOLIKA for Malayalam

• LEKHINI for Telugu
As per e-Governance standards of character encoding for
Indian-languages, all government web applications should
be in Unicode. Standardization is one of the baselines to
be followed in localization. Standardization means to
follow certain universally accepted standards so that the
developers from any part of the globe could interact
through the application. The worldwide encoding standard
“Unicode” provides code points to every alphabet of the
world.

All the major operating systems, browsers, editors, word
processors and applications and tools are supporting
Unicode so it is necessary to use Indian languages and
scripts in the Unicode environment, which will resolve the
compatibility issue.

Laclisation is the process of adapting software for a
particular country or region. For example, software must
support the character set of local language and must be
configured to numbers and other values in local format.
Localising a word processor or DTP software might
require adding new spell checker that recognizes the
words in local language scripts.

With the mandate given by the Government of India for the
Rupee sign, now ISM introduced Rupee sign in both
Inscript and QWERT keybaord overlays for all 20 Indian
official languages

Unicode

It is an international encoding standard for use with
different languages and scripts, by which each letter,
digit, or symbol is assigned a unique numeric value that
applies across different platforms and programs.

Unicode is intended to address the need for a workable,
reliable world text encoding. Unicode could be roughly
described as “wide-body ASCII” that has been stretched to
16 bits to encompass the characters of all the world’s living
languages. In a properly engineered design, 16 bits per
character are more than sufficient for this purpose.

Unicode provides a unique number for every character,

• no matter what the platform
• no matter what the program
• no matter what the language

The Unicode Consortium was founded to develop, extend
and promote use of the Unicode Standard, which specifies
the representation of text in modern software products and
standards. The Consortium is a non-profit, charitable
organization.

Notable addition to Unicode include Arabic, Armenian,
Cyrillic, Devanagari, Georgian, Greek, Gujarati, Gurumukhi,
Hebrew, Kannada, Latin, Malayalam, Oriya, Tamil, Telugu,
Thai, Tibetan etc.

ISM Publisher V6

The latest ISM V6 is completely UNICODE compliant
which offers support for Open Type fonts. ISM V6 will cater
to diverse user requirements from word processing,
database applications, web-based applications, publishing
and even custom built software, said a press release.

The ISM V6 is UNICODE compliant and comprises of ISM
Office, ISM Publisher and ISM Soft and supports 19 Indian
languages such as Assamese, Bengali, Gujarati, Hindi,
Kannada, Marathi, Malayalam, Oriya, Punjabi, Sanskrit,
Tamil, Telegu, Manipuri, Nepali, Konkani, Bodo, Santhali,
Maithili, Dogri besides English. It also has a rich collection
of designs and clip arts. It also include an enhanced
spellchecker for Open Office and MS Word macros like
Find-replace, keyboard shortcut, convert macro,
spellchecker, synonym dictionary and Official language
dictionary available for documents in open type font.

Most ISM utilities now have Bilingual font implementation.
This means that the same font contains both English and
Indian language capability. It is not necessary to select a
different font for English and Indian scripts. The Script
toggle key will automatically switch between the two. This
facility is particularly useful in applications such as
Spread Sheet and Database programs that allow only one
font to be selected at a time and where bi-lingual data is
to be displayed.
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The ISM is supplied with Dongles. A dongle is a piece of
hardware that attaches to a computer and allows a piece
of secured software to run. The device does not contain the
software in its entirety, but rather is an electronic key that
unlocks the program on a computer. In most cases, it is
used as an anti-piracy measure, since making a copy of
the hardware is much more difficult than copying the
program itself.

Installing the ISM software

It is recommended that you close all other programs while
running the ISM V6 Installer. To install the software, insert
the ISM V6 CD in the CD-ROM drive.Most of the systems
are enabled for CD autorun. This will initiate the installation
process automatically. However if the installation does not
start automatically, run setup.exe.

The Installation program is interactive. It will prompt you for
the requred information and guide you through the entire
installation.

Most of the utilities and fonts in your ISM V6 distribution
CD-ROM are in encrypted and compressed form. During
installation the ISM V6 installer will automatically decrypt
and uncompress these files while copying them to your
hard disk.

The following table lists utilities and fonts that get installed
with ISM V6.

• Clip Art Viewer
• Configurable Keyboard
• Font Previewer
• ISM and HTML Converter
• Data Migration System
• Official Language Dictionary
• Name Trans
• ISM api Help
• Kbd api Help
• ISM Editor
• MS Office Macros
• Star Office 6.0 Macros
• Open Office Macros
• Fonts

Before beginning to install ISM V6, set the macros
security settings in MS Word to set 'low'. ISM V6 comes
with a collection of utilities that can be used with MS Word
and MS Excel. True Type Default fonts of all languages
along with two Open Type Fonts also installed.

Font Types in ISM

1. Open Type (OT) Fonts

Open Type fonts support UNICODE data. You require
Windows OS and Language Pack installed in your system
in-order to use Open Type Fonts. An Indian language
Open Type font can be used in various applications which
support UNICODE for complex scripts such as those by
Indian Languages. These are 16 bit fonts and so require
the latest OS and applications to work.

2. TrueType Fonts

These are single files using the extension .TTF. You can
use a TrueType font on any computer running Windows.
An Indian language True Type font file consists of information
about character shapes, also known as glyphs. One or
more glyphs from the true type font file are used to form
Indian language characters.

ISM V6 works with USB based Dongle. These are
especially useful in modern-day systems and laptops.
ISM V6 can also be alternatively used with a hardware lock
which can be connected to your computer's parallel port
for using the ISM V6 package. Your printer cable can be
connected after this dongle. This does not affect the
normal functioning or performance of any of your system's
hardware or software. If you have two parallel ports, you
can install the dongle in any one of them and the other can
be used to install the printer's cable. Do not remove or
attach the dongle when your computer is switched on.
Also make sure that your printer port is configured for a
"Centronics" parallel port.
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2. ISFOC Fonts

The aesthetic quality of the displayed text output depends
on the number of unique shapes available with the font.
Fonts cater to a heterogeneous range of applications. For
e.g. the publishing industry requires very high quality
display, but does not need support for English characters,
where as a data entry software would require bilingual
support from a single font. Web data poses other specific
requirements on fonts. With these considerations in mind,
ISM V6 supports 6 font types.

2.1.1. ISFOC Bilingual Web

This font is similar to the bilingual font. In addition, it is
optimized for web applications. This font type is especially
useful for developing Indian language applications and
static or dynamic web pages. The Monolingual and Bilingual
web fonts can be used in web as well as non-web
application areas with equal effectiveness.

2.1.2 ISFOC Bilingual

A bilingual font is one, which has glyphs for one Indian
language script along with glyphs for English. With this
font you can create content that contains Indian language
as well as English text without having to change the font.

2.1.3 ISFOC Monolingual Web

This font is similar to the monolingual font. This font is
additionally optimized for web applications. It is recommend
Desktop Publishers, web content creators, who don’t
require bilingual text, but require high quality monolingual
text, to use this font type.

2.1.4 ISFOC Monolingual

A monolingual font has glyphs for only one script. This
allows the font to have a large number of unique glyphs for
a particular script. This font type produces high quality
output and should be used for DTP applications.

2.1.5 ISO Bilingual

ISO Bilingual fonts are recommended for use where
Bilingual support is required in special applications such
as Oracle Forms, .Net, etc. Note that all languages are not
supported under ISO Bilingual.

2.1.6 ISO Monolingual

ISO Monolingual fonts are recommended for use where
Monolingual support is required in special applications
such as Oracle Forms, .Net, etc. Note that all languages
are not supported under ISO Monolingual.

2.1.7 Printer Outline (.PFB)

The printer outline contains the information for printing a
smooth font of any size. Adobe Type Manager (ATM) also
uses the printer outline to create smooth fonts on the
screen of all sizes.

2.1.8 The Metrics File (.PFM)

The metrics file contains measurement information for the
font. Always keep these two files together so that the font
prints and displays properly.

ISM Conventions (ISFOC Script Mnemonic)

Each script is given a two letter mnemonic in ISM V6,
which are the first two characters of all the ISFOC fonts.

The ISFOC Script Mnemonics are:

Mnemonics Language
AS Assamese
BN Bengali
DV Devanagari
EN English
GJ Gujarati
KN Kannada
ML Malayalam
OR Oriya
PN Punjabi
SD Sanskrit
TM Tamil
TL Telugu
BRXOT Bodo
DGROT Dogri
KONOT Konkani
MAIOT Maithili
NEPOT Nepali
SATOT Santhali

ISFOC Font Naming Convention

ISM V6 comes with two types of fonts, namely True Type
and open type. An ISFOC font file name can have 8
characters. The first two characters in the font file name
constitute the script and font type mnemonic. For example,
here DV indicates Devanagari, similarly KN indicates
Kannada.

Mnemonic Script Font Type
DV Devanagari Monolingual
DVB Devanagari Bilingual
DVW Devanagari Monolingual Web
DVBW Devanagari Bilingual Web
DVOT Devanagari Unicode
TM Tamil ISFOC Monolingual
TMB Tamil ISFOC Bilingual
TMW Tamil ISFOC Monolingual Web
TMBW Tamil ISFOC Bilingual Web
TMOT Tamil UNICODE Unicode

IT&ITES: DTPO - Related Theory for Exercise 2.4.01



254

Windows explorer will display the font file as
DVYG0NTT.TTF, whereas the application menu
will display the font as DV-TT Yogesh.

Introduction to Digital Printing

Digital printing refers to methods of printing from a digital-
based image directly to a variety of media. It usually refers
to professional printing where small run jobs from desktop
publishing and other digital sources are printed using large
format and/or high volume laser or inkjet printers. Digital
printing has a higher cost per page than more traditional
offset printing methods, but this price is usually offset by
avoiding the cost of all the technical steps required to
make printing plates. It also allows for on-demand printing,
short turn around time, and even a modification of the
image used for each impression. The savings in labour and
the ever increasing capability of digital presses means
that digital printing is reaching the point where it can
match or supersede offset printing technology's ability to
produce larger print runs of several thousand sheets at a
low price.

The process

The greatest difference between digital printing and other
methods such as letterpress, lithography, flexography or
gravure is that there is no need to replace printing plates
in digital printing, whereas in analog printing the plates are
repeatedly replaced. This results in quicker turnaround
time and lower cost when using digital printing, but
typically a loss of some fine-image detail by most
commercial digital printing processes.

In digital printing, an image is sent directly to the printer
using digital files such as PDFs and those from graphics
software such as Illustrator and InDesign.

Without the need to create a plate, digital printing has
brought about fast turnaround times and printing on
demand. Instead of having to print large, pre-determined
runs, requests can be made for as little as one print. While
offset printing still often results in slightly better quality
prints, digital methods are being worked on at a fast rate
to improve quality and lower costs. In other words, it is
printing without a printing press, without printing plates.

Offset, or conventional printing, has changed little since
the original steam powered offset press was first developed
in 1906. It involves a mechanical process of applying
layers of ink to paper with a series of rollers. Each roller
has its own specified ink – Cyan, Magenta, Yellow and
Black — or CMYK. As each of these rollers pass over the
page, they transfer ink and build layers of colors, resulting
in complete images and text on the page. Additionally,
specialized colors called Pantones or PMS colors can be
added to the layout if very specific colors are needed, for
instance in a logo.

Digital printing eliminates the numerous steps involved in
the offset printing process, such as creating films and
plates for ink rollers. Most digital presses today apply ink
in a single pass from a single ink head, similar to common
inkjet printers found in homes and offices.

Examples of Digital Presses are:

¨ Technova Pamex
¨ Konica Minolta Bizhub Presses
¨ Kodak Prosper
¨ Xerox iGen4
¨ Xerox Nuvera
¨ DocuTech

IT&ITES: DTPO - Related Theory for Exercise 2.4.01



255

To begin using ISM with any application software, for
example with Adobe PageMaker 6.5 or 7.0, First we can
load the application software, here it is Adobe PageMaker.
And create a new file by using File --> New command.

Later goto ISM and choose script you want to enter,
Keyboard overlay to be used, selection of Toggle key and
Font type as shown below. Then select the Font from the
Adobe PageMaker. Switch on the toggle key to begin
typing. When there is a need to enter any English scripts
in between, proceed clicking on Toggle key to switch over
to English.

IT-ITES
DTPO - Bi-Lingual Software Related Theory for Exercise 2.4.02

Working with multilingual software
Objectives: At the end of this lesson you shall be able to
• practice working with multilingual software with application software
• practice working with multi scripts in the same page.

Keyboards in ISM V6

ISM V6 allows you to type with keyboards of your choice.
The keyboards supported by ISM V6 are INSCRIPT,
Phonetic, Easy Phonetic and numerous other popular
typewriters. ISM V6 also allows you to configure your own
keyboard.

But it is recommended to use any one of the Keyboard
overlay to expertise in Regional Language Script entry.

INSCRIPT

The INSCRIPT (Indian Script) keyboard overlay was
standardized by Department of Electronics (DOE) in 1986
with a subsequent revision in 1998. This keyboard overlay
is phonetic in nature and has a common layout for all the
scripts provided with this software. The INSCRIPT overlay
contains characters required for all the Indian scripts, as
defined by the ISCII character set. The Indian script
alphabet (ISCII) has a logical structure derived from the
phonetic properties of the Indian scripts. The INSCRIPT
overlay mirrors this logical structure. Due to the phonetic
nature of the keyboard, a person who knows typing in one
Indian script can type in any other Indian script. The logical

structure allows ease in learning. Most modern operating
systems come with Inbuilt support for INSCRIPT layout.

Phonetic English
This keyboard overlay, has the Indian script alphabets
phonetically assigned to that of English alphabets on the
IBM-PC QWERTY overlay. This keyboard is useful for
people who are acquainted with the language

Typewriter

Typewriter keyboard overlay functions in the same manner
as the manual typewriter. Users accustomed to working
with a typewriter can use this facility with minimal learning
and training time.

Easy Phonetic English

This is special Keyboard Layout designed by
C-DAC, same as Phonetic English Typing for Indian
languages. This makes Typing in Indian languages very
simple for anyone who know english Typing.

Indian Language Scripts or Indian Language
Alphabets can be divided into Vowels,
Consonants, Conjucts, Vowel Diacritics
(Matras), Halents etc.

Custom Keyboard

Besides a wide range of keyboards to choose from,  ISM
V6 additionally provides users with a facility to create fully
customized keyboards.

Language & Scripts in India
Hindi is spoken as a mother tongue of majority of the
population, mainly in the area known as the Hindi belt
comprising Bihar, Madhya Pradesh, Rajasthan,
Chhattisgarh, Uttarakhand, Uttar Pradesh, Haryana
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Jharkhand, Arunachal Pradesh and Himachal Pradesh. It
is the official language of the Indian Union and the above
states. Hindi is also spoken in Nepal. Devanagari is the
script used to write Hindi, Nepali, Marathi, Konkani, Bodo
and Maithili and some other languages and dialects of
India.

Assamese is the state language of Assam and is spoken
by nearly 65 to 70% of the State’s population. The origin
of this language dates back to the 13th century and also
spoken in Arunachal Pradesh. This is written in Assamese
script which is similar to Bangla script.

Bengali (Bangla) is spoken by nearly 200 million people in
the world. It includes in West Bengal, Tripura, Assam,
Andaman & Nicobar Islands, Jharkhand, Bihar and in
Bangladesh. It developed as a language in the 13th
century and is the official state language of the eastern
state of West Bengal and Tripura. This is written in Bengali
script.

Gujarati is the state language of Gujarat and is spoken by
70% of the State’s population. It is Indic in origin and
branched out from the Indo-European group of languages.

Kannada is the State language of Karnataka and is
spoken by 70% of the State’s population. Kannada is
written in Kannada script.

Kashmiri is a language written in both Persio-Arabic and
Devanagri script and is spoken by 55% of the population
of Jammu and Kashmir.

Konkani, principally based on classical Sanskrit, belongs
to the south western branch of Indo-Aryan languages. It is
spoken in the Konkan region covering Goa and parts of the
coastal regions of Karnataka, Kerala and Maharashtra.
But it does not have its own script.

Malayalam is a Dravidian language, spoken by the people
of Kerala, Lakshdweep and parts of Puducherry. It is an
ancient language and is thousands years old and written
in Malayalam script. Malayalam is also spoken in Bahrain,
Fiji, Israel, Malaysia, Qatar, Singapore, UAE and  Saudi
Arabia.

Marathi is an Indic language dating back to the 13th
century. It is the official language of the western state of
Maharashtra and also spoken in Goa. This is also written
in Devanagari script.

Oriya, the state language of Orissa is spoken by nearly
90% of its population and written in Oriya script.

Punjabi is an Indic language and is spoken in the state of
Punjab. Although based on the Devanagri script, it is
written in the 16th century script called Gurumukhi,
created by the Sikh Guru, Angad.

Sanskrit is one of the oldest languages of the world and
also the language of classical India. All the classical
literature and the Indian epics are written in this language.
Sankrit is also written in Devanagari script with slight
variations.

Sindhi is spoken by a great number of people in the
Northwest frontier of the Indian sub-continent comprising
parts of India and Pakistan. In Pakistan, the language is
written in the Perso-Arabic script, while in India in the
Devanagri script.

Tamil, an ancient Dravidian language is at least 2,000
years old. It is the state language of Tamil Nadu, Puducherry
and Andaman Nicobar Islands and is spoken by at least
165 million people around the globe. Tamil is also spoken
in Sri Lanka, Malaysia, Singapore and Mauritius and
written in Tamil script.

Telugu is also a Dravidian language and is the spoken by
the people of Andhra Pradesh, Telangana and parts of
Puducherry. Telugu is written in Telugu script.

Urdu is the state language of Jammu and Kashmir and it
evolved with Hindi in the capital of India, Delhi. Urdu  is also
spoken in Pakisthan and Middle East. Urdu is written in
the Persio-Arabic script and contains many words from
the Persian language.

English is also spoken in most of states of Indian Union
and used as the Languages for Inter state communication.
English is the officail state language of Mekhalaya,
Nagaland, Manipur, Andaman & Nicobar Islands,
Chandigarh,  Dadra & Nagar Haveli and Lakshadweep and
is spoken by 5% of the Indian population. But 28% to 30%
of the Indian population deals with English scripts.

Feature of ISM V6

• Macros for Open Office and MS-Word,  find-replace for
regional scripts, keyboard shortcuts, script converters,
spellcheckers, synonym dictionary, official language
dictionary etc. are available. The mail merge feature is
now also available in UNICODE also.

• UNICODE sorting of data in Excel, Calc through
macros

• Enhanced spellcheckers in Hindi, Gujarati, Bengali &
Malayalam are available.

• Features like insert date & time facility, number to
word conversion etc.

• Easy phonetic keyboard.
• Apart from BIS standardized INSCRIPT keyboard

support for popular keyboard layouts like typewriter as
well as custom designed layouts available.

• On screen keyboards to expedite content creation and
facilitate learning etc.

• Range of aesthetic assortment of True Type fonts,
symbols, borders and cliparts.

• Publish content on the web using applications like MS
Front Page, Flash, Dreamweaver etc.

• Supports popular publishing software such as
CorelDraw, PhotoShop, Adobe Illustrator etc.

• Indian languages in mailing through ISM-Mail.

IT&ITES: DTPO - Related Theory for Exercise 2.4.02



257

Historically, India has been a multilingual country. Today,
the India Constitution officially recognizes 18 languages
and ten different scripts used in different states / regions
spread across the country.

Despite the plurality of languages and scripts, the
underlying grammar is largely similar across languages
with a common vocabulary of 40 to 80 percent. Hence
translation from one script to English and English to
regional language script is necessitted.

C-DAC provided the solution to us by introducing nTrans.

nTRANS Software

nTrans can be used for converting English names to Indian
language in ISCII and vice versa.

It is possible to convert either a single name at a time or
an entire file of data from either English to ISCII or from
ISCII to English. All names in a file must be either in
English or in ISCII.

The utility also allows the user to build and update a
Personal Dictionary where the user can store preferred
conversions.

If the source file contains data in English, two ouput files
with data converted to ISCII and ISFOC respectively are
generated.

While, if the source file contains names in ISCII, the output
file generated will contain data in English.

The utility appends "_Isc.txt" to the output file with ISCII
data and "_Isfoc.txt" to the output file with ISFOC data.
"_Eng.txt" is appended to the output file containing English
data (in case of ISCII to English conversion.).

To view the converted data, click on View English Output
if your source file is in ISCII. Click on View ISCII Output or
View ISFOC Output if your source file contains names in
English.

nTrans uses its default dictionary to convert names from
ISCII to English and vice versa. To bring the accuracy of
nTrans closer to your requirements, you can store preferred
conversions or customized conversions for specific names
in the Personal Dictionary. The utility will then use the
preferred conversions or customised conversions whenever
it encounters the specified names.

IT-ITES
DTPO - Bi-Lingual Software Related Theory for Exercise 2.4.03

Working with advanced tools & settings of ISM
Objectives: At the end of this lesson you shall be able to
• practice creating conjects in regional language scripts
• inserting special characters.

For example

The default dictionary of nTrans will give the English
conversion for the name  as "jagdish". However
you may prefer the converted output to be "jagadish" or
"jagdeesh".

Please note that the utility will take a longer time to do
conversion as the custom dictionary increases in size.
The total number of words that users can add to the
Personal dictionary is about 4000 words. By default the
personal dictionary is empty. Personal Dictionary does
not accept duplicate entries; new entry will replace old
entry. Commonly used acronym such as Dr., Mr., Mrs. are
available as an inbuilt feature.

Figures to Words Conversions

This utility allows users to convert numbers, date and time
into words in Indian language and transfer the converted
data on to UNICODE enabled documents or editors. The
data gets converted to the language that has been specified
in Language on the ISM V6 user interface. The font type for
data transfer is as specified by user on the ISM V6 user
interface. Various formats for Date and Time are also
supported.

Font Previewer

ISM V6 is packaged with a plethora of aesthetic TT and OT
fonts and symbols. To save disk space, the installation
program installs two most commonly used fonts for each
language by default. Additional TT fonts are located at

CD Root:\Fonts\Language\TTFonts.

Using the Font Previewer tool, users can install/uninstall
additional fonts. The Font Previewer also provides facility
to preview a font before installing it.

Font Previewer can be accessed from the ISM V6 user
interface or from Windows Start menu, through Tools in
ISM V6 Publisher.

The Font Previewer can be used to install or uninstall only
True Type fonts and Open Type fonts.

Monolingual and Bilingual data is not supported under
Windows Vista Operating System. For Windows Vista, it
is recommend using Web fonts or Open Type fonts
(wherever supported).

Uninstalling Fonts

Type Face Name on Remove Fonts page displays fonts
installed on the system. Select the fonts you want to
uninstall and click on Remove Fonts button. A preview of
the selected font will be displayed in the preview pane.
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ISM V6 comes with a plethora of fonts and symbols. The
installation program installs two most commonly used
fonts for each language, by default, for all types of
installations.

These fonts do not get installed automatically through the
installation program. The user can install extra fonts in
from the Control Panel.

Clip Art Viewer

Lists various available categories of clip-art. Select a Clip-
Art Category to view a list of available cliparts in the Clip-
Arts list.

This lists various clip-arts within each category. You can
select a clip-art from this list to display it in the preview
window. Clip-arts are available as .jpg format files. Clip
Arts Viewer permit us to browse, open, copy, save,
changing attributes etc.

Floating Keyboard

The Floating Keyboard is a handy typing tool developed
especially for users who are not comfortable with the
keyboard overlay. The Floating Keyboard is also useful for
keyboards that do not have a printed overlay. The Floating
Keyboard facilitates typing by displaying on the screen,
the layout of the selected keyboard (INSCRIPT, Phonetic,
Typewriter or Customized) for the selected language and
font type.

The Floating Keyboard resides on top of all applications
running on the system.  Floating keyboard is placed in
system tray when minimized.

When toggling between applications you need to click on
the active application each time before you can use the
Floating Keyboard.

To type a character key that is located in the Shift position,
press down the Shift key of the physical keyboard or the
floating keyboard.

IT&ITES: DTPO - Related Theory for Exercise 2.4.03
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IT & ITES
DTPO - Printing and publishing                         Related Theory for Exercise  2.5.01
Classification of Printers
Objectives : At the end of this lesson you shall be able to
• explain impact and non-impact printer
• determine the importance non-impact printers
• illustrate with diagram thermal printer.

Printers can be categorized as:

• Impact printers

• Non impact printers

• LASER - Light Amplification Stimulated Emulsion By
Radiation

• LCD - Liquefied Crystal Diode
• LED - Light Emitting Diode

IMPACT PRINTER - In an impact printer printing heads
strikes and imaged on a paper. In impact printer printing
heads marks the sheet (paper) by impact against a ribbon
as in Tele type printer, Line printer, Dot matrix printer,
Daisy wheel printer.

NON - IMPACT PRINTER - We divided non impact
systems into inkjet printer and eletronic printer (laser
printer) used as an output to work in D.T.P.

Non-impact printer - There are countless methods of
actually transferring a rasterized image to paper. The
contending technologies can be broadly grouped into non-
impact systems and conventional process that have been
modified to accept direct digital imaging of the printing
surface (the term "non-impact" was originally coined to
describe computer printers that did not employ printing
heads that marked sheets by impact against a ribbon, as
do Tele type printer,  Dot matrix printer and Daisy wheel
printer) for convenience, we have divided the non-impact
systems into inkjet (where a liquid ink is propelled onto the
paper); electrostatic ( where a wax or dye colorant is
transferred to the paper by heat).Further we can add a
thermal technology for broad scenario. The classification is
something of a simplification, and many devices do not fit
neatly into one or other of the categories proposed.

All non-impact printers (system) have three basic compo-
nents:-

a) A RIP

b) A buffer

c) A marking engine

a) A RIP:- A raster image processor to convert the image
into a bitmap suitable for the printer.

b) A buffer:- A buffer that holds the rasterized image in
memory ready for printing.

c) A marking engine :- A marking engine that transfers
colorant to the substrate.

The RIP may be located within the printing device itself, or
externally in a separate hardware RIP or in the host
computer (Main computer that attached directly to the
printer). In some cases, the printing speed of the marking
engine can be as high as that of a small conventional
printing press, but in practice, the speed may be limited by
the capabilities by the RIP and the page buffer.

Inkject printer

Inkjet printers generate ink droplets, either by forcing a
continuous stream of ink through a nozzle (with the
unwanted droplets deflected electro-statically to a waste
gutter) or by dropellng droplets on demand according to the
image requirements. Drop-on-demand desktop inkjet print-
ers propel ink by thermal or piezoelectric methods.

Thermal inkjet (or bubble jets) printer heat a tiny amount of
ink until it vapourizes, its expansion forcing liquid ink
through an aperture (setting a shape) at a high speed, while
piezoelectric (or phase change) systems rely on the
properties of quartz and ceramic material (used to give
shape image) to change shape when a charge is applied,
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mechanically forcing ink out through an oppening/
nozzle.Most systems are effectively binary-droplets tha
cannot vary in size but some continuous inkjet  printer have
the ability to send several droplets to the same location on
the paper, resulting in the droplets merging and spreading
as they arrive at the paper surface.The number of droplets
that can be sent to the same spot determines the number
of gray levels that the process can achieve.

Most desktop inkjet printers can produce resolutions
comparable to low-end laser printers, at around 300 dpi. At
this resolution, working at upto 20,000 cycles per second,
a twelve jet array takes a minute or show to print a single
page. The lower resolutions and faster droplet generation
of pres-mounted continuous ink inkjet allow them to print
at the full production speed of the press, which may be as
much as 70,000 copies per hour.

Inkjet devices can print on most papers, although drying is
slow on stocls with low absorbency, and wicking (an ink
which is spread  into the fibres inside) can occur on highly
absorbent materials newsprint.

Desktop color inkjet printers produce color documents and
visualization proofs, but higher resolutions are needed for
approval proofs, and even these can not reproduce the
halftone screen exactly as it will appear in the final printed
job.With some color inkjet devices, the the ink used is solid
at room temperature and briefly liquifies as it is heated prior
to printing.It then re-solidifies immediately upon reaching
the paper, providing a sharper image and stronger color
since the paper does not absorb this ink at as it would any
normal liquid ink.

Electrostatic printer

Electostatic printers, covers photocopiers, laser printers,
LED printers , LCD printers and other printing devices that
employ the Xerography principle of using an electrical
charge to attract the image areas.A pattern of charged
areas corresponding to the image that is to be printed is
created on a dielectric drum (OPC-Organic Photo
Conductor).Toner with an opposite charge charge is brused
over the drum,where it adheres only to the image areas and
is then transferred to the paper.

Inkjet printer diagram

The image is formed on the drum by the first applying a
charge to the whole drum.A high-intensity light source
scans across the surface, switching on and off according
to the image requirementsand the charge dissipated wher-
ever light falls on it. In a photocopier, the light is reflected
from an original resting a platen through a lens on to the
drum, while, in a laser-printer, the light sources are laser or
LED or LCD devices driven by digital image data which is
sent by computer system.

Basic laser printer components

Schematic of a laser printer

Laser printers usually have resolutions of 600 dpi,although
4800 dpi now technically feasible.

Toner particles size around 10 microns and the resolving
powder of the transferred drum set the ultimate upper limit
of the possible resolution.High microns of toner particles
having less dpi and low microns of toner particles have
more/high dpi.High resolution electrostatic system using
liquid toner(instead of solid particles) produce high quality
color print but they are more expensive than solid toner
system.Toner particles size (aroun 2 microns) is smaller
than solid toner.

Laser printer

A typical laser printer that utilize a laser beam to produce
an image on a drum.The light of the laser attracts the
electrical charge on the drum whenever it hits.The drum is
then roll through a reservoir of toner which is picked up by
the charged portion of the drum.Finally,the toner is trans-
ferred to the paper through a combination of heat or
pressure.
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LED

The difference is only the method of the light distribution in
LED printers.LED printers function by the beam of an array
of LED  builts into the cover of the printer that usually more
than 2500 covering the entire width of the drum which
creates an image when shinning down at 90°. The number
of dpi depends upon the number of LED. If the printer prints
600 dpi than the printers have 600 LED per square inch.

LCD

LCD printers using a similar principles only differences is
the light source. Liquid crystal panels is used as a light
source in place of laser on LED matrices.

Thermal printer

The 'Thermal printer' covers a very wide variety of different
techniques but the following two are of particular impor-
tance:

a) Thermal transfer

b) Dye sublimation

Both type use semi-conductor resistor to heat the colorant
so that it can be transferred to the paper.

a) Thermal transfer -  In the thermal transfer, the colorant
is effectively melted onto the paper,like a miniature version
of wax sealing.

b) Dye sublimation - The dye sublimation printing,the
colorant is vapourized before transfer to the paper.

Thermal system that produces binary images does not
have adequate resolution (dpi) to form halftone screens and
instead uses coarse dither patterns to reproduce continu-
ous - tone images.

By applying a variable voltage to the resistors in a dye-
sublimation printer, different densities of colorant can be
transferred to give a gray scale instead of binary image.

The dye of three primary colors (black is often unnecessary
due to high density of the CMY solid overprint) combines,
resulting in a continuous-tone image very similar to the
photographic point. Dye-sublimation systems of this sort
do not simulate a halftone dot when used for proofing, and
because a continuous-tone image is produced a resolution
of around 300 dpi is adequate.

Dye-sublimation printers produce brilliant, saturated col-
ors. The  slow down speed of output makes them suitable
mainly for one-off print such as color proofs, print from
digital cameras, and presentation materials. Special pa-
pers are required for most systems.

For longer runs, electrostatic systems are currently the
most successful technologies, with speeds that approach
conventional lithographic printing. In the future it is possible
that inkjet may emerge as the most viable digital printing
technology, but at present the difficulty in achieving ac-
ceptable resolution at high production speeds excluding
inkjet from color printing at speed.

 

 

 

 

Digital color presses are faster to set up than conventional
presses since there is no need to adjust position or inking
levels. The current thermal electrostatic printing technolo-
gies includes-

i. Dry Electro Photography - With pigmented toner pow-
der as the printing media.
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ii. Liquid Electro Photography - With pigment particles
suspended in a liquid.

iii. Phase-Change Electro Photography - With pigment
suspended in a waxy solid that is briefly liquefied during
image transfer.

Some important notes

a. Inkjet Printer - Both speed and dpi low.

b. Thermal Printer - Speed low and dpi high.

c. Electrostatic Printer - Both dpi and speed high.

• Sublimation - Direct from solid to gas state is called
sublimation.

Merits of inkjet printer
• Colour printing is possible

• Print quality is good

• Noiseless

• Printing speed is high

• Most models are relatively light weight and compact so
they don't take up too much space on the desk

De-merits merits of inkjet printer

• Not be the printer of choice for everyone, Due to the cost
of ink, running an inkjet printer over time is a more
expensive than a laser printer.

• Prints emerge from the printer slightly wet and may
need time to dry.

• Printing is slower and therefore inkjets aren't designed
for high volume printing. Ink cartridges spill out tiny
droplets of ink to print, the resolution is lower than that
of laser toners

Merit of laser printer

• High quality printouts - better than ink-jet or dot-matrix

• Fast printouts - faster than ink-jet or dot-matrix

• Prints very quietly - quieter than ink-jet or dot-matrix

• Cost per page is low - cheaper than ink-jet or dot-matrix

De-merit of laser printer

• Most expensive printer type to buy, especially colour
lasers.

• Toner is more Expensive than inkjet printer.

• Expensive to repair -lots of complex equipment inside.

• Larger in size than inkjet printer.
Binding

Book are repositories of knowledge and wisdom. They are
mirrors of our culture and civilization. Books are records of
our history and have been treasured and preserved from
time immemorial. If binding is not done adequately and
securely, in the required style and strength, the whole
labour in designing and publishing a book may go waste,
the product will not last long. The shape of book gave rise
to the need of binding. Binding, therefore was and is needed

for saving books for as long a period as possible. The main
purpose of the binding is to hold pages of a book together
and protect them.

Sheets of paper are bound together in several pages by
different ways. Methods of binding are important to use and
like of the book. Some are designed for low cost and short
life. Others for long life and hard use. Methods of binding are
classified into five types. They are:

Mechanical binding

In this type of binding some mechanical devices are used.
Three common mechanical binding methods are spiral
binding, comb binding, and wire 'O' binding. In these
binding method, holes are punched by the punching
machine to accommodate the consumable such as spiral,
comb, wire etc. These are mainly mainly used for short life
publication such as business reports, meeting reports etc.

Examples

• Spril binding
• Comb binding
• Wire 'O' binding
Loose leaf binding

This binding method permits ease in add and removing
sheets. Three common loose - leaf binding are ring binder,
post binder and friction binder. The ring binders and post
binders are widely used in accounting filed. Friction binding
is a plastic 'U' shape strip clamping the paper edges.
Booklets of few pages are suitable for this binding method.

Examples

• Ring Binder
• Post Binder
• Friction Binder

Wire staple binding

Two common wire staple binding are saddle wire binding
and side wire binding. Saddle wire method is used to bind
periodicals and small booklets. Side wire binding is used
for thicker magazines and book.

Examples

Saddle wire binding
Side wire binding
Perfect Binding

This binding does not require sewing. Sheets of paper are
held together by flexible and heat sensitive adhesive. PUR
(Poly Urethane Adhesives) is relatively new adhesive used
in perfect binding. Pocket size books are usually bound in
this manner.

Sewn Binding

Sewn binding is the most permanent and durable way to
hold sheets of paper together. Strong thread is placed
through binding edges securely holds all sheets. There are
two types of sewn binding - Thread stitch, Section sewn.
The section sewn are more expansive book binding but
most the dureable.
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